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Bienvenue sur les Briques de Géomatique !

Cette documentation a pour but de présenter quelques manipulations courantes (et moins courantes) de géomatique avec différents outils. L’idée est de présenter des briques élémentaires avec une entrée mêlant étroitement théorie et pratique. Chaque utilisateur est invité à appliquer et à assembler ces briques à son propre projet géomatique.

L’approche se veut par besoin clef : reprojeter un raster / vecteur, construire une composition colorée, faire une jointure attributaire… et sans à priori logicielle (même si dans un premier temps une large part se fera avec QGIS). L’idée est d’expliquer brièvement en théorie chaque brique puis d’explorer leurs applications avec différents logiciels et langages.

Cette documentation est distribuée en licence CC BY-NC-SA 3.0 FR. Vous pouvez donc librement l’utiliser, la partager et la modifier.

Pour une lecture hors ligne, il est possible de télécharger la version PDF ou EPUB de cette documentation :



	PDF [https://briques-de-geomatique.readthedocs.io/_/downloads/fr/latest/pdf/]


	EPUB [https://briques-de-geomatique.readthedocs.io/_/downloads/fr/latest/epub/]







Introduction à la télédétection

Ce chapitre d”Introduction est consacrée à la présentation théorique de la télédétection, des grandes missions d’observation de la Terre et des sources de téléchargement des images satellites associées.



	Télédétection : théorie, missions, données
	Quelques points de théorie
	À la base de la télédétection optique : le Soleil

	Interaction avec l’atmosphère

	Interaction avec la surface

	Mesure du rayonnement réfléchi

	Le segment sol

	Les grandes missions d’observation de la Terre





	Missions d’observation de la Terre
	Les images Landsat

	Les images Sentinel-2





	Télécharger des images satellites
	EarthExplorer













Logiciels et outils

Ce chapitre sur les Logiciels et outils présente quelques logiciels et outils utiles à la géomatique et détaille leur procédure d’installation.



	Logiciels, présentation et installation
	QGIS
	Module SCP dans QGIS

	Installation de QGIS

	Installation d’extensions dans QGIS





	GDAL/OGR
	Installation de GDAL/OGR





	GRASS GIS

	SAGA GIS

	Orfeo ToolBox
	Installation de Orfeo Toolbox





	SNAP Toolbox
	Installation de la SNAP toolbox de l’ESA





	WhiteboxTools
	Installation de WhiteboxTools





	Python
	Librairie rasterio

	Librairie geopandas





	R
	Librairie terra

	Librairie sf





	PostgreSQL/PostGIS
	Installation de PostGreSQL/PostGIS













Format de données et import

Ce chapitre consacré au Format de données présente les principaux formats de données utilisés en géomatique et la manière de procéder pour les importer dans les différents logiciels.



	Données géospatiales, formats, import et export
	Les données rasters
	Les formats rasters





	Les données vecteurs
	La géométrie des données vecteur

	La topologie des données vecteur

	Les formats vecteurs

	Travailler avec les GeoPackage dans QGIS

	Modifier les GeoPackage dans QGIS





	Importer des données rasters
	Importer un raster dans QGIS

	Importer un raster dans R

	Importer un raster dans Python

	Importer un COG dans QGIS

	Importer un COG dans R

	Importer un flux WMS dans QGIS





	Importer des données vecteurs
	Importer une couche vecteur dans QGIS

	Importer une couche vecteur dans R

	Importer une couche vecteur dans PostGIS

	Importer un flux WFS dans QGIS





	Importer des données textes
	Importer une couche texte dans QGIS

	Importer une couche texte dans R





	Importer un tableur
	Importer un tableur dans QGIS





	Importer des points GPS
	Importer des points GPS dans QGIS

	Importer des points GPS dans R





	Importer des photos localisées
	Importer des photos localisées dans QGIS





	Importer des fonds de cartes Web
	Données Web dans QGIS





	Exporter des données rasters
	Exporter un raster depuis R

	Exporter un raster depuis Python





	Exporter des données vecteurs
	Exporter un vecteur depuis R













Systèmes de Coordonnées de Référence

Ce chapitre présente quelques généralités théoriques sur les Systèmes de Coordonnées de Référence ainsi que quelques manipulations pratiques pour les manipuler.



	Les Systèmes de Coordonnées de Références
	Les formes de la Terre
	La Terre comme une sphère

	La Terre comme un géoïde

	La Terre comme un ellipsoïde

	Les coordonnées géographiques





	Les projections, éléments de définition
	La nature des projections

	Le type de plans de projection

	La position du plan de projection

	Les codes EPSG





	Quelques projections courantes
	Pour la France

	Pour l’Europe

	Pour le monde par zones UTM

	Pour le monde





	Implications dans les SIG et en télédétection
	Sur le calcul des surfaces

	Quelle fonction choisir pour calculer des surfaces ?

	Implications sur les rasters





	Géoréférencement
	Géoréférencer un document dans QGIS





	Changement de Système de Coordonnées de Référence
	Reprojection d’un raster

	Reprojection d’une couche vecteur













Création de données

Ce chapitre sur la Création de données présente des outils pour créer ses propres données géospatiales.



	Création de données
	Digitalisation
	Digitalisation avec QGIS : les fondamentaux





	Créer des données par export d’une sélection
	Exporter une sélection avec QGIS













Tables attributaires

Ce chapitre sur les Tables attributaires est consacrée à la présentation des outils portant sur l’édition des tables attributaires associées aux couches vecteurs.



	Travailler sur les tables attributaires
	Exploration des attributs
	Exploration des attributs dans QGIS





	Calcul de champs
	Calcul de champs dans QGIS

	Calcul de champs dans R





	Renommer un champ
	Renommer un champ dans QGIS

	Renommer un champ dans R





	Changer le format d’un champ
	Convertir un champ dans QGIS





	Supprimer un champ
	Supprimer un champ dans QGIS

	Supprimer un champ dans R

	Sélectionner un champ dans R





	Ordonner les champs
	Ordonner les champs dans R





	Jointure attributaire
	Jointure attributaire dans QGIS

	Jointure attributaire dans R





	Sélection attributaire
	Requêtes attributaires dans QGIS

	Requêtes attributaires dans R





	Regrouper des entités selon un attribut
	Regrouper des entités dans QGIS

	Regrouper des entités dans R













Géométries vectorielles

Ce chapitre sur les Géométries vectorielles est consacrée à la présentation de quelques outils permettant de travailler sur les géométries des couches vecteurs.



	Travailler sur les géométries vecteur
	Erreurs de géométries
	Vérifier la géométrie

	Réparer la géométrie





	Prédicats géométriques

	Extraction des sommets
	Extraction avec QGIS





	Sélection spatiale
	Sélection spatiale dans QGIS





	Jointure spatiale
	Jointure spatiale dans QGIS





	Conversion de polygones en lignes
	Avec QGIS





	Désagréger des géométries
	Désagréger des géométries dans QGIS

	Désagréger des géométries dans R





	Géotraitements
	Zones tampons

	Intersection de polygones

	Différence de polygones

	Fusion de polygones

	Intersection de lignes





	Création de grilles
	Création de grilles dans QGIS





	Exploser des couches vecteurs
	Séparer une couche vecteur dans QGIS













Outils rasters

Ce chapitre sur les Outils rasters présente quelques outils utiles au traitement et à l’analyse de données rasters.



	Outils raster
	Histogramme d’un raster
	Histogramme d’un raster avec QGIS

	Histogramme d’un raster avec R





	Découper un raster
	Découper un raster dans QGIS

	Découper des rasters par lot dans QGIS

	Découper un raster dans R





	Créer une mosaïque de rasters
	Mosaïque de rasters dans QGIS

	Mosaïque de rasters dans R





	Raster multi-bandes
	Création d’un raster multi-bandes avec QGIS

	Création d’un raster multi-bandes avec R

	Défusionner un raster multi-bandes avec SCP (QGIS)





	Rapport de valeurs uniques
	Rapport de valeurs uniques avec QGIS

	Rapport de valeurs uniques avec SCP

	Rapport de valeurs uniques avec R





	Calcul raster mono-bande
	Calcul raster avec QGIS

	Calcul raster avec SCP

	Calcul raster avec OTB

	Calcul raster avec R

	Calcul raster avec GDAL





	Calcul raster avec statistiques
	Calcul raster et stats avec QGIS et SCP

	Calcul raster et stats avec OTB





	Reclassifier un raster
	Reclassifier un raster avec QGIS

	Reclassifier un raster avec R





	Compresser un raster
	Compresser un raster avec QGIS

	Compresser un raster avec GDAL





	Statistiques zonales raster
	Statistiques zonales raster avec QGIS

	Statistiques zonales raster avec OTB





	Aligner deux rasters
	Aligner deux rasters avec QGIS

	Aligner deux rasters avec OTB

	Aligner deux rasters avec R













Combinaison raster et vecteur

Ce chapitre sur la Combinaison raster et vecteur présente des outils permettant de faire dialoguer des couches rasters et vecteurs.



	Combinaison de rasters et vecteurs
	Découper un raster selon une couche vecteur
	Découper un raster avec un vecteur dans QGIS

	Découper un raster avec un vecteur dans SCP

	Découper un raster avec R





	Statistiques zonales
	Statistiques zonales avec QGIS

	Statistiques zonales sur raster multi-bandes avec QGIS

	Statistiques zonales avec OTB

	Statistiques zonales avec R





	Histogramme zonal
	Histogramme zonal avec QGIS





	Échantillonnage de raster selon des points
	Échantillonnage avec QGIS

	Échantillonnage avec R





	Raster vers vecteur
	Raster vers vecteur dans QGIS

	Raster vers vecteur avec SCP

	Raster vers vecteur avec GRASS GIS dans QGIS

	Raster vers vecteur avec GDAL

	Raster vers vecteur avec OTB

	Raster vers vecteur avec R





	Découper un raster selon une grille
	Découper un raster selon une grille dans QGIS













Outils de télédétection

Ce chapitre d”Outils de télédétection présente quelques manipulations de base à éventuellement effectuer avant des analyses de télédétection plus poussées.



	Outils de télédétection
	Les compositions colorées en télédétection
	Les fondements : la synthèse additive des couleurs

	Application à la télédétection optique

	Interprétation d’une composition colorée

	Composition colorée avec QGIS

	Composition colorée avec R





	Correction radiométrique
	Correction radiométrique dans QGIS avec SCP





	Correction atmosphérique
	Correction atmosphérique dans QGIS avec SCP





	Masquer les nuages
	Nuages et Landsat dans QGIS





	Les indices radiométriques
	Indices dédiés à la végétation

	Indices dédiés aux sols nus

	Indices dédiés aux zones incendiées

	Indices dédiés à l’eau

	Indices dédiés à la neige

	Outils dédiés













Classification non supervisée

Ce chapitre sur la Classification non supervisée présente la façon de procéder pour réaliser une classification non supervisée d’images satellites selon différents outils.



	Classification non supervisée d’images satellites
	Classification non supervisée avec OTB
	Préparation des données

	Kmeans dans OTB - QGIS

	Kmeans dans OTB - OTBcli





	Classification non supervisée dans R









Classification supervisée

Ce chapitre sur la Classification supervisée présente la façon de procéder pour réaliser une classification supervisée d’images satellites selon différents outils.



	Classification supervisée d’images satellites
	Quelques algorithmes
	Classification par distance minimale





	Création des couches d’entraînement et de validation
	Définition des classes

	Couche d’entraînement

	Couche de validation





	Classification supervisée d’images satellites dans QGIS avec SCP
	Définition du jeu de bandes à classifier

	Définition des classes d’occupation du sol

	Digitalisation des polygones d’apprentissage

	Contrôle des polygones d’apprentissage

	Classification standard





	Classification supervisée d’images satellites avec OTB
	Couches d’apprentissage et de validation

	Échantillonnage de la couche d’apprentissage

	Apprentissage du modèle

	Application du modèle













Post-traitement de classification

Ce chapitre sur le Post-traitement de Classification présente quelques traitements utiles à appliquer à la suite d’une classification d’images satellites pour en améliorer l’interprétation.



	Post-traitement d’une classification
	Validation d’une classification supervisée
	Validation avec le plugin SCP de QGIS

	Validation avec Orfeo ToolBox

	Indicateurs de qualité





	Fusion de classifications
	Fusion de classifications avec OTB













Segmenation d’images

Ce chapitre sur la Segmentation d’images présente les principes et les techniques de segmentations d’images à utiliser pour extraire des informations à partir notamment d’images à très haute résolution spatiale.



	Segmentation d’images
	Segmentation d’images avec Orfeo ToolBox
	Segmentation de l’image en trois sous-étapes

	Segmentation de l’image en une seule étape

	Calcul de primitives

	Classification des segments

	Validation de la classification













Géomorphologie

Ce chapitre consacré à la Géomorphologie présente quelques outils à appliquer à des modèles numériques de terrain pour en tirer des informations éclairant sur la géomorphologie d’une zone d’étude.



	Calculs géomorphologiques
	Calcul de pentes
	Calcul de pentes avec QGIS













Terrain

Ce chapitre Terrain présente des outils permettant de capturer des données géospatiales directement depuis son terrain d’étude.



	Capture de données sur le terrain
	Capture d’une trace GPS
	Trace GPS avec l’application OsmAnd





	Prendre une photo géoréférencée
	Prendre une photo géolocalisée en « natif » avec son smartphone

	Prendre une photo géolocalisée avec l’application OsmAnd













Cartographie et visualisation

Ce chapitre Cartographie et visualisation présente comment produire des cartes et des visualisations simples à partir de ses données.



	Rendu cartographique et visualisation
	Visualisation 3D
	Visualisation 3D dans QGIS avec l’extension QGIS2threejs

	Visualisation avec la Vue Cartographique 3D de QGIS

	Créer une animation ou une vidéo





	Synchroniser des vues
	Synchroniser des vues dans QGIS





	Affichage de couches avec R









Divers

Ce chapitre Divers présente des manipulations qui ne sont pas propres à la géomatique mais qui peuvent s’avérer utile dans un contexte d’analyse de données spatialisées.



	Divers
	Fouiller un fichier texte
	Fouille avec R

	Extraire du texte avec R

	Trier avec R
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Télédétection : théorie, missions, données

Cette fiche présente quelques éléments de théorie relatifs à la télédétection optique. Cette théorie est à dessein très vulgarisée et ne fera pas appel à des bases physiques poussées. L’idée est de comprendre de façon qualitative les grands principes sous-jacents à la télédétection optique afin de manipuler les images de façon éclairée. Si vous êtes intéressés par la physique du signal et des images, reportez vous à des cours ou des ouvrages spécialisés dans ce domaine. Dans cette présentation, nous nous efforcerons de lier la théorie à la pratique en nous appuyant sur des exemples concrets.

Suit une partie présentant les grandes missions d’observation de la Terre par satellite couramment utilisées en géographie.

Pour finir, quelques portails permettant de télécharger facilement les données sont présentés de façon pratique.


Table des matières


	Quelques points de théorie


	À la base de la télédétection optique : le Soleil


	Onde et longueur d’onde


	Le spectre électromagnétique






	Interaction avec l’atmosphère


	Interaction avec la surface


	Les trois composantes de l’interaction


	Le concept de signature spectrale






	Mesure du rayonnement réfléchi


	Satellite et capteur


	Décomposition en pixels


	Décomposition en bandes spectrales


	Ce que mesure le capteur


	Image en niveau d’énergie


	Image en luminance


	Image en réflectance TOA


	Image en réflectance BOA






	Des bandes spectrales aux signatures radiométriques


	Les quatre résolutions associées à un capteur






	Le segment sol


	La transmission des données


	La distribution des données






	Les grandes missions d’observation de la Terre






	Missions d’observation de la Terre


	Les images Landsat


	Bref historique


	Caractéristiques


	MSS - Landsat 1-5


	TM - Landsat 4-5


	ETM+ - Landsat 7


	OLI/TIRS - Landsat 8 / OLI-2/TIRS-2 - Landsat 9


	Path and Row


	Niveaux de traitements


	Niveau L1


	Niveau L2 - Réflectances de surface


	Niveau L2 - Températures de surface


	Niveau L3






	Métadonnées et nom des images Landsat


	Les métadonnées


	Nom des images Landsat






	Télécharger les images Landsat






	Les images Sentinel-2


	Capteur MSI


	Tuiles Sentinel-2


	Niveaux de traitements Sentinel-2


	Télécharger les données Sentinel-2










	Télécharger des images satellites


	EarthExplorer


	Emprise géographique


	Emprise temporelle et nuages


	Choix des images à télécharger


	Images Landsat


	Images MODIS


	MNT SRTM



















Quelques points de théorie

Télédétection optique

Commençons par définir ce qu’est la télédétection. Selon le Larousse, la télédétection est la « Technique d’acquisition à distance d’informations sur la surface terrestre, principalement fondée sur l’analyse d’images obtenues dans différentes gammes de longueurs d’onde à partir d’aéronefs ou de satellites. » Il faut traduire le terme d”aéronef par avion ou drone. Cette définition sera amplement suffisante pour nos besoins. Dans cette documentation, nous verrons en effet différentes techniques pour exploiter des images multi-spectrales prises à partir de satellites en orbite autour de la Terre. Nous verrons également, moins en détails, des techniques pour exploiter des images issues de prises de vue par avion ou par drone. Dans la quasi totalité des cas, nous traiterons en effet d’images prises dans différentes gammes de longueurs d’ondes.

Ici, nous ajoutons le qualificatif optique à télédétection car cette partie théorie ne se focalisera que sur les images qualifiées de optique opposées aux images qualifiées de radar. Les images optiques sont les images prises dans les gammes de longueurs d’ondes correspondantes au domaines du visible et de l’infrarouge, à savoir de 0.4 µm à 13 µm à peu près. Les images radar, quant à elles, sont prises dans les gammes de longueurs d’ondes de l’ordre de quelques décimètres correspondantes aux micro-ondes. Les techniques d’analyses de ces deux familles d’images sont sensiblement différentes, c’est pourquoi ces deux techniques sont souvent séparées.

Télédétection passive

La télédétection peut être divisée en télédétection passive et télédétection active. La télédétection passive se « contente » d’analyser l’énergie telle que réfléchie ou émise par la surface terrestre. Le capteur embarqué ne joue que le rôle de récepteur. La télédétection active, quant à elle, émet un signal en direction de la surface terrestre et analyse l’écho de se signal reçu en retour. La télédétection optique est dans la plupart des cas passive mais elle peut également être active dans le cas du Lidar. Par contre, la télédétection radar est toujours active.

Pour récapituler, dans le domaine optique, la télédétection est le plus souvent passive mais peut être active dans le cas du Lidar. Dans le domaine des micro-ondes, la télédétection est le plus souvent active - cas du radar - mais est également passive dans certains cas. Dans cette fiche, nous ne présenterons que la télédétection optique passive.


À la base de la télédétection optique : le Soleil

Dans cette partie théorie, nous suivrons le cheminement d’un rayon de lumière, ou d’un photon, depuis son émission par le Soleil, jusqu’à sa réception par un capteur embarqué sur un satellite, après avoir interagi avec la surface terrestre.

Le Soleil est l’étoile la plus proche de la Terre et est l’étoile autour de laquelle notre planète orbite. Le Soleil est situé à peu près à 150 millions de kilomètres de la Terre et sa lumière met environ 8 minutes pour nous parvenir. En fait, la « lumière » que nous percevons n’est que la fraction que nous pouvons percevoir avec nos yeux de l’ensemble du rayonnement électromagnétique émis par notre étoile. En effet, le Soleil, comme la plupart des étoiles, émet des rayonnements électromagnétiques dans des gammes de longueurs d’ondes très différentes.

Le Soleil est la source de la télédétection car c’est son rayonnement qui, après interaction avec la surface terrestre, sera mesuré par les capteurs embarqués sur les satellites. Si un jour le Soleil s’éteint, seule la télédétection active sera possible (mais ce ne sera sûrement pas le problème principal à ce moment là…).


Onde et longueur d’onde

Toute onde électromagnétique, ou tout rayonnement électromagnétique, est le résultat de la vibration couplée d’un champ électrique et d’un champ magnétique (Fig. 378 B). Toute onde est caractérisée par une longueur d’onde. Cette longueur d’onde se note fréquemment par la lettre grecque λ et représente la longueur séparant deux points identiques de l’onde, deux sommets par exemple. Elle représente la périodicité spatiale des oscillations. Celle longueur d’onde s’exprime en mètre, ou en subdivision du mètre. La longueur d’onde est aussi la distance parcourue par l’onde pendant une période d’oscillation. Elle est donc inversement proportionnelle à la fréquence. Les ondes peuvent avoir une longueur d’onde tendant vers des valeurs extrêmement petites (< 1pm) ou extrêmement grandes (milliers de kilomètres). Le champ des longueurs d’ondes est continue, c’est-à-dire qu’une infinité de valeurs est possible (Fig. 378 B). C’est pour cette raison que chaque onde peut être repérée dans ce que nous appelons le spectre électromagnétique.


[image: alternate text]

Fig. 1 Déplacement d’une onde dans le champ électromagnétique (A) et différentes longueurs d’ondes (B), de la plus petite à la plus grande (de B1 à B3).



Il existe une relation directe entre longueur d’onde et fréquence :


\[\lambda = \frac{v}{f}\]

où :


	λ est la longueur d’onde exprimée en mètre


	v est la vitesse de déplacement de l’onde, qui est assimilable à la vitesse de la lumière dans le vide dans la plupart des cas, soit 300 000 km/s


	f est la fréquence exprimée en Hertz




Ainsi, plus la longueur d’onde est petite plus la fréquence est élevée et inversement, plus la longueur d’onde est grande plus la fréquence est faible.



Le spectre électromagnétique

Comme dit précédemment, l’ensemble des longueurs d’ondes, de la plus petite à la plus grande, forme le spectre électromagnétique (Fig. 2). Ce spectre permet de regrouper les longueurs d’ondes par grand domaine comme le visible, l”infrarouge, les ondes radios, … Ce spectre est typiquement représenté avec les plus petites longueurs d’ondes sur la gauche et les plus grandes sur la droite. Chaque longueur d’onde possède un niveau d’énergie. Ce niveau est d’autant plus élevé que la longueur d’onde est petite.


[image: alternate text]

Fig. 2 Le spectre électromagnétique et les principaux domaines de longueurs d’ondes.



Les longueurs d’ondes les plus faibles appartiennent au domaine des rayons gamma. Ces rayons se retrouvent notamment dans les processus liés à la radioactivité. Ces rayons sont mortels pour le vivant. Nous retrouvons ensuite les rayons X, utilisés par exemple en radiographie médicale. Ces rayons sont nocifs mais acceptables à faible dose. Vient ensuite le domaine des ultra-violets (UV), dont il ne faut pas abuser pour la santé. Le domaine suivant est le domaine du visible, c’est-à-dire le domaine perceptible par l’œil humain. C’est bien sûr le domaine le plus important pour les êtres humains mais pour toute la vie animale en général. C’est également un domaine très utilisé en télédétection. Ce domaine a une amplitude très faible, de 400 nm pour le bleu à 700 nm pour le rouge. Ensuite, le domaine de l’infrarouge s’étend sur une large amplitude. Il s’agît du deuxième domaine important en télédétection et de loin le plus intéressant pour l’étude de la végétation. Ensuite nous trouvons le domaine des ondes radios utilisé par de nombreuses activités : radio, wi-fi, téléphone cellulaire, … Et enfin, le domaine des grandes ondes regroupe toutes les ondes dont la longueur d’onde est supérieure à quelques centaines de mètres. Chacun de ces grands domaines est découpé de façon officielle [https://fr.wikipedia.org/wiki/Spectre_%C3%A9lectromagn%C3%A9tique#Usages_et_classification] en sous domaines par l’Union Internationale des Télécommunications.


Note

Nous pouvons noter que souvent nous désignons les rayonnements les plus petits par leurs longueurs d’ondes, mais à partir du domaine des micro-ondes nous les exprimons par leurs fréquences. Ainsi, nous dirons que le bleu correspond à une longueur d’onde de 400 nm mais que Radio Libertaire émet sur une onde qui a une fréquence 89.4 MHz.



Il est utile d’avoir en tête les longueurs d’ondes qui correspondent aux principales couleurs [https://fr.wikipedia.org/wiki/Spectre_visible#Longueurs_d'onde_approximatives_des_couleurs_spectrales], nous verrons par la suite qu’elles correspondent à des bandes spectrales de nombreux capteurs. La figure suivante récapitule les longueurs d’onde du domaine du visible (Fig. 3).
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Fig. 3 Couleurs et longueurs d’ondes.



D’une manière générale, le tableau suivant présente les bandes de longueurs d’ondes approximatives des domaines les plus utilisés en télédétection optique. Les bornes inférieures et supérieures ne sont données qu’à titre indicatif, il n’y a en fait pas de valeurs absolues définies une fois pour toutes.


Tableau 1 Quelques domaines utiles pour la télédétection optique






	Domaine

	λ inférieure (µm)

	λ supérieure (µm)





	Bleu

	0.45

	0.52



	Vert

	0.52

	0.60



	Rouge

	0.63

	0.69



	Red Edge

	0.71

	0.80



	Proche infrarouge

	0.75

	0.90



	Infrarouge moyen

	1.20

	2.50



	Infrarouge thermique

	10.40

	12.50









Interaction avec l’atmosphère

Nous avons vu que le Soleil émet un rayonnement électromagnétique dans une très grande partie du spectre électromagnétique et dans toutes les directions de l’espace. Une petite partie de ce rayonnement parvient donc à notre planète et va devoir traverser (ou pas) l’atmosphère terrestre avant de parvenir à la surface. De par les propriétés physico-chimiques des gaz constitutifs de l’atmosphère, certaines longueurs d’ondes seront stoppées par l’atmosphère et d’autres pourront la traverser. Les ondes qui peuvent la traverser sont situées dans ce que nous appelons des fenêtres atmosphériques. La figure suivante répertorie les fenêtres atmosphériques et les portions opaques de l’atmosphère (Fig. 4).
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Fig. 4 Fenêtres atmosphériques.



Sur cette figure (Fig. 4), une opacité de 100 % correspond à un domaine de longueurs d’ondes pour lequel l’atmosphère est totalement opaque. C’est-à-dire que les ondes de ce domaine sont totalement stoppées par l’atmosphère et ne parviennent pas à la surface terrestre. C’est notamment le cas de toutes les ondes à forte énergie représentées par les ondes à longueurs d’ondes très petites. Ainsi, les rayons gamma, les rayons X et la majorité des UV sont bloqués par l’atmosphère. D’ailleurs, sans ce blocage, il n’y aurait pas de vie sur Terre, car ces rayonnements provoquent des mutations au niveau de l’ADN des cellules vivantes. Seule une petite partie des UV, les UV C, pénètrent l’atmosphère et est responsable du bronzage ou des coups de Soleil.

Ensuite, le rayonnement dans le domaine du visible se trouve évidemment dans une fenêtre atmosphérique. C’est pourquoi l’évolution a « produit » l’œil des animaux sensible à cette gamme de longueurs d’ondes. Si l’atmosphère
devenait opaque à ces longueurs d’ondes, nous aurions l’impression de vivre dans une nuit permanente. Les satellites en orbite, donc au delà des couches supérieures de l’atmosphère, profite également de cette fenêtre pour scanner la surface terrestre dans plusieurs bandes de ce domaine.

Les domaines de l’infrarouge proche et moyen, aux alentours de 1 - 2 µm sont également des fenêtres atmosphériques. La transparence n’est pas de 100 % dans ce domaine mais largement suffisante pour voir la surface dans ces gammes de longueurs d’ondes depuis l’espace. Nous retrouvons ensuite une fenêtre étroite aux alentours de l’infrarouge thermique dans les longueurs d’ondes de l’ordre de 10 - 12 µm. Cette gamme est également suivie par certains satellites. Mais la plus grande partie du domaine de l’infrarouge est opaque, entre 50 µm et quelques millimètres. C’est justement dans cette gamme de longueurs d’ondes que la Terre émet un rayonnement, appelé rayonnement tellurique, qui est à l’origine de l’effet de serre.

Une grande fenêtre totalement transparente se trouve ensuite pour les longueurs d’ondes radio comprises entre quelques centimètres et quelques mètres. Il est ainsi possible d’observer l’espace lointain par radioastronomie dans cette gamme de longueurs d’ondes. Grâce à cette fenêtre, il est également possible de communiquer en ondes radios avec les vaisseaux spatiaux. Enfin, l’atmosphère est opaque pour les ondes radios les plus grandes.



Interaction avec la surface


Les trois composantes de l’interaction

Le rayonnement électromagnétique qui n’a pas été bloqué par l’atmosphère peut parvenir jusqu’à la surface terrestre. Ce rayonnement va interagir avec la surface de trois façons possibles. Une part du rayonnement sera réfléchi, une part sera absorbée et une autre sera transmise. Cette interaction est présentée dans la figure suivante (Fig. 5).
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Fig. 5 Devenir d’un rayon incident sur la surface terrestre.



Dans tous les cas, la somme des énergies réfléchies, transmises et absorbées est égale à l’énergie incidente. Ainsi pour un rayon incident de 1, 0.5 peut être réfléchi, 0.25 transmis et 0.25 absorbée. Dans le cas d’une surface réfléchissant parfaitement, l’énergie réfléchie sera de 1 et les énergies transmise et absorbée seront de 0. En télédétection, c’est la part du rayonnement réfléchi qui va nous intéresser, car c’est celui-ci qui sera mesuré par le capteur à bord du satellite, de l’avion ou du drone.



Le concept de signature spectrale

Cette discrétisation en trois composantes du rayonnement incident dépend bien sûr de la nature de la surface mais aussi de la longueur d’onde du rayonnement incident. Ainsi, une surface d’eau ou de végétation réfléchiront différemment le rayonnement solaire incident. Mais en plus, une surface donnée réfléchira différemment la composante bleu du rayonnement incident de la la composante vert et ainsi de suite. Ainsi, chaque état de surface est associé à une signature spectrale qui lui est propre. Tout le jeu de la télédétection est finalement d’identifier les états de surface en fonction de leurs signatures spectrales. C’est vraiment sur ce concept de signature spectrale que repose toute la télédétection.

Les signatures spectrales peuvent être mesurées en laboratoire ou sur le terrain à partir de spectro-radiomètre. Ces signatures seront proches des signatures « pures », alors qu’en télédétection nous aurons affaire à des signatures plus ou moins bruitées selon la résolution spatiale du capteur et le niveau d’hétérogénéité de la surface. Par exemple, un lac aux eaux claires et sans algues aura une surface homogène et donc une signature spectrale proche de la signature parfaite de l’eau. Par contre, une forêt aura bien une signature typique de la végétation mais dégradée du fait des ombres, des éventuels arbres morts et des éventuelles portions de sol nu qui seraient visibles depuis le capteur.

La figure suivante présente quelques signatures spectrales de surface couramment rencontrées (Fig. 6).
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Fig. 6 Quelques signatures spectrales emblématiques.



L’eau présente une signature spectrale caractéristique. L’eau réfléchit très peu dans toutes les longueurs d’ondes et quasiment pas du tout dans le domaine de l’infrarouge. Elle présente simplement un très léger pic dans le domaine du bleu. D’où sa coloration bleu sombre. Cette signature est valable pour de l’eau pure. Dès que l’eau observée sera chargée en matières en suspension ou en algues, sa signature sera légèrement différente.

À l’opposé, la neige réfléchit énormément dans toutes les longueurs d’ondes, dans le visible comme dans la première partie de l’infrarouge. C’est pour cette raison que naturellement la neige apparaît d’une blancheur éblouissante. Cette blancheur peut tirer un peu sur le bleuté car la neige a tendance à réfléchir encore un peu plus dans le domaine du bleu. Par contre, le pouvoir de réflexion de la neige s’effondre totalement dans le moyen infrarouge. Si nous pouvons voir la neige avec nos yeux à une longueur d’onde de 1.5 µm, elle nous apparaîtrait noire.

Le sable réfléchit également beaucoup dans toutes les longueurs d’ondes, mais moins que la neige. Même si il réfléchit beaucoup, il réfléchit de plus en plus en partant du domaine du bleu. C’est pour cette raison que nous voyons le sable de couleur jaune clair.

La végétation présente également une signature typique qu’il faut retenir. Elle réfléchit peu dans le bleu et peu dans le rouge mais présente un pic dans le domaine du vert. Cette signature dans le domaine du visible explique pourquoi nous voyons la végétation en vert. Par contre, la spécificité de la végétation est de présenter un très fort pic dans le proche infrarouge, aux alentours de 0.75 µm jusqu’à 1.3 µm. Ce pic est caractéristique de la végétation. Si nous étions capables de voir dans l’infrarouge, la végétation ne nous apparaîtrait pas vert mais d’un bel infrarouge pétant. Cette signature typique de la végétation est à moduler en fonction du type de végétation. Par exemple sur la figure précédente, nous constatons que l’herbe présente un pic dans le proche infrarouge plus marqué que le chêne. Il est donc possible, dans une certaine mesure de distinguer les différents types de végétation, voire même certaines espèces.




Mesure du rayonnement réfléchi


Satellite et capteur

Comme dit précédemment, ce qui va nous intéresser en télédétection c’est le rayonnement réfléchi par la surface. C’est ce rayonnement réfléchi qui va être mesuré par le capteur embarqué sur le satellite (ou l’avion ou le drone). Même si par abus de langage nous faisons la confusion entre capteur et satellite, les deux sont différents. Le satellite est la plateforme qui supporte le capteur. Le capteur est, quant à lui, l’appareil qui mesure le rayonnement réfléchi par la surface lui parvenant. C’est bien le capteur l’élément central. Le satellite est là pour maintenir le capteur en orbite, l’alimenter en énergie via des panneaux solaires et pour le faire communiquer avec la surface pour la transmission des données par exemple (Fig. 7).

Dans la plupart des cas le satellite et le capteur ont des noms différents. Par exemple, le satellite Landsat 8 embarque un capteur nommé OLI (Optical Land Imager). Ainsi, en toute rigueur nous ne devrions pas parler d’image Landsat 8 mais d’image OLI. D’autant plus, que plusieurs capteurs peuvent être embraqués sur un même satellite. Toujours dans le cas de Landsat 8, en plus du capteur OLI, nous y trouvons le capteur TIRS (Thermal Infrared Sensor) qui mesure le rayonnement en provenance de la surface dans le domaine de l’infrarouge thermique. Il en va de même pour le satellite européen Sentinel-2 qui embarque le capteur MSI (Multispectral Instrument).
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Fig. 7 Les capteur OLI et TIRS sur le Space craft Bus de Landsat 8 (image Wikimedia Commons [https://commons.wikimedia.org/wiki/File:628643main_Fam_Portrait_466_2.jpg]).



Le satellite, embarquant le ou les capteurs, est mis en orbite autour de la Terre selon des critères précis. Son orbite définira, entre autres, son temps de retour au-dessus du même zone (16 jours pour Landsat, 5 jours pour Sentinel-2), la largeur de sa fauchée ou son angle de prise de vue. Même si les satellites sont en orbite à plusieurs centaines de kilomètres au-dessus de la surface, ils sont encore soumis aux frottements des dernières traces de l’atmosphère terrestre. Ce frottement ralentit le satellite, ce qui modifie son orbite. Des corrections d’altitude de vol sont alors nécessaires régulièrement. Lorsque le carburant nécessaire à ces manœuvres vient à manquer, le satellite est en fin de vie. C’est souvent le critère déterminant la durée de vie d’un satellite. Au final, l’orbitographie est une science en soi.


Astuce

Il existe des outils pour visualiser les orbites des différents satellites et ainsi connaître les dates de survol pour un lieu donné de la surface terrestre (ou d’une autre planète). Un de ces outils est le logiciel libre Ixion [https://climserv.ipsl.polytechnique.fr/ixion/] développé par des chercheurs du CNRS et de l’École polytechnique.





Décomposition en pixels

Le capteur à bord du satellite mesure le rayonnement réfléchi par la surface lui parvenant. Lorsque le satellite survole une portion de la surface, appelée scène, le capteur mesure le rayonnement réfléchi par cette scène et la stocke sous forme d’une image décomposée en pixels (Fig. 8).
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Fig. 8 Quelques signatures spectrales emblématiques.



La figure précédente (Fig. 8) présente un exemple simple qui nous permettra de comprendre comment le capteur enregistre le rayonnement qui lui parvient. Dans cet exemple, le satellite survole une scène simple sur laquelle nous trouvons de la forêt, de l’eau et une ville. Cette scène est décomposée en pixels par le capteur. Le raster résultant présente 42 pixels, agencés en 9 colonnes et 7 lignes. Ses dimensions sont donc de 9 × 7. Chaque pixel enregistre le rayonnement moyen réfléchi par la portion de surface correspondante. Ainsi, le pixel en haut à gauche n’enregistre que du rayonnement réfléchi par la forêt. Ce rayonnement sera donc caractéristique de la végétation. De même, le pixel en bas à droite n’enregistre que du rayonnement réfléchi par le lac. Il sera donc caractéristique d’une surface en eau. Par contre, les pixels du milieu qui sont à cheval entre de la forêt et l’eau enregistrent un rayonnement qui est un mixte entre celui de la forêt et de l’eau. Ils ne seront donc caractéristiques ni de l’un ni de l’autre.


Avertissement

En réalité, dans la quasi totalité des cas, les pixels ne sont jamais homogènes. C’est d’autant plus vrai pour les résolutions spatiales les plus grossières. Même un pixel d’océan peut présenter une hétérogénéité due à une efflorescence algale, à la présence d’un récif, au passage d’un bateau, …





Décomposition en bandes spectrales

En plus d’une décomposition en pixels, le capteur décompose le rayonnement reçu en bandes spectrales. C’est-à-dire que le capteur n’enregistre pas la totalité du rayonnement d’un coup, mais l’enregistre gamme de longueurs d’ondes par gamme de longueurs d’ondes. Dans notre exemple, nous considérerons que le capteur mesure le rayonnement réfléchi dans quatre bandes spectrales : le domaine du bleu, du vert, du rouge et du proche infrarouge. Tout se passe comme si le capteur regardait la même scène mais dans quatre bandes spectrales différentes. Pour chaque bande spectrale, il enregistre le niveau d’énergie réfléchie correspondant. Ainsi, en sortie nous n’obtiendrons pas une mais quatre images de la même zone : une image dans la bande spectrale du bleu, une dans celle du vert, une dans celle du rouge et une dernière dans celle du proche infrarouge (Fig. 9).
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Fig. 9 Une même scène vue dans quatre bandes spectrales différentes.



Sur la figure précédente, nous retrouvons notre scène initiale composée d’eau, de forêt et de ville mais vue dans les quatre bandes spectrales du satellite. Dans la première bande, le capteur a mesuré l’énergie qui lui parvient depuis la surface dans le domaine du Bleu. Comme vu plus haut, l’eau réfléchit un peu dans le bleu, le capteur va donc enregistrer un peu d’énergie pour les pixels correspondant à l’eau. Par convention, sur un raster en niveaux de gris, un pixel recevant beaucoup d’énergie va apparaître clair, et inversement un pixel recevant peu d’énergie va apparaître foncé. Ici, les pixels d’eau apparaissent donc en gris pas trop foncé. Par contre, la végétation comme le bâti réfléchissent peu dans le domaine du bleu. Les pixels correspondants à ces surfaces vont donc apparaître très foncés.

Dans la deuxième bande spectrale correspondant au domaine du Vert, le capteur mesure l’énergie réfléchie dans ce domaine. Seule la végétation qui réfléchit un peu dans le vert va apparaître claire. L’eau comme le bâti réfléchissent peu et vont donc apparaître très foncé. Dans la troisième bande spectrale, celle du rouge, les trois surfaces réfléchissent très peu, la scène va donc apparaître très sombre partout.

Enfin, la quatrième bande spectrale, celle du proche infrarouge est très intéressante pour la végétation. Nous avons vu plus haut que la végétation réfléchit très fortement dans le domaine du proche infrarouge, c’est une de ces caractéristiques les plus fortes. Les pixels correspondant à la forêt vont ainsi apparaître en gris très clair. Par contre l’eau ne réfléchit pas du tout dans le proche infrarouge. Les pixels d’eau vont donc apparaître  noirs. Le bâti réfléchit juste un peu plus que l’eau dans ce domaine, il apparaîtra donc très foncé mais pas totalement noir.



Ce que mesure le capteur

Le capteur en lui-même mesure des niveaux d’énergie dans différentes bandes spectrales que nous pouvons assimiler à des puissances. Ce niveau de mesure n’est pas suffisant pour étudier les états de surface, il est nécessaire de lui apporter une série de corrections. Le nombre de corrections à apporter dépend du but poursuivi par l’utilisateur et du niveau de traitement des données récupérées (tableau suivant). Le tableau suivant récapitule les différents niveaux de corrections. Des détails de chacun de ces niveaux sont donnés par la suite. La théorie reste la même pour tous les capteurs, mais pour plus de clarté nous nous focaliserons plus spécifiquement sur le capteur Landsat (Les images Landsat).


Tableau 2 Niveaux de produits d’images








	Grandeur mesurée

	Phénomène impactant

	Correction à apporter

	Niveau de produit

	Exemples de domaine d’utilisation





	Niveau d’énergie / puissance

	Propriétés du capteur et orbite

	Transformation en luminance

	L1 (Landsat) (1)

	Peu d’utilisation



	Luminance

	Éclairement

	Transformation en réflectance TOA (2)

	–

	Peu d’utilisation



	Réflectance TOA

	Effets atmosphériques

	Transformation en réflectance BOA (3)

	L1C (Sentinel-2)

	Étude mono-date



	Réflectance BOA

	Effets topographiques et directionnels

	Transformation en réflectance de surface

	L2

	Séries temporelles



	Réflectance de surface après corrections topographiques

	Effets directionnels

	–

	Selon les missions

	Étude en milieu montagneux



	Réflectance de surface après corrections des effets directionnels

	–

	–

	Selon les missions

	Qualité de l’eau







	Les images Sentinel-2 ne sont pas distribuées à ce niveau de correction au grand public.


	TOA pour Top Of Atmosphere (Haut de l’Atmosphère)


	BOA pour Bottom Of Atmosphere (Bas de l’Atmosphère), souvent assimilée par simplification à la réflectance de surface





Image en niveau d’énergie

Les images en niveaux d’énergies ne reflètent pas directement les états de la surface. Les niveaux d’énergie enregistrés par le capteur dépendent en effet de l’altitude du satellite, de sa vitesse de défilement, de la durée de la mesure et de l’angle solide de l’observation. Un même capteur à bord de deux satellites différents n’enregistrera pas le même niveau d’énergie pour une même surface si les deux satellites sont sur des orbites différentes (Fig. 10).
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Fig. 10 Deux capteurs identiques pointant la même portion de surface. Le capteur A mesurera un plus grand niveau d’énergie que le capteur B de par son altitude moins élevée alors que la surface est la même.



Les pixels des images en niveaux d’énergie sont exprimées en Comptes Numériques (CN) aussi appelés Digital Numbers (DN) en anglais. Les valeurs des pixels s’étalent de 0 à plusieurs milliers selon l’encodage de l’image. Les images Landsat sont disponibles en niveaux d’énergie, elles sont alors en niveau L1, mais il est rare de travailler directement sur ces images. Il est dans la plupart des cas nécessaire de au moins les transformer en réflectande haut de l’atmosphère (TOA). Les images Sentinel-2, quant à elles, ne sont pas distribuées à ce niveau pour le grand public. Pour transformer ces niveaux d’énergie en une grandeur réellement reliée à l’état de surface il faut convertir ce niveau d’énergie en luminance spectrale. L’USGS fournit une documentation pour effectuer ces différents traitements [https://www.usgs.gov/landsat-missions/using-usgs-landsat-level-1-data-product].



Image en luminance

Afin de rendre la mesure indépendante des propriétés physiques du capteur et de l’orbite du satellite, nous devons transformer les Comptes Numériques en luminance spectrale. Cette transformation est un calcul simple qui prend en entrée deux paramètres, un gain et un offset, fournis dans les métadonnées de l’image. La luminance se calcule pour chacune des bandes spectrales et les paramètres de gain et de offset peuvent varier d’une bande spectrale à l’autre. L’équation à appliquer est la suivante.


\[L_{\lambda} =  gain_{\lambda} * CN_{\lambda} + offset_{\lambda}\]


	où :
	
	Lλ: luminance pour une bande spectrale donnée


	gainλ: le paramètre de gain pour une bande spectrale donnée


	CNλ: l’image en Comptes Numériques d’une bande spectrale donnée


	offsetλ: le paramètre de offset pour une bande spectrale donnée








Ce calcul peut tout à fait se faire à la main en utilisant simplement la calculatrice raster de notre logiciel de géomatique préféré. Pour une image Landsat 8, dans le fichier texte de métadonnées (_MTL.txt) le gain est connu sous le nom de RADIANCE_MULT_BAND et le offset par RADIANCE_ADD_BAND avec une déclinaison par bande (Fig. 11).
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Fig. 11 Gain et Offset d’une image Landsat 8 pour chacune des 8 bandes spectrales.




Note

La luminance est aussi souvent vue sous son nom anglais de radiance.



Une fois l’image convertie en luminance, les valeurs des pixels sont directement liées à l’énergie effectivement réfléchie par la surface. Cependant, des bruits sont encore présents, notamment ceux liés à aux conditions d’éclairement de la scène au moment de la prise de vue. Ainsi, il est très rare de travailler avec des images en luminance. La luminance n’est qu’une étape pour calculer des réflectances TOA. Les images en luminance ne sont d’ailleurs jamais fournies directement.



Image en réflectance TOA

Sur une image en luminance, une partie de l’énergie enregistrée ne provient pas de la surface mais de l’éclairement directement reçu du Soleil (Fig. 14). Il est donc nécessaire d’enlever cette composante pour analyser l’état de la surface. Cette correction peut se faire de deux façons différentes pour les images Landsat, une méthode historique et une méthode plus actuelle.


Note

Les images Sentinel-2 sont directement fournis en réflectance TOA. Ce sont les images de niveau L1C.



La méthode historique

Cette correction se fait en prenant en entrée différents paramètres. Une simple équation, à appliquer à chacune des bandes avec les paramètres spécifiques, est à utiliser. Cette équation est la suivante.


\[ρ_{\lambda} = \frac{π * L_{\lambda} * d^2}{ESUN_{\lambda} * cos(θ_s)}\]


	où :
	
	ρλ: réflectance TOA de la bande spectrale


	Lλ: luminance de la bande spectrale


	d : la distance Terre - Soleil en unités astronomiques [https://www.futura-sciences.com/sciences/definitions/univers-unite-astronomique-63/] au moment d’acquisition


	ESUNλ: éclairement exoatmosphérique de la bande spectrale


	θs: angle zénithal du Soleil








La luminance (Lλ) se calcule comme indiqué dans le paragraphe précédent (Image en luminance). La distance Terre - Soleil du moment d’acquisition se trouve soit dans le fichier de métadonnées sous le nom EARTH_SUN_DISTANCE soit dans des éphémérides trouvables en ligne [https://www.usgs.gov/media/files/earth-sun-distance-astronomical-units-days-year]. Le paramètre d’éclairement ESUNλest une caractéristique du capteur à retrouver dans la documentation du fournisseur [https://www.usgs.gov/landsat-missions/using-usgs-landsat-level-1-data-product]. Enfin, l’angle zénithal est la différence entre l’angle droit (90°) et l’angle d’élévation du Soleil au moment de la prise de vue (SUN_ELEVATION du fichier de métadonnées) (Fig. 12).
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Fig. 12 Angle zénithal et angle d’élévation du Soleil.




Note

Le cosinus de l’angle zénithal est aussi égal au sinus de l’angle d’élévation du Soleil.



La méthode actuelle

Avec les dernières générations de produits Landsat, il existe une méthode plus directe [https://www.usgs.gov/landsat-missions/using-usgs-landsat-level-1-data-product] pour passer des images en Comptes Numériques en réflectance TOA. Cette méthode ne repose que sur des paramètres disponibles dans le fichier de métadonnées et s’affranchit du passage par la luminance et des paramètres ESUNλ et de distance Terre - Soleil. L’équation à employer est la suivante.


\[ρ_{\lambda} = \frac{M_{\lambda} * CN_{\lambda} + A_{\lambda}}{sin(θ_{se})}\]


	où :
	
	ρλ: réflectance TOA de la bande spectrale


	Mλ: facteur multiplificatif pour la bande spectrale (REFLECTANCE_MULT_BAND)


	Aλ: facteur additif pour la bande spectrale (REFLECTANCE_MULT_BAND)


	CNλ: l’image en Comptes Numériques de la bande spectrale


	θse : angle d’élévation du Soleil (SUN_ELEVATION)









Avertissement

Depuis Landsat 8 il n’est plus possible d’utiliser la méthode historique car les paramètres ESUN associés aux capteurs ne sont plus diffusés par la NASA, même si certains sites annexes [https://www.gisagmaps.com/landsat-8-atco/] les répertorient. Il faut donc utiliser la méthode actuelle.



À ce niveau, que ce soit avec la méthode historique ou la méthode actuelle, nous avons des images exprimées en réflectance TOA (Haut de l’Atmosphère). Cette réflectance est représentative de la réflectance de la surface mais présente encore un bruit dû à la présence de l’atmosphère. En effet, l’atmosphère, de par sa composition physico-chimique va avoir tendance à atténuer ou brouiller l’énergie réfléchie par la surface. Il est donc conseillé de poursuivre les corrections en appliquant une correction atmosphérique qui va permettre d’obtenir une image en réflectance BOA (Bottom Of Atmosphere, Réflectance Bas de l’Atmosphère).


Astuce

Dans les logiciels de géomatique il existe souvent des modules qui font ces corrections radiométriques automatiquement (Correction radiométrique). Il n’y a donc pas à entrer à la main les différentes équations. Le module SCP de QGIS le propose par exemple (Correction radiométrique dans QGIS avec SCP).





Image en réflectance BOA

Pour se convaincre des effets atmosphériques il suffit de se mettre à l’ombre d’un arbre ou d’un bâtiment par une belle journée ensoleillée. Même en étant dans l’ombre, donc n’étant pas éclairé directement par le Soleil vous pourrez voir autour de vous. La zone à l’ombre sera plus obscure que la zone directement éclairée mais vous y verrez tout de même clairement. Cette clarté des zones en ombre vient du fait qu’une partie de l’éclairement solaire est réfléchi dans toutes les directions par l’atmosphère. Ainsi, le rayon lumineux qui vous parvient lorsque vous êtes à l’ombre, ne parvient pas directement du Soleil mais provient d’un rayon solaire qui a été réfléchi dans votre direction par une particule de l’atmosphère. C’est en somme un rayonnement indirect.

Il est intéressant de voir que sur la Lune, où il n’y a pas d’atmosphère, les zones en ombre sont totalement obscures, elles apparaissent comme des zones de néant. C’est largement visible sur les photos prises pendant les missions Apollo. Sur la figure suivante (Fig. 13) nous constatons que les zones dans l’ombre de l’astronaute et du Rover sont totalement noires, impossible d’y voir quoi que ce soit.
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Fig. 13 Gene Cernan sur la Lune lors de la mission Apollo 17. Les zones en ombre sont totalement obscures. (Photo NASA)



Les deux principaux facteurs d’influence sont la diffusion et l”absorption. Le premier est surtout dû à la présence d’humidité dans l’atmosphère (Fig. 14). Par une journée humide la diffusion sera plus importante que par une journée sèche. Le second est dû à la présence d’aérosols comme des poussières, du sable ou des suies. Les jours de vent de sable (dans les régions arides) ou les jours de fortes pollutions, le rayonnement réfléchi par la surface sera très atténué.
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Fig. 14 Corrections radiométriques et atmosphériques. La correction radiométrique enlève les composantes 1 et 2 du rayonnement. La correction atmosphérique enlève (tout au moins réduit) la diffusion (3) et l’atténuation (4).



Par définition, les effets atmosphériques sont très fluctuants dans le temps car dépendants des conditions météorologiques locales et même variables d’un endroit à l’autre de la scène. Ils sont également dépendants de la pollution atmosphérique qui change elle aussi rapidement. Il n’est donc pas simple de corriger ces effets. Deux types de méthodes existent, celles basées sur des modèles physiques et celles basées sur des relations empiriques entre bandes spectrales de l’image.

Les méthodes à bases physiques sont gourmandes en données d’entrée et font appel à des données météos et de qualité de l’air. Ces données peuvent provenir de mesures sur le terrain mais aussi d’autres produits satellites orientés sur l’étude de l’atmosphère. Ces corrections ne sont pas simples à mettre en œuvre, mais ce sont celles-ci qui sont utilisées par les grands producteurs de données (USGS, ESA, …). Ainsi, les images Landsat proposées en réflectance BOA sur les différents portails ont été produites sur la base de ces méthodes. La méthode à base physique 6S [https://grass.osgeo.org/grass78/manuals/i.atcorr.html] est souvent employée. Mais lorsque nous disposons d’une image en réflectance TOA et que nous souhaitons la transformer en réflectance BOA par nous mêmes, nous utilisons plutôt une méthode empirique de type Dark Object Soustraction (DOS).

Les méthodes DOS partent de l’hypothèse que certains pixels de l’image devraient être totalement sombres, i.e. avoir une réflectance à 0, dans certaines longueurs d’ondes. Typiquement, les pixels en eau devraient avoir une réflectance nulle dans l’infrarouge si il n’y avait pas d’effets atmosphériques. Ces méthodes ne sont pas parfaites mais donnent des résultats satisfaisants.


Note

Il existe plusieurs méthodes DOS, dénommées DOS1, DOS2, etc. Pour les détails, consulter la documentation de l’outil utilisé [https://grass.osgeo.org/grass78/manuals/i.landsat.toar.html].



Il est possible d’appliquer ces corrections atmosphériques à l’aide de modules tout prêts dans les logiciels de géomatique (Correction atmosphérique). Le module de SCP de QGIS propose une méthode DOS (Correction atmosphérique dans QGIS avec SCP).


Astuce

La réflectance BOA est souvent assimilée à la Réflectance de Surface et il est tout à fait possible de s’en contenter. Elle en est en effet une bonne approximation dans la plupart des cas. Mais en toute rigueur, il faut encore prendre en compte les effets topographiques et les effets spéculaires.






Des bandes spectrales aux signatures radiométriques

Au sein d’une même scène, les pixels sont spatialement cohérents, ils ont exactement les mêmes coordonnées géographiques. Ils se superposent parfaitement. Il est donc possible de « superposer » les différentes bandes spectrales et de tracer les signatures radiométriques d’un pixel en relevant ses valeurs d’énergies réfléchies dans chaque bande spectrale (Fig. 9 B).
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Fig. 15 Dérivation de signatures radiométriques (C) des pixels 1 et 2 (A) selon 4 bandes spectrales (B).



Dans notre exemple, nous allons tracer les signatures radiométriques des pixels Px1 et Px2 (Fig. 9 A). Nous commençons par relever les valeurs des niveaux d’énergies réfléchies pour ces deux pixels dans chacune des bandes spectrales (Fig. 9 B). Une fois ces valeurs relevées nous les traçons sur un graphique dont l’axe des ordonnées est le niveau d’énergie enregistré dans chaque bande spectrale et l’axe des abscisses correspond aux quatre bandes spectrales. Nous construisons ainsi les signatures radiométriques des deux pixels (Fig. 9 C). Le travail est ensuite d’analyser ces signatures et d’en déduite la nature de la surface sous-jacente.

Le pixel 1 présente une faible valeur dans le bleu et le rouge mais un léger pic dans le vert. Il présente surtout un très fort pic dans le proche infrarouge. Cette signature est caractéristique de la végétation. Nous pouvons donc en déduire que le pixel 1 est couvert de végétation en bonne santé. Le pixel 2, quant à lui, présente un léger pic dans le domaine du bleu, puis diminue très vite et descend quasiment à 0 dans le proche infrarouge. Cette signature est typique de l’eau. Le pixel 2 correspond donc à une surface en eau.



Les quatre résolutions associées à un capteur

Chaque capteur à bord d’un satellite est caractérisé par quatre résolutions différentes : résolution spatiale, spectrale, temporelle et radiométrique.

La résolution spatiale correspond à la taille élémentaire de la surface au sol mesurée par le capteur embarqué. Par exemple, un capteur présentant une résolution spatiale de 10 m, mesurera le rayonnement réfléchi par la surface sur un carré au sol de 10 m de côté. Le rayonnement enregistré par le capteur sera la moyenne de tous les rayonnements en provenance de ce carré de 10 mètres de côté. Tout objet inférieur à 10 m de côté ne sera pas perçu individuellement par le capteur. Lorsque les images sont fournies aux utilisateurs, la résolution des rasters fournis correspond à la résolution spatiale du capteur.


Avertissement

Par abus de langage nous sommes tentés de dire que la résolution spatiale d’un capteur est égale à la résolution du raster de l’image mais c’est un raccourci à éviter. Ce sont en fait deux résolutions indépendantes mais que nous faisons la plupart du temps coïncider. Mais il est tout à fait possible de construire un raster à une résolution de 100 m ✕ 100 m en moyennant 100 pixels de 10 m de côté à partir d’une image issue d’un capteur à une résolution spatiale de 10 m. Au final, nous aurons bien une distinction entre la résolution spatiale du capteur (10 m) et la résolution du raster (100 m).



La résolution spectrale est, à l’origine, la largeur en termes de longueurs d’ondes, de chaque bande spectrale du capteur. En effet, lorsque nous parlons de bande spectrale, nous parlons en fait d’un intervalle entre deux longueurs d’ondes. Par exemple, la bande du proche infrarouge du capteur OLI sur Landsat 8 s’étale de de 0.85 à 0.88 µm, soit 0.33 µm alors que la bande du proche infrarouge de MSI sur Sentinel-2 s’étale de 0.8542 à 0.8752 µm soit 0.021 µm. La résolution spectrale de MSI est donc plus fine que celle de OLI pour cette bande. Par extension, il est fréquent également d’associer la résolution spectrale d’un capteur au nombre de bandes spectrales du capteur. Par exemple, un capteur disposant de 20 bandes spectrales aura ainsi une résolution spectrale de 20.

La résolution temporelle correspond à la fréquence de revisite d’un site, c’est-à-dire à la durée de temps nécessaire pour qu’un capteur survole deux fois la même zone. Une résolution temporelle fine correspond à un temps de revisite court. Cette résolution ne dépend pas du capteur mais à l’orbite du satellite ainsi qu’à la latitude du point d’observation. Par exemple, le satellite Sentinel-3 à un temps de revisite de 1 à 2 jours selon la latitude. Concrètement ça signifie que le satellite passer tous les jours au-dessus d’une ville située proche de l’Équateur et tous les deux jours pour une ville située en Arctique.

La résolution radiométrique correspond à la sensibilité du capteur. Elle correspond à sa capacité à mesurer et à permettre la distinction dans une même bande spectrale de différences dans l’énergie réfléchie par la surface. Un capteur avec une résolution radiométrique très fine devra enregistrer un nombre de niveaux d’intensité plus important. Une résolution radiométrique fine demandera donc d’enregistrer les images dans un encodage permettant de stocker beaucoup de valeurs différentes.




Le segment sol

Une fois ces mesures effectuées par le capteur à bord du satellite, les données sont stockées sur une mémoire interne mais elles doivent ensuite être transmises à la Terre pour être traitées par ce qu’on appelle le segment sol. Ce segment sol est l’ensemble des infrastructures à la surface terrestre qui vont réceptionner les images, les traiter, les calibrer et les distribuer auprès des scientifiques, des gestionnaires ou tout autre acteur.


La transmission des données

Au tout début de l’âge de la télédétection spatiale, les images étaient simplement des photographies prises sur pellicules. Ces pellicules étaient protégées dans une capsule blindée qui était alors éjectée vers la Terre. Lors de son entrée dans l’atmosphère un parachute était automatiquement déployé et un avion était en charge de la repérer dans le ciel et de la récupérer en plein vol grâce à une sorte de rateau qu’il traînait derrière lui. Ça demandait évidemment pas mal de logistique et quelques ratés étaient possibles. Cette technique était notamment celle employée par le programme d’espionnage étasunien Corona [https://en.wikipedia.org/wiki/Corona_%28satellite%29] des années 1960 (Fig. 16).
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Fig. 16 Un avion de l’US Air Force récupérant une capsule contenant des films Corona vers les années 1960 (Image NASA).



Bien sûr, aujourd’hui les données sont transmises par ondes radios de façon tout à fait dématérialisée. Cette transmission nécessite par conséquent un large réseau d’antennes réceptrices au sol. Ces antennes sont souvent localisées proches des régions polaires. Ces régions ont en effet l’avantage d’être survolées à chaque révolution du satellite. Le satellite peut ainsi se décharger de ses données à chaque orbite. Le volume de données étant très important, le réseau d’antennes doit être étendu afin de multiplier les points de réception (Fig. 17).
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Fig. 17 Carte des stations de réception utilisées par le programme Landsat (à gauche); station de réception de Kiruna [https://www.esa.int/Enabling_Support/Operations/ESA_Ground_Stations/Kiruna_station] en Laponie [https://www.google.fr/maps/place/67%C2%B051'25.7%22N+20%C2%B057'51.6%22E/@68.2471108,15.2092732,724017m/data=!3m1!1e3!4m5!3m4!1s0x0:0x0!8m2!3d67.8571278!4d20.964325?hl=fr] utilisée par l’ESA (à droite, image de l’ESA).



Une fois ces données réceptionnées, elles doivent être prétraitées et calibrées avant d’être distribuées à différents niveaux de corrections.



La distribution des données

Les satellite transmettent les données dans un niveau très brut intitulé Niveau 0 ou Level 0 en anglais, abrégé en L0. Ce niveau n’est pas proposé aux utilisateurs finaux. Avant distribution, les données sont au moins transformées en niveau 1 (L1). À ce niveau les données sont fournies sous formes d’images orthorectifiées avec plus ou moins de finesse. Mais les valeurs associées aux pixels ne sont pas encore des réflectances mais des niveaux d’énergie exprimés en comptes numériques ou Digital numbers (DN). À ce stade, si l’utilisateur souhaite obtenir des images en réflectance en haut de l’atmosphère (Top Of Atmosphere (TOA)), il est nécessaire d’appliquer des corrections radiométriques. Ces corrections corrigent l’image en prenant en compte des paramètres comme l’inclinaison du Soleil sur l’horizon au moment de la prise de vue ou l’orientation du Soleil par rapport au capteur. Ces corrections se font grâce au fichier de métadonnées associé à chaque image. Il est ensuite possible d’obtenir une réflectance de surface ou Top Of Canopy (TOC) reflectance en appliquant en plus une correction atmosphérique. Cette correction permet de corriger les artefacts dus aux aérosols ou à l’humidité de la colonne d’air se trouvant sur le chemin de la surface au capteur. Cette correction peut se faire de façon empirique ou sur la base d’un modèle physique.

Les images sont fournies en réflectance à partir du niveau 2 (L2). Il s’agît dans la plupart des cas de réflectances de surface (Fig. 18). L’intérêt c’est que les corrections radiométriques et atmosphériques ont déjà été appliquées par le fournisseur de l’image. La correction atmosphérique est généralement mieux faite par le fournisseur que par l’utilisateur. Parfois, une bande de qualité est associée à l’image. Dans cette bande de qualité, à chaque pixel est associée une valeur indiquant si il s’agît d’un pixel clair, nuageux, couvert d’aérosol ou de cirrus. Cette bande est utile pour faire un masque des pixels non valides avant de faire des traitements comme des classifications.
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Fig. 18 Image en réflectance en haut de l’atmosphère (TOA, à gauche), en réflectance de surface (SR, au centre) et en température de surface (à droite). L’image en réflectance de surface est nettement plus contrastée. Image issue de la documentation de la NASA sur les images de la Collection 2 Level 2 [https://www.usgs.gov/core-science-systems/nli/landsat/landsat-collection-2-level-2-science-products].



Il existe également un niveau 3 (L3) qui correspond à un produit plus élaboré qu’une simple image en réflectance. Par exemple, il peut s’agir d’une image composite sur une période donnée, où à chaque pixel est associée la meilleure valeur de réflectance de la période. Les images composites de cette sorte présentent l’avantage de minimiser la présence de nuages. Par contre, ces images mélangent des réponses spectrales de dates différentes. Les produits de niveaux 3 peuvent également être les surfaces en eau dérivées de l’image, ou des indices comme le NDVI.

Selon missions la définition des niveaux peut légèrement changer. Il est bien de se référer à la documentation associée aux images pour être sûr. Pour plus de détails sur les corrections et leurs mise en œuvre, vous pouvez vous référer aux fiches correspondantes.




Les grandes missions d’observation de la Terre

Il existe de très nombreuses missions d’observation de la Terre par satellite, mais quelques unes sont plus importantes ou plus utilisées que d’autres. Le tableau suivant présente quelques missions dont les images sont très employées. Seules les missions de télédétection optique et consacrées à l’étude de la surface sont présentées.


Tableau 3 Quelques grandes missions satellites d’observation de la surface










	Mission

	Période

	Résolution (m)

	Bandes

	Temps de retour

	Agence

	Accès





	Landsat

	1972 - →

	15 - 90

	4 - 11

	≈ 16 jours

	NASA

	Libre



	SPOT 1- 5

	1986 - 2015

	10 - 20

	4 + 2 PAN

	
	CNES

	Restreint



	SPOT 6- 7

	2012 - →

	1.5 - 6

	4 + PAN

	
	CNES

	Restreint



	Sentinel-2

	2015 - →

	10 - 20

	13

	≈ 5 jours

	ESA

	Libre



	Pléiades

	2011 - →

	0.5 - 2

	4 + PAN

	≈ 26 jours

	CNES

	Restreint



	Sentinel-3

	2014 - →

	300

	21

	1 à 2 jours

	ESA

	Libre



	MODIS

	1999 - →

	250 - 1000

	36

	1 à 2 jours

	NASA

	Libre



	ResourceSat

	2003 - →

	5.8 - 56

	4

	
	ISRO

	Libre






La résolution spatiale peut différer d’une bande à l’autre d’un même capteur et change avec l’évolution des missions. Par exemple, les premières images Landsat avaient une résolution spatiale de 90 m mais seulement de 15 ou 30 mètres aujourd’hui. Vous trouverez plus de détails sur les missions Landsat sur la fiche dédiée : Les images Landsat et pour Sentinel-2 : Les images Sentinel-2.




Missions d’observation de la Terre

Il existe de nombreux programmes d’observations de la Terre par satellites. Nous présenterons ici quelques un des programmes les plus utilisés en géographie ainsi que quelques portails Web qui permettent de télécharger les images des missions correspondantes.
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Les images Landsat

Le programme Landsat est un programme étasunien d’observation de la Terre depuis l’espace. Il est maintenu depuis 1972 par la NASA et l’USGS (United States Geological Survey). C’est le programme le plus employé en télédétection spatial. Cette fiche présente un bref historique du programme ainsi que les principales caractéristiques des images au cours du temps.


Bref historique

Les missions Landsat ont débuté en 1972, avec Landsat 1, et se sont poursuivies jusqu’à aujourd’hui (presque) sans interruption (Fig. 19). Ce programme est voué à continuer avec la mise sur Orbite de Lanbsat 9 en septembre 2021. Grâce à ce programme nous disposons de près de 50 ans de données relatives à l’observation des surfaces terrestres depuis l’espace. De plus, ces images sont mises à disposition du grand public librement et gratuitement au travers de portails très ergonomiques. La résolution spatiale des images est de 30 mètres, depuis le capteur TM mis en service en 1982, ce qui est déjà largement suffisant pour beaucoup d’applications. Ces caractéristiques spatiales et temporelles font que ces images sont utilisées dans tous les domaines d’application possibles : suivi de l’usage des sols, hydrologie, glaciologie, géologie, suivi des risques …
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Fig. 19 Chronologie des missions Landsat.



Il est important de noter que les satellites Landsat (1 à 9) sont les plateformes et que les capteurs portent des noms différents. Ainsi, à bord des premières générations de Landsat 1 à Landsat 3, nous retrouvons le capteur MSS qui possède certaines caractéristiques physiques. Ensuite, à bord des Landsat 4 et 5, lancés en 1982 et 1984, nous retrouvons conjointement les capteurs MSS et TM (Thematic Mapper). Le capteur TM est plus évolué que le MSS et présente des résolutions radiométriques et spatiales plus fines. Ensuite, à bord de Landsat 6, un nouveau capteur fait son apparition ETM. Mais malheureusement Landsat 6 n’est pas parvenu à se mettre en orbite et a donc échoué. Suit Landsat 7, lancé en 1999, avec à son bord le capteur ETM+ (Enhanced Thematic Mapper +). Ce satellite a pris des images jusqu’au 6 avril 2022, mais suite à une défaillance survenue en mai 2003, ses images sont difficilement exploitables (Fig. 20). Ainsi, les deux satellites en orbite sont Landsat 8 et Landsat 9. Ils embarquent respectivement les capteurs OLI (Operational Land Imager) et TIRS (Thermal Infrared Sensor) pour l’infrarouge thermique pour Landsat 8 et OLI-2 et TIRS-2 pour Landsat 9. Ces deux capteurs OLI et OLI-2 (tout comme TIRS et TIRS-2) sont identiques en termes de bandes spectrales. Notons que nous mélangeons fréquemment les noms des images, nous pouvons parler d’images Landsat 9 ou d’images OLI-2 de façon interchangeable.
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Fig. 20 Problème sur l’optique de ETM+ à bord de Landsat 7. Seule la bande centrale est nette, les reste de l’image est striée de bandes sans données.



Nous pouvons noter la très longue longévité de Landsat 5, près de 28 ans d’observations à lui tout seul. Entre 1984 et 1999 le capteur MSS a acquis des prises de vue en parallèle du capteur TP. Puis, à partir de 1999,  seul le capteur TM a été maintenu en activité. Ce capteur est tombé en panne en novembre 2011 et les ingénieurs de la NASA ont réussi à remettre en route le capteur MSS en juin 2012 bien qu’il soit resté éteint pendant 12 ans. Ainsi, de juin 2012 à septembre 2013 nous retrouvons des images MSS. Malgré cette remise en route, du fait de la défaillance des capteurs TM et ETM+, l’année 2012 est un trou dans les données Landsat. La figure suivante résume les disponibilités temporelles de chaque capteur (Fig. 21).
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Fig. 21 Disponibilité temporelle des différents capteurs Landsat.




Note

Derrière toutes ces données numériques, il y a bien sûr des femmes et des hommes et notamment Virginia Tower Norwod [https://www.technologyreview.com/2021/06/29/1025732/the-woman-who-brought-us-the-world/] qui a mis au point le capteur MSS de Landsat 1 à la fin des années 1960.





Caractéristiques

Le capteur MSS avait une résolution spatiale de 60 m et depuis le capteur TM la résolution spatiale est de 30 m. Si la résolution spatiale n’évolue plus, la résolution radiométrique, elle, évolue. Au cours des générations, de nouvelles bandes spectrales sont disponibles. Un des gros avantages des images Landsat est leur superposition parfaite au cours du temps. Un pixel TM de 30 mètres sur mètres de 1984 est spatialement rigoureusement identique au pixel de 30 mètres sur 30 mètres d’une image OLI prise en 2021 au même endroit. Cette concordance spatiale permet une analyse temporelle très robuste.

Les tableaux suivants résument les caractéristiques radiométriques des différents capteurs.



MSS - Landsat 1-5


Tableau 4 Capteur MSS. PIR : Proche Infrarouge ; MIR Moyen Infrarouge








	Capteur

	Bande

	Domaine

	λ (µm)

	Résolution (m)





	MSS

	1

	Vert

	0.5 - 0.6

	60



	MSS

	2

	Rouge

	0.6 - 0.7

	60



	MSS

	3

	PIR

	0.7 - 0.8

	60



	MSS

	4

	MIR

	0.8 - 1.1

	60








TM - Landsat 4-5


Tableau 5 Capteur TM. PIR : Proche Infrarouge ; MIR Moyen Infrarouge








	Capteur

	Bande

	Domaine

	λ (µm)

	Résolution (m)





	TM

	1

	Bleu

	0.45 - 0.52

	30



	TM

	2

	Vert

	0.52 - 0.60

	30



	TM

	3

	Rouge

	0.63 - 0.69

	30



	TM

	4

	PIR

	0.76 - 0.90

	30



	TM

	5

	MIR 1

	1.55 - 1.75

	30



	TM

	6

	Thermique

	10.40 - 12.50

	120 (30)



	TM

	7

	MIR 2

	2.08-2.35

	30






La résolution spatiale de la bande 6 (Thermique) est de 120 m mais est rééchantillonnée à 30 m a posteriori.



ETM+ - Landsat 7


Tableau 6 Capteur ETM+. PIR : Proche Infrarouge ; MIR Moyen Infrarouge








	Capteur

	Bande

	Domaine

	λ (µm)

	Résolution (m)





	ETM+

	1

	Bleu

	0.45 - 0.52

	30



	ETM+

	2

	Vert

	0.52 - 0.60

	30



	ETM+

	3

	Rouge

	0.63 - 0.69

	30



	ETM+

	4

	PIR

	0.77 - 0.90

	30



	ETM+

	5

	MIR 1

	1.55 - 1.75

	30



	ETM+

	6.1

	Thermique

	10.40 - 12.50

	60 (30)



	ETM+

	6.2

	Thermique

	10.40 - 12.50

	60 (30)



	ETM+

	7

	MIR 2

	2.09 - 2.35

	30



	ETM+

	8

	Panchromatique

	0.52 - 0.90

	15






Une bande panchromatique apparaît avec une résolution spatiale plus fine, 15 m au lieu de 30 m. La bande thermique (10.40 µm - 12.50 µm) est acquise deux fois, une fois en high gain et une en low gain. Cette même bande a une résolution spatiale de 60 m mais est rééchantillonnée à 30 m a posteriori.



OLI/TIRS - Landsat 8 / OLI-2/TIRS-2 - Landsat 9


Tableau 7 Capteurs OLI/TIRS et OLI-2/TIRS-2. PIR : Proche Infrarouge ; MIR Moyen Infrarouge








	Capteur

	Bande

	Domaine

	λ (µm)

	Résolution (m)





	OLI

	1

	Aérosol côtier

	0.43-0.45

	30



	OLI

	2

	Bleu

	0.45 - 0.51

	30



	OLI

	3

	Vert

	0.53 - 0.59

	30



	OLI

	4

	Rouge

	0.64 - 0.67

	30



	OLI

	5

	PIR

	0.85 - 0.88

	30



	OLI

	6

	MIR 1

	1.57 - 1.65

	30



	OLI

	7

	MIR 2

	2.11 - 2.29

	30



	OLI

	8

	Panchromatique

	0.50 - 0.68

	15



	OLI

	9

	Cirrus

	1.36 - 1.38

	30



	TIRS

	10

	Thermique 1

	10.6 - 11.19

	100



	TIRS

	11

	Thermique 2

	11.50 - 12.51

	100






La bande 1 de OLI (OLI-2) n’est plus le Bleu mais une bande nommé Coastal aerosol utilisé notamment pour le suivi des littoraux. De ce fait, les bandes Bleu, Verte et Rouge sont respectivement les bandes 2, 3 et 4. La bande panchromatique à une résolution de 15 m est la bande 8.



Path and Row

Comme toutes les images satellites, les images Landsat sont founies sous forme de scènes. Une scène coorespond à une portion de la surface terrestre telle que vue par Landsat. Dit autrement, la surface terrestre est divisée  en colonnes, appelées Paths et en lignes, appelées Rows. À l’intersection d’une ligne et d’une colonne nous trouvons une scène. Ce découpage permet de fournir des images dans un référentiel stable dans le temps. Par exemple, la ville de Paris se trouve sur la scène à l’intersection du path 199 et du row 26. Ainsi, si nous voulons voir l’évolution de Paris au cours du temps, il suffira de télécharger toutes les dates des images Landsat pour le couple path and row 199 - 26 (Fig. 22).
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Fig. 22 Path and Row (WRS 2) Landsat au-dessus de la France métropolitaine. En orange le path 199 et en bleu le row 26. En rouge, la scène à l’intersection de ce path et row dans lequel nous trouvons Paris.



Sur la figure précédente, nous trouvons l’ensemble des scènes qui recouvrent la France métropolitaine. Le path 199 est représenté en orange et le row 26 en bleu. À l’intersection des deux nous trouvons la scène qui contient Paris, en rouge. Les shapefiles et les kml des paths et rows du monde entier sont disponibles à ce lien [https://www.usgs.gov/core-science-systems/nli/landsat/landsat-shapefiles-and-kml-files]. L’extraction pour la France métropolitaine peut être téléchargée ici Path and Row WRS 2 Fance

Il existe en fait deux systèmes de path et row différents, un premier pour les orbites descendantes (descending) et un pour les orbites ascendantes (ascending). Cela s’explique par le fait que les satellites tournent autour de la Terre en passant par les pôles. Au-dessus de la face éclairée de la planète, le satellite se déplace du Pôle Nord vers le Pôle Sud. Inversement, au-dessus de la face à l’ombre, il se déplace du Pôle Sud vers le Pôle Nord. C’est pourquoi les images Landsat de jour, c’est-à-dire l’immense majorité des images, sont référencées dans le système d’orbite descendante. Les quelques (rares) images Landsat de nuit seront quant à elles référencées dans le système d’orbite ascendante.


Avertissement

Le système de path et row n’a pas toujours été le même pour tous les satellites de Landsat. De Landsat 1 à 3, il s’agissait du WRS 1 (world Reference System 1) et depuis Landsat 4 nous sommes en WRS 2. Par conséquent nous aurons la plupart du temps affaire au WRS 2. Il faudra simplement être vigilant si nous souhaitons manipuler les plus anciennes des images Landsat, leur système de path et row sera différent.





Niveaux de traitements

Les images Landsat sont distribuées sous différents niveaux de traitements. Pour une généralité sur les niveaux de traitements vous pouvez vous référer à la fiche La distribution des données. Les images Landsat sont disponibles en niveau L1 [https://www.usgs.gov/centers/eros/science/usgs-eros-archive-landsat-archives-landsat-8-9-operational-land-imager-and?qt-science_center_objects=0#qt-science_center_objects]. c’est-à-dire en comptes numériques, en niveau L2 i.e. en réflectance et en niveau L3 soit des produits déjà plus élaborés comme les surfaces en eau extraites des images.


Niveau L1

Le niveau L1 correspond à une image orthorectifiée. C’est-à-dire une image qui a été corrigée pour prendre en compte les distorsions relatives à l’optique du capteur et celles liées au relief terrestre. Néanmoins, cette ortho-rectification peut avoir été obtenue selon trois méthodes différentes, de la plus robuste à la moins robuste.

Niveau L1TP : Pour ce niveau, les images ont été corrigées sur la base d’un Modèle Numérique de Terrain (MNT ou DEM en anglais) et de points de contrôle (Ground Control Points, GCP) mesurés directement sur le terrain. Il s’agît de la correction la plus robuste du niveau L1.

Niveau L1GT : Pour ce niveau, seul un MNT a été utilisé pour corriger les distorsions géométriques. Aucun point de contrôle n’a été utilisé. Ce niveau est souvent le meilleur possible lorsque la couverture nuageuse est trop importante, lorsque l’image est prise de nuit, ou qu’il s’agît d’une petite île isolée.

Niveau L1GS : Pour ce niveau, aucune donnée externe, ni MNT ni point de contrôle, n’a été utilisée pour les corrections. Seules les données enregistrées par le capteur ont été utilisées. Il s’agît du niveau de traitement le moins fiable des trois. En pratique ce sont essentiellement les zones d’inlandsis comme l’Antarctique qui sont fournies sous ce niveau de traitement.


Note

Il est rare de tomber sur une image qui ne soit pas au moins en L1GT. Néanmoins il peut arriver de tomber sur en L1GS, dans ce cas, le décalage par rapport à la réalité peut être de plusieurs dizaines de kilomètres. Si votre image ne tombe pas sur la zone présentie, vérifiez son niveau de traitement, c’est souvent la cause du problème.



Lors de la fourniture d’une image, ces trois niveaux sont regroupés dans deux catégories, appelées Tier : Tier 1 (T1) et Tier 2(T2). La catégorie Tier 1 regroupe les « meilleures » images de niveau L1TP. La catégorie Tier 2 regroupe les moins bonnes images L1TP ainsi que toutes les images de nivau L1GT et L1GS. Au final, si nous souhaitons n’utiliser que les images à la qualité la plus sûre, i faut utiliser celles du Tier 1.

Les images en niveau L1 sont téléchargeables sur le portail EarthExplorer dans le menu Data Sets ‣ Landsat ‣ Landsat Collection 2 Level-1.

Si des images en niveau L1 sont choisies, l’utilisateur devra faire au moins une correction radiométrique afin d’obtenir la réflectance en haut de l’atmosphère (TOA) avant toute analyse. Une correction atmosphérique pourra également être faite afin d’obtenir des images en réflectance de surface.



Niveau L2 - Réflectances de surface

Les images de niveau L2 [https://www.usgs.gov/centers/eros/science/usgs-eros-archive-landsat-archives-landsat-8-9-olitirs-collection-2-level-2?qt-science_center_objects=0#qt-science_center_objects] sont non seulement ortho-rectifiées mais fournies en réflectance de surface. Les corrections radiométriques et atmosphériques ont été réalisées par l’organisme fournisseur. Autant les corrections radiométriques sont faciles à mettre en œuvre, autant les corrections atmosphériques sont plus délicates. L’avantage avec ce niveau est que ces corrections atmosphériques ont été faites grâce à des modèles élaborés. C’est le niveau à privilégier pour des études diachroniques. Notons que la bande panchromatique n’est pas fournie en réflectance de surface.


Astuce

En plus des réflectances de surface, les températures de surface sont également fournies. Ces températures sont dérivées des bandes 10 et 11 (de OLI) correspondant à l’infrarouge thermique. La fourniture de ce produit est appréciable car il n’est pas évident à construire par soi-même.



Les images en niveau L2 sont téléchargeables sur le portail EarthExplorer dans le menu Data Sets ‣ Landsat ‣ Landsat Collection 2 Level-2.


Avertissement

Les données fournies en Level 2 ne sont pas directement exploitables. Les réflectances de surface associées aux pixels ont été « étalées » sur une gamme de valeurs permettant de stocker des valeurs entières et non réelles (des nombres entiers et pas des nombres à virgules), voir ci-après pour les détails.



Avant de manipuler les images en niveau L2, les valeurs de chaque pixel doivent être rapportées à une « vraie » valeur de réflectance comprise entre 0 et 1. Selon la documentation [https://www.usgs.gov/media/files/landsat-8-9-collection-2-level-2-science-product-guide] fournie par l’USGS, cette transformation se fait en multipliant la valeur de chaque pixel, de chaque bande spectrale, par 0.0000275 et en lui ôtant 0.2, comme indiqué sur l’équation suivante.


\[RS = pixel \times 0.0000275 - 0.2\]

Avec RS pour Réflectance de Surface

Cette relation n’est valable que pour les pixels qui sont initialement dans la gamme de validité. C’est-à-dire dont la valeur est comprise entre 7273 et 43636 pour toutes les bandes sauf la bande 6. Pour cette dernière, la gamme de validité est de 1 à 65535 (cf page 12 de la documentation [https://www.usgs.gov/media/files/landsat-8-9-collection-2-level-2-science-product-guide]). Après application de l’équation, les pixels en dehors de la plage de validité auront des valeurs légèrement inférieures à 0 ou légèrement supérieures à 1. Il sera alors possible de forcer ces valeurs à 0 ou 1.


Astuce

Nous proposons un modèle QGIS qui permet de faire ce ré-étalonnage facilement et ce forçage à 0 et 1, à télécharger ici : Landsat C2L2 (faire un clic droit et Enregistrer le lien sous…). Une fois le modèle téléchargé, il suffit d’aller dans la Boîte à outils de traitements, de cliquer sur l’icône Modèles [image: icone_modeles], de sélectionner Ajouter un modèle à la boîte à outils... et d’aller chercher le modèle téléchargé nommé Landsat_C2L2_RS.model3. Le modèle se trouve alors dans l’arborescence Modèles. Il n’y a plus qu’à l’exécuter. Il est même possible de l’exécuter par lot afin de traiter plusieurs bandes spectrales en même temps.



En plus des bandes en réflectance de surface, une bande de contrôle de qualité est également fournie. Dans cette bande, chaque pixel est associée à une valeur qui renseigne sur la qualité de la mesure pour le pixel donné. Pour chaque pixel il est ainsi possible de savoir si ce pixel était masqué par des nuages, des cirrus ou encore des aérosols. Cette bande est très utile pour ne réaliser les traitements que sur les pixels effectivement valides. Les correspondances entre la valeur du pixel et sa qualité sont fournies dans la documentation [https://www.usgs.gov/media/files/landsat-8-9-collection-2-level-2-science-product-guide] à la page 14.

Enfin, un avantage de ce produit en niveau L2 est la possibilité de ne télécharger que la ou les bandes spectrales d’intérêt. En effet, contrairement au niveau L1 où nous sommes obligés de télécharger l’ensemble des bandes spectrales et des fichiers associés, ici nous pouvons simplement télécharger les bandes 4 et 5 si nous ne sommes intéressés que par un calcul de NDVI.



Niveau L2 - Températures de surface

À partir de la mise en route du capteur TM, Landsat capture des images dans l’infrarouge thermique. À partir de ces données enregistrées dans cette bande, il est possible de dériver des températures de surface (Land Surface Temperature ou LST en anglais). Ce calcul n’est pas évident, mais le niveau L2 fournit un raster déjà exprimé en température de surface. Il s’agit de la bande B10 du niveau L2. Le nom de la bande se termine d’ailleurs par le suffixe ST comme Surface Temperature.


Note

La température de surface n’est pas la température de l’air. C’est simplement la température telle qu’on pourrait la mesurer en appliquant un thermomètre directement au contact de la surface. C’est souvent une température plus chaude que celle de l’air. Enfin, il faut bien garder en tête que c’est une température instantanée prise au moment du passage du satellite et non une température représentative d’une journée.



Il faut simplement faire attention à recalibrer les valeurs avant d’utiliser ce produit. En effet, comme pour les réflectances de surface L2, le raster a été modifié afin de stocker des entiers et non pas de flottants. Un simple calcul permet de retransformer ce raster en vrai raster de températures de surface. Ce calcul est décrit dans la documentation [https://www.usgs.gov/media/files/landsat-8-9-collection-2-level-2-science-product-guide] officielle des produits L2 (page 12). Le calcul à effectuer est le suivant :


\[TS = pixel \times 0.00341802 + 149\]

Avec TS pour Température de Surface, exprimée en kelvins.


Avertissement

Notons bien que ce calcul fournit les températures de surface en kelvin. Or il est souvent plus pertinent de travailler en degrés Celsius. Il suffit donc de retrancher 272.15 au calcul précédent.



Ainsi, nous appliquons le calcul suivant pour directement obtenir un raster des températures de surface exprimés en degrés Celsius :


\[TS = pixel \times 0.00341802 + 149 - 272.15\]



Niveau L3

Les images de niveau L3 sont des produits prêts à être analysés. Il peut s’agir de l’extraction des surfaces en eau [https://www.usgs.gov/centers/eros/science/usgs-eros-archive-landsat-landsat-level-3-dynamic-surface-water-extent-dswe?qt-science_center_objects=0#qt-science_center_objects], du couvert neigeux [https://www.usgs.gov/centers/eros/science/usgs-eros-archive-landsat-landsat-level-3-fractional-snow-covered-area-fsca?qt-science_center_objects=0#qt-science_center_objects] ou des surfaces brûlées [https://www.usgs.gov/centers/eros/science/usgs-eros-archive-landsat-landsat-level-3-burned-area-ba-science-product?qt-science_center_objects=0#qt-science_center_objects]. Ces images sont à réserver pour des analyses très précises. Les images en niveau L3 sont téléchargeables sur le portail EarthExplorer dans le menu Data Sets ‣ Landsat ‣ Landsat Collection 1 Level-3.




Métadonnées et nom des images Landsat

Lorsque des images Landsat sont téléchargées, nous récupérons en fait un répertoire dans lequel se trouve un raster,au format .tif, par bande spectrale, plus éventuellement un ou plusieurs rasters de qualité. Nous retrouvons également un fichier texte avec l’extension .MTL qui contient des métadonnées utiles aux pré-traitements.


Les métadonnées

Ce fichier .MTL est un fichier texte contenant diverses informations sur les conditions d’acquisition de l’image. Nous y retrouvons des informations relatives au SCR employé, l’angle du Soleil au-dessus de l’horizon et par rapport au nord, l’heure de prise de vue, les conditions nuageuses, … C’est sur ce fichier que se basera le calcul des corrections radiométriques pour passer des comptes numériques à la réflectance en haut de l’atmosphère (TOA).



Nom des images Landsat

Le nom des images suivent les conventions suivantes : LXSS_LLLL_PPPRRR_YYYYMMDD_yyyymmdd_CC_TX, où :


	L = Landsat


	X = Capteur (C = OLI/TIRS combinés, O = OLI seul, T = TIRS seul, E = ETM+, T” = *TM, *M = MSS)


	SS = Satellite (07 = Landsat 7, 08 = Landsat 8)


	LLL = Niveau de traitement (L1TP/L1GT/L1GS)


	PPP = WRS path


	RRR = WRS row


	YYYYMMDD = Date d’acquisition au format année, mois, jour


	yyyymmdd - Date de traitement au format année, mois, jour


	CC = Numéro de collection (01 ou 02)


	TX = Catégorie de collection (RT = Temps réel, T1 = Tier 1, T2 = Tier 2)




Puis à la fin du nom des rasters nous retrouvons le numéro de bande de B1 à B11 par exemple. Pour les produits de niveau L2, nous trouvons un SR qui signifie Surface Reflectance juste avant le numéro de bande.




Télécharger les images Landsat

Les images Landsat sont disponibles notamment sur le portail EarthExplorer [https://earthexplorer.usgs.gov/] de l’USGS (Télécharger des images satellites).




Les images Sentinel-2

Le programme Sentinel-2 est un programme d’observation de la Terre par satellite piloté par l’Agence Spatiale Européenne (ESA). La mission, lancée en juin 2015, est toujours en activité et est prévue pour durer. Cette mission est constituée de deux satellites quasi identiques : Sentinel-2A et Sentinel-2B (Fig. 23). Chaque satellite a un temps de retour sur une même zone de 10 jours. Le temps de retour est donc de 5 jours en combinant les deux satellites. Sentinel-2A a été mis en orbite le 23 juin 2015 et Sentinel-2B le 7 mars 2017.
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Fig. 23 Image d’artiste d’un satellite Sentinel-2 (ESA).




Capteur MSI

Les deux satellites Sentinel-2 embarquent le capteur Multi Spectral Instrument (MSI). Ce capteur prend des images dans 13 bandes spectrales différentes à des résolutions spatiales allant de 10 mètres à 20 mètres ou 60 mètres selon la bande considérée.


Tableau 8 Capteur MSI. PIR : Proche Infrarouge ; MIR Moyen Infrarouge








	Bande

	Domaine

	λ centrale (nm)

	largeur λ (nm)

	Résolution (m)





	1

	« Côtier »

	442.7

	21

	60



	2

	Bleu

	492.4

	66

	10



	3

	Vert

	559.8

	36

	10



	4

	Rouge

	664.6

	31

	10



	5

	Red Edge 1

	704.1

	15

	20



	6

	Red Edge 2

	740.5

	15

	20



	7

	Red Edge 3

	782.8

	20

	20



	8

	PIR

	832.8

	106

	10



	8A

	PIR étroit

	864.7

	21

	20



	9

	Vapeur d’eau

	945.1

	20

	60



	10

	MIR Cirrus

	1373.5

	31

	60



	11

	MIR 1

	1613.7

	91

	20



	12

	MIR 2

	2202.4

	175

	20






Ce capteur est très intéressant de par son temps de retour très court, sa résolution spatiale fine et ses nombreuses bandes spectrales, notamment dans les domaines du Red Edge et du proche infrarouge. Cette bonne résolution radiométrique fait de ce capteur un très bon outil pour le suivi de la végétation et des cultures.



Tuiles Sentinel-2

Les images Sentinel-2 sont capturées selon des tuiles régulières dans l’espace, sur le même principe que les Path and Row de Landsat. Ainsi, si nous nous intéressons à l’évolution d’une région donnée dans le temps, nous pouvons télécharger la tuile de la région pour les différentes dates d’intérêt. La logique d’organisation est un peu moins claire que dans le cas de Landsat. Chaque tuile est fournie dans une projection UTM / WGS84 en utilisant le Military Grid Reference System [https://en.wikipedia.org/wiki/Military_Grid_Reference_System#/media/File:Universal_Transverse_Mercator_zones.svg] (MGRS). Dans ce système, le globe est découpée en 60 tranches dans le sens Nord Sud. Chaque tranche mesure donc 6° de longitude (\(60 \times 6°\)). Puis chaque tranche est découpée en bandeau dans le sens de la latitude. Chaque bandeau mesure 8° de latitude sauf pour les régions les plus proches des Pôles. Ensuite, chaque zone ainsi définie est découpée en tuiles de 100 km \(\times\) 100 km. Chacune de ces tuiles est codée par deux lettres indiquant la position sur l’axe Ouest - Est puis Sud - Nord.

Par exemple, la ville de Paris se trouve sur la tuile 31UDQ qui se comprend de la façon suivante :


	31 signifie que nous sommes sur la zone UTM 31


	U signifie que nous sommes sur la latitude du bandeau U


	D indique la position de la tuile sur l’axe Ouest - Est au sein de cette zone 31U


	Q indique la position de la tuile sur l’axe Sud - Nord au sein de cette zone 31U




Des détails peuvent être trouvés sur le site de Kalideos [https://littoral.kalideos.fr/drupal/fr/content/tuilage-sentinel-2] et du Cesbio [https://labo.obs-mip.fr/multitemp/les-tuiles-de-sentinel-2-comment-ca-marche/]. Et vous trouverez ici les tuiles Sentinel-2 pour la France métropolitaine Tuiles Sentinel-2 Fance



Niveaux de traitements Sentinel-2

Les images Sentinel-2 sont distribuées sous trois (principaux) différents niveaux de traitements. Pour chacun de ces traitements, les images sont ortho-rectifiées :


	Niveau L1C : les images sont corrigées des effets radiométriques, il s’agît ainsi des réflectances en haut de l’atmosphère (TOA). C’est notamment le niveau fourni sur le portail EarthExplorer [https://earthexplorer.usgs.gov/]. Une correction atmosphérique peut être ensuite faite manuellement par l’utilisateur pour obtenir les réflectances de surface.


	Niveau L2A : les images sont corrigées des effets radiométriques et atmosphériques. Il s’agît donc des réflectances de surface. Un masque des nuages et des ombres des nuages est en plus fourni. Ce niveau est disponible sur le site de Theia [https://catalogue.theia-land.fr/].


	Niveau L2B : il s’agît de variables géophysiques dérivées des images comme le LAI, le fAPAR, la teneur en chlorophylle, …


	Niveau L3A : il s’agît de synthèses temporelles de réflectances de surface sur une période donnée, par exemple mensuelle. Sur ce type d’image, chaque pixel est la « meilleure » valeur mesurée sur un mois donné. Ça permet d’obtenir une image en réflectance de surface sans nuages, sans ombres de nuages et sans aérosols (si au moins une image non nuageuse a été trouvée sur le mois bien sûr). Le désavantage est que chaque pixel peut présenter une valeur de réflectance d’une date différente du pixel voisin. Ce type d’images est donc bien pour le suivi des évolutions relativement lentes comme l’urbanisation ou la déforestation mais ne sera pas suffisant pour le suivi des évolutions rapides comme les inondations ou les incendies. Ce niveau L3A est également disponible sur le site de Theia [https://catalogue.theia-land.fr/].






Télécharger les données Sentinel-2

Ces images sont librement distribuées par l’ESA. Il est donc possible de les télécharger et de les utiliser librement dans tout contexte. Les images sont téléchargeables sur le portail de données de Theia [https://catalogue.theia-land.fr/], celui de l’ESA [https://scihub.copernicus.eu/dhus/#/home] ou EarthExplorer [https://earthexplorer.usgs.gov/].





Télécharger des images satellites

Il existe différents portails pour télécharger plus ou moins facilement et plus ou moins gratuitement des images satellites. Les images les plus utilisées sont celles issues du programme Landsat (NASA) suivies, entre autres, des images issues des programmes Sentinel (ESA). Ces deux programmes mettent leurs images à disposition du grand public gratuitement. D’autres images, comme celles du programme MODIS (NASA) sont également gratuites. Nous présentons ici quelques portails utiles pour télécharger ces images.


EarthExplorer

Le portail EarthExplorer [https://earthexplorer.usgs.gov/] est sans aucun doute le portail le plus complet et le plus ergonomique. Il est maintenu conjointement par la NASA et l”USGS [https://www.usgs.gov/] (United States Geological Survey). Il met à disposition de très nombreuses données parmi lesquelles les images Landsat, à différents niveaux de traitements, les images MODIS, les images Sentinel-2 et le MNT global SRTM. L’utilisation du portail et le téléchargement des données est gratuit mais une inscription est obligatoire. Cette inscription nécessite une adresse mail qui fera office de login. Le portail se présente comme montré sur la figure suivante (Fig. 24).
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Fig. 24 La page d’accueil du portail EarthExplorer.



Sur cette page d’accueil nous trouvons en haut à droite le menu pour s’identifier (Login, 1), les onglets qui vont nous permettre de rentrer des paramètres de recherche et d’accéder aux images (2) et un fond de carte qui va nous permettre de sélectionner une zone géographique (3). Une fois identifié, notre identifiant apparaît en haut à droite et nous pouvons maintenant explorer les données et les télécharger.


Emprise géographique

La première chose à faire est de sélectionner l’emprise géographique sur laquelle nous souhaitons obtenir des images. Cette sélection se passe dans le premier onglet Search Criteria, en utilisant soit le panneau de l’onglet Geocoder soit le panneau de l’onglet Polygon (Fig. 25).
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Fig. 25 Sélection de l’emprise géographique.



L’onglet Geocoder permet de zoomer directement soit sur une entité géographique via le menu Feature (GNIS), soit sur une adresse via le menu Adress/Place, soit par un identifiant de Path and Row Landsat via le menu Path/Row. Dans ce même panneau, il est également possible d’importer un fichier KML ou shapefile de notre emprise via l’onglet KML\Shapefile Upload.

Mais la méthode la plus simple est de zoomer sur son emprise dans le panneau central et d’utiliser l’onglet Polygon du deuxième panneau. Par exemple, si nous souhaitons des images sur Ouagadougou (Burkina), nous zoomons sur cette ville, puis dans l’onglet Polygon, nous sélectionnons le menu Use Map. L’emprise visible à l’écran est ainsi définie comme zone de sélection et apparaît en rouge (Fig. 26).
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Fig. 26 Sélection de l’emprise géographique selon la carte visible à l’écran.




Note

Cette méthode de sélection selon l’emprise de la vue cartographique est vraiment la plus simple à utiliser.



Il est ensuite possible de peaufiner manuellement cette zone de sélection. Il suffit de dézoomer un peu puis de déplacer à l’aide de la souris les coins du rectangle (Fig. 27). Cette manipulation peut être utile pour restreindre le champ de recherche. En effet, toutes les images qui intersectent, même légèrement, le polygone de sélection seront proposées au téléchargement.
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Fig. 27 Modification manuelle de la zone de sélection.



Nous pouvons noter qu’il est également possible de définir une zone de sélection circulaire via l’onglet Circle. Il faut alors entrer les coordonnées décimales du centre du cercle et le rayon du cercle en mètres. Il est aussi possible d’importer un shapefile de la zone d’intérêt depuis notre ordinateur via l’onglet Predefined Area. Notons que ce shapefile ne doit pas contenir trop de sommets.


Avertissement

La zone de sélection ne doit pas être trop étendue car dans les résultats, pas plus de 100 images sont proposées à la fois au téléchargement.





Emprise temporelle et nuages

Une fois l’emprise géographique définie, il est nécessaire de paramétrer l’emprise temporelle souhaitée. Cela se fait avec le panneau qui contient l’onglet Date Range (Fig. 28).
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Fig. 28 Emprise temporelle de la recherche d’images.



La date de début de la période qui nous intéresse doit être renseignée dans la case Search from: et la date de fin dans la case to:. Il n’est pas nécessaire d’entrer les dates à la main, il est possible d’utiliser le fonction de calendrier disponible en cliquant sur l’icône [image: icone_eo_calendrier]. Il est également possible de ne chercher des images que pour certains mois de cette période via le menu Search months:. C’est une option intéressante si nous souhaitons des images seulement en saison sèche, ou au moment du développement des cultures, ou juste des images hivernales …

Dans ce même panneau, il est bien de préciser quelle couverture nuageuse maximale nous autorisons dans les images proposées. Dans l’idéal, nous souhaitons 0 nuage mais dans les faits c’est assez rare, d’autant plus que les scènes Landsat ou Sentinel-2 (et encore plus MODIS), couvrent des portions de territoires relativement importantes. Cette valeur peut être mise à 15 ou 20 % dans un premier temps (Cloud Cover Range: 0% - 15%). Si 20 % de l’image est couverte de nuages, il y a une chance pour que notre zone d’intérêt se situe dans les 80 % sans nuages. Évidemment ce critère a une importance différente selon la zone géographique. Pour Ouagadougou, nous trouverons facilement une image sans nuages mais pour Singapour en zone équatoriale, ce sera beaucoup plus compliquée. C’est à l’utilisateur de jongler avec ce seuil.


Astuce

Même si certains nuages sont présents sur notre zone d’étude, il existe des méthodes pour les masquer à posteriori et ainsi les enlever de l’analyse de télédétection qui sera faite à partir de l’image.





Choix des images à télécharger

Une fois ces réglages préliminaires effectués, il est maintenant temps de choisir les images que nous souhaitons télécharger. Ce choix s’effectue dans l’onglet Data Sets, deuxième onglet du panneau de gauche. Comme nous pouvons le voir, il y a de très (très) nombreux types d’images disponibles. Il est rare de tous les utiliser, nous allons simplement présenter rapidement comment télécharger des données Landsat, Sentinel-2, MODIS et SRTM.


Images Landsat

Les images Landsat sont un peu la raison d’être de ce portail et ce sont probablement les images les plus téléchargées. Pour y avoir accès, il faut déplier le menu Landsat. Ensuite les deux sous menus qui vont nous intéresser sont Landsat Collection 2 Level-2 et Landsat Collection 2 Level-1 (Fig. 29). Des détails sur les images Landsat et leurs caractéristiques sont donnés sur la fiche dédiée : Les images Landsat.
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Fig. 29 Choix des images Landsat.



Landsat Collection 2 Level-2

Les images du sous menu Landsat Collection 2 Level-2 correspondent aux images en réflectances de surface, déjà corrigées des effets radiométriques et atmosphériques. Des détails sur les niveaux de traitements des images Landsat sont donnés sur la fiche dédiée : Niveaux de traitements. Nous y trouvons les images Landsat 8 OLI, Landsat 7 ETM+ et Landsat 4-5 TM. Des informations détaillées sur les niveaux de traitements et autres aspects sont disponibles en cliquant sur l’icône d’information [image: icone_eo_information]. Il est également possible de voir la couverture mondiale d’un produit en cliquant sur l’icône sous forme de carte [image: icone_eo_emprise] (Fig. 30). Les images téléchargées de cette collection sont accompagnées d’un raster localisant les pixels sous nuages, ombres de nuages ou aérosols, appelé raster de qualité. Ce qui permet de les éliminer lors de l’analyse.
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Fig. 30 Emprise mondiale des images ETM+ en Level-2.




Avertissement

Les images fournies dans la Collection Level-2 ne sont pas utilisables telles quelles. Il est nécessaire de leur appliquer un étalonnage (simple), tel que décrit dans la section consacrée aux différents niveaux de traitements des images Landsat : Niveau L2 - Réflectances de surface.



Landsat Collection 2 Level-1

Les images du sous menu Landsat Collection 2 Level-1 correspondent aux images en radiance sur lesquelles c’est à l’utilisateur de faire les corrections radiométriques et atmosphériques. Les images téléchargées de cette collection contiennent tout de même un raster localisant les pixels se trouvant sous les nuages ou les ombres des nuages. Notons que pour les images les plus anciennes, c’est-à-dire les images Landsat 1-5 MSS, seul le niveau L1 est disponible. Le portail ne met pas à disposition ces images directement en réflectance de surface.


Note

Quelle collection choisir ? Dans la plupart des cas, la collection en Level 2 correspondant aux réflectances de surface est un bon choix. Les algorithmes de corrections utilisés par l’USGS et la NASA sont performants. L’intérêt du Level 1 est de rester maître des corrections et savoir exactement quelle méthode est employée.



Mettons que nous souhaitons des images Landsat 8 et 7 en réflectance de surface sur notre zone de Ouagadougou, il suffit de sélectionner les lignes Landsat 8 OLI/TIRS C2 L2 et Landsat 7 ETM+ C2 L2 dans le sous menu Landsat Collection 2 Level-2. Il ne reste plus qu’à cliquer sur le menu Results >> en bas du panneau de gauche. Les résultats de la recherche sont alors visibles dans l’onglet Results (Fig. 31).
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Fig. 31 Résultats de la recherche des images Landsat sur la zone d’intérêt.



Les résultats sont affichés par défaut 10 par 10 et pas plus de 100 résultats sont affichés à la fois. Si la requête dépasse les 100 résultats, il faut découper l’emprise spatiale ou temporelle en plusieurs parties. Les résultats sont classés par capteur. Sur la figure précédente (Fig. 31), ce sont les images Landsat 8 OLI qui correspondent aux critères de recherche qui sont présentées. Nous accédons aux images Landsat 7 ETM+ demandées en dépliant le menu qui se trouve sous Data Set. Les résultats sont rangés du plus récent au plus ancien et une petite vignette donne un aperçu de chaque scène. Pour chaque scène nous trouvons son identifiant (ID), sa date d’acquisition (Date Acquired), son Path et son Row. En cliquant sur l’icône d’empreinte [image: icone_eo_empreinte], nous pouvons voir l’emprise de la scène par rapport à notre zone d’intérêt, et en cliquant sur l’icône d’image [image: icone_eo_image] nous pouvons afficher un aperçu de la scène en vraies couleurs afin de se rendre compte visuellement de sa qualité, surtout vis-à-vis des nuages (Fig. 32).
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Fig. 32 Empreinte (A) et aperçu (B) d’une scène Landsat par rapport à la zone d’intérêt.



En cliquant sur l’icône en forme de feuille de papier [image: icone_eo_metadonnees], nous pouvons accéder aux métadonnées de l’image, comme le pourcentage précis de couverture nuageuse. Pour télécharger l’image souhaitée, il suffit alors de cliquer sur l’icône de téléchargement [image: icone_eo_telecharger]. La fenêtre de téléchargement s’ouvre (Fig. 33).
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Fig. 33 Choix de téléchargement d’une scène Landsat en Level 2.



Une scène Landsat de cette Collection 2 Level-2 va contenir de nombreux rasters et fichiers texte de métadonnées. Parmi ces rasters, deux grands produits sont disponibles : les réflectances de surface et les températures de surface. Il est possible de télécharger tous les rasters, i.e. toutes les bandes spectrales et les rasters annexes, concernant les réflectances de surface en cliquant sur Download All Files Now de la ligne Level-2 Surface Reflectance Bands. Mais l’archive correspondante sera très volumineuse car elle contiendra toutes les bandes spectrales ainsi que différents rasters de qualité, 13 rasters au total. Il est plus pertinent de ne télécharger que les bandes spectrales et les rasters qui nous intéressent, en les choisissant en cliquant sur Select Files. Par exemple, si nous souhaitons simplement calculer un NDVI, nous n’avons besoin que des bandes du rouge et du proche infrarouge soit les bandes 4 et 5 de Landsat 8. Nous pouvons également télécharger le raster de qualité afin de masquer les nuages et leurs ombres. Au final nous ne téléchargeons que 3 rasters au lieu de près d’une vingtaine. Il suffit de télécharger les rasters …B4.tif, …B5.tif et …QA_PIXEL.tif (raster de qualité) en les sélectionnant, comme présenté dans la figure suivante (Fig. 34).
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Fig. 34 Choix des rasters à télécharger.



Il n’y a plus qu’à cliquer sur Download All Selected Now et une archive zip contenant les rasters sélectionnés est téléchargé.


Avertissement

Les bandes panchromatiques ne sont pas distribuées en réflectance de surface et ne sont donc pas proposées au téléchargement dans cette Collection 2 Level-2. Il faut aller les récupérer depuis la Collection 2 Level-1.




Note

Le téléchargement des images de la Collection 2 Level-1 se fait de la même manière.



Pour les températures de surface, la manipulation est identique, il suffit de choisir la ligne Level-2 Surface Temperature Bands de la fenêtre de téléchargement (Fig. 33). Dans cette même fenêtre, il est également possible de télécharger les bands une par une en cliquant sur Product Option, la fenêtre suivante s’ouvre et il suffit alors de télécharger la bande qui nous intéresse (Fig. 35).
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Fig. 35 Téléchargement bande par bande.



Les rasters des bandes spectrales et autres produits Landsat téléchargés sont au format GeoTIFF. Ces rasters sont géoréférencés en WGS84 UTM zone (Les Systèmes de Coordonnées de Références). Une image Landsat de Paris sera par exemple en WGS84 UTM zone 31 Nord (EPSG 32631).



Images MODIS

Il est également possible de télécharger des images MODIS via ce portail. Le paramétrage de l’emprise géographique et temporelle se fait de la même manière que pour les images Landsat. Une fois les paramètres réglés, dans l’onglet Data Sets, il suffit de déplier le menu NASA LPDAAC Collections pour avoir accès à tous les produits MODIS. De très nombreux produits sont dérivés des images MODIS aussi bien pour les surfaces continentales, les océans que l’atmosphère. Chaque produit est identifié par un code. La signification des codes est fourni sur le site des produits MODIS [https://modis.gsfc.nasa.gov/data/dataprod/]. Ainsi, si nous souhaitons par exemple télécharger les images en réflectance de surface à une résolution de 250 m agrégées sur 8 jours, nous déplions le sous menu MODIS Land Surface Reflectance et choisissons les produits MOD09Q1 (satellite Terra) et MYD09Q (satellite Aqua) (Fig. 36).
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Fig. 36 Arborescence des produits MODIS.



Les images MODIS sont ici téléchargées au format .hdf qui est un format propre aux images MODIS. Ce format est néanmoins géré par la plupart des logiciels de géomatique sans problèmes.



MNT SRTM

Via ce portail, il est aussi possible de télécharger le MNT global issue de la mission SRTM. Ce MNT, connu simplement sous le nom de SRTM, a été relevé au mois de février 2000 grâce à un capteur radar embarqué sur la navette spatiale étasunienne. Comme il s’agît d’un produit pris une seule fois, il n’est pas nécessaire de régler l’emprise temporelle, seule l’emprise spatiale importe. Elle se définit comme pour les images satellites. Plusieurs niveaux de traitements du SRTM sont disponibles. Certains sont à 90 m de résolution et d’autres à 30 m. Certains présentent des valeurs manquantes, i.e. des trous, et d’autres ont été traités pour combler ces valeurs manquantes.

Les différents niveaux de traitements sont disponibles dans l’onglet Data Sets, dans le sous menu Digital Elevation puis dans SRTM (Fig. 37). Le niveau le plus abouti est le SRTM à 30 m de résolution sans valeurs manquantes (ou peu). Ce niveau est nommé SRTM 1 Arc-Second Global. Au téléchargement, il est conseillé de choisir le format GeoTIFF. Le raster téléchargé est en EPSG:4326 - WGS 84 et correspond à un territoire de à peu près 100 km sur 100 km.
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Fig. 37 Arborescence des produits SRTM.
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Logiciels, présentation et installation

Dans cette fiche nous présenterons succinctement quelques logiciels et outils couramment utilisés en géomatique, aussi bien en SIG qu’en télédétection. Il s’agît de logiciels libres, gratuits et multi-plateformes que vous pouvez utiliser sans aucun restriction dans vos études, projets de recherche et projets professionnels.

Les logiciels libres ne sont pas des clones de leurs équivalents propriétaires et payants. Certaines capacités des logiciels payants ne s’y retrouvent pas, mais certaines autres leurs sont spécifiques. C’est au final à l’utilisateur de faire son choix.

Après la présentation des logiciels, les différentes procédures d’installation sont expliquées. L’installation d’extension est également présentée à la fin de cette partie.
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QGIS

QGIS [https://www.qgis.org/fr/site/] (Fig. 38) est le logiciel phare de la géomatique libre. Très orienté pour les traitements vecteurs à l’origine, sa capacité de traitements rasters tend à se développer depuis quelques années. Des informations et les liens de téléchargement sont disponibles sur le site officiel.

En plus de nombreuses capacités intrinsèques, il est possible d’étendre QGIS en lui adjoignant des centaines d’extensions également gratuites. De plus, QGIS est maintenant capable d’interfacer d’autres logiciels plus orientés pour les traitements rasters comme GRASS GIS, SAGA GIS et Orfeo Toolbox. L’intégration de ces logiciels est inégale. Les modules de GRASS GIS sont inclus par défaut et fonctionnent bien. Les modules de SAGA GIS le sont aussi, mais correspondent à une ancienne version de SAGA. Enfin, QGIS est l’interface graphique par défaurt utilisé par Orfeo Toolbox.

Une autre force de QGIS est de pouvoir très facilement interfacé une base de données PostGIS. Notons également que QGIS est basé en partie sur Python. Il est possible de créer son propre bout de code Python pour automatiser des tâches dans QGIS ou même sa propre extension. Si le code n’est pas votre spécialité, il existe un interface graphique pour construire ces propres chaînes de traitements (model builder).

Enfin, il est possible d’utiliser QGIS directement depuis la ligne de commande ou bien via les langages de programmation R ou Python. Il existe un package R nommé qgisprocess permettant d’appeler les modules QGIS depuis R.

Il y a une grande communauté d’utilisateurs de QGIS, ce qui fait que ce logiciel est relativement bien documenté et surtout nous trouvons, la plupart du temps, la réponse à d’éventuelles questions par une simple recherche sur le Web. Enfin, l’interface se veut ergonomique et est plutôt aboutie (Fig. 38), même si les goûts et les couleurs sont un vaste débat.
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Fig. 38 Interface général de QGIS.




Astuce

L’UMR Passages a mis en ligne une très grande documentation spécifiquement dédiée à QGIS [https://ouvrir.passages.cnrs.fr/tutoqgis/]. Vous pourrez y retrouver de nombreux tutoriels très pédagogiques sur son utilisation pour différentes applications.




Module SCP dans QGIS

Bien que le module Semi-Automatic Classification Plugin (SCP [https://fromgistors.blogspot.com/p/semi-automatic-classification-plugin.html?spref=sacp]) ne soit pas un logiciel indépendant, c’est un module si riche de fonctionnalités qu’il a sa place ici. Il s’agît d’une extension à ajouter dans QGIS qui permet de faire des traitements orientés vers la télédétection, comme les classifications supervisées. Ce module s’installe comme une extension classique.

Par contre, contrairement à la plupart des extensions, il ajoute de très nombreux outils. C’est quasiment un logiciel dans le logiciel. Ces outils sont parfaits pour faire de la télédétection sans quitter QGIS et sans passer par un outil tiers interfacé (comme GRASS GIS ou SAGA). Le cœur du module est de proposer des techniques classiques de classifications supervisées (Fig. 39), basées sur les méthodes Plus proche voisin, Maximum de vraisemblance, Spectral angle mapping ou Random forest. Les résultats sont très bons et la vitesse d’exécution est raisonnable. Un autre avantage de ce module est de proposer des outils connexes très pratiques. Nous y retrouvons la possibilité de générer les signatures spectrales de nos polygones d’apprentissage, de reclassifier un raster, de produire une matrice de validation, de découper en lot des bandes spectrales et même de télécharger des images sources (Landsat, MODIS, GOES ou Sentinel-1, 2 et 3).

Le seul point négatif de ce module est son interface beaucoup trop touffue à mon sens. Il est facile de se perdre dans les menus et sous menus, les cases à cocher, les barres d’outils, les icônes, les onglets… Mais si on dépasse cet aspect, on est en possession d’un outil très intéressant en restant dans QGIS. De plus, ce module est maintenu de façon soutenue et évolue très vite. De nouvelles fonctionnalités apparaissent régulièrement.
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Fig. 39 Classification supervisée dans SCP.





Installation de QGIS

Nous allons voir dans cette fiche comment installer le logiciel libre de SIG QGIS, sous Windows et sous Linux (Ubuntu / Debian). Nous verrons également comment installer des outils complémentaires.
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Installation de QGIS dans Windows

La première chose à faire est d’aller sur le site de QGIS [https://www.qgis.org/fr/site/]. Sur la page d’accueil nous cliquons sur Téléchargez. Nous allons ensuite dans la rubrique Téléchargement pour Windows. Il existe deux façons d’installer QGIS : une façon rapide avec une configuration de base (largement suffisante dans la plupart des cas), et une façon personnalisable.



Façon rapide

Pour cette installation rapide, nous allons dans partie du Téléchargement pour Windows nommée Installateurs autonomes (MSI) depuis les paquets OSGeo4W (recommandé pour les nouveaux utilisateurs). Nous avons alors le choix entre la toute dernière version ou une version long terme. Nous pouvons généralement choisir la dernière version afin de profiter des dernières avancées. Le fichier téléchargé est un exécutable au format .msi.


Astuce

Si QGIS vous paraît instable, vous pouvez installer la version long terme LTR (Long Term Release). Cette version LTR est plus stable mais en contrepartie moins fournie que la dernière version.



Une fois l’exécutable téléchargé, il suffit de le lancer en double cliquant sur le fichier .msi. Ensuite, classiquement, nous cliquons sur Accepter et autres Installer. Le processus prend plus ou moins de temps selon les ordinateurs. Ensuite QGIS peut être lancé via l’icône éventuellement créée sur le Bureau ou en le recherchant dans le menu Démarrer.


Note

Par défaut, QGIS est installé avec les outils GRASS, d’où la présence de with GRASS dans le nom de l’installation. GRASS GIS est un autre logiciel de géomatique qui peut ainsi être utilisé de façon transparente dans QGIS. Cet interfaçage d’outils externes démultiplie les traitements possibles avec QGIS.



Nous pouvons maintenant ouvrir et utiliser QGIS. Nous constatons dans la Boîte à outils de traitements la présence des outils GRASS mais aussi GDAL et SAGA (Fig. 40).
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Fig. 40 Présence des outils GRASS, GDAL et SAGA dans QGIS.




Astuce

Si au lancement de QGIS, vous vous apercevez que le menu Raster est incomplet et/ou que le menu Vecteur est vide il n’est pas nécessaire de tout réinstaller. Généralement, en allant dans le menu Extensons ‣ Installer/Gérer les extensions puis en allant dans l’onglet Installées, il faut cocher (ou décocher et recocher) l’extenson Processing. Suite à ça, les menus vecteur et Raster devraient être maintenant complets.





Façon personnalisable

Pour sélectionner finement la version de QGIS à installer et les différentes briques sous-jacentes il faut télécharger l’installateur réseau OSgeo4W. Ensuite en lançant cet installateur et en choisissant l’installation avancée, il est possible de choisir la version de QGIS, les différentes librairies et même d’installer des logiciels tierces.

À ce stade nous avons une version de QGIS tout à fait suffisante pour la plupart des utilisations. Cependant, certains modules supplémentaires auront besoin de briques logicielles qui ne sont pas comprises dans la version de base. Dans cet exemple, nous allons installer une librairie Python nommée Rasterio qui permet de manipuler des données rasters.

Nous retournons dans le menu Démarrer > QGIS X.XX (où X.XX est la version installée et nous trouvons une entrée nommée Setup (Fig. 41).
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Fig. 41 Installation de modules complémentaires.



C’est cette entrée qui va nous permettre d’installer le module manquant.


Avertissement

Il faut lancer ce Setup en mode Administrateur.



Dans la fenêtre qui s’affiche, nous choisissons Advanced Install puis Suivant. Ensuite, nous pouvons cliquer sur Suivant pendant quelques fenêtres jusqu’à parvenir à la fenêtre suivante (Fig. 42).
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Fig. 42 Choix d’un dépôt distant.



Ici, nous choisissons sur quel site nous allons télécharger le module souhaité. Ça n’a aucune importance, nous pouvons sélectionner le premier dépôt et cliquer sur Suivant. Nous arrivons alors à la fenêtre qui nous intéresse vraiment. C’est ici que nous pourrons choisir les modules à installer.

Si nous déplions le menu Desktop, nous retrouvons les logiciels installés (Fig. 43).
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Fig. 43 Les logiciels Desktop installés.



Ici, nous voyons que nous avons déjà installés GRASS GIS 7.8.5-1, QGIS 3.16.2-1 et SAGA 2.3.2-4. Nous pouvons passer par ici pour désinstaller ou mettre à jour les logiciels en cliquant sur Keep. Si nous voulions installer le dernier logiciel nommé tora, il suffirait de cliquer sur Skip et de faire apparaître la version à installer.

Dans la cas qui nous intéresse, nous n’allons pas installer un nouveau logiciel mais seulement ce que nous appelons un Libs (une librairie). Nous déplions donc l’onglet correspondant. De très nombreuses librairies sont disponibles, il nous faut trouver celle qui nous intéresse. Elles sont rangées par ordre alphabétique, nous regardons donc à python3-rasterio (Fig. 44).


[image: alternate text]

Fig. 44 Installation de rasterio avec OsGeo.



Pour l’instant, la ligne correspondant est à Skip (passer), il suffit de cliquer sur ce Skip pour faire apparaître le numéro de version de la librairie qui sera installée (Fig. 45).
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Fig. 45 Version de la librairie installée.



Ici, le Skip s’est changé en 1.1.8-1, c’est donc cette version qui sera installée. Il suffit ensuite de cliquer plusieurs fois sur Suivant et la librairie souhaitée est installée.


Avertissement

Toutes les librairies ne sont malheureusement pas disponibles via cet installeur.






Installation d’extensions dans QGIS

Version de QGIS : 3.16.1

QGIS propose de très (très) nombreuses extensions supplémentaires librement téléchargeables et utilisables. Il est très facile de les ajouter afin de les utiliser directement depuis QGIS. Pour commencer, il est plus facile de connaître par avance le nom de l’extension à télécharger. Ce nom peut se trouver en faisant une recherche sur le web. Dans cet exemple, nous allons télécharger et installer l’extension nommée Cadastre qui permet de manipuler les données cadastrales françaises.

Pour l’installer, nous allons dans le menu Extensions > Installer/gérer les extensions. La fenêtre de
gestion des extensions apparaît alors (Fig. 46).
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Fig. 46 Installation d’une extension dans QGIS.




Astuce

Dans l’onglet Paramètres vous pouvez ajouter un dépôt d’extensions si vous possédez son URL et vous pouvez également lister les extensions encore expérimentales.



Entrez le nom de l’extension recherchée ou un mot clé dans la barre de texte, ici cadastre. Puis sélectionnez la parmi les extensions filtrées. Une description s’affiche avec éventuellement un lien vers une page web décrivant le fonctionnement de l’extension et d’autres informations. Cliquez ensuite sur Installer le plugin. Une fois l’installation effectuée, l’extension est accessible dans le menu Extensions ou sous forme d’un menu autonome.


Avertissement

La multitude des extensions et la diversité de la communauté les développant est un point fort mais également un point faible. En effet, les extensions seront plus ou moins traduites en français, certaines ne seront pas stables et beaucoup n’auront malheureusement pas de documentation détaillée. À utiliser sans modérations donc, mais avec un regard critique.






GDAL/OGR

GDAL [https://gdal.org/] n’est ni un logiciel ni un langage de programmation. GDAL est en fait une collections de codes informatiques qui permet de faire des traitements rasters de base. Il est également possible de faire des traitements vecteur avec la partie de GDAL appelée OGR.

GDAL est utilisable directement en lignes de commandes. L’apprentissage de la syntaxe spécifique à GDAL est relativement facile et manier ces commandes peut s’avérer utile et pratique. Cependant, sans le savoir nous utilisons GDAL tout le temps lorsque nous utilisons les outils de géomatique libres. Les briques GDAL sont en effet à la base de très nombreux traitements dans d’autres logiciels, et notamment dans QGIS. D’ailleurs lorsque GDAL est implicitement utilisé dans QGIS, souvent la ligne de commande correspondante est visible. C’est très pratique lorsque nous souhaitons utiliser GDAL seul en lignes de syntaxe. Nous avons ainsi un exemple de syntaxe sur lequel baser notre script personnalisé.


Installation de GDAL/OGR

À l’installation de QGIS, GDAL (GDAL/OGR) devrait être installé et reconnu automatiquement comme une variable système. Pour le vérifier, ouvrez une console de commandes de votre système d’exploitation et taper la commande suivante qui vous renverra simplement la version de GDAL installé.

gdalinfo --version





Si GDAL est bien reconnu dans le PATH système, une sortie similaire à celle-ci devrait s’afficher : GDAL 3.0.4, released 2020/01/28. Si un commentaire vous disant que la commande n’est pas reconnue, vérifiez votre installation de GDAL selon votre système d’exploitation. Vérifiez également que GDAL est reconnu dans le PATH du système, selon que vous utilisez Windows [https://www.computerhope.com/issues/ch000549.htm] ou Ubuntu [https://techpiezo.com/linux/set-path-environment-variable-in-ubuntu/].

Une fois GDAL installé et paramétré, il s’utilise en lignes de commandes, assez simples à construire. La documentation en ligne est bien faite pour s’y retrouver [https://gdal.org/programs/index.html]. Le plus simple est de se placer dans son répertoire de travail pour exécuter une commande GDAL. Mais il est également possible d’accéder aux fichiers de travail en indiquant leurs chemins relatifs ou absolus.

Par exemple, si nous souhaitons obtenir les métadonées d’un fichier raster nommé B5_L93.tif, nous pouvons ouvrir le répertoire le contenant puis y ouvrir une console. Ainsi, la console est bien localisée au niveau du raster et nous pouvons directement y entrer la commande dédiée, avec l’option -stats pour afficher les statistiques du raster en plus du reste.

gdalinfo -stats B5_L93.tif





Dans la console, ça ressemble à la figure suivante (Fig. 47).
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Fig. 47 Commande GDAL dans le même répertoire que le fichier raster à traiter.



Si la commande ne s’exécute pas depuis le même répertoire que le raster, il est possible de pointer vers le raster via son chemin relatif (Fig. 48).
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Fig. 48 Commande GDAL avec chemin relatif.



C’est enfin possible d’exécuter GDAL en pointant vers un raster via son chemin absolu (Fig. 49).


[image: alternate text]

Fig. 49 Commande GDAL avec chemin absolu.




Lancer GDAL avec Python

Une fois GDAL bien configuré, il est possible d’appeler une commande GDAL depuis un script Python. La solution présentée ici n’est pas très pythonesque et certains pourraient penser qu’elle tient du bricolage, mais c’est néanmoins une astuce bien pratique. Cette astuce consiste à construire une chaîne de caractères, i.e. un string Python, et de le faire exécuter comme une commande système grâce à la libraire os. Le string de la commande se construit par concaténation. Par exemple, la commande précédente incluse dans un script Python peut ressembler à ceci.

# import des commandes os
import os

# le chemin vers le fichier à reprojeter
src = '/home/poulpe/SIG/Demo/Demo_Python/Landsat_13/B5_L93.tif'

# construction du string de la commande
cmd = 'gdalinfo -stats ' + src

# exécution de la commande
os.system(cmd)





Le tout reste propre et lisible et fonctionne bien. Il faut juste bien faire attention aux espaces dans la commande.

À savoir qu’il existe également une API Python de GDAL afin d’utiliser GDAL de façon plus proprement intégré à Python.





GRASS GIS

GRASS GIS [https://grass.osgeo.org/] (Fig. 50) est un logiciel de géomatique existant depuis très longtemps et plutôt orienté vers des traitements rasters, même si ses fonctionnalités vecteurs sont finalement très riches. À l’origine il ne tournait que sous Linux mais maintenant il fonctionne sans aucun problème sur Windows. Ce logiciel a une réputation d’être réservé aux geeks car à l’origine il ne s’utilisait qu’en lignes de commandes. Aujourd’hui, les lignes de commande sont toujours possibles mais il existe également une interface graphique tout à fait honnête (Fig. 50).
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Fig. 50 Une session de travail sous GRASS GIS.



Le côté reboutant de son utilisation vient du fait que ce logiciel oblige l’utilisateur à structurer son projet dans une base de données GRASS. Même si il est extrêmement simple de construire cette base de données via l’interface graphique, ce côté continue à repousser les utilisateurs non avertis.

Comme dit précédemment, GRASS GIS est interfaçable par QGIS. Les deux logiciels fonctionnent très bien ensemble. Cependant, certains modules spécifiques de GRASS ne sont pas interfacés. Il peut donc être utile de travailler directement avec le logiciel en lui-même. Pour les utilisateurs avertis, la possibilité de travailler en lignes de commandes peut faire gagner un temps certain.

GRASS GIS, comme QGIS, gère Python et l’utilisateur peut y adjoindre ses propres codes pour automatiser ses tâches. Notons enfin que la documentation officielle est bien faite. Par contre, la communauté est moins nombreuse et il peut être plus compliqué que pour QGIS de trouver les réponses à ses questions.



SAGA GIS

SAGA GIS [http://www.saga-gis.org/] (Fig. 51) est un autre logiciel de géomatique plutôt orienté pour les traitements rasters. C’est un logiciel très complet dont les algorithmes sous-jacents fonctionnent bien et plutôt rapidement. Comme GRASS il peut s’utiliser aussi bien en lignes de commandes que via son interface graphique. Il faut avouer que les développeurs n’ont pas tout misé sur cet interface qui peut apparaître quelque peu vintage pour les années 2020 (Fig. 51).
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Fig. 51 Une image Landsat 8 dans SAGA GIS.



Ce logiciel peut s’avérer très utile dans certains cas. Sa sous utilisation malgré ses capacités très intéressantes vient sûrement du fait de sa (très) mauvaise documentation. L’utilisateur est un peu lâché face à lui même dans l’utilisation des différents modules. Une documentation plus fournie, gage de confiance, pourrait propulser ce logiciel.



Orfeo ToolBox

Orfeo ToolBox [https://www.orfeo-toolbox.org/] (OTB) (Fig. 52) est un logiciel initié par le CNES (Centre National d’Études Spatiales), l’agence spatiale française. C’est un logiciel entièrement dédié à la télédétection et à toutes ses composantes. Nous y retrouvons des outils pour les images de télédétection optiques, radar, à très haute résolution spatiale… Les algorithmes sur lesquels le logiciel reposent sont très puissants et optimisés pour tourner rapidement même sur des ordinateurs modestes.

OTB est utilisable en ligne de commande, via Python, ou via QGIS comme interface graphique.
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Fig. 52 Une ortho-photo chargée dans Orfeo ToolBox via l’ancien interface Monteverdi.



La force de OTB est de proposer des outils très performants, notamment pour la segmentation d’images ou les classifications (Kmeans, Random forest, SVM, …). La documentation officielle est complète mais pas toujours très user friendly. Ce logiciel mériterait d’être plus utilisé. Sa communauté reste encore faible et les questions risquent de ne pas trouver réponse facilement sur le Web. Sa prise en mains n’est pas forcément très évidente, mais au final, pour la télédétection, c’est un très bon logiciel pour la télédétection.


Installation de Orfeo Toolbox

Nous allons voir dans cette fiche comment installer le logiciel libre de télédétection Orfeo Toolbox abrégé en OTB.


Installation d’Orfeo ToolBox dans Windows

Ici nous allons voir comment installer le logiciel de télédétection Orfeo ToolBox (OTB) dans Windows. Pour rappel, OTB est en fait une « collection » de modules (appelés Applications dans la terminologie OTB) réalisant chacun une tâche spécifique (classification, calcul raster, segmentation, …). Il est ensuite possible d’accéder à cette collection de modules via des lignes de commandes ou une interface graphique. L’interface graphique par défaut est QGIS. Il suffit d’installer OTB et QGIS en parallèle, puis de paramétrer QGIS pour afficher les modules de OTB.

Comme OTB est distribué sous licence libre, il suffit de le télécharger depuis le site officiel de OTB [https://www.orfeo-toolbox.org/]. Une fois sur la page, la dernière version est disponible sous l’icône Download OTB X.X.X où X.X.X correspond à la dernière version disponible. Nous choisissons ensuite la version correspondant à notre OS, ici Windows (Fig. 53). Notons que des versions Linux et Mac existent également.
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Fig. 53 Téléchargement de Orfeo ToolBox.




Note

À priori maintenant tous les ordinateurs tournent en 64 bits, vous pouvez donc certainement prendre cette version.



Le gros avantage de OTB est de ne pas nécessiter d’installation. En effet, une fois l’archive téléchargée et décompressée, nous pouvons directement utiliser les modules d’OTB en ligne de commandes ou via QGIS. C’est notamment pratique lorsque nous n’avons pas les droits administrateurs de la machine.


Astuce

Le logiciel de décompression par défaut de Windows n’est pas toujours des plus rapides. Il est possible d’utiliser le logiciel gratuit 7zip [https://www.7-zip.org/] qui fonctionne très bien.



Pour l’intégration de OTB dans QGIS, voir la partie dédiée dans la documentation du logiciel [https://www.orfeo-toolbox.org/CookBook/QGISInterface.html] ou plus bas sur cette page (OTB via QGIS).



Utilisation de OTB en lignes de commandes dans Windows

Une des forces de OTB est de pouvoir s’utiliser en lignes de commandes. C’est notamment très pratique lorsque nous souhaitons créer des scripts d’automatisation ou des bouts de programmes. La première chose à faire est de régler le PATH en y ajoutant le répertoire qui contient les différents modules. Ce répertoire se trouve dans le sous répertoire bin du répertoire principal de OTB. Imaginons que nous ayons stocké le répertoire téléchargé et décompressé directement sur le disque C:, le répertoire en question est : C:\OTB-7.3.0-Win64bin. Si nous l’ouvrons dans un explorateur de fichiers, nous trouvons bien tous les modules, qui correspondent aux fichiers .bat commençant par otbcli_. Pour rappel, la procédure pour ajouter un répertoire au PATH de Windows est décrite sur ce site [https://www.computerhope.com/issues/ch000549.htm]. Attention de ne pas effacer son PATH mais simplement d’ajouter le chemin vers les modules de OTB à la fin du PATH existant.

Une fois le PATH réglé, nous ouvrons une console Windows (vous gagnez alors 100 points de geeks !). Pour ouvrir cette console, dans le menu Démarrer vous chercher cmd et vous lancez le cmd.exe qui vous est proposé. Une fois la console ouverte vous pouvez par exemple tenter de lancer le module qui permet de faire des segmentations d’images, nommé Segmentation. Par défaut, les modules se lancent en entrant otbcli_ (comme OTB Command Line Interface) suivi du nom du module désiré. Ici nous entrons donc :

otbcli_Segmentation





Il suffit d’appuyer sur Entrée pour lancer la commande. Si tout est bien réglé, le module est bien lancé mais il vous est spécifié que des paramètres sont manquants et une liste des paramètres demandés s’affiche (Fig. 54).
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Fig. 54 Exécution d’une ligne de commande OTB dans une invite de commandes Windows.



Par exemple, pour calculer un NDVI à partir d’un raster multi-bandes disposant d’une bande infrarouge et d’une bande rouge, la commande à entrer serait :

otbcli_BandMath -il xtr_dalle1.tif -exp "(im1b1 - im1b2)/(im1b1 + im1b2)" -out ndvi_dalle_1.tif





L’utilisation des commandes sera détaillée à chaque présentation de modules tout au long de cette documentation.



Installation d’Orfeo ToolBox dans Ubuntu/Debian

La procédure est exactement la même que pour l’installation dans Windows sauf qu’il faut sélectionner l’icône Linux sur la page de téléchargement (Fig. 53). Une fois l’archive téléchargée et décompressée, OTB est utilisable directement, il n’est pas nécessaire d’installer un package en .deb. Pour lancer l’interface Monteverdi, il suffit d’aller dans le répertoire téléchargé et décompressé et de lancer le processus monteverdi.sh en double cliquant dessus. Il faut préciser que nous souhaitons l’exécuter et Monteverdi se lance.



Utilisation de OTB en lignes de commandes dans Linux

Contrairement à Windows, Linux est très bien conçu pour être utilisé en lignes de commandes. Il est donc encore plus simple d’utiliser OTB en lignes de commandes sous cet OS. Il est simplement nécessaire d’installer le package otb-bin via la commande suivante :

sudo apt-get install otb-bin





Le PATH est réglé automatiquement et les commandes peuvent maintenant être lancées. La syntaxe est la même que nous soyons sous Windows ou Linux.



Interfaces graphiques pour OTB

Comme dit précédemment, les modules (ce que les développeurs de OTB appellent les applications) peuvent être interfacées via QGIS.


OTB via QGIS

Une possibilité pratique est d’interfacer les applications d’OTB via QGIS. Pour ce faire, il est tout d’abord nécessaire de récupérer le chemin du répertoire OTB téléchargé. Par exemple, dans le cas d’une installation sous Windows, admettons que nous l’ayons directement stocké sur le disque C:. Une fois que nous avons ce chemin, nous ouvrons QGIS et nous allons ajouter OTB parmi les Fournisseurs de traitements.

Dans la Boîte à outils de traitements, nous cliquons sur l’icône Options [image: icone_reglages]. La fenêtre suivante apparaît (Fig. 55).
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Fig. 55 Ajout de Orfeo ToolBox comme fournisseur de traitements à QGIS.



Nous déroulons le menu sous la ligne OTB, nous cochons la case Activer, nous réglons le chemin du Répertoire des applications OTB à C:/OTB-7.3.0-Win64/lib/otb/applications puis le chemin du Répertoire OTB à C:/OTB-7.3.0-Win64. Puis nous cliquons sur OK. Les outils OTB sont maintenant disponibles depuis la Boîte à outils de traitements de QGIS dans le menu OTB (Fig. 56).
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Fig. 56 Les outils OTB dans la Boîte à outils de traitements de QGIS.



Note

Évidemment les chemins sont à modifier selon votre installation et votre version de OTB. Si vous êtes sous Ubuntu, le chemin sera du genre /home/user/OTB-7.2.0-Linux64/lib/otb/applications.







Vous venez alors de décupler les capacités de QGIS, qui devient alors extrêmement puissant.






SNAP Toolbox

L”Agence Spatiale Européenne [https://www.esa.int/] (ESA) a développé une série de boîtes à outils toolboxes pour traiter les données produites par le programme spatial européen : les données Sentinel, SMOS et PROBA-V (Fig. 57). Ces boîtes à outils sont connues sous le nom de SNAP toolboxes [https://step.esa.int/main/toolboxes/] (Sentinel Application Platform). Il s’agît de cinq boîtes à outils indépendantes, une pour chacun des Sentinel-1 [http://www.esa.int/Applications/Observing_the_Earth/Copernicus/Sentinel-1], 2 [https://www.esa.int/Applications/Observing_the_Earth/Copernicus/Sentinel-2] et 3 [https://www.esa.int/Applications/Observing_the_Earth/Copernicus/Sentinel-3], une pour SMOS [http://www.esa.int/Applications/Observing_the_Earth/SMOS] et une pour PROBA-V [https://www.esa.int/Applications/Observing_the_Earth/Proba-V]. Ces boîtes à outils sont distribuées gratuitement [https://step.esa.int/main/download/snap-download/] sous licence libre et sont multi plateformes. Il est possible de les télécharger une par une ou de télécharger une sorte de super boîte à outils qui les regroupe toutes les cinq. L’installation se fait facilement en choisissant la version qui correspond à votre OS, Windows, Mac ou Linux.

L’interface n’est pas des plus sexy mais les fonctionnalités proposées sont très intéressantes et très puissantes. Par exemple, pour les images optiques, sont proposés des modules de classification non supervisée, de classification supervisée basée sur la méthode de random forest, svm, … de pansharpening, de segmentation… Pour les données radar, différents outils d’ortho-rectification, de calcul de polarisation, de filtres … sont proposés.

Les boîtes à outils sont utilisables via un interface graphique ou via Python, ce qui en fait un outil intéressant dans une optique d’automatisation. Notons également que la classification supervisée basée sur le random forest est interfaçable par QGIS via le plugin SCP.
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Fig. 57 Une bande Sentinel-2 chargée dans la SNAP Toolbox de l’ESA.




Installation de la SNAP toolbox de l’ESA

Nous allons voir dans cette fiche comment installer le logiciel libre de télédétection développé par l’Agence Spatiale Européenne (ESA). Ce logiciel est en fait une série de boîtes à outils (Toolboxes) dédiées à l’exploitation des images des différentes missions de l’ESA : Sentinel, SMOS ou PROBA-V.


Installation de SNAP dans Ubuntu/Debian

Ici nous allons voir comment installer les boîtes à outils SNAP sur un ordinateur tournant sous Ubuntu ou Debian. Ces boîtes à outils sont librement téléchargeables sur le site dédié [https://www.qgis.org/fr/site/https://step.esa.int/main/download/snap-download/], dans la catégorie Téléchargements (Fig. 58).
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Fig. 58 Téléchargement des boîtes à outils SNAP.



Nous avons le choix de ne télécharger que les boîtes à outils Sentinel ou SMOS ou toutes à la fois. Quelque soit le choix, nous choisissons la version Unix 64-bit. Le fichier téléchargé est un fichier shell d’installation nommé esa-snap_all_unix_8_0.sh (version 8 au moment de la rédaction de ces lignes). Une fois ce fichier téléchargé, nous l’exécutons via la commande suivante.

sh esa-snap_sentinel_unix_8_0.sh





Le processus d’installation se lance, il n’y a qu’à suivre les instructions. Notons que si Python est installé, nous pouvons lier les outils SNAP à notre installation Pyhton. Le logiciel se lance alors en cherchant simplement snap dans le lanceur d’application. Le lanceur se nomme SNAP Desktop.



Installation de SNAP dans Windows

Nous allons voir ici comment installer les boîtes à outils SNAP sur un ordinateur tournant sous Windows. Au niveau de la page de téléchargement (Fig. 58), nous sélectionnons simplement la version Windows 64-bit. Un fichier exécutable est alors téléchargé nommé esa-snap_all_windows-x64_8_0.exe. Le 8 correspond à la version du logiciel, version disponible au moment de la rédaction de ces lignes. Ensuite, le logiciel s’installe de façon classique en double cliquant sur ce fichier et en suivant les instructions. Si Python est installé, nous pouvons lier SNAP à Python. Le logiciel est ensuite disponible dans le menu Démarrer.





WhiteboxTools

WhiteboxTools [https://jblindsay.github.io/wbt_book/intro.html] est un logiciel qui se présente sous la forme d’une collection de différents modules dédiés aux traitements vecteurs et rasters. C’est une plateforme d’analyse de données géospatiales initié par le professeur John Lindsay [https://jblindsay.github.io/ghrg/index.html] de l’Université de Guelph (Canada). Le cœur de cette plateforme est distribuée sous licence Open Source et donc utilisable par tout un chacun. Une extension proposant quelques outils supplémentaires est disponible mais payante. Mais notons que le cœur libre de la plateforme propose déjà plusieurs centaines de modules.

Une force de cette plateforme est de proposer des outils pointus dans le domaine du traitement raster, des traitements hydrologiques (Fig. 59) (extraction de réseau hydrographique, de bassins-versants, comblement de MNT …) et des traitements Lidar, comme dériver un modèle numérique d’élévation à partir d’un nuage de points Lidar.

La plateforme WhiteboxTools est utilisable via une ligne de commande propre au logiciel, via une API Python, via un package R, via un interface développé spécialement pour son utilisation ou via QGIS. Ces différents moyens d’utilisation et sa puissance font de cet outil un outil très précieux pour des traitements poussés.
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Fig. 59 Analyse stochastique pour analyse de zones humides (figure tirée du site officiel).




Astuce

La  documentation de WhiteBoxTools [https://www.whiteboxgeo.com/manual/wbt_book/preface.html] est très bien faite et très détaillée (mais en anglais).




Installation de WhiteboxTools

La procédure d’installation est similaire sous Windows ou sous Linux/Ubuntu. Il est nécessaire de télécharger le WhiteboxTools Open Core sur la page dédiée au téléchargement [https://www.whiteboxgeo.com/geospatial-software/]. Une fois le téléchargement effectué selon la version de son OS, un répertoire nommé WTB compressé se trouve maintenant sur notre disque dur. Une fois décompressé, nous pouvons l’explorer. Nous y trouvons trois fichiers qui nous seront utiles pour faire tourner WhiteBoxTools : wb_runner.py, whitebox_tools et whitebox_tools.py.


WBT via l’interface native

Le fichier Python wb_runner.py permet de lancer un interface graphique minimal mais qui permet d’accéder aux différents modules de WBT. Le plus simple est d’ouvrir ce script dans un éditeur Python comme PyCharm ou Spyder puis de le lancer comme un script normal. L’interface permettant d’accéder aux différents modules apparaît alors (Fig. 60).
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Fig. 60 Lancement de l’interface natif de WBT.



Cet interface est tout à fait basique mais permet de lancer facilement tous les modules.



WBT via la commande

WBT peut se piloter via la ligne de commande. Ces commandes appellent en fait les modules contenus dans le fichier whitebox_tools. Il est donc nécessaire de lancer les commandes depuis le répertoire qui contient ce fichier ou bien d’ajouter ce fichier au path de son système. Par exemple, pour lancer le module permettant de calculer un raster de pentes à partir d’un MNT, la commande suivante doit être lancée.

./whitebox_tools -r=Slope -v --dem=srtm_roya_L93.tif --output=slopeWBT.tif --units="degrees"






	où :
	
	whitebox_tools : appel aux commandes


	-r=Slope : appel du module slope qui permet de calculer un raster de pentes


	-v : pour avoir des sorties verbeuses dans la console


	–dem : le MNT à prendre en entrée


	–output : le raster de pentes en sortie


	–units : le choix de l’unités des pentes










WBT via QGIS

WBT peut s’interfacer dans QGIS, ce qui est très confortable lorsqu’on est habitué à ce logiciel. Pour utiliser WBT dans QGIS, il est tout de même nécessaire de télécharger WhiteBoxTools sur son ordinateur. En fait, QGIS pointera vers le fichier contenant les commandes whitebox_tools.


Avertissement

Pour interfacer WBT, la version de QGIS doit être au moins la 3.18.



Dans un premier temps il est nécessaire d’installer le plugin dédié. Il ne se trouve pas dans les dépôts officiels, il faut l’ajouter manuellement, dans le menu Extensions ‣ Installer/Gérer les extensions puis aller dans l’onglet Paramètres (Fig. 61).
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Fig. 61 Ajout du dépôt WBT dans les dépôts d’extensions de QGIS.



Nous cliquons sur Ajouter puis dans la fenêtre qui apparaît nous entrons un Nom pour le dépôt. Ce Nom peut être Alex Bruy Plugins (du nom de la personne qui maintient le plugin). Nous entrons ensuite l”URL du dépôt  : https://plugins.bruy.me/plugins/plugins.xml puis nous cliquons sur OK. Nous retournons ensuite dans l’onglet Toutes de la fenêtre de gestion des extensions et nous cherchons l’extension WhiteBoxTools dans la barre de recherche (Fig. 62).
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Fig. 62 Installation de l’extension WhiteBoxTools pour QGIS.



Puis nous cliquons sur Installer. Une fois l’extension installée, il est maintenant nécessaire de dire à QGIS où se situe le fichier whitebox_tools téléchargé précédemment. Pour cela nous allons dans la Boîte à outils de traitements et nous cliquons sur l’icône Options [image: icone_reglages]. Dans la fenêtre qui s’affiche, nous déplions le menu Fournisseur de services puis le menu WhiteBoxTools (Fig. 63).
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Fig. 63 Définition du chemin vers les outils WhiteBoxTools dans les fournisseurs de services.



Une fois cliqué sur OK, les outils WhiteBoxTools apparaissent dans la Boîte à outils de traitements (Fig. 64).
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Fig. 64 Les outils WhiteBoxTools dans la Boîte à outils de traitements de QGIS.





WBT via Python

WBT peut s’utiliser via Python. Il est ainsi possible d’utiliser WBT facilement dans des scripts Python. Cet interfaçage se fait via le fichier whitebox_tools.py. Dans le script il est donc nécessaire de régler le Python Path pour qu’il intègre le répertoire WBT dans lequel se situe le fichier Python whitebox_tools.py. Cela ce fait avec la fonction sys.path.append('/home/poulpe/WBT/'). Concrètement, un script faisant appel à WBT doit commencer comme l’expemple ci-dessous.

# Réglage du Python Path
import sys
sys.path.append('/home/poulpe/WBT/')

# Import des modules WhiteBoxTools
from whitebox_tools import WhiteboxTools
wbt = WhiteboxTools()

# Lancement d'un module pour découper un raster avec un polygone
wbt.clip_raster_to_polygon('raster_in.tif', 'polygone.gpkg', 'raster_out.tif', False)





Dans ce script, après avoir réglé le Python Path, nous appelons le module clip_raster_to_polygon de WhiteBoxTools en précisant un raster d’entrée, un polygone de découpage et un raster de sortie.





Python

Python [https://pythonprogramming.net/] est un langage de programmation très utilisée dans la communauté scientifique (mais pas que). Il est virtuellement possible de tout faire avec Python (du calcul scientifique, gestion de bases de données, de l’intelligence artificielle, des interfaces graphiques, des sorties graphiques …). Ce langage n’a pas été développé pour la géomatique, mais des modules pour traiter ces questions ont été développés. Tous les logiciels présentés plus haut interagissent de près ou de loin avec Python.

En ce qui concerne la géomatique, il est possible de faire des traitements vecteurs aussi bien que rasters avec Python. Il est également possible de facilement se connecter avec des bases de données PostGIS. De très nombreux modules portant sur des questions de géomatique existent. Il est parfois difficile de s’y retrouver et de bien les appréhender. Nous en présenterons deux ici, le premier pour traiter les données rasters et le second pour les données vecteur : rasterio et geopandas. Ces deux librairies s’installent de façon classique.


Librairie rasterio

La librairie rasterio [https://rasterio.readthedocs.io/en/latest/index.html] permet de manipuler des données rasters avec Python. Elle permet, l’import et l’export depuis et vers de nombreux formats. Une fois un raster importé, avec rasterio il est possible de le manipuler en le retaillant, en le modifiant via des calculs rasters, en le reprojetant… Cette librairie est très utilisée et propose une documentation en ligne bien faite.



Librairie geopandas

La librairie geopandas [https://geopandas.org/en/stable/docs.html] est en quelque sorte une extension de la librairie pandas [https://pandas.pydata.org/docs/user_guide/index.html]. Cette librairie pandas est dédiée à la manipulation de tableaux, qu’on appelle souvent par le terme anglais de dataframe. Pandas rend possible la gestion, l’interrogation et la manipulation de ces tableaux, un peu dans l’esprit de ce qui se fait avec R. geopandas fait exactement la même chose mais ajoute une colonne de géométrie au tableau. Grâce à cette colonne, il est possible de faire des traitements SIG géospatiaux sur ces objets, comme des sélections et jointures spatiales, des géotraitements (zones tampons, intersections…), des reprojections… Cette librairie est très utilisée et beaucoup de documentation se trouve facilement en ligne.




R

R [https://www.r-project.org/] est à l’origine un langage dédié à l’analyse statistique et à la fouille de données. Mais il a tellement évolué et s’étoffe tous les jours de fonctionnalités nouvelles que c’est maintenant considéré comme un langage de programmation à part entière. À la base R n’était pas fait pour traiter les données à caractère spatial comme les couches rasters et vecteurs. Mais aujourd’hui, des modules dédiés existent et faire de la géomatique ou de la cartographie avec R est très courant et facile. R est donc une solution optimale pour automatiser des chaînes de traitements géomatiques et produire des cartes de qualité professionnelle. Ici, nous ne nous intéresserons qu’à la partie géomatique, pour la partie cartographie, reportez aux ouvrages et modules dédiés comme mapsf [https://riatelab.github.io/mapsf/].

Pour traiter les données rasters avec R, il existe plusieurs librairies (packages) comme raster, terra et stars, mais dans la suite de cette documentation nous ne présenterons que l’usage de terra. Pour traiter les données vecteurs, la librairie la plus utilisée est sf, mais terra gère également les données vecteurs. Ces packqges s’installent très simplement de façon classique.


Librairie terra

La librairie terra [https://rspatial.org/terra/pkg/1-introduction.html] est une librairie très complète pour manipuler des données rasters mais également vecteur. Nous y retrouvons tous les traitements les plus tuilsiés en géomatique. Cette librairie peut quasiment être perçue comme un SIG complet au sein de R. la syntaxe est simple et les temps de calcul sont optimisés. En termes de programmation au servide de la géomatique, c’est peut-être ce qui se fait de mieux.



Librairie sf

La librairie sf [https://r-spatial.github.io/sf/] (pour simple features) est devenue une des librairies les plus utilisées pour la gestion de données vecteur. Bien qu’historiquement il existe de nombreuses autres librairies pour lire et traiter les données vecteurs, sf tend à maintenant dominer. Avec cette librairie, il est possible de lire tous les formats vecteurs, de faire des traitements sur leurs tables attributaire et des géotraitements sur leurs géométries. Comme sf commence à être largement utilisée, beaucoup de documentation se trouve en ligne et la communauté est active. Enfin, sf dialogue bien avec la librairie Stars et permet de faire des cartes esthétiques avec mapsf [https://riatelab.github.io/mapsf/].




PostgreSQL/PostGIS

PostgreSQL [https://www.postgresql.org/] est un système de gestion de bases de données relationnelles [https://fr.wikipedia.org/wiki/Syst%C3%A8me_de_gestion_de_base_de_donn%C3%A9es] (SGBDR). Il s’agît d’un logiciel qui permet de stocker, gérer et manipuler des bases de données. Une base de données peut être vue comme un ensemble de tables c’est-à-dire un ensemble de tableaux organisés en lignes et colonnes. Ces tables sont en relation les unes avec les autres. Ainsi, en interrogeant une table, il est possible d’interroger en même temps plusieurs tables par le jeu des relations qu’elles entretiennent.

L’intérêt d’utiliser une base de données et de travailler sur des données bien structurées et donc facilement interrogeables. Ces requêtes se font à l’aide du langage SQL. SQL est un langage très puissant, qui permet de faire des requêtes complexes en un minimum de manipulations.

Il existe différents SGBDR mais PostgreSQL a l’avantage d’être puissant, libre, gratuit et multi-OS. Un autre avantage qui nous intéresse particulièrement ici est qu’il peut être étendu avec l’extension PostGIS (Fig. 65). PostGIS [https://postgis.net/] permet de gérer des tables disposant d’informations géographiques. Ces tables sont vues comme des tables classiques disposant simplement d’une colonne supplémentaire renseignant sur la géométrie. Cette géométrie peut être ponctuelle, linéaire, surfacique …
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Fig. 65 Les trois outils intéressants à utiliser ensemble.



Avec PostgreSQL/PostGIS seuls, il est possible de gérer et interroger les bases de données en ligne de commandes, ce qui peut être un peu ardu. Heureusement, il existe des outils ergonomiques qui permettent d’interfacer les bases de donées stockées afin de les gérer et de les interroger plus facilement. Parmi ces outils, il y a QGIS, qui permet de charger les tables géographiques stockées et de les interroger. Pour une gestion plus fine et pour profiter pleinement des potentialités du SQL, il est également possible d’utiliser des interfaces non orientés SIG (Fig. 65) comme le logiciel (libre) DBeaver [https://dbeaver.io/]. C’est cette solution que j’utilise personnellement.


Note

La gestion de données géographiques à l’aide de vraies bases de données structurées avec les outils dédiés est souvent réservée aux experts de la question. Ça ne devrait pas être le cas. L’effort de prise en mains n’est pas du tout insurmontable et la puissance de ces outils les rendent très intéressants.




Installation de PostGreSQL/PostGIS

Dans cette section nous allons voir comment installer le SGBDR (Système de Gestion de Bases de Données Relationnelles) PostGreSQL et son extension spatiale PostGIS.
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Notions de bases pour bien comprendre

Après avoir installé PostGreSQL sur notre ordinateur, nous disposerons d’un serveur de bases de données en local. Il ne faut pas être effrayé par le terme de serveur. À moins de déployer vos bases sur un réseau, la notion de serveur sera totalement transparente. Nos différentes bases seront stockées sur ce serveur.

Au cours de l’installation, une base sera créée par défaut. Cette base sera nommée postgres. Il s’agira de la base mère qui contiendra des données relatives au bon fonctionnement du serveur comme les identifiants des différents utilisateurs. Nous toucherons très peu à cette base, nous la laisserons tranquille dans son coin.

Comme nous sommes sur une logique de serveur, il sera nécessaire de créer des utilisateurs (aussi appelés rôles dans le jargon des bases de données) qui auront le droit, ou non, de se connecter et de modifier les différentes bases. À l’installation, un utilisateur spécial est créé. Cet utilisateur possède les droits d’administration de la partie serveur. Cet utilisateur se nomme postgres et nous lui associerons un mot de passe. C’est en prenant le rôle de cet utilisateur que nous pourrons créer d’autres utilisateurs.

Il sera nécessaire de créer au moins un autre utilisateur. C’est l’utilisateur que nous utiliserons pour administrer, gérer et interroger les bases de données autres que la base mère. Il est en effet non recommandé de travailler avec le super utilisateur postgres. À priori, dans notre cas, nous ne créerons qu’un seul utilisateur qui sera nous, avec lequel nous travaillerons.

De même que nous ne travaillerons pas avec l’utilisateur postgres, nous ne travaillerons pas dans la base mère du même nom. Nous allons donc créer une, ou plusieurs autres bases de données. Ces bases seront associées à l’utilisateur nous. C’est au sein de ces bases que nous stockerons et interrogerons les données sur lesquelles nous travaillerons.

Au sein d’une base de données, il sera possible de créer ce que nous appelons un (ou plusieurs) schéma. Un schéma peut être vu comme un sous répertoire aidant à ranger les différentes données i.e. les différentes tables. Par exemple, nous pouvons créer une base de données usage_du_sol dans laquelle nous stockons les données relatives à l’usage du sol. Au sein de cette base, nous pouvons créer un schéma Corine_Land_Cover dans lequel nous stockerons les différentes couches (i.e. les différentes tables) de Corine Land Cover (2000, 2006, 2012 …). Ensuite nous pouvons créer un schéma oso_theia dans lequel nous stockons les différentes tables relatives à l’usage du sol Theia (2015, 2016, 2017 …). Cette organisation est tout à fait libre et laissée à l’appréciation de l’utilisateur.

Concrètement, nous ne toucherons jamais au logiciel PostGreSQL en lui-même. Toute la phase d’administration comme la création d’utilisateurs et de bases passera par le logiciel DBeaver. C’est également via ce logiciel que nous interrogerons nos bases à l’aide de requêtes SQL plus ou moins poussées. Enfin, nous visualiserons les tables spatiales (équivalentes à des couches) à l’aide de QGIS. Nous pourrons également faire quelques requêtes simples directement dans QGIS.

Pour récapituler, les grandes étapes d’installation et de configurations sont les suivantes :


	installation de PostGreSQL et de son extension spatiale PostGIS


	installation de DBeaver


	définition d’un mot de passe pour le super utilisateur administrateur nommé postgres


	à l’aide de DBeaver, création d’un utilisateur (aussi appelé rôle) normal


	toujours à l’aide de DBeaver, création d’une base de données appartenant à l’utilisateur normal


	ajouter à cette base de données l’extension PostGIS afin de pouvoir y stocker des données géographiques


	dans QGIS, se connecter à cette base de données géographiques


	à l’aide de QGIS, y importer des données





Note

Tout cela est assez procédurier mais manipuler ses données à l’aide de ces outils et des requêtes SQL peut s’avérer extrêmement puissant. L’effort de prise en mains en vaut la peine.





Installation sous Debian/Ubuntu

Nous allons voir ici comment installer les différents outils sous un système Debian ou Ubuntu (une procédure pour Windows viendra plus tard).

Les dépôts de base ne contiennent pas les dernières versions des outils à installer. La première étape consiste donc à ajouter des dépôts spécifiques dans notre liste de dépôts. Pour cela, nous entrons la commande suivante dans une une console.

sudo sh -c 'echo "deb http://apt.postgresql.org/pub/repos/apt $(lsb_release -cs)-pgdg main" > /etc/apt/sources.list.d/pgdg.list'





Nous ajoutons ensuite la clé d’identification de ce dépôt.

wget --quiet -O - https://www.postgresql.org/media/keys/ACCC4CF8.asc | sudo apt-key add -





Nous rechargeons la liste des dépôts.

sudo apt-get update





Nous pouvons ensuite installer les outils désirés.

sudo apt-get -y install postgresql-13 postgis postgis-gui postgresql-13-postgis-3 postgresql-13-postgis-3-scripts





Ici, nous installons :


	postgresql-13 : la version 13 de PostGreSQL (la dernière disponible au moment de la rédaction de cette fiche)


	postgis postgis-gui : PostGIS et un interface graphique à PostGIS utile dans certains cas


	postgresql-13-postgis-3 postgresql-13-postgis-3-scripts : les outils de liaison entre PostGreSQL et PostGIS




À l’issue de cette phase, nous avons bien installé PostGreSQL et son extension PostGIS. Il est maintenant nécessaire de passer à la configuration du système.

Maintenant, nous installons le logiciel DBeaver qui nous servira pour administrer nos bases et les interroger. Là aussi, il est nécessaire d’ajouter un dépôt spécifique via la commande suivante.

sudo add-apt-repository ppa:serge-rider/dbeaver-ce





Il n’y a plus qu’à recharger la liste des dépôts et à installer le logiciel comme suit.

sudo apt-get update
sudo apt-get install dbeaver-ce







Configuration de l’admin de PostGreSQL

En premier lieu, il est nécessaire de définir un mot de passe pour l’utilisateur administrateur nommé postgres. Cette manipulation se fait en root. Nous ouvrons un terminal et nous entrons la commande suivante qui nous permet de nous identifer en root.

sudo -i





Cette commande nous fait passer en root. Nous voyons que le prompt change en conséquence. Nous changeons ensuite d’utilisateur pour passer en utilisateur postgres. Cela se fait avec la commande suivante.

su - postgres





Une fois identifié comme étant l’utilisateur postgres, nous spécifions un mot de passe grâce à la commande suivante.

psql -c "ALTER USER postgres WITH password 'postgres'"





Avec cette commande nous spécifions le mot de passe postgres pour l’utilisateur postgres. Nous aurions pu mettre n’importe quel autre mot de passe.



Création d’un utilisateur lambda

Comme dit précédemment, nous ne pouvons pas travailler sous l’identité de l’administrateur en chef postgres. Il nous faut créer un utilisateur normal que nous nommerons my_user. C’est avec cette identité que nous gérerons et interrogerons nos bases. Cette étape se fait à l’aide de DBeaver. Nous lançons donc ce logiciel.

À l’ouverture de DBeaver, dans le panneau de gauche, nous constatons que nous disposons de notre serveur identifié comme localhost dans lequel se trouve notre base de données mère nommée postgres (Fig. 66).
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Fig. 66 Le serveur localhost et la base mère postgres.



Nous allons créer notre utilisateur my_user au sein de cette base mère. Pour cela nous faisons un clic droit sur la base postgres ‣ Créer ‣ Rôle. Dans la fenêtre qui s’affiche, nous spécifions le nom du nouvel utilisateur my_user et nous lui associons un mot de passe (Fig. 67).
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Fig. 67 Création d’un nouvel utilisateur.



Une fois ce nouvel utilisateur créé, il est nécessaire de le garder en dur en cliquant sur Sauvegarder, en bas à droite de l’écran. Une nouvelle fenêtre s’affiche alors. Nous cliquons sur Persister (Fig. 68).
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Fig. 68 Sauvegarde du nouvel utilisateur.



Ce nouvel utilisateur apparaît bien dans la liste des utilisateurs reconnus par la base postgres (Fig. 69).
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Fig. 69 Liste des utilisateurs.





Création d’une nouvelle base de données (vide)

Maintenant que nous avons créé un utilisateur de travail, nous allons pouvoir lui associer une base de données dans laquelle il pourra travailler. Pour cela, nous restons dans DBeaver et nous faisons un clic droit sur la ligne localhost. Nous choisissons Créer ‣ Database. Dans la fenêtre qui apparaît, nous spécifions le nom de la base, par exemple geodata ainsi qu’un utilisateur associé my_user (Fig. 70).
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Fig. 70 Création d’une base de données geodata associée à l’utilisateur my_user.



La nouvelle base apparaît bien dans le panneau des bases sous la base postgres.


Avertissement

Si le nouvel utilisateur n’apparaît pas dans la liste, il peut être nécessaire de redémarrer DBeaver.



À ce stade, nous disposons d’une nouvelle base de données vide, qui appartient à my_user. Mais cette base n’est pas encore géographique. Il va falloir maintenant lui associer l’extension PostGIS.



Association de l’extension PostGIS à une base

Cette association se fait très simplement. Dans un premier temps il est nécessaire de spécifier à DBeaver que nous souhaitons maintenant travailler avec la nouvelle base. Pour cela, nous faisons un clic droit sur cette nouvelle base geodata et nous sélectionnons Définir l'objet défaut. Nous remarquons au passage que la traduction en français de DBeaver n’est pas sensationnelle… La base geodata apparaît maintenant en gras ce qui signifie que c’est notre base de travail. Ensuite, nous déroulons la base afin de faire apparaître le sous menu Extensions (Fig. 71).
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Fig. 71 Les sous menus associés à la base.



Nous faisons ensuite un clic droit sur le menu Extensions. Une fenêtre de gestion des extensions apparaît (Fig. 72).
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Fig. 72 Liste des extensions disponibles.



Nous y cherchons l’extension postgis et nous l’installons en cliquant sur OK. Nous refaisons la même manipulation pour installer l’extension postgis_raster qui nous permettra de manipuler des données rasters avec PostGIS. Une fois ces deux extensions installées, elles apparaissent bien dans le sous menu Extensions de notre base geodata.

Nous disposons maintenant d’une base géographique, nommée geodata et qui appartient à l’utilisateur normal my_user. Nous pouvons maintenant y ajouter des données.



Exploration des données via DBeaver

Lorsqu’une couche a été ajoutée à notre base, il est possible de l’explorer via DBeaver. En retournant dans ce logiciel, nous allons dans la base qui a été mise à jour et nous constatons l’ajout d’une nouvelle table, i.e. couche. Cette couche est éventuellement dans un nouveau schéma, selon la façon dont elle a été ajoutée (Fig. 73).
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Fig. 73 La table est bien synchronisée dans DBeaver.



Nous pouvons faire un clic droit sur notre table et sélectionner View Data. La table s’affiche alors dans le panneau central (Fig. 74).
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Fig. 74 Les données associées à la table.



Outre les attributs initiaux de la couche (scalerank, min_zoom, …) nous trouvons un nouvel attribut geom. Il s’agît simplement d’une colonne de géométrie stockant la géométrie de chaque entité. Ici, nous constatons qu’il s’agît de multipolygon. En logique base de données, la géométrie est un attribut comme un autre. Simplement, c’est un attribut qui nous permettra de faire des géotraitements comme des intersections, des zones tampons, des jointures spatiales …
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Données géospatiales, formats, import et export

En géomatique, nous sommes amenés à travailler avec deux grands types données : les données rasters et les données vecteur. Chacun de ces types à des particularités et des domaines d’utilisation différents. La plupart des logiciels de géomatique sont capables de traiter ces deux types de données, même si certains sont plus spécialisés pour traiter l’un ou l’autre. Par exemple, le logiciel Orfeo ToolBox ne traite que du raster.

Il est possible dans certains cas de transformer une couche raster en une couche vecteur et réciproquement. Mais cette conversion ne se fait pas n’importe quand et est réservée à des objectifs précis.

Cette fiche va nous permettre de nous familiariser avec ces deux types de données de façon pratique ainsi qu’avec d’autres types de données pouvant avoir un caractère géospatial comme des données textes disposant de coordonnées, des traces GPS ou des photos géoréférencées.
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Les données rasters

Les données rasters sont des données purement numériques organisées sous forme de tableau, aussi appelé matrice. Une couche raster est une couche rectangulaire (ou carrée) composée de pixels organisées en lignes et colonnes. Chaque pixel est caractérisé par une position au sein de cette grille, par une dimension et par une valeur. Les pixels sont souvent, mais pas toujours, de forme carrée et présentent tous la même forme. Chaque pixel est associée à une et une seule valeur. Cette valeur peut être totalement arbitraire, comme dans le cas d’un raster d’occupation du sol où les pixels en 1 seraient les pixels d”eau, les pixels en 2 serait des forêts etc ou bien ces valeurs peuvent avoir un réel sens physique. C’est notamment le cas des Modèles Numériques de Terrain (MNT) où chaque pixel présente une valeur d’altitude. C’est aussi le cas des images satellites où chaque pixel présente une valeur de radiance ou réflectance.

Dans l’exemple ci-après (Fig. 75), nous avons un raster (grille gris clair), composé de pixels dont la dimension vaut d. Il s’agît d’un raster à 10 colonnes et 7 lignes. Au centre, nous trouvons un pixel de valeur x. Les valeurs des pixels des rasters sont toujours numériques. Un raster peut contenir n’importe quel nombre réel ou entier, positif ou négatif, mais ne peut rien contenir d’autre, ni texte, ni booléens, ni rien d’autre. Par convention, les rasters sont repérés dans un plan dont l’origine est le pixel en haut à gauche. Ainsi, ce pixel x a comme coordonnées (7 ; -4). La définition de ce repère explique pourquoi dans les logiciels de géomatique, les pixels sont présentés comme ayant une dimension positive, la dimension en x, et une dimension négative, la dimension y.


[image: alternate text]

Fig. 75 Raster schématisé dans son repère cartésien.



Pour un aperçu concret de ces propriétés, nous pouvons charger la toute petite extraction d’un MNT nommée « mnt_extract ». Cette petite dimension nous permet d’apprécier les pixels individuellement. Pour accéder aux informations du pixel, nous ouvrons ses propriétés via un clic droit sur cette couche dans le panneau des couches. Nous pouvons ainsi facilement comparer les informations et le raster en lui même (Fig. 76).


[image: alternate text]

Fig. 76 Dimensions x et y du raster.



Dans l’onglet Information, au niveau de Dimensions nous pouvons lire X : 9 et Y : 5, soit 9 colonnes et 5 lignes (Fig. 77). Ces dimensions correspondent bien au nombre de pixels en colonnes (en vert) et en lignes (en rouge). L”Origine juste au-dessous correspond bien au centre du pixel en haut à gauche.


[image: alternate text]

Fig. 77 Dimensions x et y d’un pixel.



Pour la Taille du Pixel, nous constatons qu’un pixel mesure 22 m en x (en vert) et 30 m en y (en rouge). Nous constatons également que la dimension en y est bien négative.


Note

Valeurs manquantes : il arrive fréquemment que certains pixels n’aient d’un raster n’aient pas de valeurs. Ces pixels sans valeurs sont souvent les pixels en bord de raster, mais pas seulement. Or un pixel ne peut pas être « vide », il doit obligatoirement posséder une valeur numérique. Une valeur est donc dédiée par convention à la valeur no data. Le problème est qu’il n’y a pas de règle fixe. C’est souvent une valeur comme -999 ou -9999 ou bien une autre valeur très négative. Dans QGIS, par défaut cette valeur est -32767.




Les formats rasters

Il y a deux grandes familles de formats rasters. La première regroupe les formats que nous pouvons qualifier de stockage comme le format GeoTIFF ou JPEG 2000. La seconde regroupe les formats propres à certains langages de programmation comme R ou Python. En effet, ces langages peuvent tout à fait importer des rasters au format GeoTIFF ou autre, mais les transformeront en rasters de type terra, raster, stars, numpy… afin de travailler dessus directement depuis le code R ou Python. Tous ces formats, de stockage comme ceux propres aux différentes langages, présentent des spécificités propres, des avantages et des inconvénients. Nous résumerons ici quelques grands types de formats couramment rencontrés en géographie.


Le format GeoTIFF

Le principal format raster que nous rencontrons en géomatique est le format GeoTIFF, dont l’extension est .tif ou .tiff. Il s’agît d’une image TIF, comme il en existe dans le domaine de l’image numérique standard, mais qui inclut en plus un tag cartographique. Ce tag cartographique contient notamment les données relatives au système de coordonnées utilisé pour le fichier donné. Ce format est lu et écrit par tous les logiciels de géomatique. C’est le format utilisé pour stocker les modèles numériques de terrain ou les images Landsat par exemple.



Le format jpeg2000

Un autre format que nous pouvons rencontrer en télédétection est le format JPEG 2000, dont l’extension est .jp2 ou .jpg2. Contrairement au GeoTIFF, il s’agît d’un format compressé (mais sans pertes). Une même image au format jpeg 2000 pèsera donc moins lourd qu’au format GeoTIIF à qualité identique. C’est donc un format que nous retrouvons souvent pour les images à très haute résolution, notamment les ortho-photos. L’IGN fournit par exemple ses ortho-photos dans ce format. Ce format peut être lu et écrit par tous les logiciels.



Les flux WMS

Il est possible d’afficher dans QGIS, ou tout autre logiciel SIG, un raster stocké à distance via le service WMS (Web Map Service). Le WMS est basé sur le protocole http. Ces flux sont pratiques lorsque l’utilisateur souhaite afficher de gros rasters comme des orthophotographies par exemple, qu’il est coûteux de télécharger et de stocker en local. Notons cependant, que le WMS ne permet qu’un affichage et ne permet pas d’accéder aux valeurs des rasters. Il n’est pas possible d’interroger ou de manipuler les rasters WMS.



Le format Cloud Optimized GeoTIFF

Le format COG pour Cloud Optimized GeoTIFF est un simple format raster GeoTIFF mais qu’il est possible de manipuler via le protocole http. Concrètement, ce format permet de stocker à distance des rasters et de les interroger comme nous le ferions sur des rasters stockés localement. Par exemple, il est possible de les manipuler dans QGIS, OTB, R ou Python directement avec les outils dont nous sommes familiers mais sans avoir à télécharger les rasters. C’est particulièrement pratique lorsque nous souhaitons travailler sur un gros corpus de rasters. Certains serveurs proposent les archives de certaines images satellites accessibles en COG. Les images Sentinel-2 sont accessibles gratuitement à l’échelle globale via Element 84 [https://www.element84.com/blog/sentinel-2-cloud-optimized-geotiffs-now-available-on-aws-registry-of-open-data]. La plateforme Digital Earth Africa [https://docs.digitalearthafrica.org/en/latest/data_specs/index.html] propose gratuitement les images Sentinel-2, Landsat, Sentinel-1 et d’autres sources à l’échelle de l’Afrique. Les archives Landsat à l’échelle globale sont également accessibles mais en formule payante.



Les formats utilisés par R

Il est tout à fait possible d’importer des données rasters dans R afin de les traiter en utilisant ce langage de programmation. Il est simplement nécessaire d’utiliser une librairie (un package) dédiée. Le package historiquement le plus employé est le package raster [https://rspatial.org/raster/RasterPackage.pdf]. Ce package a vocation, à terme à être remplacé par le package terra [https://rspatial.github.io/terra/index.html], plus rapide. Il existe également un autre package, qui est le package stars [https://cran.r-project.org/web/packages/stars/index.html], mais un peu plus compliqué à prendre en mains. Ces trois packages s’installent facilement, soit via l’interface graphique de RStudio par exemple, soit pas la commande R dédiée, rappelée ci-après (pour le seul package terra).

install.packages("terra")






Astuce

Cette page présente une comparaison [https://github.com/r-spatial/stars/wiki/How-%60raster%60-functions-map-to-%60stars%60-functions?utm_source=pocket_mylist] des fonctionnalités offertes entre le package raster et le package stars. Cette page ci [https://rspatial.org/terra/spatial/index.html] présente différentes fonctionnalités de terra pour l’analyse spatiale et la télédétection. Enfin, l’ensemble des fonctions de terra sont résumées à ce lien [https://rspatial.github.io/terra/reference/terra-package.html].



terra

Lorsque nous importons un raster dans R avec le package terra, nous obtenons un objet raster de type SpatRaster. Il s’agît d’un format raster propre au package terra. Un SpatRaster [https://rspatial.org/terra/spatial/4-rasterdata.html#spatraster] est toujours composé d’un nombre de lignes, d’un nombre de colonnes, d’une étendue spatiale et d’un système de coordonnées de référence. Un SpatRaster stocke également les valeurs des pixels, même si il est possible de créer un raster vide.

Pour certaines manipulations, il peut être nécessaire de convertir un raster terra en un raster au format raster comme défini par le package raster. Cette conversion se fait simplement via la commande raster. Ici, nous convertissons un SpatRaster b4 en un objet raster.

b4_convert <- raster(b4)









Les données vecteurs

Le second type de données que nous utilisons en géomatique sont les données au format vecteur, aussi appelées données vectorielles. Contrairement aux rasters, il ne s’agît plus de matrices de pixels mais de formes élémentaires décrites par des équations. Heureusement pour nous, ces équations sont gérées par les logiciels et nous n’avons pas à nous en préoccuper. L’intérêt de cette description sous forme mathématique est que ces formes ne changent pas avec le niveau de zoom. Par exemple, lorsque nous zoomons sur un raster, un effet pixelisé apparaît. Alors qu’il est possible de zoomer à l’infini sur une entité vectorielle, nous ne verrons aucune altération.

L’autre particularité de ces données vecteurs est de pouvoir leur associer des données attributaires. À chaque entité, il est possible d’associer une infinité d’attributs. Par exemple, au polygone qui correspond à l’entité d’une commune, il est possible d’associer sa superficie, sa population, son code postal, son nom, sa proportion d’espaces verts …


La géométrie des données vecteur

Les données vecteur peuvent être de trois géométries fondamentales : points, lignes et polygones.

Un point est un simple point décrit par un couple de coordonnées X et Y.

Une ligne est une succession de nœuds (aussi appelés vertex) reliés par des arcs. Chaque nœud possède une localisation X et Y et est associé à un arc (si le nœud se trouve au tout début ou à la toute fin de la ligne) ou à deux arcs (si le nœud se situe autre part sur la ligne).

Un polygone est également une succession de nœuds reliés par des arcs, mais dont la fin du dernier arc rejoint le début du premier arc. C’est donc une forme « fermée » à laquelle est associée une surface.

Chacune de ces trois géométries fondamentales peut se décliner dans sa forme multi : multi-points, multi-lignes et multi-polygones (Fig. 78). Le principe est le même sauf que chaque entité peut être représentée par plusieurs formes. Par exemple, la Corse et la France sont deux formes différentes mais ne représentent qu’une seule entité étatique.


[image: alternate text]

Fig. 78 Les trois géométries fondamentales de vecteurs.



Dans la réalité, ces trois formes n’existent pas. Par exemple, un point est censé avoir une largeur et une longueur nulle. Or si c’était le cas, un point n’existerait pas. Ces formes sont des abstractions qui résultent de choix faits par l’utilisateur, en fonction de l’échelle de travail. Ainsi, la ville de Lyon sera un polygone si nous travaillons à l’échelle du Département du Rhône mais seulement un point si nous travaillons à l’échelle du monde. De même, une autoroute sera une surface sur une photo aérienne mais une ligne sur un atlas routier (Fig. 79).


[image: alternate text]

Fig. 79 L’Autoroute A15 vue comme une surface (A) ou comme une ligne (B).





La topologie des données vecteur

Un aspect fondamental des données vecteur est leur topologie. C’est-à-dire les relations que les données ont entre elles et au sein d’elles mêmes. Deux entités peuvent être disjointes, superposées, juxtaposées… Ces relations doivent être respectées au sein d’une même couche géographique ou entre plusieurs couches différentes. Par exemple, la frontière entre la France et l’Allemagne est matérialisée par le cours du Rhin. Par conséquent, non seulement les polygones, issus d’une couche Pays d’Europe, France et Allemagne ne doivent pas se superposer ; mais la ligne Cours d’eau du Rhin, issue d’une autre couche, doit se placer très précisément sur la frontière entre les deux pays.

Cette définition de la topologie est fondamentale lorsque nous créons des données vecteur.

Imaginons une couche vecteur des pays du monde. Dans l’immense majorité des cas, les polygones des pays sont juxtaposées les uns aux autres sans chevauchement. En effet, un territoire appartient à un et unique pays. Les cas de juxtaposition sont possibles dans le cas d’un territoire disputé par plusieurs pays. Ainsi, la Crimée peut être incluse dans les polygones Ukraine et Russie, tout comme Jérusalem-Est au sein des polygones Israël et Palestine. Le contraire d’un chevauchement est un trou entre deux polygones adjacents. Autant les chevauchements peuvent être possibles sur une couche des pays du monde, autant les creux n’existent pas. Tous les territoires, à l’exception de l’Antarctique, sont revendiqués par un pays.


Note

Pour briller en société : un territoire non revendiqué est qualifié de Terra nullius [https://fr.wikipedia.org/wiki/Terra_nullius]. Il n’existe qu’un seul territoire de ce type à la surface du globe, hors Antarctique. Il s’agît du territoire de Bir Tawil [https://fr.wikipedia.org/wiki/Bir_Tawil]. Lambeau de désert de quelques kilomètres carrés à la frontière soudano-égyptienne [https://www.openstreetmap.org/search?query=bir%20tawil#map=11/21.8742/33.6353] revendiqué ni par l’Égypte ni par le Soudan.





Les formats vecteurs

En géomatique, nous avons à faire à deux formats principaux : le format shapefile et le format GeoPackage. Il existe également un protocole de flux qui permet de travailler avec des données vecteur en ligne appelé Web Feature Services (WFS). Outre ces formats de stockage et d’échanges, il existe des formats vecteurs propres aux langages de programmation comme R ou Python. En R, nous aurons affaire, par exemple, au format sf de la librairie du même nom et au format SpatVector de la librairie terra. En Python, nous aurons plutôt affaire au format geopandas.


Le shapefile

Le format shapefile, d’extension .shp, est un format élaboré par la société ESRI, la société qui développe le logiciel ArcGIS [https://www.arcgis.com/index.html]. Bien qu’il ait été développé par une société commerciale, c’est un format ouvert. C’est le format vecteur le plus répandu, car utilisé depuis longtemps par énormément de monde. C’est un format déroutant de prime abord. En effet, un fichier .shp seul n’est pas utilisable. Une couche shapefile est en fait obligatoirement composée de plusieurs fichiers. Les fichiers associés ont les extensions suivantes :


	.shx : le fichier qui porte les informations relatives aux formes (obligatoire)


	.dbf : le fichier qui contient la table attributaire (obligatoire)


	.prj : le fichier qui contient le système de coordonnées (pas obligatoire mais très vivement recommandé)


	.sbn et .sbx : des fichiers d’index spatiaux (pas obligatoire mais souvent présent)




D’autres fichiers (jusqu’à 11 en tout) peuvent accompagner un fichier shapefile. Ainsi, lorsque nous souhaitons copier-coller un shapefile d’un répertoire à un autre, il faut copier-coller tous les fichiers constitutifs en même temps. Là où certains multiplient les pains, ESRI multiplie les fichiers. De même, pour envoyer un shapefile par mail par exemple, il ne suffit pas d’envoyer le fichier .shp mais tous les fichiers. Il peut être plus facile de créer une archive (un zip) contenant tous les fichiers et d’envoyer le zip.


Avertissement

Les données attributaires d’un shapefile sont stockées dans un fichier .dbf (dBase database File). Ce format date une peu et présente une limitation génante en SIG : les noms des champs sont limités à 10 caractères. Ainsi si vous souhaitez nommer un champ population_20008, ce champ sera renommé automatiquement en population, ce qui peut être source d’embarras par la suite. Il faut donc abréger les noms des champs.





Le GeoPackage

Le format GeoPackage est un format ouvert, développé depuis 2014. Un GeoPackage peut être vu comme une base de données qui peut contenir plusieurs tables. Chaque table sera une couche vecteur indépendante. Ainsi, un seul fichier .gpkg correspondra à une ou plusieurs couches et sera manipulable plus facilement qu’une cohorte de fichiers shapefile. Depuis la version 3 de QGIS, c’est le format employé par défaut.

Nous pouvons par exemple imaginer un fichier regions.gpkg qui contiendrait simplement la couche des régions de France. Mais nous pouvons également avoir un fichier limites_administratives.gpkg qui contiendra une couche des communes, une des départements, une couche des régions, … Notons qu’il n’y a pas de restrictions pour les noms des champs dans ce format, ils peuvent être aussi longs que souhaités. Il peut s’avérer pratique de regrouper plusieurs couches dans un même GeoPackage. Nous pouvons même inclure des couches rasters dans un fichier GeoPackage mais cela est peu utilisé.


Avertissement

Il est tout à fait possible de mettre des espaces et des caractères spéciaux dans les attributs d’une couche vecteur, mais il est fortement recommandé de ne pas en mettre dans les noms de fichiers et les noms de champs. La présence de caractères spéciaux dans les chemins des fichiers et les noms de champs peuvent être sources d’erreur lors de traitements.



Entre le format shapefile et le format GeoPackage, c’est à l’utilisateur de faire son choix selon son expérience. Personnellement je suis passé au format GeoPackage.


Avertissement

Le GeoPackage souffre encore d’une certaine instabilité dans certains cas. Notamment, il y a un attribut obligatoire nommé fid qui correspond à un identifiant unique à chaque entité. Ce champ est géré par les logiciels sans intervention de l’utilisateur. Mais il se trouve qu’après certaines manipulations, comme des intersections ou des regroupements dans QGIS, ce champ ne soit plus unique, ce qui génère une erreur au moment de vouloir enregistrer son fichier. Le plus simple dans ce cas est de supprimer le champ fid et de laisser QGIS en reconstruire un automatiquement.





Flux WFS

WFS est l’acronyme de Web Feature Service. Il s’agit d’un protocole Web qui permet d’afficher et d’interroger à distance des fichiers vecteurs. Concrètement, le fichier source est stocké sur un serveur quelque part dans le monde, et grâce au protocole WFS il est possible d’afficher et d’interroger cette couche comme si elle était stockée comme un fichier classique, mais sans avoir besoin de la télécharger. C’est tout à fait intéressant dans le cas de gros fichiers vecteurs ou de couches officielles maintenues par des organismes nationaux ou autres afin de toujours travailler sur la dernière version. Le flux WFS est accessible de plusieurs façons, notamment via QGIS (Importer un flux WFS dans QGIS), R ou Python.



Les formats R

Comme dit en introduction de cette partie, le format vecteur le plus utilisé aujourd’hui en R est le format sf, proposé par la librairie du même nom. Il est possible de faire tous les traitements types d’un SIG en utilisant ce format, ce qui s’avère pratique et puissant. De façon plus marginale, il existe le format SpatVector utilisé par la librairie terra. Ce format est surtout utile lorsque nous souhaitons faire des traitements qui croisent des rasters terra avec des données vecteurs, comme dans le cas d’application de masques ou de calcul de statistiques zonales.


Format sf

La librairie sf permet la manipulation de données vecteurs sous R. Une documentation détaillée de ce package est disponible sur la page web dédiée à sf [https://r-spatial.github.io/sf/]. Ce package s’installe simplement via l’interface graphique de RStudio ou via la ligne de commande suivante :

install.packages("sf")





En utilisant cette librairie, nous obtenons des objets vecteurs au format sf (simple feature). Nous verrons dans la suite de cette documentation que nous pouvons faire toutes les manipulations typiques d’un SIG en utilisant ce format. Dans la logique R, un objet sf n’est rien d’autre qu’un dataframe avec une composante géographique.



Format SpatVector de terra

Le format SpatVector s’obtient lorsque nous importons (ou convertissons) un vecteur avec le package terra. L’intérêt de ce format est son interopérabilité avec les objets SpatRaster gérés par Terra. Il peut être nécessaire de convertir un objet sf en un objet SpatVector pour faire des traitements avec terra. Cette conversion se fait simplement à l’aide de la fonction vect de la librairie Terra.

library(sf)
library(terra)
# import d'une couche vecteur au format sf
communes_sf <- sf::st_read('communes.gpkg')

# conversion de ce sf en SpatVector
communes_spatvector <- terra::vect(communes_sf)





Ici, par exemple, nous convertissons le vecteur au format sf nommé communes_sf en un vecteur au format SpatVector nommé communes_spatvector. Il est tout à fait possible de faire l’inverse, à savoir convertir un SpatVector au format sf, comme indiqué ci-dessous.

library(sf)
library(terra)
# import d'une couche vecteur au format SpatVector
communes_spatvector <- terra::vect('communes.gpkg')

# conversion de ce SpatVector en sf
communes_sf <- sf::st_as_sf(communes_spatvector)





La conversion de sf en SpatVector et vice versa est très simple.





Travailler avec les GeoPackage dans QGIS

Version de QGIS : 3.16.1

Concrètement, lorsque nous travaillons avec des GeoPackage, dans QGIS ou ailleurs, il y a une petite gymnastique à appréhender. Cette gymnastique peut être un peu déroutante au début lorsque nous avons l’habitude de travailler avec le format shapefile.

Un fichier GeoPackage n’est pas une couche géographique. C’est une base de données (simple) qui contient une ou plusieurs tables qui, elles, sont des couches géographiques. Nous allons voir en pratique cet aspect créant un GeoPackage nommé hydro_seine.gpkg dans lequel nous stockerons trois tables, i.e. trois couches géographiques, différentes :


	le réseau hydrographique du bassin (hydro)


	les bassins-versants unitaires associés à chaque tronçon de rivière (hydro_bv)


	les limites externes du bassin de la Seine (limites_bv)




Nous chargeons dans QGIS ces trois couches. Une fois ces couches chargées, nous allons pouvoir les exporter vers un une base GeoPackage. Pour cela, nous faisons un clic droit dans le panneau des couches sur la couche hydro (ou une autre des trois, sans importance), et nous sélectionnons le menu Exporter > Sauvegarder les entités sous. La fenêtre suivante s’ouvre (Fig. 80).
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Fig. 80 Création d’un GeoPackage.



Dans le champ Format nous spécifions que nous voulons exporter notre donnée en format GeoPackage. Dans le champ Nom de fichier, nous indiquons le chemin et le nom du GeoPackage que nous souhaitons créer. Dans le champ Nom de la couche, nous indiquons sous quel nom la couche géographique sera enregistrée, dans notre cas hydro. Danns le champ SCR, nous précisons dans quel SCR nous allons enregistrer notre couche. Nous cliquons enfin sur OK.

La nouvelle couche apparaît automatiquement dans le panneau des couches de QGIS. Nous remarquons qu’elle apparaît sous le nom suivant hydro_seine hydro, ce qui signifie qu’il s’agît de la couche (aussi appelée la table) hydro du GeoPackage nommé hydro_seine. Notons que si nous allons voir les propriétés de la couche, dans l’onglet Information nous trouvons la fenêtre suivante (Fig. 81).
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Fig. 81 Propriétés d’une couche contenue dans un GeoPackage.



Dans le champ Nom, nous trouvons le nom du fichier GeoPackage. Dans le champ Chemin nous trouvons son chemin d’enregistrement sur le disque. Et dans le champ Source, nous trouvons le chemin du GeoPackage assortie du nom de la couche layername=hydro.

Nous avons maintenant un fichier GeoPackage contenant une couche géographique. Nous allons à présent y ajouter nos deux autres couches (les bassins unitaires et les limites). Il suffit de faire un clic droit sur la seconde couche des bassins unitaires, de sélectionner Exporter > Sauvegarder les entités sous… La fenêtre suivante surgit (Fig. 82).
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Fig. 82 Ajout d’une table (i.e. d’une couche) dans un GeoPackage existant.



Dans le champ Nom de fichier, nous pointons vers le GeoPackage existant dans lequel nous souhaitons ajouter une couche. Dans le champ Nom de la couche, nous spécifions le nom de la couche que nous ajoutons, ici hydro_bv. Puis OK.


Avertissement

Si jamais vous entrez un nom de couche déjà existant, une fenêtre vous demandant quoi faire surgira.
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Si il s’agit d’une inattention, nous cliquons sur Annuler et nous changeons le nom de la couche dans la fenêtre précédente. Sinon, nous pouvons Écraser le fichier ce qui écrasera complètement le GeoPackage ou Écraser la couche ce qui ne remplacera que la couche en question. Nous pouvons même Ajouter à la couche.



Nous pouvons maintenant répéter la manipulation pour la troisième et dernière couche, celle des limites. Nous avons maintenant un GeoPackage contenant trois couches. Lorsque nous ouvrons ce GeoPackage dans QGIS, par un glisser déposer par exemple, une fenêtre nous demandant quelle couche choisir apparaît (Fig. 83).
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Fig. 83 Choix de la couche à ouvrir.



Il est alors possible de tout sélectionner ou seulement un ou plusieurs couches. Si nous cliquons sur Ajouter des couches à un groupe. Les couches sont regroupées dans un groupe d’affichage dans le panneau des couches.


Note

Il est tout à fait possible d’avoir des couches dans des SCR différents au sein d’un même GeoPackage. Il est également possible de stocker des couches rasters.



Il est également possible d’enregistrer le style d’une couche au sein d’un GeoPackage (Fig. 84). Il suffit de faire un clic droit sur la couche dont nous souhaitons conserver le style, de sélectionner le menu Propriétés et d’aller dans l’onglet Symbologie.
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Fig. 84 Enregistrement d’un style dans un fichier GeoPackage.



Dans le menu Style, nous sélectionnons Enregistrer par défaut. Et dans la fenêtre suivante, nous choisissons Base de données source. Maintenant, lorsque nous ouvrons cette couche dans QGIS, son style personnalisé est automatiquement appliqué.



Modifier les GeoPackage dans QGIS

Version de QGIS : 3.16.1

Il est tout à fait possible de renommer ou de supprimer une couche au sein d’un fichier GeoPackage. Il faut néanmoins passer par un chemin qui ne se devine pas forcément de prime abord. Dans l’interface prncipal de QGIS, il faut aller dans le menu Base de données et sélectionner Gestionnaire BD… (Fig. 85).
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Fig. 85 Ouverture du gestionnaire de base de données.



Le gestionnaire de base de données intégrés à QGIS s’ouvre. C’est à partir de ce gestionnaire que nous pourrons explorer et modifier la structure de nos GeoPackage (Fig. 86).
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Fig. 86 Le gestionnaire de base de données de QGIS.



En premier lieu, il est nécessaire de connecter notre base de données GeoPackage. Pour cela, nous faisons un clic droit sur le menu GeoPackage et nous sélectionnons Nouvelle connexion… Nous pointons alors vers le GeoPackage que nous souhaitons gérer, ici hydro_seine.gpkg. Ce GeoPackage apparaît maintenant dans la liste des GeoPackages connectés (Fig. 87).


[image: alternate text]

Fig. 87 Liste des GeoPackages connectés.



Nous pouvons « dérouler » notre GeoPackage afin de voir les couches (les tables) qu’il contient (Fig. 88).


[image: alternate text]

Fig. 88 Liste des tables d’un GeoPackage.



Nous retrouvons bien nos trois tables, plus éventuellement une table de style si nous avons sauvé un style par défaut. Dans le panneau principal de ce gestionnaire de bases de données, nous trouvons trois onglets Info, Table et Aperçu, dont les noms résument bien ce qu’on y trouve (Fig. 89).
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Fig. 89 La table associée à une couche d’un GeoPackage.



Nous y retrouvons la table attributaire de la couche plus une colonne de géométrie geom. C’est normal, dans l’esprit Base de données, la géométrie est un attribut comme un autre.

En faisant un clic droit sur une couche dans ce gestionnaire, il est possible de Renommer ou Effacer la couche. Une fois l’intervention effectuée il peut être nécessaire de rafraîchir les connexions avec l’outil Actualiser [image: icone-actualiser] pour voir les changements apparaître.


Note

Si par ailleurs la couche est également chargée dans QGIS, ces modifications ne sont pas visibles immédiatement. Il peut être nécessaire de fermer puis de rouvrir le GeoPackage modifié pour voir les modifications.



Dans ce gestionnaire de base de données, il est également possible de construire ses requêtes SQL, mais c’est un autre chapitre.




Importer des données rasters

Pour rappel, les rasters sont des données matricielles géoréférencées. Il s’agît d’une image composée de pixels disposés en lignes et colonnes. Chaque pixel présente une valeur numérique unique dont le sens dépend de la nature du raster. Chaque pixel dispose également d’un couple de coordonnées géographiques X et Y.

Importer des données rasters dans un logiciel ou un script est une tâche fondamentale. L’importation est plus ou moins naturelle selon les outils. Nous allons voir ici comment importer de telles données rasters dans différents logiciels.


Importer un raster dans QGIS

Version de QGIS : 3.24.3

Il existe deux façons d’importer un raster dans QGIS. La plus simple est de faire un simple glisser-déposer depuis l’explorateur de fichier vers le panneau d’affichage de QGIS. La seconde est de passer par le menu Couche > Ajouter une couche > Ajouter une couche raster…

Dans cet exemple nous allons importer un raster de modèle numérique de terrain (MNT) issu de la mission SRTM et localisé sur une portion des Alpes françaises. Une fois le raster chargé, il apparaît dans le panneau d’affichage de QGIS (Fig. 90).
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Fig. 90 Chargement d’un raster dans QGIS.



Nous remarquons que le nom du raster apparaît dans le panneau des couches sur la gauche. Si plusieurs couches sont chargées, seule la couche au dessus de la pile est visible.


Avertissement

Les valeurs qui apparaissent sous le nom du raster dans le panneau des couches correspondent simplement aux valeurs associées à la symbologie employée. Il ne s’agît nullement des valeurs minimales et maximales du raster.



Il est ensuite possible de déplacer le raster ou de zoomer et dézoomer via la barre d’outils Navigation cartographique [image: icone-zoom-dezoom]. La dernière icône Zoom sur l’emprise totale permet de zoomer sur l’ensemble des couches chargées. Cette fonctionnalité s’avère lorsque nous sommes perdus dans l’affichage. Notons que nous pouvons également zoomer simplement sur l’étendue d’une couche donnée en faisant un clic droit sur son nom dans le menu des couches et en sélectionnant Zoomer sur la couche.


Améliorer les contrastes d’un raster

Dans QGIS, il existe un outil pratique pour améliorer les contrastes d’un raster. La barre d’outils correspondante n’est pas visible par défaut. Pour l’afficher dans l’interface, il suffit d’aller dans le menu Préférences > Barres d’outils et de cocher la case Raster. Une fois la barre d’outils activée, elle apparaît avec les autres barres d’outils en haut de l’interface [image: icone-raster-contraste].

Finalement, seule la première icône de cette barre d’outils est la plus utile, celle intitulée Histogramme cumulatif de l’emprise locale utilisant l’emprise actuelle. Cette fonction est très intense lorsque nous zoomons sur une zone du raster et que nous souhaitons optimiser les contrastes sur cette zone (Fig. 91).
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Fig. 91 A : zoom sans optimisation des contrastes ; B: même zoom mais avec optimisation des contrastes via l’outil de la barre d’outils raster.





Interroger les valeurs des pixels d’un raster

Il est possible d’accéder aux valeurs des pixels d’un raster chargé. Cela se fait facilement à l’aide de l’outil Identifier des entités [image: icone-identifier].

Une fois l’outil sélectionné, le curseur de la souris est assorti d’un i et nous pouvons cliquer sur un pixel donné. Lors du clic, la valeur du pixel sous-jacent s’affiche dans le panneau Résultats de l’indentification à droite. Nous disposons même, dans le menu (Dérivé) des coordonnées du clic (Fig. 92).
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Fig. 92 Interrogation d’un pixel.




Astuce

Il est possible de copier la valeur dans le presse papier simplement en faisant un clic droit sur cette valeur dans ce panneau de résultats.





Exploration des propriétés d’un raster

Il est souvent utile de recueillir quelques données relatives à la couche proprement dite. Pour cela, il suffit de faire un clic droit sur la couche dans le panneau des couches et de sélectionner Propriétés. La fenêtre de propriétés apparaît alors (Fig. 93).
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Fig. 93 Propriétés d’une couche raster.



Un onglet intéressant est celui nommé Information. Nous y trouvons les informations suivantes :


	Nom : simplement le nom de la couche


	Chemin : le chemin du raster sur le disque dur


	SCR : le système de projection du raster. Nous y retrouvons le code EPSG et l’intitulé exact de la projection


	Emprise : l’emprise de la couche exprimée dans les unités de la projection, exprimée en Xmin,Ymin : Xmax,Ymax


	Unité : l’unité de la projection, souvent mètres ou degrés


	Largeur : la largeur du raster exprimée en nombre de pixels


	Hauteur : la hauteur du raster exprimée en nombre de pixels


	Type de données : façon dont le raster est encodé. Ici, il s’agît d’un nombre entier signé de seize bits


	Bande 1 : quelques statistiques descriptives du raster comme le maximum, la moyenne et le minimum


	Dimensions : la dimension en X (sur l’axe horizontal) en nombre de pixels, la dimension en Y (sur l’axe vertical) en nombre de pixels et la dimension en terme de nombre de bandes. Les dimensions en X et Y sont les mêmes que la largeur et la hauteur fournies plus haut


	Origine : les coordonnées du pixel d’origine exprimées dans le SCR du raster. Il s’agit du pixel se trouvant dans le coin supérieur gauche du raster.


	Taille du pixel : la taille du pixel exprimée dans les mêmes unités que le système de projection. Par convention, la seconde dimension est toujours négative.





Astuce

Une autre information intéressante se trouve plus bas dans ce même onglet d’Information. Dans la section Bandes nous trouvons la valeur numérique utilisée comme no data.



L’autre onglet intéressant à ce niveau est l’onglet Histogramme. Nous y trouvons l’histogramme des valeurs des pixels du raster considéré (Fig. 94).
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Fig. 94 Histogramme du raster.




Note

La qualité graphique de l’histogramme ainsi que sa lisibilité ne sont pas merveilleuses.






Importer un raster dans R

Version de R : 4.1.1

Dans tout ce qui suit pour cette partie R, nous travaillerons avec le package terra.


Avec terra

La première chose à faire est d’appeler le package terra, ce qui se fait de façon classique.

library(terra)





Une fois le package chargé, nous pouvons charger un raster stocké en local, au format GeoTIFF ou autre. Ici, nous importerons une bande spectrale Landsat 8 nommée LC08_L2SP_196030_20190613_20200828_02_T1_SR_B4.TIF. La fonction d’import du package se nomme rast.

b4 <- terra::rast("Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B4.TIF")





En tapant simplement le nom de la variable dans la console R, nous pouvons afficher les propriétés du raster, à savoir :


	class : ici logiquement un SpatRaster


	dimensions : les dimensions en termes de lignes, de colonnes et de bandes


	resolution : la résolution du raster exprimée dans les unités du SCR


	extent : l’étendue du raster selon le shcéma (xmin, xmax, ymin, ymax)


	coord. ref. : le SCR du raster




Il est possible de récupérer ces propriétés individuellement et de les stocker dans des variables.

# récupération du SCR d'un raster dans une variable
b4_crs <- crs(b4)
# récupération de la résolution
b4_res <- res(b4)
# l'étendue du raster (coordonnées min en max)
b4_ext <- terra::ext(b4)
# et pour accéder au x min par exemple
x_min <- b4_ext[1]





IL est tout à fait possible d’importer des rasters multi-bandes avec terra.

# import d'un raster multi-bandes
multi_bandes <- terra::rast("Landsat_13/stack_L8_2-5.tif")





Si nous affichons les propriétés de ce raster, dans ses dimensions, nous trouverons bien 4 pour le nombre de bandes. Nous pouvons accéder à une bande spécifique via son indice.

# accès à la bande 2 du raster multi bandes et stockage dans une variable
bande_2 <- multi_bandes[[2]]





Nous pouvons également nommer les bandes avec un nom plus explicite, et ensuite interroger les bandes via le nom donné.

# nous nommons les bandes selon leur domaine spectral
names(multi_bandes[[1]]) <- 'Bleu'
names(multi_bandes[[2]]) <- 'Vert'
names(multi_bandes[[3]]) <- 'Rouge'
names(multi_bandes[[4]]) <- 'PIR'
# accès la bande du 'PIR'
pir <-  multi_bandes['PIR']







Affichage de rasters dans R

Nous supposons ici que nous souhaitons afficher des rasters de type SpatRaster, importés dans R à l’aide de terra.

Comme pour un graphique, il est possible d’afficher une vue du raster avec R. Il suffit d’employer la commande plot(mon_raster). Par exemple pour afficher un raster qui serait stocké dans une variable nommé b4, il suffit d’entrer la ligne suivante.

# affichage d'un raster mono-bande
plot(b4, col=gray.colors(100, start = 0.1, end = 0.9))





La partie col=gray.colors(100, start = 0.1, end = 0.9) est facultative mais permet d’améliorer les contrastes (Fig. 97).
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Fig. 95 Affichage d’un raster mono-bande (SpatRaster) dans R.



Dans le cas de rasters multi-bandes, un simple plot affichera toutes les bandes sous forme de facettes.

# affichage d'un raster multi-bandes en facettes
plot(multi_bandes, col=gray.colors(100, start = 0.1, end = 0.9))





Notons bien que le numéro des bandes qui apparaît dans les titres des vignettes correspond simplement au numéro des sous bandes du raster et non pas aux bandes spectrales Landsat.
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Fig. 96 Affichage d’un raster multi-bandes (SpatRaster) en facettes.



Si nous souhaitons affiche seulement une bande particulière d’un raster multi-bandes, il suffit de préciser son numéro avec des doubles crochets.

# affichage d'une bande spécifique d'un raster multi-bandes
plot(multi_bandes[[4]], col=gray.colors(100, start = 0.1, end = 0.9))





Ici nous affichons la 4ème bande du raster multi-bandes.



Nom des rasters dans R

Une fois un raster chargé dans R avec le package terra, ce raster porte un nom propre indépendant du nom de la variable qui le stocke. Par exemple, sur la figure (Fig. 95) nous avons tracé le raster stocké dans la variable b4 mais ce raster en lui-même se nomme LC08_L2SP_196030_20190613_20200828_02_T1_SR_B4, comme nous le constatons sur le titre de la figure. Il est tout à fait possible de renommer ce raster. Par exemple si nous souhaitons simplement le nommer bande4, nous utiliserons la méthode names() du package terra. La commande pour le renommer est alors très simple.

names(b4) <- 'bande4'





Nous indiquons simplement à names la variable qui contient le raster à renommer et nous lui attribuons un nouveau nom.




Importer un raster dans Python

Version de Python : 3.8.10

Il est tout à fait possible d’importer des rasters dans un script Python. Il existe différentes librairies permettant de le faire. Nous allons ici nous focaliser sur la librairie rasterio. Il est tout d’abord nécessaire d’installer cette librairie. Ensuite, elle s’utilise de façon très simple. Elle s’importe dans le script via le mot clé import. L’idée est de commencer par importer un fichier raster puis ensuite d’accéder à une bande se trouvant dans ce fichier. La bande ainsi récupérée sera stockée sous forme d’un objet array (Numpy), c’est-à-dire un tableau de chiffres. La commande ci-dessous montre la procédure dans le cas d’un raster mono bande.

# chargement de la librairie de gestion des rasters rasterio
import rasterio

# le chemin vers le raster mono-bande à charger et chargement
rast = rasterio.open('./Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF')
# on récupère ensuite la bande qui nous intéresse (ici qu'une bande)
band = rast.read(1)





Ici nous avons importé un raster mono-bande que nous avons stocké dans une variable nommée rast. Puis nous avons chargé la première (et unique) bande de ce raster dans une variable nommée band.

Il est également possible d’importer un raster multi-bandes, la procédure est tout à fait identique.

# chargement de la librairie de gestion des rasters rasterio
import rasterio

# le chemin vers le raster multi-bandes à charger
rast_multi = rasterio.open('./Landsat_13/stack_L8_2-5.tif')
# on récupère ensuite la bande qui nous intéresse, la 2ème par exemple
band_2 = rast_multi.read(2)





Nous avons ici importé un raster multi-bandes, stocké dans une variable rast_multi puis nous avons chargé la deuxième bande de ce raster dans la variable band_2.

Une fois ces rasters importés, il est possible d’accéder à différentes caractéristiques associées comme les dimensions, le SCR ou les coordonnées de l’emprise.

# afficher le SCR d'un raster
rast.crs
# la largeur du raster
rast.width
# la hauteur du raster
rast.height
# les coordonnées de l'emprise
rast.bounds





Pour accéder à la résolution spatiale du raster, i.e. la taille des pixels, il y a une petite manipulation à connaître. La taille d’un pixel est indiquée dans les paramètres de transformation du raster. Ces paramètres sont une sorte de tableau et la résolution en X est la 1ère entrée du tableau et la résolution en Y est la 4ème entrée. Il est important de noter que la résolution en Y est donnée par convention en négatif, il faut donc la multiplier par -1.

# récupération des paramètres de transformation
gt = rast.transform

# dimension en X (1er paramètre des transformations)
dimX = gt[0]
# dimension en Y (4ème paramètre des transformations)
dimY = -gt[4]





Lorsque nous disposons d’un raster multi-bandes, il est possible de récupérer le nombre de bandes et d’accéder à une bande en particulier.

# le chemin vers le raster multi-bandes à charger
rast_multi = rasterio.open('./Landsat_13/stack_L8_2-5.tif')

# affichage du nombre de bandes
rast_multi.count

# accès à une bande spécifique d'un raster multi-bandes, la 4 par exemple
b4 = rast_multi.read(4)






Affichage de rasters dans Python

Une fois un raster chargé, il est possible de l’afficher. Cette affichage passe par le package Python matplotlib très couramment utilisé dans tout ce qui touche à la visualisation. Il est ensuite possible de régler quelques paramètres d’affichage comme le contraste, le titre, la taille, …

#import de matplotlib
from matplotlib import pyplot

# le chemin vers le raster multi-bandes à charger
rast_multi = rasterio.open('./Landsat_13/stack_L8_2-5.tif')

# définition d'un objet figure qui ne contiendra qu'une figure "ax" dont les dimensions seront de 8 par 8
fig, ax = pyplot.subplots(1, figsize=(8, 8))
# on affiche la bande 4 du raster multi-bandes
# selon une palette de gris "gray"
# à l'emplacement de la figure "ax"
# avec un titre personnalisé "title"
# et en améliorant les contrastes avec vmin et vmax, le noir est attribué à 0 et le blanc à 0.5
show((rast_multi, 4), cmap='gray', ax=ax, title='Bande 4 Landsat 8', vmin=0, vmax=0.5)





Nous obtenons la vue suivante (Fig. 97). Nous constatons que les axes correspondent bien au référentiel géographique du raster affiché. Il est possible de modifier le contraste en jouant sur les paramètres vmin et vmax.
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Fig. 97 Affichage d’un raster dans Python en teintes de gris contrasté.



Il est également possible d’afficher plusieurs bandes côte à côte avec des teintes de couleurs différentes. Ici, par exemple, nous affichons les bandes des domaines du Bleu, Vert et Proche Infrarouge dans des dégradés de bleu, vert et rouge.

#import de matplotlib
from matplotlib import pyplot

# le chemin vers le raster multi-bandes à charger
rast_multi = rasterio.open('./Landsat_13/stack_L8_2-5.tif')

# définition d'un objet figure qui contiendra 3 graphiques ax1, ax2 et ax3
# paramétrage de la taille avec figsize
fig, (ax1, ax2, ax3) = pyplot.subplots(1,3, figsize=(21,7))
# on trace la bande Bleu en dégradé de bleu, avec un titre et amélioration des contrastes
show((rast_multi, 1), ax=ax1, cmap='Blues', title='Bande Bleu', vmin=0, vmax=0.1)
# on trace la bande Verte en dégradé de vert, avec un titre et amélioration des contrastes
show((rast_multi, 2), ax=ax2, cmap='Greens', title='Bande Verte', vmin=0, vmax=0.15)
# on trace la bande PIR en dégradé de rouge, avec un titre et amélioration des contrastes
show((rast_multi, 1), ax=ax3, cmap='Reds', title='Bande PIR', vmin=0, vmax=0.15)





Nous obtenons la figure suivante (Fig. 98).
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Fig. 98 Affichage de trois bandes en différents dégradés.






Importer un COG dans QGIS

Version de QGIS : 3.22.1

Il est possible d’importer facilement dans QGIS un raster au format COG (Cloud Optimized GeoTIFF). Ce format permet d’interroger un GeoTIFF stocké à distance sur un serveur (Le format Cloud Optimized GeoTIFF). La difficulté est de trouver / construire le lien du raster à charger. Il existe de nombreux tutoriels expliquant la démarche. Quoi qu’il en soit, un raster COG se présente sous la forme d’une URL HTTP, qu’il est possible de charger dans QGIS. Par exemple, sur le serveur Element 84 [https://www.element84.com/blog/sentinel-2-cloud-optimized-geotiffs-now-available-on-aws-registry-of-open-data], qui stocke toutes les images Sentinel-2, nous y trouvons la scène T31UFP du 16 août 2018 centrée sur la Champagne, sous l’URL suivant :

https://sentinel-cogs.s3.us-west-2.amazonaws.com/sentinel-s2-l2a-cogs/31/U/FP/2018/8/S2A_31UFP_20180816_0_L2A/

Si nous voulons accéder à la bende 8, correspondant au domaine du proche infrarouge, il faut lui ajouter B08.tif à la fin. L’URL complet devient ainsi :

https://sentinel-cogs.s3.us-west-2.amazonaws.com/sentinel-s2-l2a-cogs/31/U/FP/2018/8/S2A_31UFP_20180816_0_L2A/B08.tif

Il suffit de copier l’URL puis, dans QGIS, d’aller dans Couche ‣ Ajouter une couche ‣ Ajouter une couche raster… La fenêtre suivante apparaît (Fig. 99).
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Fig. 99 Ajouter un raster COG dans QGIS.



Dans Type de source, nous sélectionnons Protocole: HTTP(S), puis dans Type nous sélectionnons HTTP/HTTPS/FTP et enfin à la ligne URI nous collons l’URL. Nous cliquons ensuite sur Ajouter et la bande 8 de la scène choisie apparaît dans QGIS. Il est maintenant possible de la traiter comme un raster normal. Nous procédons de même avec les autres bandes si désiré, en terminant l’URL par B02.tif si nous souhaitons charger la bande du domaine du Bleu.

Les images Landsat au format COG sont librement accessibles pour l’Afrique via le serveur de Digital Earth Africa [https://docs.digitalearthafrica.org/en/latest/data_specs/index.html]. Ainsi, la bande 5 de la scène Landsat 8 du 16 août 2020 prise au niveau des agglomérations de Brazzaville et Kinshasa peut être chargée via l’URL suivante :

https://deafrica-landsat.s3.af-south-1.amazonaws.com/collection02/level-2/standard/oli-tirs/2020/182/063/LC08_L2SP_182063_20200816_20200920_02_T1/LC08_L2SP_182063_20200816_20200920_02_T1_SR_B5.TIF

En suivant la même démarche que précédemment, cette bande Landsat apparaît bien dans QGIS (Fig. 100).
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Fig. 100 Une bande spectrale Landsat chargée en COG dans QGIS.




Note

Bien sûr, avec les COG, la difficulté est de trouver / construire les URL de chaque raster. Il faut fouiller sur le web et regarder les différents tutoriels. Mais généralement, il est plus intéressant d’explorer les serveurs hébergeant les COG via un code écrit en R ou Python qui pourra requêter automatiquement le serveur.





Importer un COG dans R

Version de R : 4.3.1

Version de Terra : 1.7.29

Il est possible et très simple de charger un raster au format COG dans R via la librairie terra. Il suffit d’ajouter /vsicurl/ au début de l’URL, juste avant le http. Ainsi, si nous reprenons l’exemple utilisé dans la partie précédente (Importer un COG dans QGIS), pour charger une bande Sentinel-2 dont nous connaissons l’URL, le script R sera le suivant.

library(terra)
s2_b8 <- terra::rast('/vsicurl/https://sentinel-cogs.s3.us-west-2.amazonaws.com/sentinel-s2-l2a-cogs/31/U/FP/2018/8/S2A_31UFP_20180816_0_L2A/B08.tif')





Le raster COG est ainsi chargé en spatRaster qu’il est possible de manipuler comme n’importe quel raster dans R.



Importer un flux WMS dans QGIS

Version de QGIS : 3.22.1

Il est facile d’importer un flux WMS dans QGIS. Par exemple, nous allons ajouter les données topo-bathymétriques globales fournies par le GEBCO (General Bathymetric Chart of the Oceans). Ces données sont accessibles via ce lien : https://www.gebco.net/data_and_products/gebco_web_services/web_map_service/mapserv Il suffit de copier ce lien puis d’aller dans le panneau Explorateur, puis de faire un clic droit sur la ligne WMS/WMTS et de choisir Nouvelle connexion…. La fenêtre suivante apparaît (Fig. 101).
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Fig. 101 Ajouter un flux WMS dans QGIS.



À la ligne Nom nous renseignons librement le nom de la connexion, ici GEBCO, puis à la ligne URL nous collons le lien copié précédemment. Il n’y a plus qu’à cliquer sur OK. Une nouvelle entrée nommée GEBCO apparaît alors sous l’onglet WMS/WMTS proposant différents produits topo-bathymétriques à l’échelle globale.


Astuce

Dans le fichier XML WMS_IGN_Geoportail.xml disponible ici WMS_IGN_Geoportail (faire un clic droit et Enregistrer le lien sous…) vous trouverez réunis des liens pour ajouter les flux WMS de l’IGN et du Géoporatil dans QGIS. Il suffit de télécharger le fichier, puis d’aller dans le panneau Explorateur ‣ Clic droit sur WMS/WMTS ‣ Charger des connexions… puis de pointer vers le fichier téléchargé. Une nouvelle entrée apparaît avec les différentes données WMS de l’IGN et du géoporatil. Vous y trouverez notamment les flux des orthophotographies couleurs et IRC et leurs déclinaisons historiques.






Importer des données vecteurs

Pour rappel, les données vecteur (ou vectorielles) sont les données de base en SIG. Ce sont des formes géométriques de type ponctuelle, linéaire ou surfacique auxquelles sont associées des données attributaires. Charger ce type de données dans un logiciel ou un script est une brique fondamentale de la géomatique. Nous allons voir ici comment importer de telles données vecteurs dans différents logiciels.


Importer une couche vecteur dans QGIS

Version de QGIS : 3.16.1

Comme pour l’import de données raster, il existe deux façons d’importer des données vectorielles dans QGIS. La plus simple est de faire un glisser déposer de son fichier depuis l’explorateur de fichiers vers le panneau central de QGIS.

La seconde façon est de passer par le menu Couche ‣ Ajouter une couche ‣ Ajouter une couche vecteur….


Note

Depuis quelques années, le format vecteur utilisé par défaut dans QGIS est le format geopackage, dont l’extension est .gpkg. Il a pour vocation de concurrence le format shapefile.



Dans cet exemple, nous allons importer la couche des États du monde (ne_10m_admin_0_countries) disponible sur le site Natural Earth [https://www.naturalearthdata.com/http//www.naturalearthdata.com/download/110m/cultural/ne_110m_admin_0_countries.zip]. Cette couche contient les polygones de tous les pays du monde. Chaque polygone représente un pays, et à chacun de ces polygones différentes données attributaires sont associées comme le nom, la population, le PNB … (Fig. 102).


[image: alternate text]

Fig. 102 Le vecteur des pays du monde chargé dans QGIS.




Polygones et données attributaires

Les polygones, ici les pays, sont les objets spatiaux. À chacun de ces objets spatiaux sont associées des données attributaires. Ces données sont stockées dans une table attributaire. Il s’agit d’un tableau de données structuré de façon rigoureuse. Il est possible d’accéder à cette table attributaire en faisant un clic droit sur le nom de la couche dans le panneau des couches et en sélectionnant Ouvrir la table d'attributs. La table s’ouvre alors dans une nouvelle fenêtre (Fig. 103).


[image: alternate text]

Fig. 103 La table attributaire associée à notre couche.



Comme tout tableau, nous y trouvons des lignes et des colonnes. Chaque ligne correspond à un enregistrement ou à un individu, dans notre cas chaque ligne correspond donc à un pays. Chaque colonne correspond à un attribut. Par exemple, l’attribut Name correspond au nom du pays en anglais, l’attribut Pop_est correspond à la population estimée etc… Nous remarquons qu’un champ peut, pour certains pays, être non renseigné. Sa valeur sera alors NULL.


Avertissement

De l’importance des métadonées : normalement, à chaque donnée diffusée devraient être associées des métadonnées, même succinctes. Une métadonnée est une information présentant la donnée diffusée. Ici, par exemple, sans métadonnées, impossible de bien saisir le sens de tous les attributs de cette couche. Malheureusement, cette métadonnée est très souvent absente…



Cette table attributaire est liée aux objets spatiaux que sont les polygones affichés dans QGIS. Ainsi si nous sélectionnons la première ligne (South Africa dans le cas de cet exemple), cette ligne se surligne en bleu. Si nous retournons dans le panneau d’affichage de QGIS, nous constatons que l’objet géographique correspondant à cette ligne est également sélectionnée. Le polygone de l’Afrique du Sud apparaît en jaune, ce qui signifie que nous avons bien sélectionné l’Afrique du Sud (Fig. 104).


[image: alternate text]

Fig. 104 Lien entre table d’attributs et objets spatiaux.



Notons que ce lien fonctionne bien sûr dans l’autre sens. Si nous sélectionnons un pays sur la couche via l’outil Sélectionner les entités avec un rectangle ou un simple clic [image: icone_selection-clic], la ligne correspondante dans la table sera également sélectionnée.


Astuce

Pour désélectionner des entités, soit nous cliquons sur « rien » soit nous cliquons sur l’icône Désélectionner toutes les entités [image: icone_deselect].





Interroger une couche vecteur

Il est possible d’interroger rapidement une couche vecteur dans QGIS. Il suffit de se servir de l’outil Identifier des entités en cliquant sur l’icône [image: icone-identifier]. En cliquant sur un objet géographique avec cet outil, il n’est pas sélectionné même s’il apparaît surligné en rouge. Les attributs associés à cette entité s’affichent dans le panneau Résultats de l'identification. Les attributs sont listés dans le même ordre que dans la table attributaire (Fig. 105).


[image: alternate text]

Fig. 105 Identification des attributs d’une entité.



Dans ce panneau, il est possible de copier dans le presse-papier une valeur d’attribut. Un simple clic droit sur la valeur à copier, suivi de la sélection du menu Copier la valeur d'attribut suffit. Nous pouvons également copier toutes les valeurs d’attributs en sélectionnant Copier les attributs des entités. Il est alors possible de coller ces valeurs sous forme de tableau dans un tableur. Il est même possible de copier l’entité avec sa géométrie en sélectionnant Copier l'entité. L’entité est ainsi exportée au format texte wkt (Well Known Text).

Nous pouvons également accéder à des propriétés intrinsèques de l’entité comme la superficie ou son périmètre en déroulant le menu Dérivé.



Explorer les propriétés d’une couche vecteur

Il est souvent utile d’explorer les propriétés d’une couche vecteur chargée dans QGIS. Il suffit de faire un clic droit sur le nom de la couche dans le panneau des couches et de sélectionner le menu Propriétés. La fenêtre des propriétés s’affiche (Fig. 106).


[image: alternate text]

Fig. 106 Propriétés d’une couche vecteur.



Dans l’onglet Information, nous trouvons les renseignements suivants :


	Nom : simplement le nom de la couche


	Chemin : le chemin de la couche sur le disque dur


	Stockage : le format dans lequel est enregistré la couche. Pour une couche vecteur ce sera la plupart du temps ESRI Shapefile ou Geopackage


	Encodage : l’encodage de la table attributaire. La plupart des données sont maintenant encodées en UTF-8 qui permet d’afficher tous les caractères, même les plus exotiques.


	Géométrie : le type de géométrie de la couche. Ici, nous avons Polygon (MultiPolygon). Ça signifie que nous avons des entités sous forme de polygones mais qui peuvent être composées de plusieurs polygones. Par exemple, la France continentale et la Corse sont représentées par deux polygones différents mais ils ne forment qu’une seule entité. Une seule ligne de la table attributaire est associée à cette entité multi polygones.


	SCR : le système de projection de la couche, ici c’est la projection globale WGS 84


	Emprise : les coordonnées extrêmes de la couche


	Unité : les unités du système de projection de la couche. Ici, il s’agît de degrés. D’autres projections utilisent le mètre.


	Décompte d’entités * : le nombre d’entités dans la couche, ici 177. Ce chiffre correspond également au nombre de lignes dans la table attributaire. Selon cette couche, il y a 177 pays.




À ce niveau, l’autre onglet intéressant est l’onglet Champs. Nous y trouvons la façon dont les différents champs sont sont formatés. Nous pouvons voir quels champs sont de type texte, entiers ou booléens… (Fig. 107).


[image: alternate text]

Fig. 107 Le format des champs de la table attributaire.



Ici, nous constatons que certains champs sont codés en Integer (entiers) et d’autres en String (pas le sous-vêtement mais le texte…).


Note

Le format des champs n’est pas toujours aussi évident qu’il n’en a l’air. Par exemple, nous pourrions penser qu’un champ stockant les numéros des départements français serait de type entier. Pourtant ce champ devrait être de type texte. En effet, les départements corses sont 2A et 2B. De plus les neuf premiers départements seraient identifiés en 1, 2, 3 … au lieu de 01, 02, 03, …






Importer une couche vecteur dans R

Comme vu dans la partie dédié aux formats de données (), il existe deux grandes librairies R pour manipuler les objets vecteurs : sf et terra. La première est plus ancienne et donc plus utilisée, notamment par celles et ceux qui ne travaillent qu’en vecteur. Mais la seconde a l’avantage d’être pratique lorsque nous souhaitons mélanger traitements vecteurs et rasters dans un même projet. C’est pour cette raison que nous commencerons à présenter l’import de données vecteurs avec la librairie terra.


Importer une couche vecteur avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

Nous allons charger une couche vecteur de France métropolitaine qui contient un attribut “POP_1999” qui contient le nombre d’habitants par département en 1999.

dep <- terra::vect('departements_france_L93.gpkg')





La couche vecteur est maintenant stockée en un objet SpatVector. Si jamais le fichier GeoPackage contient plusieurs couches, il est possible de charger la couche d’intérêt en ajoutant le mot clef layer= dans l’import. Par exemple, si notre fichier contient plusieurs couches dont une nommée pop_1999, nous la chargeons comme présenté ci après.

dep_1999 <- terra::vect('departements_france_L93.gpkg', layer='pop_1999')





Il est possible d’afficher cette couche avec des couleurs correspondant à la population de 1999.

terra::plot(dep, 'POP_1999')





Il est possible de connaître son système de coordonnées de référence via la fonction crs.

terra::crs(dep, describe=TRUE)





Et si nous souhaitons ne récupérer que le code EPSG du SCR, c’est également possible.

terra::crs(dep, describe=TRUE)['code']





Il est aussi facile d’obtenir l’étendue de la couche, c’est à dire les coordonnées X et Y minimums et maximums.

ext_dep <- terra::ext(dep)
# et si nous souhaitons accéder au x min
x_min <- ext_dep[1]







Importer une couche vecteur avec sf

Version de R : 4.3.1

Version de sf : 1.0-12

Dans l’exemple suivant, nous importerons une couche vecteur via la librairie sf. Nous prendrons l’exemple de l’import d’une couche vecteur au format geopackage contenant les départements de France métropolitaine, nommée departements_france_L93.gpkg. La commande d’import se nomme st_read(mon_vecteur). Ici, nous stockerons cette couche vecteur dans un objet sf nommé dep.

librairy(sf)
dep <- st_read("departements_france_L93.gpkg")





Il est ensuite possible de l’afficher sous forme d’un graphique à l’aide de la commande plot(mon_vecteur).

plot(dep)





Par défaut, pour les objets sf, autant de figures sont tracées qu’il n’y a de champs attributaires. Dans cet exemple, notre couche vecteur contient 6 champs attributaires, nous obtenons donc 6 figures (Fig. 108).


[image: alternate text]

Fig. 108 Affichage d’une couche vecteur avec R.




Note

Le package sf est capable d’importer de très nombreux formats vecteurs : gpkg, shp, geojson, …



Une fois une couche vecteur importée, il est possible d’afficher différentes informations de base relatives à la couche. Le plus simple est de simplement entrer le nom de la couche pour faire apparaître dans la sortie de la console de R différentes informations (Fig. 109).
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Fig. 109 Affichage d’informations de base d’une couche vecteur dans R.



Nous y trouvons le type de géométrie (Multipolygon ici), le CRS et un aperçu des 10 premières lignes de la table attributaire. Pour avoir des informations précises à propos du système de coordonnées de référence de la couche, la commande st_crs() est suffisante.

library(sf)
# chargement de la couche
dep <- st_read("departements_france_L93.gpkg")
# affichage des informations sur le SCR
st_crs(dep)





La commande prend simplement en argument le nom de la variable contenant la couche vecteur. Le code EPSG se trouve tout en bas de la sortie dans la console.




Importer une couche vecteur dans PostGIS

Nous allons voir ici comment importer une couche vecteur dans une base de données PostGreSQL/PoqtGIS.


En utilisant QGIS

Version de QGIS : 3.20.0

L’ajout de données dans une base PostGIS peut se faire via QGIS. Dans QGIS, dans le panneau Explorateur, nous faisons un clic droit sur la ligne PostGIS et nous sélectionnons Nouvelle connexion. La fenêtre de configuration de la connexion s’affiche. Dans le champ Nom, nous nommons la connexion. Ce nom est libre, nous mettons par exemple geodata_my_user. Dans le champ Hôte, nous mettons localhost pour spécifier que notre base est en local et non sur un serveur distant. Dans Base de données nous entrons le nom de la base à laquelle nous souhaitons nous connecter, à savoir geodata. Dans le panneau Authentification, nous devons entrer les identifiants de l’utilisateur de la base, à savoir my_user et son mot de passe tel que défini dans DBeaver au moment de la création de cet utilisateur. Il est possible de se souvenir de ces identifiants en cliquant sur Stocker. Ensuite nous cliquons sur OK (Fig. 110).


[image: alternate text]

Fig. 110 Connexion à notre base dans QGIS.



Une fois la connexion réalisée, elle apparaît dans le menu PostGIS du panneau Explorateur. La base apparaît sous le nom défini lors de la connexion geodata_my_user. Cette base contient un schéma public (schéma de base créé automatiquement) qui est vide (Fig. 111).
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Fig. 111 La base connectée à QGIS disposant d’un seul schéma encore vide.



Il s’agît maintenant de charger une couche dans cette base. Nous allons d’abord crer un nouveau schéma afin de ne pas travailler dans le schéma public (pour ranger un peu nos données). Ici, nous allons charger la couche des limites des terres émergées telles que fournies par le site Natural Earth (Land [https://www.naturalearthdata.com/downloads/110m-physical-vectors/]). Nous allons donc créer un schéma nommé natural_earth. Pour cela, nous faisons un clic droit sur notre base dans le panneau Explorateur et nous choisissons Nouveau schéma... Dans la fenêtre suivante, nous nommons notre schéma natural_earth. Ce nouveau schéma apparaît bien à côté du schéma public.

Pour y ajouter la couche souhaitée, nous allons dans le menu Base de données ‣ DB Manager… Dans la fenêtre qui s’ouvre, nous déplions le menu PostGIS et la base geodata_my_user puis nous sélectionnons le schéma dans lequel nous souhaitons ajouter une couche natural_earth (Fig. 112).


[image: alternate text]

Fig. 112 Ajout d’une couche à un schéma donné.



Nous cliquons ensuite sur Import de couche/fichier en haut de la fenêtre. La fenêtre d’import s’ouvre (Fig. 113).
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Fig. 113 Sélection de la couche à importer.



Dans le champ Source nous pointons vers la couche à importer qui peut être de n’importe quel format. Dans les champs Schéma et Table, nous vérifions le schéma d’import et nous spécifions un nom pour la table correspondante à cette couche qui sera créée dans la base. Nous pouvons également sélectionner Créer un index spatial. Cet index permettra d’accélérer les traitements sur cette couche. C’est toujours une bonne idée d’en avoir un. Puis nous cliquons sur OK. La nouvelle couche apparaît bien sous le schéma correspondant de la table geodata_my_user dans le panneau Explorateur. Il est possible d’afficher la couche en double cliquant dessus.




Importer un flux WFS dans QGIS

Version de QGIS : 3.26.0

Pour rappel, un flux WFS permet à l’utilisateur de travailler sur une couche vecteur stockée sur une serveur distant sans avoir à la télécharger. Il est très simple d’importer un Flux WFS dans QGIS. La première chose à faire est de trouver sur le web l’adresse du flux que nous souhaitons importer. Ici, nous allons importer la BD TOPAGE [http://www.sandre.eaufrance.fr/actualite/diffusion-de-la-1%C3%A8re-version-de-la-bd-topage%C2%AE-m%C3%A9tropole] en flux WFS. La BD TOPAGE est la base de données géographique de référence du réseau hydrographique français. Nous y retrouvons par exemple les cours d’eau et leurs bassins-versants pour la France métropolitaine ainsi que pour les DROM-COM [https://fr.wikipedia.org/wiki/France_d%27outre-mer]. Cette donnée est référencée par le Sandre [http://www.sandre.eaufrance.fr/] et possède donc une fiche dans le référentiel du Sandre pour chacun des items de la BD TOPAGE. Sur chacune de ces fiches se trouve une catégorie WFS indiquant l’adresse du flux WFS de la BD TOPAGE. Par exemple, sur la fiche des Bassins Hydrographiques [https://www.sandre.eaufrance.fr/atlas/srv/fre/catalog.search#/metadata/4714a793-dcd8-4528-bd6a-80bfdbee9728], la rubrique WFS correspond à la figure suivante (Fig. 114).
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Fig. 114 Flux WFS de la BD TOPAGE sur le site du Sandre.



Le flux est l’URL indiquée en bleu, à savoir : https://services.sandre.eaufrance.fr/geo/topage2019?

Nous copions ce lien par un simple clic droit Copier le lien. Une fois ce lien nous allons dans QGIS, dans le panneau Explorateur et nous faisons un clic droit sur l’entrée WFS / OGC API - Features. Dans le menu qui apparaît, nous choisissons Nouvelle connexion et le menu suivant s’affiche (Fig. 115).
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Fig. 115 Connexion à un flux WFS dans QGIS.



À la ligne Nom nous entrons un nom libre qui décrit la connexion que nous entrons, ici par exemple, simplement BD TOPAGE. À la ligne URL nous collons le lien du flux que nous avons copié à l’étape précédente. Le reste peut rester vide car il n’y a pas besoin d’authentification pour cette donnée librement accessible. Nous cliquons ensuite sur OK. Maintenant, toujours dans le panneau Explorateur, si nous déplions le menu WFS / OGC API - Features nous retrouvons une entrée BD TOPAGE. Lorsque nous la déplions nous y retrouvons les différentes couches de cette base (Fig. 116).
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Fig. 116 Liste des couches de la BD TOPAGE accessibles depuis le flux WFS.



Pour afficher une couche dans QGIS, il suffit de double-cliquer sur la couche en question. Cette donnée apparaît alors dans le panneau Couches comme n’importe quelle autre couche vecteur. Il est maintenant possible de la traiter comme une couche vecteur normale, aussi bien pour y faire des requêtes attributaires (Requêtes attributaires dans QGIS) que des Géotraitements.


Astuce

Dans le fichier XML WFS_IGN.xml disponible ici WFS_IGN (faire un clic droit et Enregistrer le lien sous…) vous trouverez réunis des liens pour ajouter les flux WFS de l’IGN dans QGIS. Il suffit de télécharger le fichier, puis d’aller dans le panneau Explorateur ‣ Clic droit sur WFS / OGC ‣ Charger des connexions… puis de pointer vers le fichier téléchargé. Une nouvelle entrée apparaît avec les différentes données WFS de l’IGN.






Importer des données textes

Il peut arriver de devoir traiter une donnée géographique simplement stockée dans un fichier texte de type csv. Il peut s’agir de données capturées avec un GPS sur le terrain, ou de tout autre type de données récupérées ici ou là. Dans la plupart des cas, il s’agit de données ponctuelles. C’est de ce cas là dont nous traiterons ici.


Note

Les géométries linéaires ou surfaciques peuvent tout à fait être stockées au format texte, mais dans ce cas il s’agira d’un format spécifique connu sous le nom de Well Known Geometry dont l’extension est .wkt.



Concrètement, les fichiers csv qui peuvent être importés doivent respecter quelques règles simples. Chaque ligne doit correspondre à une entité. En fait, le fichier csv en lui même peut être considéré comme une table attributaire. Parmi les colonnes, doivent obligatoirement figurer une colonne stockant les coordonnées en X et une autre stockant les coordonnées en Y. Le système de coordonnées de référence de ces coordonnées doit absolument être connu à priori par l’utilisateur.


Astuce

Lorsque vous recevez un tel fichier, pensez toujours à demander au fournisseur quel est le système de coordonnées utilisé. À fortiori, si c’est vous qui diffusez un tel fichier, accompagnez le toujours de la mention du système de coordonnées utilisé.
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Importer une couche texte dans QGIS

Version de QGIS : 3.16.1

Dans cet exemple, nous allons importer dans QGIS l’implantation de stations de mesures de la qualité de l’eau dans des cours d’eau Corse ( »stations_qualite_Corse_L93.csv »). Premièrement il est possible d’ouvrir ce fichier dans un tableur afin de se rendre compte de sa structure (Fig. 117).


[image: alternate text]

Fig. 117 Structure du fichier csv à importer.




Avertissement

Les tableurs comme LibreOffice Calc ou Excel ne gèrent pas forcément de façon optimale les types de champs. Ici, par exemple, le champ CdStationM est en fait de type texte. En observant la deuxième ligne, nous nous apercevons que LibreOffice Calc a considéré que ce champ était de type numérique. Alors qu’en réalité cette station a pour identifiant « 06215990 ». Non seulement le type n’est pas respecté mais en plus le « 0 » initial a été supprimé. Il peut être plus prudent d’ouvrir ce csv avec un éditeur de texte de type bloc-note, même si la lecture s’en trouve compliqué.



Dans ce fichier, la première ligne correspond à l’en-tête des colonnes (leurs noms). En anglais, l’en-tête est appelé Header. Ce fichier correspondra en fait à la table attributaire de la couche géographique que nous allons créer. Chaque ligne correspond à une entité géographique, à savoir, ici, une station de mesure. Chaque colonne est un attribut d’une station. Parmi ces attributs, deux sont indispensables : les coordonnées X et Y. Nous les retrouvons dans les champs coord_X et ccord_Y. Il s’agît de coordonnées exprimées en Lambert 93.

Le principe va être de charger ce fichier dans QGIS en lui disant de se baser sur ces deux champs pour définir la géométrie de la couche.

L’import se fait via le menu Couche > Ajouter une couche > Ajouter une couche de texte délimité. La fenêtre suivante s’affiche (Fig. 118).
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Fig. 118 Importation d’une couche de texte délimité dans QGIS.



Dans le champ Nom de fichier nous sélectionnons le fichier csv à importer, ici « stations_qualite_Corse_L93.csv ». Le champ Nom de la couche est personnalisable et le champ Encodage permet de définir l’encodage de la table d’attributs. UTF-8 est la plupart du temps la meilleure solution.

Dans le panneau Format de Fichier, il est possible de spécifier quel est le séparateur de champ utilisé. Par exemple, un « vrai » fichier csv sépare les champs en utilisant une virgule (comma en anglais). Mais ici, notre fichier a un séparateur en Point-virgule.

Dans le panneau Option des champs et enregistrements, il est possible de définir si il y a ou non un en-tête, si il faut ignorer des lignes au début du document, si le séparateur de décimal est une virgule… Souvent les options par défaut dans ce panneau sont suffisantes.

Dans le panneau Définition de la géométrie, nous définissons le type de géométrie (point, ligne, polygone) et les champs qui la renferment. Ici, le champ X est « coord_X » et le champ Y est « coord_Y ». Il est encore nécessaire de définir le système de coordonnée utilisé, le Lambert 93 dans notre cas (EPSG 2154).

Le panneau Échantillon de données nous permet de vérifier que le tableau est bien lu avant de la charger dans QGIS.

Une fois ces réglages effectués, il n’y a plus qu’à cliquer sur Ajouter. La nouvelle couche de points apparaît bien dans le panneau central. Après l’import d’un tel fichier, il est toujours bien de vérifier la localisation de notre couche en ajoutant au projet une donnée de référence comme un fond OpenStreetMap ou autre. Se reporter à la fiche correspondante si besoin : Importer des fonds de cartes Web.
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Fig. 119 Vérification de l’import avec une couche externe (OSM).



À ce stade, il faut bien noter que la couche est temporaire, elle est simplement affichée dans QGIS mais n’est pas sauvée sur le disque. Pour l’exporter en une couche géographique, nous devons faire un clic droit sur le nom de la couche dans le panneau des couches et sélectionner le menu Exporter > Sauvegarder les entités sous… et ensuite définir un chemin d’export.


Avertissement

Nous ne pouvons qu’insister sur le rôle crucial des métadonnées en général et dans ce cas là en particulier. Le fichier en lui même n’est pas suffisant, il faut connaître également le système de cordonnées correspondant aux coordonnées X et Y. Il est également important de préciser ce que représentent les autres champs.





Importer une couche texte dans R

Il est possible de charger dans R un fichier texte non géoréférencé mais contenant deux colonnes renseignant les coordonénes X et Y de chaque point, et de le transformer en objet géographique SpatVector ou sf. Il est nécessaire de connaître le système de coordonnées de référence (SCR) employé et que chaque point soit exprimé dans le même SCR. Dans l’exemple ci-dessous, nous allons charger dans R un csv contenant les points hydrographiques de France métropolitaine suivis par l’Office Français de la Biodiversité. Dans ce fichier, chaque ligne est une station, simplifiée sous forme de point, et les coordonnées de chaque station sont contenues dans les colonnes CoordXSiteHydro et CoordYSiteHydro. ces coordonnées sont exprimées en Lambert 93 (EPSG 2154). Nous verrons la démarche avec la librairie terra et la librairie sf. La syntaxe est quasiment la même pour les deux librairies.


Importer une couche texte avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

# import du csv de points en précisant le séparateur de champ ','
stations_text <- read.csv('SiteHydro_FXX.csv', sep=',')
# transformation en vectur selon X et Y
stations <- terra::vect(stations_text, geom=c('CoordXSiteHydro', 'CoordYSiteHydro'), crs='EPSG:2154')





De façon assez logique, nous précisons le tableau à utiliser, les colonnes X et Y puis le SCR via la fonction vect. Nous obtenons au final un objet de type SpatVector.



Importer une couche texte avec sf

Version de R : 4.3.1

Version de sf : 1.10.12

# import du csv de points en précisant le séparateur de champ ','
stations_text <- read.csv('SiteHydro_FXX.csv', sep=',')
# transformation en vectur selon X et Y
stations <- sf::st_as_sf(stations_text, coords=c('CoordXSiteHydro', 'CoordYSiteHydro'), crs='EPSG:2154')





De façon assez logique, nous précisons le tableau à utiliser, les colonnes X et Y puis le SCR via la fonction st_as_sf. Nous obtenons au final un objet de type SpatVector.





Importer un tableur

Dans certains cas il peut être utile d’importer un tableur ne disposant d’aucune information géographique dans un projet SIG. Par exemple si nous disposons d’une couche géographique des pays du monde, nous pourrions avoir besoin de lui adjoindre des informations relatives à leurs populations récupérées par ailleurs sous forme d’un tableur. Souvent l’idée sous-jacente est de faire une jointure attributaire entre une couche géographique et le tableur importé.


Importer un tableur dans QGIS

Version de QGIS : 3.16.1

Dans QGIS, rien de plus simple, il suffit de faire un glisser déposer du tableur depuis l’explorateur vers le panneau central de QGIS. Le fichier est chargé, il apparaît dans le panneau des couches, et est traitée comme une table attributaire indépendante. QGIS reconnaît aussi bien le format ods de LibreOffice que xls ou xlsx de Microsoft Office.




Importer des points GPS

Après avoir capturé une trace GPS d’un itinéraire, ou des points d’intérêts, soit à l’aide de son smartphone soit à l’aide d’un récepteur GPS dédié, il peut être intéressant d’importer cette trace dans un logiciel SIG. Cette trace est enregistrée au format .gpx. Cette importation nous permettra de comparer notre trace avec des données tierces et de la manipuler comme n’importe quelle donnée géoréférencée.

La plupart des logiciels SIG offrent une fonction d’import de ce type de fichiers .gpx. Un fichier .gpx se comporte un peu comme un fichier geopackage. Il s’agît d’un fichier contenant plusieurs couches, ce qui nous est indiqué au moment de l’import (Fig. 120). Un fichier gpx contient généralement 5 couches :


	route_points : couche de type points contenant les points à suivre tels que définis par l’utilisateur


	route : couche de type polylignes contenant les arcs reliant les points de la couche précédente


	track_points : couche de type points contenant les points (i.e. les nœuds) de la trace GPS capturée


	tracks : couche de type polylignes contenant les arcs reliant les points de la couche track_points


	waypoints : couche de type points contenant les éventuels points d’intérêts, comme les prises de notes audio ou vidéos, relevés par l’utilisateur





Importer des points GPS dans QGIS

Version de QGIS : 3.16.1

La façon la plus simple d’importer un fichier .gpx dans QGIS est de faire un simple glisser-déposer du fichier depuis l’explorateur de fichiers vers le panneau principal de QGIS. Dans cette exemple, nous allons charger le fichier nommé trace_GPS_Malakoff.gpx qui est une trace GPS capturée sur la commune de Malakoff dans les Hauts-de-Seine (92) (Fig. 120).


[image: alternate text]

Fig. 120 Import d’un fichier gpx dans QGIS.



Dans notre cas, aucune route n’avais été définie, nous pouvons donc ignorer ces deux couches en ne sélectionnant que les 3 dernières. Nous pouvons sélectionner l’option Ajouter des couches à un groupe, ce qui permettra de charger ces trois couches dans un groupe dans le panneau des couches. Le chargement se fait après avoir cliqué sur OK (Fig. 121).


[image: alternate text]

Fig. 121 Les couches gpx chargées dans QGIS et dans un groupe de couches.



De façon basique, les couches de points apparaissent comme des couches vecteurs ponctuelles et les couches de polylignes comme des couches vecteurs linéaires. Nous remarquons que nous avons bien groupé ces éléments de la trace dans un groupe qui a pris le nom du fichier initial trace_GPS_Malakoff.


Avertissement

Notons que le système de coordonnées de référence d’une couche gpx est la plupart du temps de type WGS 84 (4326).



Comme pour n’importe quelle couche vecteur, nous pouvons consulter les tables attributaires associées à ces données. Nous commençons par ouvrir celle de la couche waypoints (Fig. 122).


[image: alternate text]

Fig. 122 La table attributaire de la couche waypoints.



La plupart des colonnes ne sont pas renseignées. Mais nous trouvons des informations intéressantes dans les colonnes time et name. Dans cette dernière nous trouvons les noms de fichiers associés à ces points. Il s’agît ici de fichiers .jpg donc de photos. Il s’agît de deux photos prises par l’utilisateur pendant l’enregistrement de la trace GPS. Dans la colonne time, nous trouvons la date et l’heure de prises de ces photos.


Note

La colonne name contient le nom du fichier lors de la prise de vue. C’est un nom donné automatiquement par l’application. Même si l’utilisateur renomme la photo dans l’application, le nom ne sera pas mis à jour dans ce champ (ce qui aurait été pratique).



Nous pouvons regarder la table associée à la couche track_points (Fig. 123).


[image: alternate text]

Fig. 123 La table attributaire de la couche track_points.



Dans notre cas, seules trois colonnes sont intéressantes. La première est track_srg_id qui est un simple identifiant numérique unique de chaque point. La deuxième est ele qui correspond à l’altitude du point lors de son enregistrement. La troisième est speed qui contient la vitesse à laquelle se déplaçait l’utilisateur lors de l’enregistrement du point.


Note

L’altitude associée à chaque point est celle mesurée par le capteur GPS employé par l’utilisateur. Cette valeur est donc plus ou moins précise en fonction du matériel, du nombre de satellites captés à ce moment, des conditions atmosphériques … Il en est de même pour la vitesse.



Enfin, la couche tracks, dans notre cas, ne contient aucune information intéressante.



Importer des points GPS dans R

Pour importer des points GPS dans R, nous procédons exactement de la même manière que pour n’importe quelle fichier vecteur. La seule différence est qu’il faut bien nommer spécifiquement la couche à importer parmi toutes celles présentes dans le fichier .gpx (Importer des points GPS). Ici nous allons importer un fichier GPS nommé trace_explo.gpx, d’abord via terra puis via sf.


Importer des points GPS avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

Comme présenté pour les fichiers vecteurs classiques, il faut faire appel à la fonction vect de la librairie terra et bien spécifier la couche à importer à l’aide du paramètre layer=.

# import des points de la trace
track_points <- terra::vect('trace_explo.gpx', layer='track_points')
# import des polylignes de la trace
tracks <- terra::vect('trace_explo.gpx', layer='tracks')
# import des waypoints utilisateurs
waypoints <- terra::vect('trace_explo.gpx', layer='waypoints')





Nous obtenons nos trois couches en format SpatVector.



Importer des points GPS avec sf

Version de R : 4.3.1

Version de sf : 1.10.12

Comme présenté pour les fichiers vecteurs classiques, il faut faire appel à la fonction st_read de la librairie sf et bien spécifier la couche à importer à l’aide du paramètre layer=.

# import des points de la trace
track_points <- sf::st_read('trace_explo.gpx', layer='track_points')
# import des polylignes de la trace
tracks <- sf::st_read('trace_explo.gpx', layer='tracks')
# import des waypoints utilisateurs
waypoints <- sf::st_read('trace_explo.gpx', layer='waypoints')





Nous obtenons nos trois couches en format SpatVector.





Importer des photos localisées

Lors d’une excursion sur son terrain d’études, ou simplement suite à une randonnée, il peut être intéressant d’importer dans un projet de géomatique des photos précisément localisées. Ces photos permettront par exemple de compléter notre analyse avec des prises de vue « réelles » correspondant à la réalité sur le terrain.

Ces photos doivent bien sûr disposer de coordonnées géographiques (de type GPS) dans leurs métadonnées. Les métadonnées d’un fichier photo .jpg sont incluses dans la partie Exif du fichier. Exif est l’acronyme de Exchangeable image file format. Concrètement, c’est une partie du fichier image qui est utilisée pour stocker différentes métadonnées relatives à la prise de vue : nom, date, heure, distance focale, vitesse d’obturation, coordonnées géographiques, … Toutes ces métadonnées ne sont pas forcément renseignées. L’utilisateur peut choisir de les renseigner ou pas au moment de la prise de vue. Ici, nous considérons que nous avons pris nos photos de terrain au travers de l’application OsmAnd afin d’être sûr que nos prises de vue incluent la localisation.

Ces photos peuvent par exemple servir à confronter une image satellite à la réalité terrain. Elles peuvent également être utiles pour construire ou valider une classification d’usage du sol à partir de ces images de télédétection.

Cette manipulation peut se faire avec différents outils faciles d’utilisation.


Importer des photos localisées dans QGIS

Version de QGIS : 3.16.1

Dans cette section, nous allons voir comment importer des photos géoréférencées dans QGIS. Il existe différentes façons d’importer des photos localisées dans QGIS. Ils existent plusieurs extensions dédiées à cette tâche. Mais nous allons voir comment le faire en utilisant les capacités internes à QGIS sans passer par une extension.

Pour l’exemple, nous allons superposer nos photos localisées à une trace GPS que nous avons capturée en même temps.


Import des localisations

La première étape consiste à importer les localisations des photos et de les stocker dans une couche de points. Au préalable il est nécessaire de stocker les photos à importer au sein d’un répertoire dédié sur son disque. Dans cet exemple, notre répertoire se nomme tagged_photos. Cela se fait simplement en passant par la Boîte à outils de traitements > Création de vecteurs > Importer des photos géolocalisées. Le menu suivant s’ouvre (Fig. 124).


[image: alternate text]

Fig. 124 Importer les localisations des photos dans QGIS.



Concrètement, ce module va lire les métadonnées de localisation depuis les Exif de chaque photo et les transformer en une couche de points. Dans le champ Dossier source nous indiquons le répertoire contenant les photos à importer, ici tagged_photos. Dans le champ Photos nous indiquons le chemin et le nom de la couche de points qui sera créée, ici tagged_photos_georef.gpkg. La couche résultante apparaît automatiquement après avoir cliqué sur Exécuter.

La couche de points apparaît bien dans le panneau des couches. Nous pouvons explorer sa table d’attributs. Nous n’avons qu’une photo dans notre cas (Fig. 125).


[image: alternate text]

Fig. 125 La table attributaire associée à la localisation des photos.



Dans cette table nous retrouvons les champs suivants :


	photo : le chemin de la photo sur le disque


	filename : le nom de la photo


	directory : le chemin du répertoire contenant la photo


	altitude : l’altitude prise de vue


	direction : l’azimut dans lequel pointait l’appareil photo au moment de la prise de vue (non renseigné ici)


	longitude : la longitude de la localisation de la photo (en WGS 84)


	latitude : la latitude de la localisation de la photo (en WGS 84)


	timestamp : la date et l’heure de la prise de vue






Affichage des photos sous forme de popups

Une fois les localisations importées, il est utile d’afficher directement les photos dans notre projet. Cet affichage se règle dans les Propriétés de la couche de points de localisations, puis dans l’onglet Affichage (Fig. 126).


[image: alternate text]

Fig. 126 Réglage de l’affichage des photos dans QGIS.



Nous allons utiliser les possibilités html de l’affichage de QGIS. Dans le champ Afficher le nom, nous sélectionnons le champ contenant le chemin vers la photo à afficher, à savoir filename. Ensuite nous réglons le code HTML à utiliser dans le panneau Infobulle HTML. Nous y entrons :

<img src="file:///[% photo %]" width="350" height="250">





Nous reconnaissons la balise img signifiant en HTML que nous allons afficher une image. src indique la source de l’image à afficher. La source commence par file:// car l’image est stockée sur notre disque et non en ligne. La partie [% photo %] sera remplacée à la volée par le chemin correspondant au champ filename. Et enfin, suivent les dimensions d’affichage de la photo.


Astuce

Pour les connaisseurs du langage HTML, il est possible de paramétrer encore plus finement toute cette partie.



Nous cliquons ensuite sur OK. Il n’y a plus qu’à activer l’affichage des infobulles dans l’interface de QGIS. Il suffit de cliquer sur l’icône Afficher les infobulles [image: icone_infobulle] dans la barre d’outils générale. La photo s’affichera dès que nous survolerons le point correspondant avec le curseur de la souris (Fig. 127). Notons, qu’il peut y avoir un petit temps de latence entre le survol et l’affichage.


[image: alternate text]

Fig. 127 Apparition du popup de la photo au survol du curseur.





Affichage des miniatures des photos au niveau des points

Pour un aperçu rapide des photos, il est possible de changer la symbologie de la couche des points de localisation en y mettant une miniature de la photo correspondante. Ce réglage se fait dans la symbologie de la couche. Nous faisons un clic droit sur la couche dans le panneau des couches, nous sélectionnons Propriétés puis nous allons dans l’onglet Symbologie (Fig. 128).


[image: alternate text]

Fig. 128 Affichage de la miniature des photos comme symbologie.



Nous réglons la symbologie en Symbole Unique. Dans le panneau juste au-dessous, nous sélectionnons la ligne qui est par défaut à Symbole simple et dans Type de symbole, nous choisissons Symbole image raster. De nouvelles options apparaissent dans le bas de la fenêtre. À côté du champ vide, nous cliquons sur l’icône [image: icone_options]. Un menu apparaît dans lequel nous cliquons sur Type de champ:string puis nous sélectionnons photo (string). Ici, nous lui disons de lire le chemin qui se trouve dans le champ photo de la table attributaire. Nous pouvons ensuite régler la taille de la miniature dans le champ Largeur. Puis nous cliquons sur OK (Fig. 129).


[image: alternate text]

Fig. 129 La miniature de la photo utilisée comme symbologie.



Par contre, la taille de la miniature ne change pas avec le niveau de zoom, ce qui peut rendre l’affichage général du projet plus ou moins illisible.


Note

Cette présentation de cet outil est inspirée de la documentation fournie sur ce blog [https://opengislab.com/blog/2020/8/23/mapping-and-viewing-geotagged-photos-in-qgis].







Importer des fonds de cartes Web

Dans certains cas il peut être utile d’ajouter « en fond » des données tierces comme les fonds de cartes Open Street Map, Google Earth ou les otrho-photos de l’IGN. Ces fonds de carte seront chargées « à la volée » depuis Internet et ne seront pas téléchargés en local. Ils pourront être utilisés pour se repérer ou pour illustrer une scène.


Données Web dans QGIS

Version de QGIS : 3.16.1

Il existe deux façons d’ajouter des données tierces au sein d’un projet QGIS. Soit via une extension, soit via l’explorateur incorporé à l’interface. Dans les deux cas une connexion à Internet est requise.


Via l’extension QuickMapServices

La solution la plus facile est de passer par une extension nommée QuickMapServices. Au préalable, il est donc nécessaire d’installer cette extension.

Une fois cette extension installée, elle apparaît dans le menu Internet qui se trouve dans la barre des menus principaux, en haut de l’interface. Certains fonds de cartes sont directement accessibles via ce menu dans Internet > QuickMapServices. Parmi les données proposées, la plus couramment utilisée est le fond OSM (OpenStreetMap) (Fig. 130).


[image: alternate text]

Fig. 130 Zoom sur un quartier de Singapour depuis OSM dans QGIS.




Astuce

Il est préférable d’ajouter au préalable dans QGIS une couche géographique de notre zone d’étude, puis d’ajouter un fond de carte externe. De cette manière, le fond de carte chargé sera automatiquement centré sur notre zone d’intérêt. Sinon, le monde entier est chargé, ce qui peut s’avérer un peu long.



Il est possible d’accéder à quelques propriétés des couches distantes chargées. Nous y accédons par un clic droit sur le nom de la couche dans le panneau des couches puis Propriétés. La fenêtre des propriétés apparaît alors.


[image: alternate text]

Fig. 131 Propriétés de la couche OpenStreetMap.




	Parmi les informations intéressantes nous trouvons :
	
	URL : l’URL source de la couche


	SCR : le système de coordonnées de la couche. Ici, il s’agît d’un SCR global de type Mercator qui a la particularité d’être projeté et d’être exprimé en mètres et non en degrés.


	Unité : l’unité du système du SCR, ici le mètre








QGIS est capable de changer le SCR à la volée de ces fonds de cartes externes pour respecter le SCR des données de l’utilisateur (Fig. 132).


[image: alternate text]

Fig. 132 Le fond Google Earth projeté en Lambert 93.



Il est tout à fait possible d’ajouter des données autres que celles proposées par défaut comme les images Google Earth ou les ortho-photos de l’IGN. Il suffit de retourner dans le menu QuickMapServices et de sélectionner Search QMS. Un panneau nommé Search QMS apparaît en bas à droite de l’interface (Fig. 133).


[image: alternate text]

Fig. 133 Rechercher d’autres données avec QuickMapServices.



Nous entrons dans le champ du haut un mot clé de la couche que nous souhaitons ajouter. Par exemple Google satellite pour ajouter les images Google Earth. Une autre donnée intéressante est la couche des ortho-photos de l’IGN. Pour les obtenir, nous pouvons entrer ortho IGN dans la barre de recherche et d’ajouter la couche BDOrtho IGN (Fig. 134).


[image: alternate text]

Fig. 134 L’ortho-photo de l’IGN au niveau du bâtiment Olympe de Gouges de l’Université de Paris (Paris 13ème).




Avertissement

Il peut être tentant d’utiliser les images Google Earth pour créer des polygones d’entraînement pour classifier une image satellite. Mais il faut être très prudent pour ce genre de démarche. Nous n’avons aucune idée de la date de prise de vue de l’image Google. La région peut avoir changé. La saison est également importante, un champ nu sur l’image Google Earth sera peut-être une belle prairie sur votre image satellite à classer.





Via le panneau des couches

Si l’explorateur n’apparaît pas automatiquement, nous le réactivons en allons dans le menu Préférences > Panneaux > Explorateur (2). Un explorateur s’ajoute alors sur la partie gauche de l’interface (Fig. 135).


[image: alternate text]

Fig. 135 L’explorateur intégré à QGIS.



Dans cet explorateur nous allons ajouter des données tierces grâce au menu XYZ tiles. Afin d’utiliser ce menu, il est tout d’abord nécessaire de connaître l’URL de la couche à ajouter. Trouver cet URL peut être laborieux. Ici, nous allons ajouter une entrée vers les images Google Satellite. Le plus simple pour récupérer son URL est de passer par QuickMapServices, puis de regarder dans les propriétés de la couche tel que que nous l’avons vu dans la section précédente. Nous copions l’URL se trouvant dans le champ URL.

Ensuite, nous faisons un clic droit sur le menu XYZ tiles et nous sélectionnons Nouvelle connexion… La fenêtre suivante apparaît (Fig. 136).


[image: alternate text]

Fig. 136 Ajout d’une nouvelle connexion XYZ.



Dans le champ Nom, nous pouvons indiquer Google Satellite (ou tout autre nom, ça n’a pas d’importance). Dans le champ URL nous collons l’URL copiée précédemment. Les autres réglages peuvent être laissés par défaut dans notre cas. Nous cliquons sur OK et la couche est ajoutée. Une nouvelle entrée correspondante apparaît dans le menu XYZ tiles (Fig. 137).


[image: alternate text]

Fig. 137 La nouvelle couche XYZ apparaît dans le menu.



Au final, cette solution peut être utilisée comme une sorte de raccourci qui nous évite de passer par la fonction de recherche de l’extension QuickMapServices.


Astuce

Il est possible de se connecter à de nombreux fournisseurs de données de fonds de cartes en récupérant le fichier xml suivant : XYZ (faire un clic droit et Enregistrer le lien sous…). Il suffit de télécharger le fichier, puis d’aller dans le panneau Explorateur ‣ Clic droit sur XYZ Tiles‣ Charger des connexions… puis de pointer vers le fichier téléchargé. Une nouvelle entrée apparaît alors, qui contient des liens vers de nombreux fonds génériques comme Goole Earth, OSM, Bing, …







Exporter des données rasters

Lorsqu’un traitement raster a été effectué, il est peut être utile d’enregistrer la couche résultante dans un format d’échange facile comme le GeoTiff. Cette manipulation est surtout utile pour exporter des couches rasters créées au travers de scripts R ou Python.


Exporter un raster depuis R

Version de R : 4.8.1

Au cours d’un traitement avec un script R, différents rasters peuvent avoir été créés. Dans certains cas, il est bien de pouvoir les exporter au format GeoTiff par exemple, afin de les rendre exploitables au travers d’un logiciel comme QGIS ou d’un autre langage de programmation comme Python. Chaque package de gestion des rasters propose sa propre méthode d’export. Ici, pour l’exemple, nous exporterons le MNT du bassin de la Roya que nous aurons au préalable reprojeté. Le tout se fait simplement avec les lignes suivantes.

# chargement du raster à reprojeter
mnt_roya <- terra::rast("srtm_roya_L93.tif")

# reprojection vers le système 323631
crs(mnt_roya) <- 'EPSG:32631'

# export du MNT reprojeté sous le nom 'mnt_repro.tif'
terra::writeRaster(mnt_roya, "mnt_repro.tif", overwrite=TRUE)





L’option overwrite est facultative et permet d’écraser le fichier si il existe déjà au moment de l’export.



Exporter un raster depuis Python

Version de Python : 3.8.10

Une fois des traitements rasters réalisés au sein d’un script Python, il est souvent utile d’exporter le résultat dans un fichier raster standard de type GeoTiff. Cette exportation peut se faire à l’aide du package rasterio. L’idée générale est qu’à la fin de notre traitement nous disposons d’un array Numpy qui correspond à une bande raster. Et c’est cette bande raster pour l’instant stockée sous forme de array que nous allons exporter en GeoTiff. Le principe va être de créer un raster vide que nous allons définir selon des caractéristiques de base (hauteur, largeur, CRS, type, …), puis nous allons écrire la bande à exporter dans ce raster vide. Dans l’exemple suivant, nous allons importer une bande raster depuis un fichier tif existant et nous allons exporter cette bande dans un nouveau raster. Cette manipulation n’a évidemment aucun intérêt à part montrer la procédure d’export.

# chargement de la librairie de gestion des rasters rasterio
import rasterio

# le chemin vers le raster mono-bande à charger et chargement
rast = rasterio.open('./Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF')
# on récupère ensuite la bande qui nous intéresse sous forme d'un array Numpy
band = rast.read(1)

# exportation de cette bande
# on commence par créer un raster "vide" dont on définit les paramètres de base
raster_export = rasterio.open(
     './Landsat_13/band.tif',
     'w',
     driver='GTiff',
     height=band.shape[0],
     width=band.shape[1],
     count=1,
     dtype=band.dtype,
     crs=rast.crs,
     transform=rast.transform,
)
# enfin on écrit dans ce raster la bande à exporter
raster_export.write(band, 1)
# on n'oublie pas de fermer l'instance de raster pour finaliser son export
raster_export.close()





La signification des différents paramètres est présentée ici :


	“./Landsat_13/band.tif” : le chemin et le nom du raster qui sera créé


	“w” : nous rendons ce raster vide éditable (w pour writable)


	driver=”GTiff” : nous spécifions le format de raster vers lequel exporter


	height=band.shape[0] : le raster sera de même hauteur que le nombre de lignes dans la bande à exporter


	width=band.shape[1] : le raster sera de même largeur que le nombre de colonnes dans la bande à exporter


	count=1 : le raster sera constitué d’une seule bande


	dtype=band.dtype : les pixels seront du même type que ceux de la bande à exporter (float32, unint16, …)


	crs=rast.crs : le raster sera du même SCR que le raster initial


	transform=rast.transform : nous appliquons les mêmes paramètres de transformation que ceux du raster initial




Nous obtenons bien au final un raster band.tif qui est identique au raster initialement chargé.




Exporter des données vecteurs

Lorsqu’un traitement vecteur a été effectué, il est peut être utile d’enregistrer la couche résultante dans un format d’échange facile comme le Geopackage. Cette manipulation est surtout utile pour exporter des couches vecteurs créées au travers de scripts R ou Python.


Exporter un vecteur depuis R

Lorsque nous avons effectué des traitements vecteurs dans R sur un objet de type sf ou SpatVector, il peut être utile de l’exporter dans un format intelligible par d’autres logiciels et langages de programmation comme les formats .gpkg, .shp, geojson, … Ici, nous exporterons un vecteur stocké sous forme d’un objet sf ou SpatVector et se trouvant dans une variable nommée dep. Nous l’exporterons dans un geopackage nommé limites_administratives et nous enregistrerons la couche sous le nom departements.


Exporter un vecteur depuis terra

Version de R : 4.4.1

Version de terra : 1.7-71

La fonction terra à utiliser est writeVector.

terra::writeVector(dep, 'limites_administratives.gpkg', layer='departements')





Notons que le format GeoPackage permet de stocker plusieurs couhes dans un même fichier. Imaginons que nous ayons les limites de la France stockées dans une variable SpatVector nommée lim_fr et que nous souhaitons ajouter cette couche au GeoPackage que nous venons de créer. Pour ce faire, il suffit d’utiliser le mot clef insert=TRUE comme ci-dessous.

terra::writeVector(lim_fr, 'limites_administratives.gpkg', layer='limites_fr', insert=TRUE)







Exporter un vecteur depuis sf

Version de R : 4.4.1

Version de sf : 1.0-16

La fonction sf à utiliser est st_write() qui prend en paramètre, le nom de l’objet sf à exporter, un chemin vers la destination de stockage, et le driver à utiliser (à définir selon le format d’export choisi).

sf::st_write(dep, dsn = "limites_administratives.gpkg", layer=departements, driver="GPKG")
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Les Systèmes de Coordonnées de Références

Dans cette section nous allons découvrir quelques points théoriques et pratiques sur les systèmes de coordonnées de références (SCR), aussi appelés abusivement projections. Nous nous efforcerons de voir les implications de la théorie sur les applications en géomatique. Nous verrons ensuite quelques manipulations pratiques faisant intervenir les SCR sur des données vecteur et raster.


Table des matières


	Les formes de la Terre


	La Terre comme une sphère


	La Terre comme un géoïde


	La Terre comme un ellipsoïde


	Les coordonnées géographiques






	Les projections, éléments de définition


	La nature des projections


	Le type de plans de projection


	La position du plan de projection


	Les codes EPSG






	Quelques projections courantes


	Pour la France


	Pour l’Europe


	Pour le monde par zones UTM


	Pour le monde






	Implications dans les SIG et en télédétection


	Sur le calcul des surfaces


	Quelle fonction choisir pour calculer des surfaces ?


	Implications sur les rasters






	Géoréférencement


	Géoréférencer un document dans QGIS






	Changement de Système de Coordonnées de Référence


	Reprojection d’un raster


	Reprojection d’un raster dans QGIS


	Reprojection par lot de rasters dans QGIS


	Preprojection d’un raster avec le module SCP


	Reprojection d’un raster avec GDAL


	Reprojection d’un raster avec R


	Reprojection d’un raster avec Python






	Reprojection d’une couche vecteur


	Reprojection d’un vecteur dans QGIS


	Reprojection d’un vecteur avec GDAL/OGR


	Reprojection d’un vecteur dans R


	Reprojection d’un vecteur avec terra


	Reprojection d’un vecteur avec sf



















Les formes de la Terre

La représentation de la forme de la Terre a évolué au cours du temps et peut être choisie en fonction des applications souhaitées. Définir la forme de la Terre est l’étape primordiale afin de s’y situer et donc, pour nous, d’y faire de l’analyse spatiale basée sur les systèmes d’information géographiques et la télédétection. Le choix d’un système géodésique, puis d’un système de projection a des répercussions sur le croisement des couches au sein d’un SIG et sur les calculs qu’il est possible de faire sur les longueurs et les surfaces des objets étudiés, qu’ils soient de type vecteur ou raster.


La Terre comme une sphère

Connaître la forme de la Terre est une question qui se pose depuis très longtemps. Dans le monde méditerranéen, les savants grecs furent parmi les premiers à avancer des réponses à cette question. Le premier (du moins le premier documenté) a avoir fait l’hypothèse d’une Terre sphérique serait Pythagore vers 500 avant notre ère. Cette idée viendrait des observations faites par les astronomes antiques lors des éclipses de Soleil. La Terre passe devant le Soleil et y forme alors une ombre en forme de croissant. Suite à cette hypothèse, un autre savant, du nom de Ératosthène (Fig. 138), mit au point une méthode pour déterminer la circonférence de cette sphère. Il calcule une circonférence de 250 000 stades, une unité de mesure utilisée alors en Égypte. Selon certains historiens, un stade valait 157.5 mètres, ce qui donne une circonférence de 39 375 km. Cette valeur est impressionnante car diffère seulement de 2 % de la valeur actuellement connue. Cependant, nous ne sommes pas tout à fait certains de la longueur en mètres d’un stade égyptien. Quoi qu’il en soit, pour une époque si reculée, ces résultats sont impressionnants.


[image: Eratosthène enseignant à Alexandrie]

Fig. 138 Eratosthène enseignant à Alexandrie, peinture de Bernardo Strozzi, 1635.



Selon le géographe antique romain Strabon, Cratès de Mallos aurait été le premier a réalisé un globe terrestre pour représenter physiquement la Terre sous sa forme sphérique. Il y aurait placé le monde méditerranéen connu de son époque, plus des continents inconnus faisant symétrie au monde connu. Selon lui, l’hémisphère nord et sud devaient être séparées par une zone océanique appelée zone torride.



La Terre comme un géoïde

Durant le Moyen-Âge, une image de la Terre plate a été répandue par le clergé catholique, même si certains savants pensaient toujours que la Terre était sphérique. Cette sphéricité de la Terre est finalement revenue totalement sur le devant de la scène à la Renaissance, jusqu’à ce que des observations plus fines au cours des 19ème et 20ème siècles précisent mieux la forme de notre planète pour la définir comme un géoïde. Un géoïde est une surface équipotentielle du champ de pesanteur. Nous pouvons nous aider d’une image pour visualiser cet objet. Imaginons une planète totalement recouverte par un océan qui ne subirait aucune force de marée. La surface océanique d’une telle planète épouserait alors parfaitement la forme du geoïde de la planète en question. Sur Terre, il s’agit donc du niveau moyen des mers avec sa prolongation imaginaire sous les continents. Le géoïde n’est pas une sphère pour deux raisons. Tout d’abord, du fait de sa rotation, la Terre est légèrement aplatie au niveau des pôles. Ainsi, le rayon terrestre entre le centre de la Terre et l’Équateur est d’à peu près 6378 km et entre le centre de la Terre et les pôles d’environ 6357 km. D’autre part, l’intérieur de la planète n’étant pas homogène, certaines zones sont constituées de roches plus denses que d’autres. Au niveau des zones de roches les plus denses, le géoïde tend à se creuser, alors que là où les roches sont moins denses, il tend à se bomber (Fig. 139).


[image: Illustration du géoïde]

Fig. 139 Illustration, très exagérée, du géoïde terrestre (ESA).



La forme précise du geoïde peut être définie par des mesures in-situ ou via des missions satellites dédiées à la mesure du champ de pesanteur terrestre, (comme la mission Grace [https://earth.esa.int/eogateway/missions/grace]). Un modèle souvent utilisé pour le géoïde terrestre est le EGM96 (Earth Gravitational Model 96). Selon ce modèle, le point le plus bas du géoïde se situe au sud de l’Inde dans l’Océan Indien et le point le plus haut se situe au large de l’Islande dans l’Atlantique Nord. La différence entre ces deux points atteint un peu moins de 200 de mètres. Au sud de l’Inde, le géoïde est à -106 m de sa hauteur moyenne [https://www.scientificamerican.com/article/giant-gravity-hole-in-the-ocean-may-be-the-ghost-of-an-ancient-sea1/] et au large de l’Islande il est à +85 m de sa hauteur moyenne (Fig. 140).


[image: Géoïde EGM96]

Fig. 140 Le modèle EGM96 comme représentation du géoïde terrestre.



Les ondulations du géoïde sont finalement peu importantes par rapport aux ondulations de la topographie. Le point culminant de la surface terrestre, l’Everest, culmine à 8849 m et le point le plus bas, la Fosse des Mariannes, s’enfonce à près de 10 985 mètres sous le niveau de la mer. La différence topographique est donc d’une vingtaine de kilomètres. Cette différence atteint tout de même près de 9200 m pour les seules surfaces continentales puisque le point le plus bas, la Mer Morte, se situe à -434 m.



La Terre comme un ellipsoïde

Travailler avec un objet aussi complexe qu’un géoïde s’avère extrêmement compliqué. C’est pour cette raison que nous définissons un nouvel objet conceptuel appelé ellipsoïde. Un ellipsoïde est une simplification du géoïde et peut être perçu comme la moyenne du géoïde. Finalement, en 3D un ellipsoïde est au géoïde ce que l’ellipse est au cercle en 2D. Étant une forme géométrique idéale, un ellipsoïde peut être définie par une série de paramètres :


	le demi grand axe a : correspond au rayon entre le centre de l’ellipsoïde et l’Équateur


	le demi petit axe b : correspond au rayon entre le centre de l’ellipsoïde et un des Pôles


	l’inverse de l’aplatissement : \(\frac{1}{f}=\frac{a}{a-b}\)


	la première excentricité : \(e=\sqrt{\frac{a^2-b^2}{a^2}}\)


	le carré de l’excentricité : \(e^2=\frac{a^2-b^2}{a^2}\)


	la deuxième excentricité : \(e'=\sqrt{\frac{a^2-b^2}{b^2}}\)




Par endroits, l’ellipsoïde est plus haut que le géoïde et à d’autres, il est plus bas. La figure suivante (Fig. 141) présente une vue schématique de ces deux objets où l’ondulation du géoïde a été largement exagérée pour illustration. Si nous faisons abstraction des marées et des courants, la surface des océans suit la surface du géoïde.


[image: L'ellipsoïde comme simplification du géoïde]

Fig. 141 L’ellipsoïde comme simplification du géoïde.



Il est ensuite possible de définir un système géodésique en faisant un choix d’ellipsoïde. La forme de l’ellipsoïde, l’orientation de ses axes et sa position par rapport au centre de la Terre permettent de définir un système géodésique, aussi connu sous le nom de Datum en anglais. La figure suivante (Fig. 142) présente deux systèmes géodésiques différents de part leurs formes et leurs orientations.


[image: Deux systèmes géodésiques différents]

Fig. 142 Deux systèmes géodésiques (A et B) différents selon leurs formes et leurs orientations.



Il existe des ellipsoïdes globaux et locaux. Un ellipsoïde global va moyenner le géoïde à l’échelle de toute la Terre. Tandis qu’un ellipsoïde local va le moyenner à l’échelle d’une région donnée. Le second sera donc localement plus précis que le premier mais ne pourra être utilisé que sur une partie du globe. Par exemple, en Amérique du Nord l’ellipsoïde de Clarke 1866 a été utilisé au 19ème siècle et début 20ème car il était plus proche du géoïde pour cette partie du monde. Néanmoins, avec l’avènement des systèmes de positionnement globaux par satellite (comme le GPS), la plupart des systèmes géodésiques actuels repose sur le même ellipsoïde global nommé Geodetic Reference System 1980, connu simplement comme l’ellipsoïde GRS80. Une (très faible) variante de cet ellipsoïde est utilisé dans le système géodésique mondial WGS84. La différence entre ces deux ellipsoïdes n’est pas significative dans les applications liées à la géomatique comme l’indique le tableau suivant.


Tableau 9 Paramètres de trois ellipsoïdes







	Ellipsoïde

	Demi grand axe (a)

	Demi petit axe (b)

	Inverse de l’aplatissement





	Clarke 1866

	6 378 206.4 m

	6 356 583.8 m

	294.978698214



	GRS80

	6 378 137.0 m

	6 356 752.314140 m

	298.257222100



	WGS84

	6 378 137.0 m

	6 356 752.314245 m

	298.257223563






Entre l’ellipsoïde qui était utilisé en Amérique du Nord (Clarke 1866) et les deux utilisés actuellement à l’échelle globale, la différence est de moins de 100 m sur les deux axes. Quant aux deux ellipsoïdes GRS80 et WGS84 ils sont pour ainsi dire identiques, car seul leur petit axe diffère de moins de 1 cm. Une fois le système géodésique défini, il est possible de s’y positionner et d’y faire des traitements spatiaux.



Les coordonnées géographiques

Afin de se positionner sur un ellipsoïde, il faut définir un repère géographique avec deux axes d’origine, un pour les latitudes et un pour les longitudes (Fig. 143).


[image: Longitudes et latitudes]

Fig. 143 Coordonnées du point M en longitude (λ), latitude (φ) et hauteur par rapport à l’ellipsoïde (h).



Sur la figure Fig. 143, le point M peut se repérer par trois coordonnées : sa longitude, sa latitude et son altitude. La longitude, notée λ ou X, est la valeur de l’angle entre le méridien d’origine et le méridien de M. La longitude s’exprime en degrés ouest et est selon que le point se trouve à moins de 180° à l’ouest ou à l’est du méridien d’origine. La latitude, notée φ ou Y est la valeur entre le parallèle d’origine et la droite coupant perpendiculairement le méridien de M. Elle est exprimée en degrés nord ou sud par rapport au parallèle d’origine, entre 0° et 90° (correspondant aux Pôles). Enfin, l’altitude de M est l’écart, exprimé en mètres, entre M et le niveau de référence vertical à savoir le géoïde généralement.

L’axe d’origine pour les latitudes ne pose aucun problème, il s’agît de l”Équateur, ligne imaginaire coupant la Terre en deux hémisphères égaux. L’Équateur est également le parallèle le plus long, tous les autres rétrécissant vers les Pôles. Les parallèles 90° nord ou sud ne sont d’ailleurs plus que des points. Par contre, le méridien d’origine n’es pas aussi évident. En effet, tous les méridiens ont la même longueur et il n’est pas possible de définir des hémisphères est et ouest comme nous définissons les hémisphères nord et sud. Pendant longtemps, chaque pays utilisait son propre méridien d’origine passant généralement par sa capitale. Ainsi en France, le méridien de Paris était utilisé. Mais durant l’Antiquité, le point le plus à l’ouest connu, dans l’Atlantique à l’ouest du Détroit de Gibraltar, était utilisé. Ce n’est que lors de l”International Meridian Conference de 1884 [https://www.history.navy.mil/our-collections/photography/numerical-list-of-images/nhhc-series/nh-series/NH-96000/NH-96688.html] tenue à Washington aux États-Unis, que le méridien de Greenwich a été choisi comme le seul méridien d’origine (Fig. 144). Il était déjà utilisé par les anglais dont la flotte dominait alors les mers du globe. C’est en partie en raison de cette prédominance maritime anglaise que ce méridien a été choisi. Une petite mise à jour a été faite depuis cette date, et le méridien d’origine actuel passe 102 mètres plus à l’ouest que le méridien d’origine historique. Pour en savoir plus sur l’épopée du calcul des longitudes, vous pouvez vous référer au très bon livre de Dava Sobel [https://www.babelio.com/livres/Sobel-Longitude/2797s] intitulé Longitude.


[image: Équateur et Greenwich]

Fig. 144 L’Équateur faisant office de latitude 0° passant au travers d’un café en Ouganda (A) et matérialisation du méridien de Greenwich de longitude 0° (B).



Dans ce repère géographique constitué de méridiens, qui graduent la longitude, et de parallèles, qui graduent la latitude, il est possible de repérer tout point de la planète. L’arc entre deux méridiens est subdivisé en 60 portions égales, figurant 60 minutes. Puis chaque arc de minute est lui-même subdivisé en 60 portions égales, figurant 60 secondes. Il en est de même pour les latitudes.  Ainsi, par exemple la Place de l’Étoile Rouge à Cotonou [https://fr.wikipedia.org/wiki/Place_de_l%27%C3%89toile_rouge] au Bénin a pour coordonnées 6°22’17.1 »N 2°24’35.5 »E. Le long d’un méridien, un degré équivaut à peu près à 111.3 km. Une minute vaut alors 1.855 km, unité utilisée pour le mile nautique. Enfin, une seconde vaut à peu près 30 mètres. Pour les parallèles, ces valeurs ne sont valables que pour l’Équateur. La taille des parallèles diminuant à mesure que nous nous éloignons de l’Équateur, la taille de chaque subdivision diminue également. Certains parallèles présentent des propriétés astronomiques qui leur ont valu d’être identifés nommément (Fig. 145).


[image: Longitudes et latitudes]

Fig. 145 Les longitudes et les latitudes comme repère géographique et les parallèles notables.



D’un point de vue astronomique, l’Équateur est la ligne où la durée du jour, 12 heures, est toujours égale à la durée de la nuit, quel que soit la période de l’année. Les tropiques sont les parallèles extrêmes où le Soleil passe au zénith au moins un jour dans l’année, respectivement au solstice de juin pour le Tropique du Cancer et au solstice de décembre pour le Tropique du Capricorne. Entre les Tropiques et les Pôles, le Soleil ne sera jamais au zénith. Enfin, les cercles polaires sont les latitudes extrêmes où le Soleil disparaît sous l’horizon au moins pendant 24 heures. Cette disparation a lieu lors du solstice de juin côté Antarctique et lors du solstice de décembre côté Arctique.

En plus de ces coordonnées en longitude et latitude, la troisième composante du positionnement est l’altitude. L’altitude s’exprime en mètre et correspond à l’écart entre la surface topographique et un niveau de référence. Ce niveau de référence peut être la surface de l’ellipsoïde mais le plus souvent il s’agît de la surface du géoïde, appelée communément niveau de la mer (Fig. 146).


[image: Altitude et référentiel]

Fig. 146 Altitude et hauteurs par rapport à l’ellipsoïde.



D’un point de vue pratique, les coordonnées géographiques s’obtenaient à l’aide du sextant [https://www.maxisciences.com/sciences/sextant-decouvrez-en-plus-sur-cette-invention-qui-a-revolutionne-lhistoire-de-la-navigation_art50732.html], pour la latitude, du chronomètre de marine [https://www.hautehorlogerie.org/fr/watches-and-culture/connaissances-horlogeres/encyclopedie/chronometre-de-marine], pour la longitude et du baromètre [https://www.montre-cardio-gps.fr/altimetre-barometrique-ou-gps-les-differences/] pour les altitudes. Aujourd’hui ces trois composantes sont fournies par les systèmes globaux de positionnement par satellite, GNSS en anglais pour Global Navigation Satellite System. Il existe quatre systèmes actuellement, maintenus par quatre puissances géopolitiques différentes : GPS maintenu par les États-Unis, GLONASS (ГЛОНАСС) développé par l”Union Soviétique [https://i.pinimg.com/originals/ac/6f/62/ac6f625116a3b7385723897142b968db.jpg] et maintenu aujourd’hui par la Russie, Galileo opéré par l’Union Européenne et Beidu (北斗) maintenu par la Chine [https://www.youtube.com/watch?v=LxMtasUnYY8]. Ces quatre systèmes sont interopérables et utilisables par la plupart des récepteurs GPS et smartphones pour se localiser. La plupart des récepteurs GPS intègrent un modèle de géoïde ce qui permet d’obtenir l’altitude.

Néanmoins, ces coordonnées géographiques sont parfaites pour se positionner sur un globe en trois dimensions, mais ne sont pas idéales pour la cartographie ou la géomatique qui a besoin de se faire sur des surfaces en deux dimensions. Il est donc nécessaire de transformer cet ellipsoïde en un plan muni d’un nouveau repère en deux dimensions. Ce processus s’appelle une projection.




Les projections, éléments de définition

Pour passer de l’objet 3D ellipsoïde à l’objet 2D carte ou écran, nous utilisons une projection. La figure suivante (Fig. 147). récapitule la partie précédente et y place la projection.


[image: Du géoïde à la projection]

Fig. 147 De la Terre à la carte en passant par la projection.



Mettre à plat un ellipsoïde passe donc par un processus de projection présentant trois composantes :


	
	la nature de la projection :
	
	Conforme


	Équivalente


	Équidistante


	Aphylactique










	
	le type du plan de la projection :
	
	Cylindrique


	Conique


	Azimutal










	
	la position du plan de projection :
	
	Parallèle à l’Équateur (normale)


	Perpendiculaire à l’Équateur (transverse)


	Oblique












Ces différentes composantes sont détaillées dans la partie qui suit.


La nature des projections

Mathématiquement, il est impossible de projeter à plat une forme sphérique sans entraîner des déformations. Pour ce qui intéresse le monde de la géomatique, nous devons choisir entre conserver les surfaces et donc utiliser une projection équivalente ou conserver les formes, ce qui revient à conserver les angles, et donc utiliser une projection conforme. La figure suivante (Fig. 148) éclaire le propos en faisant varier un cercle en surface ou en forme selon la projection choisie. Sur cette figure, le cercle central est répété à l’identique vers les latitudes supérieures et inférieures. Le changement visible sur le cercle n’est dû qu’à la nature de la projection choisie.


[image: Déformations selon la projection.]

Fig. 148 La projection conforme conserve la forme du cercle mais pas sa taille (A) et la projection équivalente conserve sa taille mais pas sa forme (B).



Sur la projection conforme, le cercle reste un cercle mais il semble de plus en grand à mesure que nous nous éloignons de l’Équateur. Au contraire, sur la projection équivalente, le cercle conserve sa surface initiale mais il se déforme de plus en plus à mesure que nous nous dirigeons vers les Pôles. Pour se rendre compte de ce phénomène sur une carte du monde, il est possible d’utiliser les polygones de Tissot. C’est le même principe que les cercles mentionnés précédemment mais placés sur une carte du monde de projection donnée. Sur la figure suivante (Fig. 149) nous avons une carte du monde en projection de Mercator, sans doute la projection la plus célèbre. Il s’agît d’une projection conforme, sur laquelle les formes et les angles sont conservées mais pas les surfaces comme nous le montrent les polygones de Tissot placés sur cette projection. Sur cette projection, les terres au niveau de l’Équateur présentent une forme et une superficie proches de la réalité. Par contre, vers les Pôles la forme est conservée mais la superficie est extrêmement exagérée. Par exemple, le Groenland semble faire la taille de l’Amérique du Sud, alors qu’en réalité il est un peu plus petit que l’Algérie. Cependant cette projection est pratique pour la navigation car les angles, et donc les azimuts, correspondent aux angles réels.


[image: Projection de Mercator et polygones de Tissot.]

Fig. 149 Polygones de Tissot sur projection conforme de Mercator (à gauche) et le Monde en projection de Mercator (à droite).



Inversement, sur une projection équivalente le cercle perd sa forme de cercle mais conserve sa superficie sur toute la surface projetée. À mesure que nous nous éloignons du, ou des parallèles sécants au plan de projection un cercle se déforme de plus en plus mais conserve sa surface. La figure suivante (Fig. 150) est une carte du monde en projection équivalente de Behrmann. Sur cette projection, le plan de projection est sécant à l’ellipsoïde au niveau des parallèles 30°N et 30°S. Sur ces parallèles les cercles présentent donc une forme proche de la réalité puis se déforment à mesure qu’on s’en éloigne. Même si ils sont très déformés vers les hautes latitudes, leurs superficies sont conservées.


[image: Projection de Behrmann et polygones de Tissot.]

Fig. 150 Polygones de Tissot sur projection équivalente de Behrmann.



Il existe d’autres types de projections comme les projections équidistantes et les projections aphylactiques. Néanmoins ces projections sont peu utilisées en géomatique, et surtout utilisées pour des représentations cartographiques. La projection équidistante est centrée sur un point précis et conserve ensuite les longueurs entre le point central et tout cercle l’englobant. C’est une représentation qui peut être utilisée dans les cartographies des séismes. le point central est l’épicentre du séisme, puis nous avons des cercles concentriques autour de ce point indiquant les distances à l’épicentre. Dans un autre contexte, cette projection est utilisée pour cartographier les portées des missiles depuis une base de lancement. Les projections aphylactiques, quand à elles, ne conservent ni les formes ni les surfaces mais minimisent les deux erreurs. Quelque soit la nature de la projection, une carte peut se projeter selon des plans de projection de différents types.



Le type de plans de projection

Le plan de projection est une surface plane sur laquelle est projetée l’ellipsoïde. Ce plan de projection peut être de trois grands types différents.


	Plan cylindrique : ce plan est comme enroulé sous forme de cylindre puis positionné autour de l’ellipsoïde. Le cylindre peut être positionné avec des angles différents autour de l’ellipsoïde et peut simplement le toucher sur un seul cercle, ou bien le couper sur deux cercles. Dans le premier cas le plan est dit tangent et dans le second cas sécant. Le cylindre ne fera que toucher si son diamètre est égale à la circonférence terrestre et coupera si son diamètre est inférieur à la circonférence terrestre. Plus de précisions seront données dans les paragraphes qui suivent. Par exemple, les projections UTM sont des projections cylindriques sécantes.


	Plan conique : ce plan est enroulé sous forme de chapeau chinois puis posé sur l’ellipsoïde. Il peut être posé n’importe où, sous n’importe quel angle. Il peut simplement toucher l’ellipsoïde (plan tangent) sur un seul cercle ou couper l’ellipsoïde selon deux cercles (plan sécant). Si les deux cercles sécants sont des parallèles, nous parlons de parallèles automécoïques, nouveau mot qui permet de briller en société. Par exemple, la projection Lambert93 est une projection utilisant un plan conique sécant selon deux parallèles automécoïques.


	Plan azimutal : ce plan est laissé à plat et l’ellipsoïde est soit posé dessus soit coupé par ce plan. Si l’ellipsoïde est simplement posé, le contact entre l’ellipsoïde et le plan ne sera qu’un point mais si l’ellipsoïde est coupé par le plan, alors le contact entre les deux sera un cercle.




La figure suivante (Fig. 151) schématise les trois grands types de plans de projection pour des positions fixées. Sur cette figure les plans sont tous tangents mais il est possible d’avoir les mêmes projections avec des plans sécants.


[image: Types de plans de projection.]

Fig. 151 Les trois grands types de plans de projection.



Comme évoqué, les plans sont de types différents mais présentent également des positions différentes par rapport à l’ellipsoïde. Nous parlons alors de la position des plans de projection par rapport à l’ellipsoïde.



La position du plan de projection

Que le plan soit cylindrique, conique ou azimutal, sa position vis-à-vis de l’ellipsoïde peut varier. D’une manière générale le plan est tangent si il ne fait que toucher l’ellipsoïde et sécant si il le coupe. En plus de cette propriété, nous pouvons définir le plan par rapport à sa position vis-à-vis de l’Équateur. Si le plan touche ou coupe l’ellipsoïde parallèlement à l’Équateur, le plan est normal. Si le plan touche ou coupe l’ellipsoïde perpendiculairement à l’Équateur, le plan est transverse. Pour toute position ni parallèle ni perpendiculaire, le plan est oblique. Ces trois positions peuvent s’appliquer pour les trois types de plans, cylindrique, conique et azimutal. La figure suivante (Fig. 152) présente les trois positions possibles pour une projection cylindrique.


[image: Positions de plans de projection.]

Fig. 152 Positions du plan de projection pour une projection cylindrique. Le principe est le même pour une projection conique ou azimutale.



Au final, ces différentes caractéristiques se croisent pour former une projection proprement dite. Par exemple, la projection Lambert93 utilisée en France métropolitaine est une projection équivalente conique sécante. Le plan de projection est donc conique est coupe l’ellipsoïde selon deux parallèles automécoïques. Les projections UTM sont, quant à elles, des projections conformes cylindriques tangentes transverses (comme sur le schéma du milieu sur la figure précédente). La figure suivante (Fig. 153) présente deux vues du monde selon une projection normale et une projection transverse. Dans le premier cas les altérations sont minimales le long de l’Équateur et dans le second elles sont minimales le long du méridien de Greenwich.


[image: Monde en projection normale ou transverse.]

Fig. 153 Le monde vu en projection normale centrée sur l’Équateur sur une carte soviétique des années 1920 (A) et vu en projection transverse le long du méridien de Greenwich (B).



Par la suite seront présentées plus en détails quelques grands types de projections utilisées à l’échelle de la France, de l’Europe et du monde notamment par les données globales ou les images de télédétection.



Les codes EPSG

Les systèmes de coordonnées de références ont des noms officiels mais également des noms plus courts utilisés de façon plus simple. Par exemple, la zone UTM pour la longitude de Paris est la 31. Le nom complet du SCR de cette zone est WGS 84 / UTM zone 31N mais nous parlons couramment de Zone UTM 31 N. Mais il existe également une zone UTM 31 basée sur l’ancien ellipsoïde WGS1972. Afin de s’y retrouver plus facilement, un ancien consortium nommé European Petroleum Survey Group a proposé une codification des SCR en leur attribuant un code unique, appelée code EPSG. Ainsi, chaque SCR possède un code EPSG par lequel il est pratique de se référer dans les logiciels.




Quelques projections courantes

Nous verrons dans cette partie quelques projections et systèmes de coordonnées de référence (SCR) couramment employés en France, en Europe et pour les données globales. Le tableau suivant récapitule les principaux systèmes de coordonnées de référence utilisés dans le contexte français.


Tableau 10 Codes EPSG de quelques SCR







	Système de coordonnées

	Code EPSG

	Type de projection

	Domaine de validité





	RGF93/Lambert93

	2154

	Conforme

	France métropolitaine



	LAEA/ETRS89

	3035

	Équivalente

	Europe



	WGS84 / UTM 30N

	32630

	Conforme

	6°W and 0°W



	WGS84 / UTM 31N

	32631

	Conforme

	0°E et 6°E



	WGS84 / UTM 32N

	32632

	Conforme

	6°E et 12°E



	WGS84

	4326

	Non projeté

	Monde



	WGS84 / Pseudo Mercator

	3857

	Conforme

	Monde



	WGS 84 / Equal Earth Greenwich

	8857

	Équivalente

	Monde






Le SCR WGS84 (4326) est un système non projeté à l’échelle globale dont les unités sont des degrés. Par contre, le SCR WGS84 / Pseudo Mercator (3857) est une projection cylindrique normale conforme, également utilisable à l’échelle globale, et ses unités sont donc des mètres. Cette projection est notamment utilisée par les services de webmapping mondiaux comme GoogleMaps et OpenStreetMap.


Pour la France

En France métropolitaine, depuis 2000, la projection officielle est le Lambert 93, basé sur le RGF93 (Réseau Géodésique Français 93). Le nom complet du SCR est donc RGF93/Lambert93. Le code EPSG de ce SCR est le 2154. Cette projection est conique conforme sécante. Le plan de projection est donc de forme conique et est sécant à la surface de la Terre. De plus, étant conforme, cette projection conserve les formes mais pas les surfaces. Ainsi, la France aura sa vraie forme mais pas sa vraie surface. Cependant, la déformation est minime car elle est de l’ordre de 3m/km aux extrémités du domaine d’application [http://www.geomag.fr/sites/default/files/68_91.pdf]. Concrètement, la déformation est de 2m/km à Dunkerque et de 3m/km à Bonifacio. Comme indiqué par l’IGN [https://geodesie.ign.fr/contenu/fichiers/Lambert93_ConiquesConformes.pdf], le Lambert93 présente les paramètres du tableau suivant.


Tableau 11 Principaux paramètres de la projection Lambert 93





	Paramètre

	Valeur





	Ellipsoïde de référence

	GRS80



	Type de projection

	Conique Conforme directe sécante



	Zone d’application

	41° - 51° Nord



	Méridien central

	3° Est



	Latitude origine

	46°30’Nord



	Décalage est (False easting)

	700 000 m



	Décalage nord (False northing)

	6 600 000 m



	Premier parallèle automécoïque

	44°N



	Second parallèle automécoïque

	49°N






Le méridien central est le méridien sur lequel le cône de projection est centré. Le méridien 3° Est correspond à peu près au méridien qui coupe la France en deux parties égales dans le sens de la hauteur. La latitude origine est à peu près la latitude qui coupe la France en deux parties égales dans le sens de la largeur. Comme le Lambert93 est une projection, nous nous retrouvons sur un plan en deux dimensions qui dispose d’une origine arbitraire. Cette origine est positionnée très loin de la France, quelque part dans le Golfe de Guinée, comme présenté sur la figure suivante (Fig. 154).


[image: Le repère de la projection Lambert93.]

Fig. 154 L’origine du repère utilisé dans la projection Lambert 93.



Le point d’origine (0,0) du repère de la projection Lambert 93 se situe à 700 000 m à l’ouest du méridien central de la projection (le méridien 3° E) et à 6 600 000 m au sud de la latitude origine 46°30’N. Autrement dit, le point d’intersection entre le méridien central et la latitude origine se trouve à 700 000 m à l’ouest du point d’origine (False easting) et à 6 600 000 m au sud (False northing) du point d’origine. Ce fort décalage a été choisi pour clairement différencier le Lambert 93 d’autres projections françaises utilisées par le passé. Au final, si nous recentrons le repère sur la France, nous obtenons la figure suivante (Fig. 155).


[image: La France dans la projection Lambert93.]

Fig. 155 La France représentée dans la projection Lambert 93.



Ainsi, tout point du territoire présente des coordonnées comprises entre 100 000 m et 1 300 000 m en latitude et 6 000 000 m et 7 000 000 en longitude. Nous retrouvons bien les 1000 km (1 000 000 m) d’envergure nord-sud et est-ouest du territoire français. Par exemple, le bâtiment de la Halle aux Farines de l’Université Paris Cité [https://www.geoportail.gouv.fr/carte?c=2.381454224423593,48.82939927639973&z=19&l0=ORTHOIMAGERY.ORTHOPHOTOS::GEOPORTAIL:OGC:WMTS(1)&permalink=yes] dans le 13ème arrondissement de Paris a pour coordonnées en Lambert 93 X : 654 612.688 m et Y : 6 858 969.046 m. Si à partir de ces coordonnées nous nous déplaçons de 100 m plein est, nous nous retrouvons au point de coordonnées X : 654 712.688 m et Y : 6 858 969.046 m. De même si nous nous déplaçons de 100 m plein nord, nous nous retrouvons au point de coordonnées X : 654 612.688 m et Y : 6 859 069.046 m. Enfin, les parallèles automécoïques sont les parallèles sur lesquels le cône de projection est sécant à la surface terrestre (Fig. 156). Les erreurs de surface sont minimales le long de ces deux parallèles.


[image: Exemple de parallèles automécoïques.]

Fig. 156 Représentation en 2 dimensions du concept de parallèles automécoïques.




Astuce

QGIS propose un petit outil de visualisation pour vérifier l’étendue de validité d’un SCR. Cet outil s’affiche dès que vous souhaitez régler un SCR. Par exemple, même si vous ne savez pas à priori quelle portion du globe est couverte par la projection Pulkovo 1942 / Gauss-Kruger zone 27, vous pouvez voir dans l’outil dédié, que cette projection est valable pour le Kamtchatka.


[image: _images/fig_proj_kamtchatka.png]





Pour l’Europe

L’Union Européenne a défini une projection officielle à utiliser pour les données à l’échelle de l’Europe. Il s’agît de la projection ETRS89-LAEA pour European Terrestrial Reference System 1989 - Lambert Azimuthal Equal Area. Il s’agit donc d’une projection azimutale équivalente. Sur cette projection, les contours sont déformés mais les surfaces sont respectées. Le caractère équivalent de cette projection a été choisi pour pouvoir cartographier des phénomènes en lien avec les surfaces. C’est notamment le cas de tout ce qui est densité : densité de population, rendement agricole, densité de cheptel… Les principaux paramètres de cette projection sont résumés dans le tableau suivant. Le code EPSG de cette projection est le 3035.


Tableau 12 Principaux paramètres de la projection ETRS89





	Paramètre

	Valeur





	Ellipsoïde de référence

	GRS80



	Type de projection

	Azimutal



	Zone d’application

	Europe



	Méridien central

	10° Est



	Latitude origine

	52° Nord



	Décalage est (False easting)

	4 321 000 m



	Décalage nord (False northing)

	3 210 000 m






Sur cette projection, les déformations sont minimales à l’intersection du méridien 10 °E et du parallèle 52°N, puis s’accroissent à mesure que nous nous éloignons de ce point dans toutes les directions. L’Europe prend alors un air arrondi (Fig. 157).


[image: L'Europe dans la projection ETRS89.]

Fig. 157 L’Europe dans la projection ETRS89.





Pour le monde par zones UTM

À l’échelle globale, i.e. à l’échelle du monde, nous pouvons utiliser les projections en Zones UTM pour Universal Transverse Mercator. Il s’agît d’une projection cylindrique transverse conforme. Le plan de projection est donc un cylindre posé perpendiculairement à l’Équateur et tangent à la Terre selon un méridien central (Fig. 158). Nous parlons de zones UTM car il s’agit en fait d’un corpus de 60 projections suivant le même principe. Le globe terrestre, mesurant par définition 360° de circonférence, a été divisé en 60 zones de 6° de largeur chacune, numérotées de 01 à 60. Chaque zone peut être perçue comme une sorte de quartier de Terre, comme les différents quartiers d’une orange. Pour chaque zone, un méridien central coupant la zone en deux parties égales est défini et le cylindre de projection est positionné sur ce méridien. Puis, pour la zone suivante, le cylindre est pivoté de 6° et tombe ainsi sur le méridien central de la zone suivante, et ainsi de suite 60 fois. Comme il s’agît d’un type de projection conforme, les formes sont respectées mais pas les surfaces. Les images Landsat et Sentinel-2 sont notamment fournies dans ces projections.


[image: Le principe des zones UTM.]

Fig. 158 Les 60 zones UTM (à gauche) et le cylindre de projection transverse utilisé pour chaque zone (à droite). Le méridien en rouge est le méridien le long duquel le cylindre est tangent à la surface terrestre.



Les 60 zones sont numérotées d’ouest en est avec la zone 01 positionnée sur la pointe extrême orientale de l’Eurasie. Ces zones sont ensuite chacune divisées en deux : une zone au nord de l’Équateur et une zone au sud de l’Équateur (Fig. 159). Nous parlons ainsi de zones UTM Nord et Sud. Par exemple, Paris se trouve sur la zone UTM 31 N et Hobart [https://www.openstreetmap.org/search?query=hobart+australie#map=7/-41.968/147.711] (Tasmanie, Australie) sur la zone UTM 55 Sud.


[image: Les 60 zones UTM Nord et Sud.]

Fig. 159 Le découpage en 60 zones UTM de 6° d’est en ouest et subdivisées en nord et sud.



La France métropolitaine tombe sur trois zones UTM : 30, 31 et 32 Nord. La Bretagne est sous la zone 30 N, l’Îlde-de-France sous la zone 31 N et la Corse sous la 32 N (Fig. 160). Les codes EPSG de ces trois projections sont respectivement 32630, 32631 et 32632.


[image: Les 3 zones UTM de la France.]

Fig. 160 La France sous les zones UTM 30N, 31N et 32N.




Astuce

Il est facile de retrouver les codes ESPG des zones UTM. Les 120 zones (60 Nord et 60 Sud) ont toutes un code EPSG à 5 chiffres commençant par 32. Le troisième chiffre est un 6 pour les zones Nord et un 7 pour les zones Sud. Enfin, les deux derniers chiffres correspondent au numéro de la zone, de 01 à 60. Ainsi, la zone UTM 31 Nord a pour code 32631 et la zone UTM 22 Sud a pour code 32722.



Le tableau suivant présente les principaux paramètres de la projection UTM 32 Nord. Ces paramètres seront tout à fait identiques pour toutes les zones UTM de l’hémisphère nord à l’exception du méridien central qui changera de 6° en 6° et de la zone d’application.


Tableau 13 Principaux paramètres de la projection UTM 32 Nord





	Paramètre

	Valeur





	Ellipsoïde de référence

	WGS84



	Type de projection

	Cylindrique



	Zone d’application

	De 6°E à 12°E



	Méridien central

	9° Est



	Latitude origine

	0° Nord



	Décalage est (False easting)

	500 000 m



	Décalage nord (False northing)

	0 m






Nous remarquons la présence d’un false easting qui décale l’origine du repère de projection à l’ouest du méridien central, ce qui permet de n’avoir que des coordonnées en X positives. Par contre le false northing est égal à O car l’Équateur reste l’origine de la projection. Comme nous sommes sur l’hémisphère nord, en nous éloignant vers le nord dans cette projection nous restons de toute façon en coordonénes Y positives. Par contre, comme montré dans le tableau suivant présentant les paramètres de la projection UTM 32 Sud, nous remarquons un false northing défini à 10 000 000 m. En effet, sans ce false easting nous aurions à faire à des coordonnées Y négatives au fur et à mesure que nous nous éloignons de l’Équateur vers le sud.


Tableau 14 Principaux paramètres de la projection UTM 32 Sud





	Paramètre

	Valeur





	Ellipsoïde de référence

	WGS84



	Type de projection

	Cylindrique



	Zone d’application

	De 6°E à 12°E



	Méridien central

	9° Est



	Latitude origine

	0° Nord



	Décalage est (False easting)

	500 000 m



	Décalage nord (False northing)

	10 000 000 m







Avertissement

Les images Landsat de l’hémisphère sud ne sont pas fournies en projection zones UTM Sud, contrairement à ce qu’il serait rigoureux de faire. Elles sont toutes fournies en zones UTM Nord [https://www.usgs.gov/faqs/why-do-landsat-scenes-southern-hemisphere-display-negative-utm-values], ce qui engendre des coordonnées Y négatives. Dans la plupart des cas cela ne pose aucun problème pour l’affichage et les traitements mais peut être à l’origine de surprises si les images sont croisées à des couches en zones UTM Sud.





Pour le monde

Lorsqu’il est nécessaire de représenter des données à l’échelle globale dans leur entièreté, en mode carte du monde, le système de coordonnées de référence WGS84 est couramment utilisé, dont le code EPSG est 4326. Il ne s’agît pas d’une projection, mais d’un système géographique non projeté. Dans ce système, les coordonnées ne sont pas en mètres (comme pour les projections vues plus haut) mais sont en degrés de longitude et latitude. En gros, dans ce système nous sommes à la surface de l’ellipsoïde WGS84. Les longitudes et latitudes peuvent être exprimées en degrés, minutes et secondes, mais également en degrés décimaux. Il est facile de passer de l’un à l’autre et des convertisseurs existent [https://www.rapidtables.org/fr/convert/number/degrees-minutes-seconds-to-degrees.html]. Par définition, dans 1 degré d’angle il y a 60 minutes d’angle et dans 1 minute d’angle il y a 60 secondes d’angle. Ainsi, dans 1 degré il y a 3600 secondes d’angle (\(60 \times 60\)). Nous pouvons donc facilement convertir la coordonnée suivante en degrés, minutes, secondes : 42°33’56”” par le calcul qui suit :


\[42 + 33 \times \frac{1}{60} + 56 \times \frac{1}{3600}\]

Ce qui nous donne une coordonnée en degré décimal de 42.565555.

La plupart des données à l’échelle globale produites par différentes institutions sont fournies dans ce système de coordonnées.


Avertissement

Si nous calculons des superficies en restant dans ce SCR, nous obtenons non pas des mètres carrés mais des degrés carrés, ce qui n’est pas évident à se représenter…



Si nous souhaitons travailler en mode projeté à l’échelle globale, il existe une projection conforme, qui ne respecte donc pas les surfaces (Fig. 161), utilisée notamment par GoogleMaps et OpenStreetMap. Il s’agit de la projection WGS84 / Pseudo Mercator, dont le code EPSG est 3857. C’est une projection cylindrique conforme et tangente à l’Équateur. Le point d’origine est le point d’intersection entre l’Équateur et le méridien de Greenwich sans false eastin ni false northing. Les points se situant dans le quart nord-est de cette projection auront des coordonnées X et Y positives, mais partout ailleurs, au moins une des deux coordonnées sera négative. Comme sur une projection de Mercartor classique, les régions polaires sont très exagérées, mais leurs contours respectent la réalité.

Par contre, si une projection équivalente est nécessaire, à l’échelle globale, il est possible d’utiliser la projection WGS 84 / Equal Earth Greenwich de code EPSG 8857. Les continents seront alors de plus en déformés à mesure que nous nous éloignons de l’Équateur, mais les surfaces seront préservées. Il peut être judicieux d’utiliser cette projection pour représenter des phénomènes se rapportant aux surfaces comme des densités de population ou des rendements agricoles.


[image: Le monde représenté dans trois SCR.]

Fig. 161 Une représentation des pays du monde dans trois SCR différents : WGS84 non projeté (A), la projection conforme WGS84 / Pseudo Mercator utilisée par GoogleMaps ou OpenStreetMap (B) et la projection équivalente WGS84 / Equal Earth Greenwich (C) à privilégier pour les représentations cartographiques faisant intervenir des surfaces.






Implications dans les SIG et en télédétection


Sur le calcul des surfaces

Ces aspects théoriques ont des implications concrètes et directes sur les calculs que nous pouvons faire sur des couches utilisées dans un SIG. L’implication la plus forte a lieu sur le calcul des superficies pour une couche vecteur de type polygones. Pour un même polygone, les résultats seront différents selon que la superficie est calculée sur l’ellipsoïde (donc prenant en compte la courbure de la Terre), ou sur la projection. De plus, selon la nature conforme ou équivalente de la projection le calcul donnera des résultats différents. Le tableau suivant résume la superficie de la France calculée dans différents SCR.


Tableau 15 La superficie de la France dans différents SCR






	Référentiel

	Nature

	Superficie (km2)





	Sur l’ellipsoïde

	
	548 702,564



	Lambert 93

	Conforme

	548 411,411



	WGS84/UTM 31N

	Conforme

	548 894,166



	ETRS89

	Équivalente

	548 702,521



	WGS84 / Pseudo Mercator

	Conforme

	1 163 480,151



	WGS84 / Equal Earth Greenwich

	Équivalente

	548 702,581



	WGS84

	Non projeté

	64 degrés carrés






La superficie la plus proche de la réalité est la première du tableau, celle calculée en mètres carrés directement sur l’ellipsoïde, donc en prenant en compte la courbure de la Terre. De façon logique, les superficies calculées sur des projections équivalentes conservant les surfaces se rapprochent grandement de cette valeur. Par exemple, les superficies calculées sur les projections ETRS89 et WGS84 / Equal Earth Greenwich (toutes deux équivalentes) donnent des superficies identiques au kilomètre carré près à la superficie calculée sur l’ellipsoïde. Par contre, sous le kilomètre carré, il y a tout de même un effet distorsion inhérent à la projection utilisée. Dans le même esprit, les superficies calculées sur des projections conformes ne conservant pas les surfaces donnent des résultats qui s’éloignent de la réalité. Néanmoins, même si la projection Lambert 93 est conforme, l’écart est faible car le Lambert 93 est vraiment fait pour la France. Par contre, dans la projection conforme Pseudo Mercator, la superficie de la France est extrêmement exagérée. Dans cette projection, la France mesure près du double de la réalité. Enfin, nous pouvons calculer la superficie de la France en degrés carrés, si nous souhaitons utiliser les unités géographiques (possible mais peu pertinent…)



Quelle fonction choisir pour calculer des surfaces ?

Pour calculer des superficies dans les logiciels de SIG ou les librairies géospatiales des langages de programmation, nous faisons appel à différentes fonctions. Ces fonctions ont des comportements différents qui peuvent être modifiés en changeant leurs paramètres. Il est nécessaire de savoir ce que fait chaque fonction afin de pouvoir exploiter ses résultats de superficies. Le tableau suivant répertorie le comportement de quelques fonctions couramment utilisées dans différents outils.


Tableau 16 Méthode de calcul de superficies selon différents outils







	Outil

	Fonction

	Paramètre

	Méthode





	QGIS

	$area

	
	Selon l’ellipsoïde



	QGIS

	area(@geometry)

	
	Selon la projection



	R

	terra::expanse

	transform=TRUE (1)

	Selon l’ellipsoïde



	R

	terra::expanse

	transform=FALSE

	Selon la projection







	Le paramètre transform de terra::expanse est mis à TRUE par défaut.




Au final, souvent par défaut dans QGIS nous utilisons la fonction $area et dans R avec terra nous utilisons expanse. Dans les deux cas, les superficies sont calculées le long de l’ellipsoïde et ne prennent donc pas en compte la projection. Ainsi, même si nous disposons d’une couche en projection conforme, Mercator par exemple, sur laquelle les entités sont largement déformées en taille, nous obtiendrons des superficies correctes en utilisant ces fonctions par défaut.



Implications sur les rasters

Même si nous y pensons moins immédiatement, ces questions de projections ont des implications sur les traitements rasters. En effet, tout comme les données vecteurs, les rasters sont géoréférencés dans un système de coordonnées de référence, qui peut être non projeté (comme le WGS84) ou projeté dans une projection conforme ou équivalente. Par exemple, le modèle numérique de terrain global SRTM est fourni non projeté en WGS84 et présente donc une résolution spatiale exprimée en degrés. De leurs côtés, les images satellites Landsat ou Sentinel-2 sont fournies projetées dans le système UTM. Or les projections UTM sont des projections conformes, qui ne conservent donc pas les surfaces.

Par exemple, les capteurs à bord des satellites Landsat ont une résolution spatiale de 30 m. Ils sont donc capables de distinguer au mieux des portions de surface terrestre de 30 mètres sur 30 mètres. Les images sont fournies à la résolution du capteur, donc sous formes de rasters présentant des pixels de 30 m de côté (Fig. 162).


[image: Informations spatiales d'un raster Landsat.]

Fig. 162 Informations spatiales d’un raster de bande spectrale Landsat. Le SCR est WGS 84 / UTM zone 31N avec une résolution de 30 m sur 30 m.



Cependant, comme la projection UTM est conforme, elle ne conserve pas les surfaces. Ainsi, les pixels ne représentent pas en réalité 900 m2 de territoire. Sur la figure suivante (Fig. 163), nous avons une mosaïque de quatre images Landsat (des paths and row 197-35 aux 194-35) sur le nord de l’Algérie. Ces quatre rasters s’étalent sur la totalité de la zone UTM 31 Nord. Comme toutes les projections UTM, celle-ci est une projection conforme transverse donc centrée sur un méridien central, qui est le méridien 3°E (en rouge sur la figure Fig. 163).


[image: Mosaïque Landsat zone UTM 31N.]

Fig. 163 Mosaïque de quatre tuiles Landsat recouvrant la zone UTM 31 N qui a pour méridien central le 3°E (en rouge).



Dans cette projection, chaque pixel de cette mosaïque mesure 30 m sur 30 m. Cependant, il est possible de calculer la superficie réelle de chaque pixel directement sur l’ellipsoïde. Cette manipulation peut se faire, par exemple, avec la fonction cellsize de la librairie terra de R. En sortie, nous obtenons un raster où la valeur de la superficie de chaque pixel, en mètres carrés, est directement associée à chaque pixel (Fig. 164).


[image: Superficie réelle de chaque pixel.]

Fig. 164 Superficie réelle (le long de l’ellipsoïde) de chaque pixel de la mosaïque Landsat.



Sur ce raster, les pixels directement sous le méridien 3°E, utilisé comme méridien central de la projection UTM 31N, ont logiquement une superficie très proche de 900 m2 mais tout de même légèrement supérieure (900.7203 m2). Plus nous nous éloignons de ce méridien central, à l’est et à l’ouest, plus la superficie réelle des pixels s’éloigne des 900 m2. En bordure de la zone, les pixels ne mesurent plus que 898 m2. La différence est faible mais il est intéressant de regarder l’effet sur des surfaces plus grandes qu’un pixel. Par exemple, sur la figure suivante (Fig. 165), nous avons extrait tous les pixels dont la valeur est supérieure à 0.38. Ces pixels sont représentés en rouge.


[image: Pixels supérieurs à 0.38.]

Fig. 165 Extraction des pixels dont la valeur est supérieure à 0.38 (en rouge).



Nous trouvons 23 386 234 pixels dont la valeur est supérieure à 0.38. Dans la projection du raster, chaque pixel mesure 900 m2. L’ensemble des pixels extraits recouvrent donc 21 047.61 km2 selon la projection. Par contre, ces mêmes pixels, le long de l’ellipsoïde, recouvrent 21 053.28 km2, soit une différence de 5.66 km2. Cette différence est certes faible mais tout de même éloignée de zéro.

Si nous souhaitons que les résolutions des pixels correspondent réellement à leurs superficies, il faut projeter nos rasters dans des projections équivalentes. Par exemple, si nous projetons notre mosaïque dans la projection WGS84 / Equal Earth Greenwich (EPSG 8857), la résolution des pixels est de 29.35782 m de côté. Sur ce raster reprojeté, nous trouvons 23 916 148 pixels ayant une valeur supérieure à 0.38, représentant ainsi une superficie de 20 612,88 km2 sur la projection. Or, si nous calculons la superficie de ces pixels supérieurs à 0.38 sur l’ellipsoïde nous trouvons également 20 612,88 km2. La projection équivalente conserve donc bien la superficie de chaque pixel.


Astuce

Si nous souhaitons calculer une superficie sur un raster en multipliant un nombre de pixels par la résolution d’un pixel, il est plus juste de le faire si notre raster est dans une projection équivalente.






Géoréférencement

Une des façons de créer des données est de digitaliser manuellement des informations à partir d’une carte ou de tout autre document géoréférencé comme une photographie aérienne. Dans cette section nous allons voir comment passer d’une carte papier scannée à une carte géoréférencée exploitable dans un logiciel SIG.

Lorsque nous disposons d’en document scanné, nous disposons d’un fichier raster (une image composée de pixels) mais ne présentant aucune information spatiale. Chaque pixel est caractérisé par une couleur mais pas par un couple de coordonnées. Le processus de géoréférencement permet d’attribuer à chaque pixel du document un couple de coordonnées X et Y. A la fin du processus nous obtenons le même raster qu’au départ mais exploitable dans un logiciel de SIG.

Le principe est de repérer visuellement sur la carte des points dont les coordonnées sont connues. Ces points seront appelés points d’ancrage ou points d’amer. Ensuite, manuellement nous indiquons au logiciel pour chacun de ces points les coordonnées correspondantes. Une fois un certain nombre de points ainsi renseignés, le logiciel se chargera de faire une interpolation entre ces points pour attribuer à tout pixel de l’image un couple de coordonnées. En fonction de la qualité du document, de la précision de l’opérateur, et de la précision des coordonnées initiales, le document final sera forcément imparfait et plus ou moins déformé. Mais il sera exploitable.

La question centrale est de bien choisir les points d’ancrage. Dans le cas d’un scan d’une carte topographique, il est facile de s’appuyer sur le quadrillage en longitudes et latitudes que ce type de cartes présentent généralement. Il faudra simplement être attentif au système de coordonnées présentées sur la carte.

Dans le cas de cartes anciennes ou de photographies aériennes, un tel quadrillage n’est pas indiqué. Tout l’art consistera dans ce cas à repérer des points reconnaissables dont on pourra trouver les coordonnées par ailleurs. Par exemple, si nous reconnaissons une intersection de routes ou un bâtiment emblématique comme un pont ou un clocher, nous pouvons nous en servir comme points d’ancrage. Il suffira de repérer sa position sur une source annexe comme Open Street Map.


Note

Le processus de géoréférencement sera beaucoup utilisé par certains et jamais par d’autres. Ce processus demande précision, concentration et méticulosité. Géoréférencer un document peut être long et fastidueux.




Géoréférencer un document dans QGIS

QGIS possède un menu de géoréférencement simple à prendre en mains. Dans cet exemple, nous allons géoréférencer une carte topographique scannée. Il s’agît d’une carte soviétique de la fin des années 1980 relevée pour la région de Kaliningrad [https://www.openstreetmap.org/relation/1674442#map=12/54.7056/20.4716]. La carte scannée est disponible sur cette page [https://maps.vlasenko.net/smtm200/n-34-09.jpg].

Le menu de géoréférencement se trouve dans le menu Raster ‣ Géoréférencer… ou le menu Couche ‣ Géoréférencer…, selon la version de QGIS. La fenêtre suivante apparaît (Fig. 166).


[image: alternate text]

Fig. 166 Menu de géoréférencement.



Nous ajoutons le raster à géoréférencer en cliquant sur l’icône Ouvrir un raster… [image: icone-charger-raster]. La carte apparaît alors dans le panneau central. Nous pouvons naviguer et zoomer / dézoomer à l’aide des icônes de navigation [image: icone-georef-navigation]. Nous pouvons maintenant passer à la définition des points d’ancrage.


Astuce

Combien de points d’ancrage faut-il définir pour obtenir un résultat correct ? La question n’a pas de réponse absolue. Dans le cas d’un document moderne comme une carte topographique, un minimum de quatre points (comme les quatre angles par exemple) pourra faire l’affaire. Dans le cas d’une carte ancienne, il en faudra beaucoup plus pour palier le mieux possible aux déformations inhérentes aux processus. Une dizaine sera bien. La difficulté consiste à trouver des points d’ancrage dont on est sûrs.



Dans notre cas, nous nous appuierons sur la quadrillage des coordonnées. Premièrement nous relevons le système de coordonnées employée sur cette carte. En zoomant sur un coin, nous nous apercevons qu’il s’agit d’un système global en degrés, minutes et secondes. Même les soviétiques se référaient au méridien de Greenwich, nous sommes donc dans le système global WGS84 (EPSG 4326). Lorsque nous zoomons sur le coin supérieur gauche, nous voyons les coordonnées suivantes (Fig. 167).


[image: alternate text]

Fig. 167 Coordonnées du coin supérieur gauche.



Le coin supérieur gauche de la carte a ainsi pour coordonnées 55°20’00”” Nord et 20°00’00”” Est. Nous repérons de la même façon les coordonnées des quatre coins (Fig. 168).


[image: alternate text]

Fig. 168 Les quatre points d’ancrage.



Pour récapituler nous obtenons le tableau suivant.








	Point

	Latitude

	Longitude





	P1

	55°20’00””

	20°00’00””



	P2

	55°20’00””

	21°00’00””



	P3

	54°40’00””

	21°00’00””



	P4

	54°40’00””

	20°00’00””






Maintenant que nous avons relevé les coordonnées de nos points d’ancrage, nous allons les sélectionner sur notre scan et renseigner leurs coordonnées. Nous commençons par zoomer sur le premier point, nous retombons sur la figure vue précédemment. Nous allons ajouter un point à cette intersection en cliquant sur l’icône Ajouter un point [image: icone-add-point]. Le curseur devient une croix et nous cliquons, le plus précisément possible, sur l’intersection des deux lignes du quadrillage.

Une fenêtre apparaît dans laquelle il nous est demandé de renseigner les coordonnées du point sélectionné (Fig. 169).


Avertissement

Il faut d’abord renseigner la longitude (champ X) puis la latitude (champ Y). Comme indiqué dans le texte explicatif de la fenêtre, les coordonnées doivent être entrées comme suit : degrés minutes secondes (dd mm ss.ss).




[image: alternate text]

Fig. 169 Les coordonnées du premier point d’ancrage.




Astuce

Dans le cas de la définition d’un point d’ancrage par comparaison avec une donnée existante géoréférencée, il est possible d’utiliser l’outil Depuis le canevas de la carte disponible sur la fenêtre précédente. Il suffirait alors de cliquer sur le point d’ancrage sur le document géoréférencé de comparaison préalablement chargé dans QGIS.



Une fois ce premier point défini et enregistré en cliquant sur OK, nous répétons l’opération pour les trois points suivants. Une fois la démarche effectuée pour tous les points, le tableau récapitulatif suivant s’affiche en bas de la fenêtre (Fig. 170).


[image: alternate text]

Fig. 170 Tableau récapitulatif des points d’ancrage.



Ce tableau présente plusieurs informations :


	ID : un simple identifiant unique pour chaque point.


	Source X : la coordonnée X du point mais dans le référentiel image dont l’origine est le point supérieur gauche. Par exemple, ici le point 0 se trouve à 205.065 pixels à droite du bord gauche de l’image.


	Source Y : la coordonnée Y du point dans le référentiel image. Par défaut, les coordonnées Y sont négatives.


	Destination X : la coordonnée géographique X du point telle qu’indiquée par l’utilisateur. Elle est exprimée en degrés décimaux.


	Destination Y : la coordonnée géographique X du point telle qu’indiquée par l’utilisateur, exprimée également en degrés décimaux.




Les trois autres colonnes seront remplies par la suite.

Nous allons maintenant passer au processus de géoréférencement proprement dit. Pour cela nous allons dans le menu Paramètres ‣ Paramètres de transformation…. La fenêtre suivante apparaît (Fig. 171).


[image: alternate text]

Fig. 171 Paramétrage du géoréférencement.



Dans le champ Type de transformation nous sélectionnons la façon dont l’interpolation sera effectuée. Ici par exemple nous choisissons Thin plate spline. Dans le champ Méthode de rééchantillonnage, nous pouvons choisir une méthode « lissante » comme Cubic spline. Dans le champ SCR, nous spécifions le système de coordonnées des coordonnées que nous avons entrées. Il s’agît ici du WGS 84 (EPSG 4326). Dans le champ Raster de sortie, nous spécifions le chemin et le nom du raster géoréférencé qui sera produit. Si nous le souhaitons, nous pouvons générer un rapport qui fera un état des lieux sur la qualité du géoréférencement. Nous pouvons également cocher la case Charger dans QGIS lorsque terminé afin d’afficher automatiquement le raster produit.

Une fois ces paramètres renseignés et après avoir cliqué sur OK, nous revenons à la fenêtre principale du module de géoréférencement. Pour lancer le processus, nous cliquons sur l’icône Débuter le Géoréférencement [image: icone-georef-lancer].


Astuce

Il est possible de générer la commande GDAL sous jacente à ce processus de géoréférencement dans le menu Fichier ‣ Générer un script GDAL. Il s’agira alors d’une commande au format texte qu’un utilisateur averti pourra réutiliser et modifier.



Une fois le processus achevé, le raster géoréférence apparaît dans QGIS. Il a été déformé lors de la manipulation, ce qui est normal. Pour s’assurer du bon déroulement du processus, il est possible d’afficher en fond les images Google Earth par exemple et de mettre en transparence le raster produit (Fig. 172).


[image: alternate text]

Fig. 172 Superposition de la carte géoréférencée et du fond Google Earth.



Visuellement le résultat semble tout à fait satisfaisant. Maintenant, nous pouvons nous intéresser à une question scientifique du type Le trait de côte de cette région a-t-il évolué depuis la fin des années 1980 ? ou Le réseau routier s’est-il densifié ici où là ? …

Nous pouvons quantifier la qualité du processus en regardant les résultats quantitatifs se trouvant dans le rapport PDF que nous avons sorti. Nous y retrouvons le tableau présenté plus haut dans lequel les colonnes de résidus ont été mises à jour. Dans l’idéal, les résidus devraient être égaux à 0. Dans notre cas ils sont très faible, nous pouvons être satisfaits des résultats.


Avertissement

Nous avons vu qu’il est nécessaire de définir un type de transformation et une méthode de rééchantillonnage. Nous pouvons nous poser la question légitime de quelles méthodes choisir. Il n’y a pas de réponse absolue, le choix effectué ici donne empiriquement de bons résultats, mais c’est à l’utilisateur de tester différentes méthodes si les résultats ne sont pas satisfaisants.






Changement de Système de Coordonnées de Référence

Par changement de système de coordonnées nous entendons le fait de changer le système de coordonnées de références (SCR) associé à un fichier. Nous le faisons passer d’un système de coordonnées A vers un système de coordonnées B. Ce procédé est souvent appelé reprojection. C’est une manipulation de base car il est généralement conseillé de ne travailler que dans un seul système de coordonnées au sein d’un projet géomatique. Cette manipulation n’est cependant pas anodine car elle va forcément déformer la donnée initiale. Il est évidemment nécessaire de choisir un système pertinent vis-à-vis de sa zone d’étude mais aussi selon les données mobilisées. Par exemple, si vous travaillez sur une région de France métropolitaine et que vous manipulez des données vecteurs « officielle », comme un découpage administratif fourni par l’IGN par exemple, travailler en Lambert 93 serait pertinent. Par contre, si vous mobilisez également des données Landsat dans votre projet, vous aurez ces images satellites en UTM. Dans ce cas, même si d’un point de vue géographique c’est moins précis, il sera préférable de reprojeter vos données vecteurs Lambert 93 vers l’UTM. En effet, reprojeter des images Landsat en Lambert 93 va s’avérer fastidieux, gourmand en ressources et va déformer les pixels de ces images. Ainsi il sera judicieux de faire passer toutes les données du projet en UTM.

Concrètement, lors de ce processus, dans la plupart des cas, une nouvelle couche sera créée. En effet, il est rare de changer directement le système de coordonnées d’une couche donnée. Il s’agît généralement d’une copie de la couche originale avec le nouveau système de coordonnées. La déformation engendrée par la reprojection, dans le cas des données rasters, implique une certaine interpolation dans le processus. Nous verrons qu’il est possible, ou pas, de régler la qualité de cette interpolation.

Dans cet exemple, nous allons changer le système de coordonnées d’un MNT (SRTM) dont le SCR est EPSG:32632 - WGS 84 / UTM zone 32N - Projeté vers le SCR officiel français, le Lambert 93 (EPSG:2154 - RGF93 / Lambert-93 - Projeté).


Reprojection d’un raster

Nous allons voir ici différents outils qui permettent de reprojeter un raster.


Reprojection d’un raster dans QGIS

Version de QGIS : 3.16.1

Dans QGIS, il existe deux méthodes différentes pour effectuer ce changement de SCR de couche raster. La première méthode fait appel à un module propre à QGIS, qui nécessite très peu de paramétrages. La seconde méthode utilise également un module de base de QGIS mais qui interface en fait une fonctionnalité de GDAL [https://gdal.org/]. Cette seconde méthode présente plus d’options et permet de régler plus finement la qualité de la reprojection.

Avec QGIS seul

Une fois notre raster chargé dans QGIS, nous faisons un clic droit sur cette couche dans le panneau des couches. Nous cliquons ensuite sur Exporter ‣ Enregistrer sous… . La fenêtre suivante apparaît (Fig. 173).


[image: alternate text]

Fig. 173 Changer le SCR d’un raster avec QGIS seul.



Dans le champ Nom de fichier, nous spécifions le chemin et le nom sous lequel nous souhaitons enregistrer le nouveau raster reprojeté. Dans le champ SCR, nous indiquons le SCR que nous souhaitons en résultat. Il est possible de cliquer sur l’icône [image: icone_choix_SCR] pour ouvrir une nouvelle fenêtre qui permet de sélectionner le système désiré (Fig. 174).


[image: alternate text]

Fig. 174 Choix d’un système de coordonnées de références.



Dans cette fenêtre de sélection de SCR, le plus simple est de chercher le système de coordonnées souhaité en cherchant son code EPSG dans le champ Filtre. Le code EPSG correspondant au Lambert 93 est 2154. Nous entrons donc ce code. Dans le panneau Systèmes de Coordonnées de Références Prédéfinis, les systèmes de coordonnées contenant ce code apparaissent. Il suffit de cliquer sur celui qui nous intéresse. Notons que les SCR que nous utilisons le plus apparaissent dans le panneau Systèmes de Coordonnées de Références récemment utilisés. En bas à droite de la fenêtre, QGIS nous propose un aperçu du territoire sur lequel ce SCR est valable. Il s’agît bien de la France métropolitaine dans notre cas. Il suffit ensuite de cliquer sur OK.

Dans la fenêtre précédente, le champ SCR se met bien à jour. Nous cliquons sur OK et la nouvelle couche reprojetée apparaît automatiquement dans QGIS. Si nous regardons ses propriétés, nous constatons que son système de coordonnées est bien le Lambert 93.

Nous pouvons constater que cette méthode ne permet pas de choisir et de régler l’interpolation sous-jacente. Il semblerait qu’elle utilise par défaut une méthode de type plus proche voisin. Ce type d’interpolation peut avoir des répercussions sur la qualité du raster résultat.

Avec GDAL interfacé par QGIS

Il est également possible d’utiliser GDAL interfacé par QGIS pour changer le SCR d’un raster. Cette méthode nous permet de régler l’interpolation sous-jacente, ce qui peut s’avérer précieux dans certains cas. Ce module se trouve dans le menu Raster ‣ Projections ‣ Projection (warp)…. La fenêtre suivante s’affiche (Fig. 175).


[image: alternate text]

Fig. 175 Changer le SCR  d’un raster via GDAL interfacé par QGIS.



Dans le champ Couche source, nous spécifions la couche dont nous voulons changer le SCR. À priori, QGIS trouve tout seul dans quel SCR se trouve la couche à reprojeter, par conséquent le champ SCR d'origine peut rester vide. Par contre, il est nécessaire de préciser le SCR souhaité. De la même façon que précédemment, il est possible de sélectionner le système Lambert 93 - 2154. Un champ important se trouve juste au-dessous : Méthode de ré-échantillonage à utiliser. Par défaut, la méthode choisie est Plus Proche Voisin, ce qui revient à celle utilisée par défaut dans le module QGIS dédié vu précédemment. Ici, nous choisissons Bilinéaire. Cette méthode permet de « lisser » la repojection. Enfin, dans le champ Reprojeté, nous spécifions un chemin et un nom pour le raster reprojeté résultat. Les autres champs peuvent garder leurs valeurs par défaut. Notons que le panneau du bas Console GDAL/OGR contient la commande GDAL qui sera utilisée au final. Cette commande prend en argument les différents paramètres que nous avons ajustés dans les différents champs. Après avoir cliqué sur Exécuter, le nouveau raster s’affiche dans sa nouvelle projection.


Avertissement

Finalement, quelle méthode dois-je utiliser ?

Au final, le choix ne doit pas réellement se faire entre utiliser le module interne de QGIS ou le module GDAL. La vraie question est « quelle méthode de ré-échantillonage dois-je utiliser ? ». Si une méthode de type Plus proche voisin est adaptée, vous utilisez le module de QGIS ou bien le module GDAL avec l’option « Plus proche voisin ». Si vous devez utiliser une méthode qui « lisse » le résultat, alors vous devez nécessairement utiliser le module GDAL avec une option de type Bilinéaire, Cubique ou Cubic spline. Ces trois méthodes donneront des résultats très semblables.

La question sous-jacente devient donc quand dois-je utiliser une méthode Plus proche voisin ou une méthode lissante ? D’une manière générale, lorsque que vous disposez d’un raster discret, comme un raster d’usage du sol par exemple, il faut utiliser une méthode Plus proche voisin. Si nous utilisons une méthode lissante dans ce cas, nous risquons de créer de nouvelles valeurs absurdes qui ne correspondent à aucune classe. Imaginons un raster d’usage du sol en trois classes comme suit : 1 : eau, 2 : bâti et 3 : végétation. Après une reprojection lissante nous risquons de nous retrouver avec quelques pixels de valeurs 2.3, 2.7 … entre les aplats de classes 2 et 3.
Les méthodes lissantes sont à réserver aux rasters continus, comme les MNT ou les images satellites par exemple. Pour ce type de rasters, il est également possible d’utiliser les méthodes de type Plus proche voisin, mais certains artefacts peuvent apparaître, notamment sur les MNT.





Reprojection par lot de rasters dans QGIS

Dans certains cas il est intéressant de reprojeter plusieurs rasters par lot. C’est par exemple le cas lorsque nous manipulons des images satellites multi-spectrales où nous avons un raster par bande spectrale. Au lieu de reprojeter bande spectrale par bande spectrale, QGIS propose un moyen simple pour reprojeter tous les rasters des bandes spectrales en une fois.

Pour cela, le plus simple est de charger dans QGIS les rasters à reprojeter (mais ce n’est pas obligatoire). Ici, nous allons reprojeter les trois rasters correspondant aux trois premières bandes spectrales d’une scène Landsat 8. Une fois les rasters chargés, nous ouvrons le menu Raster ‣ Projections ‣ Projection (warp)…. Nous retombons sur la fenêtre de la figure (Fig. 175). Au lieu de remplir les champs à ce niveau, nous cliquons sur le menu Exécuter comme processus de lot… La fenêtre suivante apparaît (Fig. 176).
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Fig. 176 Reprojeter des rasters par lot, réglages.



Dans cette fenêtre, nous inclurons autant de lignes que de rasters à reprojeter. Par défaut, une ligne est affichée. Dans cette ligne nous allons régler la reprojection de notre premier raster. Dans la colonne Couche source nous sélectionnons dans le menu déroulant le premier raster à reprojeter. Notons que nous pouvons également pointer vers un raster non ouvert dans QGIS grâce à l’icône [image: icone_browse].

Dans la colonne SCR cible nous spécifions le nouveau SCR que nous souhaitons. Ici nous sélectionnons le Lambert 93 (EPSG 2154). Dans la colonne Méthode de ré-échantillonnage nous sélectionnons la méthode souhaiteé, Bilinéaire par exemple. Enfin, dans le champ Reprojeté nous spécifions le chemin et le nom du raster reprojeté qui sera créé.

Il est maintenant nécessaire d’ajouter autant de lignes que de rasters à reprojeter. Pour cela soit nous cliquons sur [image: icone_plus] pour ajouter des lignes une à une, soit nous cliquons sur la case Auto-remplissage… qui se trouve immédiatement sous le titre de la colonne Couche source. Dans le menu déroulant qui apparaît nous pouvons Sélectionner des fichiers depuis un répertoire, Ajouter tous les fichiers d’un répertoire, ou Sélectionner à partir des couches chargées, ce que nous choisissons ici. Un menu nous permet alors de sélectionner les rasters chargés que nous souhaitons reprojeter. La fenêtre précédente se met à jour (Fig. 177).
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Fig. 177 Reprojeter des rasters par lot dans QGIS.



Il suffit alors de régler les colonnes pour les différents rasters et de remplir la colonne Reprojeté pour chaque raster. Il est possible de faire des copier-coller (un par un) du chemin de la première ligne vers les autres lignes et de changer juste le nom du fichier. Ces clics et ces copier-coller peuvent s’avérer un peu fastidieux mais toujours moins que de traiter les rasters un par un. En cliquant sur Exécuter, les rasters se reprojettent par lot.



Preprojection d’un raster avec le module SCP

Version de QGIS : 3.18.2

Version de SCP : 7.8.16

Le module supplémentaire à QGIS nommé Semi-Automaic Classification Plugin et connu sous l’acronyme de SCP a été conçu pour faire des classifications d’images satellites. Mais ce plugin propose également de nombreux outils connexes, notamment un pour la reprojection de couches rasters.

Dans cet exemple, nous allons utiliser SCP pour reprojeter des bandes spectrales Landsat 8 prises au-dessus du Val d’Oise depuis le SCR EPSG:32631 - WGS 84 / UTM zone 31N - Projeté vers le SCR Lambert 93 (EPSG 2154).

Pour utiliser les fonctionnalités de reprojection de SCP, il est nécessaire d’avoir au préalable défini un Jeu de bandes SCP (voir la section dédiée à la classification supervisée avec SCP). Ainsi, par défaut SCP fait des reprojections par lot. Le menu dédié se trouve dans SCP ‣ Pré-traitement ‣ Reproject raster bands. Le menu suivant apparaît (Fig. 178).
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Fig. 178 Changer le SCR de couches rasters avec SCP.



Dans le champ Sélectionner un jeu de bandes, nous indiquons le jeu de bandes à reprojeter. Dans le champ Use EPSG code, nous indiquons le SCR vers lequel nous souhaitons convertir nos rasters, ici le Lambert 93 (EPSG 2154). Enfin, dans le champ Resampling method nous pouvons choisir une méthode de ré-échantillonnage. Il semblerait que SCP utilise ici GDAL, mais nous ne savons pas avec quels paramètres. Pour finir, nous pouvons indiquer un Préfixe de sortie puis cliquer sur Lancer. Il sera alors nécessaire de spécifier un chemin où sauver les rasters reprojetés.

Pour le choix de la méthode de ré-échantillonnage, reportez vous à la discussion plus haut sur cette page. Quoi qu’il en soit, ce choix a des répercussions sur le raster reprojété (Fig. 179)..


[image: alternate text]

Fig. 179 Effet de la méthode de ré-échantillonnage choisie sur un zoom de la bande 5 d’une image Landsat 8. Les styles sont les mêmes sur les six vignettes.



La méthode Nearest neighbour semble créer le moins d’artefacts. Les méthodes Average, Maximum et Median apportent un flou et le First quartile fait « baver » les pixels.

En plus de la reprojection, ce menu propose deux outils très intéressants : ré-échantillonnage spatial et changement d’encodage. Comme nous voyons sur le menu (Fig. 178), il est possible de changer les résolutions en X (X resolution) et en Y (Y resolution). Nous pouvons même nous servir de cette option sans changer le SCR. La figure (Fig. 180) présente un ré-échantillonnage spatial à 200 mètres en X et Y d’une bande Landsat.


[image: alternate text]

Fig. 180 Ré-échantillonnage à 200 mètres d’une bande spectrale Landsat 8.



L’option de changement de l’encodage est également très intéressante. Cette option peut également s’utiliser sans reprojection. Avec cette fonctionnalité, il est possible de, par exemple, changer un raster codé en UInt16 - nombre entier non signé de seize bits vers un raster codé en Float32 - nombre à virgule flottante de 32 bits. Ces conversions peuvent s’avérer nécessaires dans certains traitements, attention toutefois à l’éventuelle altération de la donnée que ça peut engendrer.


Note

Au final, les fonctionnalités de reprojection de SCP sont similaires à ce que propose GDAL mais sont intéressantes lorsque nous travaillons sur un jeu de bandes SCP. Par contre, les options de ré-échantillonnage spatial et de transformation de l’encodage sont très intéressantes même si nous ne nous servons d’aucune autre fonctionnalité de SCP.





Reprojection d’un raster avec GDAL

Version de GDAL : 3.0.4

Une fois que GDAL (GDAL/OGR) est correctement configuré dans le PATH du système, il est possible de l’utiliser en ligne de commande pour reprojeter un raster. Le menu à utiliser est gdalwarp. La commande présentée ici est la commune minimale, suffisante dans la plupart des cas, mais elle peut être étoffée avec des options comme présentées sur la documentation de gdalwarp [https://gdal.org/programs/gdalwarp.html]. Dans l’exemple, nous allons reprojeter une bande spectrale Landsat de l’UTM vers le Lambert 93 dont le code EPSG est 2154. Il est nécessaire de se placer dans le répertoire contenant le raster à reprojeter, ou bien de bien renseigner les chemins en relatif ou en absolu.

gdalwarp -t_srs EPSG:2154 -r bilinear -of GTiff LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF B5_gdal_L93.tif






	avec :
	
	gdalwarp : la commande GDAL pour la reprojection raster


	-t_srs : le mot clé pour définir le SCR désiré en sortie (t comme target)


	-r : le mot clé pour choisir la méthode de rééchantiollonnage


	-of : le mot clé pour le format du raster en sortie


	LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF : le raster à reprojeter


	B5_gdal_L93.tif : le raster issu de la reprojection










Reprojection d’un raster avec R

Version de R : 4.1.2

Lorsqu’un raster est chargé dans R avec l’un ou l’autre des packages dédiés (Importer un raster dans R), il est possible de reprojeter facilement ce raster. Ici, nous verrons comment reprojeter un raster de type SpatRaster chargé avec terra. Dans l’exemple ci-arpès, nous allons changer de SCR du MNT du bassin de la Roya [https://fr.wikipedia.org/wiki/Roya] issu du SRTM et nommé srtm_roya_L93.tif. Nous le reprojèterons du Lambert 93 vers le système UTM zone 31N dont le code EPSG est 32631. Le tout est résumé dans les lignes suivantes.

# chargement du raster à reprojeter
mnt_roya <- terra::rast('srtm_roya_L93.tif')

# reprojection du raster dans le système 32631
mnt_roya_reproj <- terra::project(mnt_roya, 'EPSG:32631')





Si nous affichons les propriétés du raster (en entrant simplement son nom dans la console R par exemple), nous constatons bien que le SCR a été modifié.



Reprojection d’un raster avec Python

Version de Python : 3.8.10

Il est tout à fait possible de changer le SCR d’un raster importé dans un script Python.

Avec rasterio

Nous présenterons ici la manipulation avec la librairie rasterio. Il faut bien avouer que ça fait pas mal de lignes de code pour une petite manipulation… Si la reprojection est effectuée pour mettre en concordance un raster avec un vecteur, il peut être plus simple de reprojeter le vecteur plutôt que le raster.

# chargement de la librairie de gestion des rasters rasterio
import rasterio
# chargement des modules de rasterio spécifiques à la reprojection
from rasterio.warp import calculate_default_transform, reproject, Resampling

# choix du SCR de destination en code EPSG
dst_crs = 'EPSG:2154'

# chargement du raster à reprojeter et on le stocke dans la variable src
# on récupère ses paramètres "transform" et "width"
# on calcule la hauteur que prendra le raster reprojeté
# on stocke les paramètres du raster dans la variable kwargs
# on met à jour ces paramètres pour le raster de destination
with rasterio.open('./Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF') as src:
    transform, width, height = calculate_default_transform(
        src.crs, dst_crs, src.width, src.height, *src.bounds)
    kwargs = src.meta.copy()
    kwargs.update({
        'crs': dst_crs,
        'transform': transform,
        'width': width,
        'height': height
    })

    # on créé le raster de destination en lui attribuant les paramètres mis à jour précédemment
    with rasterio.open('./Landsat_13/B5_L93.tif', 'w', **kwargs) as dst:
        for i in range(1, src.count + 1):
            reproject(
                source=rasterio.band(src, i),
                destination=rasterio.band(dst, i),
                src_transform=src.transform,
                src_crs=src.crs,
                dst_transform=transform,
                dst_crs=dst_crs,
                resampling=Resampling.nearest)





Le script présenté ci-dessous est également utilisable pour reprojeter un raster multi-bandes.


Astuce

Il peut être plus simple d’utiliser une simple commande GDAL que nous pouvons exécuter dans un script Python.



Avec une commande GDAL

GDAL (GDAL/OGR) propose une commande très simple pour reprojeter un fichier raster via l’outil gdalwarp (Reprojection d’un raster avec GDAL). L’idée est de construire une chaîne de caractères qui sera la commande GDAL puis d’exécuter cette commande en tant que commande externe (Lancer GDAL avec Python). Ça suppose bien sûr que l’exécutable de GDAL soit bien reconnu dans le PATH du système. La commande présentée ici est la commune minimale, suffisante dans la plupart des cas, mais elle peut être étoffée avec des options comme présentées sur la documentation de gdalwarp [https://gdal.org/programs/gdalwarp.html].

# librairie pour exécuter des commandes système
import os

# le chemin vers le fichier à reprojeter
src = './Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF'
# le nom du fichier reprojeté et son chemin de stockage
dst = './Landsat_13/B5_gdal_python_L93.tif'
# le SCR de reprojection (en EPSG)
scr_repro = '2154'
# la méthode de rééchantillonnage
ech = 'bilinear'

# on construit la commande gdalwarp par concaténation
cmd = 'gdalwarp -t_srs EPSG:' + scr_repro + ' -r ' + ech + ' -of GTiff ' + src + ' ' + dst
os.system(cmd)





Cette solution est moins « pythonesque » mais plus rapide à coder et à lire. Cette commande fonctionne aussi pour un raster multi-bandes.




Reprojection d’une couche vecteur

Nous allons voir ici différents outils permettant de changer le SCR d’une couche vecteur.


Reprojection d’un vecteur dans QGIS

Version de QGIS : 3.16.1

Il est très simple de changer le SCR d’une couche vecteur dans QGIS. Que cette couche soit de type ponctuelle, linéaire ou surfacique la manipulation est la même. Comme pour le cas des rasters, la couche vecteur résultante sera déformée, il est donc nécessaire de choisir un SCR pertinent.

Dans cet exemple, nous allons changer le SCR du réseau hydrographique de la Vésubie ( »vesubie_hydro.gpkg ») du Lambert 93 (EPSG 2154) vers le WGS84 UTM Zone 32 Nord (EPSG 32632). Après avoir chargé la couche dans QGIS, nous faisons un clic droit sur cette couche dans le panneau des couches. Puis nous allons dans Exporter ‣ Sauvegarder les entités sous…. La fenêtre suivante s’affiche (Fig. 181).


[image: alternate text]

Fig. 181 Changer le SCR d’une couche vecteur avec QGIS.



Dans le champ Nom de fichier nous spécifions un chemin d’export et un nom pour la couche reprojetée, ici vesubie_hydro_UTM32.gpkg. Dans le champ SCR nous choisissons le système de coordonnées de la couche résultante, ici l’UTM 32 Nord. Il est possible de sélectionner ce système de coordonnées en cliquant sur l’icône [image: icone_choix_SCR].

Dans la fenêtre qui apparaît alors il est possible de sélectionner le SCR souhaité en filtrant les résultats par le code EPSG 32632. Ensuite, en cliquant sur OK le processus se lance et la nouvelle couche reprojetée apparaît automatiquement. En allant voir ses propriétés il est possible de vérifier que le changement de SCR a bien été pris en compte.



Reprojection d’un vecteur avec GDAL/OGR

Version de GDAL : 3.0.4

Il est possible de reprojeter une couche vecteur avec GDAL/OGR. Ici, nous allons reprojeter une couche des communes d’Île-de-France (communes_IDF.gpkg) en Lambert 93 vers du WGS84 UTM Zone 31 Nord (EPSG 32631). Cette manipulation se fait avec une commande ogr2ogr, comme montré ci-après.

ogr2ogr -t_srs epsg:32631 communes_IDF_32631.gpkg communes_IDF.gpkg





Avec les éléments suivants :


	ogr2ogr : le penchant vecteur de GDAL


	-t_srs epsg:32631 : le mot clé pour définir le SCR de destination


	communes_IDF_32631.gpkg communes_IDF.gpkg : bien mettre en premier la couche de destination et en second la couche à reprojeter






Reprojection d’un vecteur dans R

Reprojeter un vecteur dans R dépend si vous travaillez avec la librairie sf ou terra. Nous présentons ici les deux cas de figure.


Reprojection d’un vecteur avec terra

Version de R : 4.1.2

Version de terra : 1.7.29

Si nous avons chargé une couche vecteur avec terra nous avons un objet SpatVector. Il est facile de changer son SCR en lui spécifiant un nouveau SCR via son code EPSG.

# chargement de la couche vecteur
dep <- terra::vect("departements_france_L93.gpkg")
# reprojection en UTM Zone 31N (EPSG 32631)
dep_reporj <- terra::project(dep, 'EPSG:32631')







Reprojection d’un vecteur avec sf

Version de R : 4.1.2

Version de sf : 1.0-12

Une fois un vecteur chargé dans R via le package sf par exemple, il est possible de le reprojeter vers un nouveau système de coordonnées de référence. Il suffit d’utiliser la commande st_transform() qui prend en argument la couche à reprojeter ainsi que le SCR souhaité. Ici, nous allons reprojeter une couche depuis le Lamber 93 en UTM Zone 31 N (EPSG 32631). La commande est la suivante.

# chargement de la couche vecteur
dep <- sf::st_read("departements_france_L93.gpkg")
# reprojection en UTM Zone 31N
dep_reproj <- sf::st_transform(dep, crs = 32631)





La couche résultat est bien maintenant en UTM Zone 31 N.








            

          

      

      

    

  

    
      
          
            
  Auteur : Paul Passy

Licence : [image: cc_by_nc_sa]


Création de données

Dans un projet géomatique il est toujours nécessaire de créer de nouvelles données pour répondre à la question initiale du projet. Cette création de données peut se faire par digitalisation manuelle à partir d’un raster géoréférencé ou par export en dur d’un résultat de sélection par exemple.
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Digitalisation

Dans certains cas, nous pouvons être amenés à créer nous mêmes de la donnée en digitalisant des formes depuis un fond de carte géoréférencé. Dans certains domaines, ce processus de digitalisation sera très utilisé mais pour d’autres, cette opération sera très rare.

Les principes de base de la digitalisation sont faciles à comprendre et les logiciels de SIG proposent tous une fonction le permettant. Par contre, dès que nous souhaitons digitaliser un grand nombre d’entités, le travail se complexifie singulièrement. Dans ce cas, il faudra faire attention à la topologie entre les entités et entre les différentes couches. Heureusement, des outils nous aident à gérer ces aspects.


Digitalisation avec QGIS : les fondamentaux

Version de QGIS : 3.16.1

Dans cet exemple, nous allons digitaliser quelques éléments relatifs à l’usage du sol sur une portion de l’Île de Ré, sur la façade Atlantique française. En fond de carte, nous afficherons la BD Topo de l’IGN et nous nous baserons sur ce fond pour digitaliser les éléments suivants : bâtiment, espace arboré et parking.

La première étape est de réfléchir au format de la donnée que nous souhaitons construire. D’abord d’un point de vue géométrique, allons-nous construire une couche vecteur de type points, lignes ou polygones ? Ensuite, quels attributs allons-nous associer à chacune des entités digitalisée ? Et quelle sera la nature de ces attributs ?

Une fois ces éléments définis, nous déciderons du système de coordonnées dans lequel nous allons digitaliser notre couche. Et enfin nous pourrons passer à la digitalisation proprement dite.


Initialisation de la couche

Premièrement, nous commençons par afficher en fond les ortho-photos de l’IGN et à zoomer sur la partie de l’Île de Ré que nous souhaitons digitaliser. Nous pouvons nous référer à la fiche correspondante pour afficher ces ortho-photos.

Comme nous travaillons sur la France métropolitaine, nous décidons de travailler dans le système Lambert 93 (EPSG 2154). Les éléments digitalisés seront de type surfacique, nous allons donc digitaliser des polygones. À chacun de ces polygones nous allons associer les attributs suivants


	un champ « Nature » dans lequel nous renseignerons si le polygone correspond à un bâtiment, à un espace arboré ou à un parking. Ce champ sera donc de type « texte ».


	un champ « superficie_m2 » dans lequel nous stockerons la superficie du polygone en mètres carrés. Ce champ sera donc de type « réel ».




Dans QGIS, nous commençons par aller dans le menu Couche > Créer une couche > Nouvelle couche GeoPackage. La fenêtre suivante s’ouvre.


[image: alternate text]

Fig. 182 Création d’une couche GeoPackage dans QGIS.



Dans le champ Base de données nous spécifions le chemin et le nom du fichier GeoPackage que nous allons créer. Appelons le digit_ile_de_re. Dans le champ Nom de la table, nous définissons le nom de la table que nous allons créer dans ce GeoPackage, ici usage_sol. Dans le champ Type de géométrie nous définissons la géométrie de la couche, ici Polygone.


Note

Notons bien qu’ici nous créons un fichier GeoPackage qui est une sorte de mini base de données. Ce GeoPackage doit être nommé par l’utilisateur. Au sein de ce GeoPackage, donc au sein de cette base de données, il est possible de créer plusieurs couches qui sont aussi appelées tables. Dans notre cas, nous n’avons qu’une table, celle de l’usage du sol. Mais nous pourrions y ajouter une autre table dans laquelle nous digitaliserions les routes par exemple.



Il est ensuite nécessaire de définir le système de coordonnées de la couche. Pour le définir facilement, nous cliquons sur l’icône [image: icone_choix_SCR]. La fenêtre de choix du SCR s’affiche alors.


[image: alternate text]

Fig. 183 Choix d’un système de coordonnées.



Dans la champ Filtre nous entrons le code EPSG du Lambert 93, à savoir 2154. Il suffit ensuite de double cliquer sur la ligne correspondante dans le panneau Systèmes de Coordonnées de Références Prédéfinis. La fenêtre précédente se met à jour avec le bon système de coordonnées.

Nous pouvons passer à la définition de la table attributaire associée à cette couche dans le panneau Liste des champs. Tout d’abord nous nommons le champ (nom). Nous le nommons nature. Ce champ est de Type Donnée texte. Le champ Longueur maximale n’est pas obligatoire mais nous pouvons le définir à 50. Ça signifie que le champ nature ne pourra stocker plus de 50 caractères. Une fois ces réglages effectués, nous pouvons cliquer sur Ajouter à la liste des champs. La fenêtre se met à jour comme suit.


[image: alternate text]

Fig. 184 Définition des champs.



Nous recommençons l’opération pour le champ superficie_m2, qui sera de type Nombre entier. Lorsque tout est bien réglé, nous obtenons la fenêtre suivante.
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Fig. 185 Couche prête à être créée.



Nous cliquons sur OK et notre couche apparaît dans QGIS. Cette couche est encore vide, il n’y a ni entité spatiale, ni ligne dans la table attributaire.


Note

Notons que les Type de champ les plus utilisés sont Donnée texte pour les données textuelles, Nombre décimal (réel) pour les données numériques qui font appel à des nombres décimaux comme les superficies, les densités, les altitudes … et Nombre entier pour les données numériques entières comme les identifiants, les populations, les dénombrements …





Digitalisation des entités

Nous pouvons maintenant passer à la digitalisation proprement dite. Nous allons en fait « décalquer » les entités qui nous intéressent. Nous commencerons par un bâtiment, plus précisément une des maisons visibles sur l’ortho-photo. Assurons nous au préalable que la couche que nous venons de créer se trouve au dessus du fond de carte IGN dans le panneau des couches, sinon cette couche ne sera pas visible dans le panneau central.

Tout d’abord, il est nécessaire de passer cette couche en mode édition. Pour cela, nous sélectionnons notre couche dans le panneau des couches (elle se retrouve surlignée en bleu), puis par un clic droit, nous sélectionnons le menu Basculer en mode édition. L’icône à gauche de la couche s’orne d’un crayon.


[image: alternate text]

Fig. 186 Couche prête à être éditée.



Nous zoomons maintenant sur le bâtiment à digitaliser. La question du niveau de zoom et de la précision de la digitalisation reste ouverte. C’est à l’utilisateur de choisir un niveau de précision qui lui semble pertinent selon l’étude menée. Les outils dont nous allons avoir besoin se trouvent dans la barre d’outils de digitalisation [image: icone-barre-digit].

La digitalisation s’initie avec le menu Ajouter une entité polygonale [image: icone-ajout-entite]. Le curseur prend alors une forme de cible. La digitalisation se fait en traçant un polygone autour de l’objet choisi par une succession de clics gauches. Le polygone en cours de création apparaît en rouge.


[image: alternate text]

Fig. 187 Polygone en cours de digitalisation.



Le polygone se ferme par un clic droit. Notons que le clic droit n’ajoute pas de nouveau sommet, ainsi le polygone se ferme réellement là où nous avons cliqué gauche pour la dernière fois. Lorsque le polygone est fermé, une fenêtre nous invitant à entrer les attributs apparaît automatiquement.


[image: alternate text]

Fig. 188 Invitation à remplir les attributs.



Dans le champ nature nous pouvons entrer bâtiment, et nous laissons le champ superficie_m2 libre pour l’instant. Nous renseignerons tous les champs de superficie à la fin. Nous avons bien maintenant une entité associée à une ligne de la table attributaire. Le champ nature est bien renseignée comme nous le souhaitons et le champ superficie_m2 est resté vide (NULL).


[image: alternate text]

Fig. 189 L’entité digitalisée et ses attributs.



Si nous ne sommes pas satisfaits de la forme que nous avons donnée à l’entité, il est possible de déplacer, supprimer ou ajouter un nœud grâce à l”Outils de nœud [image: icone-outil-noeud]. Une fois cet outil sélectionné, le curseur prend la forme d’une croix. Et lors du survol d’un polygone, son contour se surligne en rouge et ses nœuds apparaissent.
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Fig. 190 Édition des nœuds d’un polygone.



Il est alors possible e déplacer un nœud avec le curseur de la souris ou d’en supprimer un en le sélectionnant puis en pressant la touche « suppr » de son clavier. Il est aussi possible d’ajouter un nœud entre deux nœuds existants en double cliquant sur la portion de ligne où nous souhaitons ajouter un nœud.


Note

Nous remarquons la présence d’un champ fid que nous n’avons jamais défini. Ce champ est en fait un champ obligatoire de toute couche au format GeoPackage. Il s’agît d’un identifiant unique qui permet d’identifier chaque entité. Ce champ ne doit pas être modifié manuellement, nous n’y touchons pas et ne nous en occupons pas. D’ailleurs nous voyons qu’il sera mis à jour automatiquement par QGIS.



Nous pouvons maintenant recommencer l’opération pour les autres polygones, au moins un parking et un zone arborée.


[image: alternate text]

Fig. 191 Les entités et leurs attributs.



Il est maintenant temps de mettre à jour le champ superficie_m2 à l’aide de la Calculatrice de champ. Une fois les entités digitalisées et les champs mis à jour, nous pouvons enregistrer notre couche [image: icone-enregistrer] et quitter le mode édition en recliquant sur [image: icone-edition].


Avertissement

Il est possible, et même recommandé, de sauvegarder régulièrement sa couche en cours d’édition en cliquant sur l’icône d’enregistrement.





Gagner en efficacité avec les formulaires

QIGS offre un outil très pratique pour nous aider dans la digitalisation : le gestionnaire de formulaires. Dans notre exemple, nous avons des entités de trois natures différentes. Mais à chaque fois nous devons taper à la main dans le champ nature les mots bâtiment, parking ou zone arborée. Or nous ne sommes pas à l’abri d’une faute de frappe, ou d’écrire batiment au lieu de bâtiment ou de mettre une majuscule ou un pluriel… surtout si nous sommes plusieurs utilisateurs à travailler sur cette même couche. Le risque est de se retrouver au final, non pas avec trois natures différentes mais une multitude (bâtiment, batiment, Parkings, parkign, …)

Pour pallier à ça, nous pouvons utiliser un formulaire. Concrètement, un tel formulaire forcera l’utilisateur à choisir seulement parmi les valeurs possibles pour remplir un champ donné. Pour définir le formulaire, nous faisons un clic droit sur la couche puis nous sélectionnons Propriétés. Dans la fenêtre qui s’ouvre, nous allons dans l’onglet Formulaire…
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Fig. 192 L’onglet de définition des formulaires.



Nous commençons par définir le formulaire à associer au champ nature. Nous sélectionnons donc nature dans le menu déroulant Fields. Le panneau de droite se met à jour. Dans le panneau Type d’outils, nous sélectionnons Liste de valeurs. Dans le tableau qui suit nous définissons les différentes valeurs possibles. La colonne Valeur contiendra les valeurs standardisées et la colonne Description contiendra une description de la valeur, le plus simple est de mettre la même chose dans les deux colonnes. Nous pouvons ainsi paramétrer ce tableau comme défini sur la figure suivante.
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Fig. 193 Définition des différentes valeurs possibles pour le champ nature.



Notons que nous pouvons également cocher la case Non null dans le panneau Contraintes. Ainsi l’utilisateur sera obligé de renseigner le champ nature.

Nous pouvons en profiter pour créer un autre formulaire pour le champ superficie_m2. Nous sélectionnons maintenant ce champ dans le menu déroulant Fields. Il ne s’agit plus de valeurs à sélectionner mais nous souhaitons que QGIS calcule de lui même automatiquement la superficie de l’entité au moment de sa création. Pour cela, nous allons dans le panneau Défauts et nous cliquons sur l’icône [image: icone-calcul-champ] à droite du champ Valeur par défaut.

La fenêtre de Calculateur d’Expressions s’ouvre. Dans le panneau Expression nous allons entrer l’expression qui permet de calculer une superficie. Pour cela, dans le panneau central, nous déroulons le menu Géométrie et nous double cliquons sur $area. Cette fonction indique à QGIS de calculer la superficie de l’entité correspondante. Le calculateur d’expressions ressemble alors à la fenêtre suivante.
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Fig. 194 Définition du calcul de l’aire de façon automatique.



En cliquant sur OK nous revenons à la fenêtre des formulaires et le champ Valeur par défaut a été mis à jour. Nous n’oublions pas de cocher la case Appliquer la valeur par défaut sur la mise à jour.
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Fig. 195 Formulaire de calcul automatique de la superficie.



Nous n’avons plus qu’à cliquer sur Appliquer et OK.

Nous allons voir l’intérêt de ces formulaires en digitalisant une nouvelle entité, une zone arborée par exemple. Nous reprenons l’outil d’ajout d’entités, nous digitalisons notre espace arborée et au moment de la fermeture du polygone, la fenêtre de mise à jour des attributs apparaît. Mais la fenêtre présente un aspect légèrement différent maintenant.


[image: alternate text]

Fig. 196 Ouverture du formulaire après création d’entité.



Nous voyons que le champ nature n’est plus un champ de texte libre mais une liste déroulante. Et le champ superficie_m2 a été automatiquement mis à jour avec la superficie. Il nous suffit maintenant de dérouler la liste du champ nature et de sélectionner celui qui nous convient.


[image: alternate text]

Fig. 197 Sélection de la nature dans le menu déroulant.



Ainsi, nous gagnons du temps et évitons des erreurs inévitables.





Créer des données par export d’une sélection

Un moyen simple et fréquent de « créer » une nouvelle couche géographique est d’exporter une sous partie d’une couche déjà existante. Il est fréquent de n’avoir besoin que d’une petite partie d’une couche fournie par un tiers. La partie d’intérêt peut être sélectionnée suite à une sélection par attributs ou suite à une sélection spatiale. Il est alors possible d’exporter le résultat de cette sélection dans une nouvelle couche.


Exporter une sélection avec QGIS

Version de QGIS : 3.16.1

La procédure d’export d’une sélection avec QGIS est très simple. Dans notre exemple, nous allons exporter les limites administratives australiennes vers une nouvelle couche australie.gpkg depuis la couche des limites administratives du monde disponible sur Natural Earth [https://www.naturalearthdata.com/http//www.naturalearthdata.com/download/50m/cultural/ne_50m_admin_1_states_provinces.zip].

Une fois cette couche chargée dans QGIS, nous commençons par sélectionner les entités administratives australiennes (Fig. 198).


[image: alternate text]

Fig. 198 Sélection des entités administratives australiennes.



L’export de cette sélection se fait par un clic droit sur la couche dans le panneau de couches et en sélectionnant Exporter > Sauvegarder les entités sélectionnées sous… La fenêtre d’export s’ouvre (Fig. 199).


[image: alternate text]

Fig. 199 Exportation de la sélection vers une nouvelle couche.



Dans le champ Format nous sélectionnons le format d’export. Dans le champ Nom de fichier, nous spécifions le chemin d’export ainsi que le nom du fichier. Dans le champ Nom de la source, nous spécifions un nom de couche. Nous pouvons également choisir un SCR dans le champ SCR. Puis nous cliquons sur OK. La nouvelle couche apparaît automatiquement dans QGIS.
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Travailler sur les tables attributaires

Comme vu dans la partie de présentation des différents formats de données, les données vecteurs sont caractérisées par la présence d’une table attributaire. Ces tables attributaires sont ds éléments primordiaux des SIG. Cette partie présente quelques manipulations à savoir faire sur ces tables. Ces manipulations vont du calcul de champ à la mise à jour d’un champ en passant par la suppression ou le formatage d’un champ (et autres).
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Exploration des attributs

Une fois une couche vecteur chargée dans son logiciel de SIG préféré ou dans son script, il est souvent utile d’en faire une exploration basique : lister les champs, calculer des statistiques sur les champs, … Nous explorerons ici les attributs d’une couche vecteur contenant les polygones des communes d’Île-de-France communes_IDF.gpkg.


Exploration des attributs dans QGIS

Version de QGIS : 3.22.3

Dans QGIS, pour ouvrir la table attributaire associée à une couche vecteur il suffit de faire un clic droit sur la couche dans le panneau de couches et de sélectionner Ouvrir la Table d'Attributs (Fig. 200).


[image: alternate text]

Fig. 200 Une table attributaire ouverte dans QGIS.



Chaque colonne correspond à un attribut aussi appelé champ et chaque ligne correspond à une entité. Si nous souhaitons maintenant avoir une vue plus simple à lire de la liste des champs ainsi que du format de chacun des champs, il suffit de faire un clic droit sur la couche dans le panneau des couches puis de sélectionner Propriétés… ‣ Champs. Nous trouvons dans cette fenêtre la liste de tous les champs avec leurs caractéristiques (Fig. 201).


[image: alternate text]

Fig. 201 Caractéristiques des champs d’une table attributaire dans QGIS.



Il est également possible d’explorer des statistiques basiques sur chacun des champs, comme la moyenne ou les valeurs extrêmes pour les champs numériques. Dans QGIS, cela se fait simplement en allant dans le menu Vecteur ‣ Outils d’analyse ‣ Statistiques basiques pour les champs… (Fig. 202).


[image: alternate text]

Fig. 202 Statistiques basiques sur les champs dans QGIS.



Dans la fenêtre du menu, dans le champ Couche source nous indiquons la couche à analyser, ici communes_IDF puis dans le champ Champ pour le calcul des statistiques, nous indiquons le champ sur lequel calculer les statistiques, ici par exemple area_km2. Dans le champ Statistiques nous pouvons sauver le résultat dans un fichier HTML si nous le souhaitons. Mais la sortie standard est souvent suffisante. Puis nous cliquons sur Exécuter. Les statistiques apparaissent alors sous forme de texte (un peu brut certes) dans l’onglet Journal de la fenêtre.

Il existe un autre moyen d’accéder à ces statistiques basiques qui est peut-être plus facile à lire. Il suffit d’ajouter le panneau Statistiques à la vue générale de QGIS. Pour cela nous allons dans le menu Préférences ‣ Panneaux ‣ Panneau Statistiques. Un nouveau panneau apparaît alors sous le panneau Couches (Fig. 203).


[image: alternate text]

Fig. 203 Le panneau statistiques dans QGIS.



Dans ce panneau nous commençons par sélectionner la couche à analyser dans le premier menu déroulant puis le champ sur lequel calculer les statistiques dans le second menu déroulant. Les statistiques apparaissent alors dans une liste plus lisible que précédemment.


Astuce

Nous pouvons même calculer les statistiques seulement sur les entités respectant une certaine condition en cliquant sur l’icône de requête [image: icone-select-expr] qui se trouve juste à droite du menu déroulant pointant vers le champ à analyser.






Calcul de champs

Les tables attributaires associées aux données vecteurs sont des objets fondamentaux en géomatique. Ces objets sont sans cesse modifier au cours du travail. Dans cette section nous allons voir comment mettre à jour une table attributaire en ajoutant un nouveau champ et en mettant à jour ce champ selon un calcul défini par l’utilisateur.


Calcul de champs dans QGIS

Version de QGIS : 3.16.1

Dans QGIS, la mise à jour d’un champ est assez simple et passe par la Calculatrice de champ. Un champ peut être mis à jour avec une valeur unique, en fonction de valeurs contenues dans d’autres champs (comme un calcul de densité de population à partir de champs « population » et « superficie » préexistants) ou en fonction de la géométrie de chaque entité (comme un calcul de superficies, périmètres …)

Dans cet exemple, nous allons simplement calculer la superficie en kilomètres carrés de chaque bassin-versant unitaire du bassin de la Seine. Nous travaillerons sur la couche nommée hydro_bv_seine.

Une fois la couche chargée dans QGIS, nous sélectionnons notre couche dans le panneau des couches et nous ouvrons la Calculatrice de champ en cliquant sur l’icône [image: icone_calc_champ]. Le menu correspondant apparaît (Fig. 204).


[image: alternate text]

Fig. 204 Calcul d’un nouveau champ avec QGIS.



Nous spécifions tout d’abord que nous créons un nouveau champ en sélectionnant Créer un nouveau champ. Notons qu’il serait également possible de mettre à jour un champ existant en sélectionnant Mise à jour d'un champ existant. Dans le champ Nom, nous baptisons notre champ superficie_km2.


Note

Il est bien d’inclure l’unité dans le nom des champs.



Dans le champ Type, nous spécifions le type du champ que nous allons créer. Ici, il s’agît d’une superficie, qui sera un nombre décimal. Nous sélectionnons donc Nombre décimal (réel).


Note

Les différents types possibles dépendent du format du fichier que nous mettons à jour. Un GeoPackage accepte plus de formats différents qu’un shapefile par exemple.



Dans le panneau Expression, nous allons entrer l’expression à utiliser pour le calcul du champ. Cette expression peut être écrite avec l’aide des fonctions données dans le panneau central. Pour la superficie, dans ce panneau central, nous déroulons le menu Géométrie et nous doubles cliquons sur $area. Cette expression apparaît dans le panneau Expression. Comme notre couche est en Lambert 93 dont l’unité est le mètre, il nous faut diviser la superficie par 1000000 pour obtenir une superficie en kilomètres carrés. Nous obtenons ainsi l’expression $area / 1000000.


Astuce

Dans la majorité des cas, nous utilisons la fontion $area, mais il existe aussi une fonction area. Quelle est la différence entre les deux ? Dans le premier cas, la surface est calculée en prenant en compte l’ellipsoïde du SCR. Autrement dit, il s’agît d’une surface qui prend en compte la courbure de la Terre. Dans le second cas, la surface est calculée de façon planimétrique, comme si la Terre était plate. C’est pourquoi, nous utilisons le plus souvent la fonction $area qui donne des résultats plus proches de la réalité.



Une fois l’expression entrée, nous cliquons sur OK. Nous avons bien maintenant un champ de superficie associée à la table attributaire (Fig. 205).


[image: alternate text]

Fig. 205 Le champ de superficie en kilomètres carrés.



Notons qu’au moment du calcul du champ, la couche passe automatiquement en mode édition. Il est ensuite nécessaire d’enregistrer la modification en cliquant sur l’icône Enregistrer les modifications de la couche [image: icone-enregistrer] puis de quitter le mode édition en cliquant sur l’icône Basculer en mode édition [image: icone-edition].


Astuce

Dans la Calculatrice de champ, dans le panneau central nous trouvons le menu déroulant Récent (fieldcalc) qui contient l’historique des dernières expressions calculées. Ce menu s’avère très pratique à l’usage.





Calcul de champs dans R

Version de R : 4.8.1

Après l’import d’un fichier vecteur dans R, il est possible de manipuler ses attributs et notamment d’en calculer de nouveaux. Ici, nous travaillerons sur un vecteur des départements de France métropolitaine de type polygone, stocké dans une variable nommé dep sous forme d’un objet sf. Cette couche est projetée en Lambert 93 (Pour la France).


Ajout d’un champ texte

Nous pouvons ajouter à chaque entité un attribut de type texte nommé type_admin qui contiendra simplement le terme departement. Cette manipulation se fait suivant la syntaxe classique de R.

dep$type_admin <- 'departement'





Par cette simple commande, un nouveau champ nommé type_admin sera ajouté et rempli selon la valeur désirée.


Astuce

Cette manipulation est valable aussi bien pour les objets sf que SpatVector.





Ajout d’un champ lié à la géométrie

Nous pouvons ajouter un champ lié à la géométrie de la couche, comme une superficie, une longueur, un couple (X, Y), … Ces valeurs seront exprimées dans l’unité du système de coordonnées de référence de la couche. Il s’agît dans la plupart des cas de mètres, mais attention il peut également s’agir de degrés dans le cas des SCR globaux (Pour le monde). Ici, nous allons ajouter un attribut, nommé superficie, qui stockera la superficie de chaque département exprimée en kilomètres carrés. Comme cette couche est en Lambert 93, son unité de base est le mètre. Il faudra bien penser à faire la conversion des m2 vers les km2.


Calcul-champ-geom avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

Avec un objet SpatVector, la fonction de calcul de la superficie est expanse, et celle du calcul du périmètre est perim. En plus de la superficie, nous allons également calculer le périmètre de chaque département en km.

# chargement du vecteur
dep <- terra::vect('departements_france_L93.gpkg')
# ajout d'une colonne de superficie
dep$superficie_km2 <- terra::expanse(dep) / 1000000
# ajout d'une colonne de périmètre
dep$perimetre_km <- terra::perim(dep) / 1000







Calcul-champ-geom avec sf

Version de R : 4.3.1

Version de sf : 1.0.12

La librairie sf utilisée est st_area(). Cette méthode renvoie la superficie de chacune des entités de la couche dans l’unité de référence de la couche. Nous divisons cette valeur par 1000000 afin de passer des superficies en m2 vers des superficies en km2.

dep$superficie <- as.numeric(st_area(dep) / 1000000)






Astuce

Nous convertissons ce nouvel attribut en numérique via la méthode as.numeric(). Si nous le le faisons pas, le champ ne sera pas de type numérique mais dans un type nommé units qui sera moins facile à manipuler.






Ajout d’un champ d’ID

Il peut être utile d’ajouter un champ ID qui contiendra un identifiant unique pour chaque entité d’une couche vecteur donnée. Ici, nous ajouterons un champ ID à une couche de départements.


Ajout d’un champ d’ID avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

# import de la couche à utiliser
dep <- terra::vect('departements_france_L93.gpkg')

# ajout d'une colonne d'ID
dep[['ID']] <- 1:nrow(dep)





Nous avons ajouté à notre SpatVector une colonne ID contenant un identifiant unique.



Ajout d’un champ d’ID avec sf

Version de R : 4.3.1

Version de sf : 1.0.12

# import de la couche à utiliser
dep <- sf::st_read('departements_france_L93.gpkg')

# ajout d'une colonne d'ID
dep_id <- cbind(ID = 1:nrow(dep), dep)





Nous avons créé une nouvelle couche dep6 dans laquelle une colonne d’ID a été ajoutée. Les numéros d’ID sont dans l’ordre d’enregistrement des entités.






Renommer un champ

Les tables attributaires associées aux données vecteurs ne sont pas figées. L’utilisateur peut tout à fait renommer un champ pour rendre son intitulé plus explicite ou corriger une faute de frappe.


Renommer un champ dans QGIS

Version de QGIS : 3.16.1

La manipulation est simple, mais le chemin pour le faire ne se devine pas. Une fois la couche à modifier chargée dans QGIS, nous allons dans ses Propriétés en cliquant droit sur la couche en question dans le panneau des couches et en sélectionnant le menu Propriétés. Une fois les propriétés ouvertes nous allons dans l’onglet Champs (Fig. 206).


[image: alternate text]

Fig. 206 Les propriétés des champs d’une couche vecteur.



Nous y trouvons la liste des champs de la couche vecteur. Nous trouvons notamment le Nom des champs qui est l’intitulé des champs. Il y a également le Type des champs. Ici, nous avons des champs de type QString, Int et même QDateTime. Dans la colonne d’à côté, nous avons le nom générique de ces types : String (texte), Integer (entier) et DateTime (date avec l’heure). Nous avons également la Longueur et la Précision des champs. Par exemple, le champ CdOH contient du texte qui ne peut pas contenir plus de 19 caractères.

Le nombre de types de champs possibles varient selon le format du fichier. Ici, il s’agît d’un GeoPackage, format qui propose une certaine variété de types possibles. Par contre, un shapefile sera plus limité. Le type DateTime ne sera, par exemple, pas possible dans ce format.

Via cet interface nous allons pouvoir renommer les champs que nous souhaitons. Pour cela, nous basculons en mode édition en cliquant sur l’icône correspondante [image: icone-edition]. Deux nouveaux menus deviennent accessibles, mais ils ne vont pas nous intéresser pour le renommage de champ. Nous allons simplement double cliquer sur le Nom du champ à modifier. Par exemple, nous allons renommer le champ TopoOH en TopoStation. Nous double cliquons sur le Nom de ce champ et nous avons accès à son édition (Fig. 207).


[image: alternate text]

Fig. 207 Renommer un champ.



Il suffit alors de taper le nom désiré à la place de l’ancien.


Note

Notons bien que seul le nom du champ peut être changé. Son type n’est pas modifiable.



Une fois la modification effectuée, nous cliquons sur Appliquer puis OK. En ouvrant la table d’attributs de la couche, nous constatons bien que le nom a été modifié.


Avertissement

Si nous travaillons sur un shapefile, n’oublions pas que le nom des champs est limité à 8 caractères seulement.





Renommer un champ dans R

Version de R : 4.8.1

Renommer un champ dans R est possible mais la méthode à employer diffère selon que nous travaillons sur un objet sf ou SpatVector de terra. Nous verrons ici les deux méthodes.


Renommer un champ dans terra

Version de R : 4.3.1

Version de terra : 1.7.29

Dans cet exemple, nous chargeons un GeoPackage des départements de France métropolitaine dans un objet SpatVector nommé dep. Nous verrons comment renommer le nom d’un champ selon son indice et selon son nom.

# chargement de la couche
dep <- terra::vect('departements_france_L93.gpkg')
# on affiche le nom des champs
names(dep)
# on renomme le 1er champ
names(dep)[1] <- 'Code_Departement'
# on renomme le champ nommé 'Nom_Depart'
names(dep)[names(dep) == 'Nom_Depart'] <- 'Nom_Departement'







Renommer un champ dans sf

Version de R : 4.3.1

Version de sf : 1.0.12

Dans cet exemple, nous chargeons un GeoPackage des départements de France métropolitaine dans un objet sf nommé dep. Nous verrons comment renommer le nom d’un champ selon son indice et selon son nom.

# chargement de la couche
dep <- sf::st_read('departements_france_L93.gpkg')
# on affiche le nom des champs
names(dep)
# on renomme le 1er champ
names(dep)[1] <- 'Code_Departement'
# on renomme le champ nommé 'Nom_Depart'
names(dep)[names(dep) == 'Nom_Depart'] <- 'Nom_Departement'









Changer le format d’un champ

Il arrive qu’il soit nécessaire de changer le format d’un champ, de le convertir dans un autre type. Par exemple, un champ que nous voudrions avoir au format Entier est en fait en format Texte et nous ne pouvons donc pas le manipuler comme nous le souhaiterions. Dans ce cas, il est possible de transformer ce champ de type Texte en type Entier (ou Réel).

Dans la plupart des cas il n’est pas possible de changer le type d’un champ. La stratégie consiste donc à créer un nouveau champ dans le type désiré puis de le mettre à jour en copiant les valeurs de l’ancien champ en les convertissant.


Avertissement

Il n’est bien sûr pas possible de tout convertir en n’importe quoi. Le texte 95 pourra être converti en entier 95 et même en réel 95.0 mais le texte Val-d’Oise ne pourra évidemment pas être converti en format numérique.



Dans les exemples suivants nous allons convertir le champ des codes INSEE des communes des Hauts-de-Seine (92) qui sont en Texte en type Entier. Cette transformation nous permettrait par exemple de pouvoir facilement sélectionner tous les départements dont leur numéro est supérieur à 90 (si nous disposions des départements pour toute la France).


Convertir un champ dans QGIS

Version de QGIS : 3.18.3

Dans QGIS la procédure à suivre est simple. Après avoir chargé la couche à modifier nous ouvrons sa table attributaire (Fig. 208).


[image: alternate text]

Fig. 208 Ouverture de la table attributaire à modifier.



Ici nous nous intéressons au champ INSEE_COMM. À première vue il contient des nombres mais on s’aperçoit que c’est en fait un champ textuel car ces « nombres » sont alignés sur la gauche des cellules. Les « vrais » nombres sont alignés sur la droite de la cellule comme nous pouvons le voir dans les champs de coordonnées des chefs lieux X et Y.

Si le doute persiste nous pouvons faire un clic droit sur la couches dans le panneau des couches puis Propriétés… ‣ Champs. Le format des champs de la table attributaire s’affiche alors (Fig. 209).


[image: alternate text]

Fig. 209 Format des champs de la table attributaire.



Nous constatons bien que le champ INSEE_COM est bien de type String (Texte, pas l’accessoire de mode…). Pour créer un nouveau champ qui contiendra ce code INSEE mais au format numérique Entier (Integer) nous sélectionnons la couche à modifier dans le panneau des couches et nous ouvrons la calculatrice de champ en cliquant sur l’icône Ouvrir la calculatrice de champ [image: icone_calc_champ]. La calculatrice de champ s’ouvre alors (Fig. 210).


[image: alternate text]

Fig. 210 Création d’un nouveau champ avec un nouveau format.



Nous cochons la case Créer un nouveau champ, dans le champ Nom, nous spécifions un nom pour le champ qui sera créé, par exemple INSEE_int et dans le champ Type nous spécifions le type du champ qui sera créé, à savoir Nombre entier (entier). Dans le bloc Expression, nous entrons l’expression qui permet la conversion

to_int("INSEE_COM")





Nous pouvons nous aider de l’explorateur de fonctions du panneau central : Conversions et Champs et valeurs pour construire cette expression. Puis nous cliquons sur OK.


Astuce

Il est tout à fait possible de convertir ce champ Texte vers un nombre réel plutôt que vers un entier. Dans ce cas, nous mettons le type de champ à Nombre décimal (réel) et nous utilisons la fonction to_real( ) plutôt que to_int( ).



En ouvrant la table attributaire nous constatons bien que le nouveau champ a été créé dans le bon format. Il ne reste plus qu’à quitter le mode édition de la couche et à la sauver.




Supprimer un champ

Les tables attributaires associées aux données vecteurs ne sont pas figées. L’utilisateur peut tout à fait supprimer un champ qui s’avérerait inutile ou faux.


Supprimer un champ dans QGIS

Version de QGIS : 3.16.1

La manipulation est très simple. Une fois notre couche vectorielle dont nous souhaitons supprimer un champ est chargée dans QGIS, nous commençons par ouvrir sa table attributaire. Une fois la table ouverte, nous passons en mode édition en cliquant sur l’icône [image: icone-edition] (Fig. 211).


[image: alternate text]

Fig. 211 Ouverture de la table en mode édition.



Une fois le mode édition activé, de nouveaux menus deviennent accessibles dans la barre d’outils. Nous y retrouvons notamment le menu Supprimer le champ [image: icone-suppr-champ]. Nous cliquons dessus et le menu suivant s’ouvre (Fig. 212).


[image: alternate text]

Fig. 212 Liste des champs à supprimer.



Ce menu liste tous les champs de la couche et invite l’utilisateur à sélectionner le ou les champs à supprimer. Par exemple, si nous souhaitons supprimer les champs CdOH, TopoOH et CommentaireOH, nous les sélectionnons en maintenant la touche Ctrl enfoncée (Fig. 213).


[image: alternate text]

Fig. 213 Sélection des champs à supprimer.



Une fois cette sélection effectuée, il ne reste plus qu’à cliquer sur OK. Nous revenons à la table attributaire et nous constatons que les champs en question ont bien été supprimés. Il ne reste plus qu’à cliquer sur Enregistrer les modifications [image: icone-enregistrer] et à sortir du mode édition en recliquant sur l’icône [image: icone-edition].



Supprimer un champ dans R

Nous pouvons supprimer un ou plusieurs champs d’une table attributaire d’un objet vecteur dans R. La méthode diffère selon que nous travaillons sur un objet sf ou SpatVector. Nous verrons ici les deux.


Supprimer un champ avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

Pour supprimer un champ depuis un objet SpatVector, il va falloir passer par la librairie tidyterra et sa fonction select. Dans l’exemple ci-après, nous allons supprimer les champs POP_1999 et Nom_reg d’un SpatVector des départements de France métropolitaine.

# chargement du vecteur
dep <- terra::vect('departements_france_L93.gpkg')
# suppression des champs
dep <- dep %>% tidyterra::select(-one_of('POP_1999', 'Nom_reg'))







Supprimer un champ avec sf

Version de R : 4.3.1

Version de sf : 1.0.12

Avec un objet sf, le plus simple est d’utiliser la fonction select de la librairie dplyr. Ici, nous allons travailler sur une couche vecteur des départements français chargés sous forme d’un objet sf. Le code pour supprimer un ou plusieurs champs est présenté ci-dessous.

# chargement des librairies utilisées
library(sf)
library(dplyr)

# chargement de la couche
dep <- sf::st_read("departements_france_L93.gpkg")

# supprimer un seul champ
dep3 <- dep %>% select(-'POP_1999')

# supprimer plusieurs champs en même temps
dep4 <- dep %>% select(-one_of('POP_1999', 'Nom_reg'))





Nous avons ainsi créé une couche vecteur dep3 dont le champ POP_1999 seul a été supprimé. Ensuite, une couche vecteur dep4 a été créée dans laquelle, les champs POP_1999 et Nom_reg ont été supprimés en une seule fois.


Astuce

D’autres options existent pour sélectionner les champs à supprimer. Cette page en présente [https://www.statology.org/remove-columns-in-r/] quelques unes intéressantes.






Sélectionner un champ dans R

Version de R : 4.3.1

Il est parfois utile de supprimer les attributs qui ne nous sont pas utiles dans notre analyse afin d’alléger ses traitements. Dans cet exemple, nous allons sélectionner les champs Code_Depar et POP_1999 depuis un SpatVector des départements de France métropolitaine. La manipulation revient à supprimer tous les champs sauf ceux-ci.

# chargement du vecteur
dep <- terra::vect('departements_france_L93.gpkg')
# sélection des champs
dep_new <- dep[c('Code_Depar', 'POP_1999')]






Astuce

La manipulation est la même pour un objet sf.






Ordonner les champs

Les tables attributaires associées aux données vecteurs ne sont pas figées. L’utilisateur peut tout à fait modifier l’ordre des champs, i.e. l’ordre des colonnes.


Ordonner les champs dans R

Il est possible de facilement réordonner l’ordre des champs d’une table attributaire dans R.


Ordonner les champs avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

Dans cet exemple, nous allons réordonner les champs d’un SpatVector des départements de France métropolitaine.

# chargement du vecteur
dep <- terra::vect('departements_france_L93.gpkg')
# réordonner les champs
dep_new <- dep[c('Nom_reg', 'code_reg', 'Nom_Depart', 'Code_Depar', 'POP_1999', 'SUP_KM2')]







Ordonner les champs avec sf

Version de R : 4.3.1

Version de sf : 1.0.12

Si nous travaillons avec un objet sf, le plus simple est d’utiliser la fonction select de la librairie dplyr. Dans l’exemple, nous allons travailler sur une couche vecteur des départements français, au préalable chargée en tant qu’objet sf. Le code ci-dessous montre un exemple de changement d’ordre des colonnes.

# chargement des librairies utilisées
library(sf)
library(dplyr)

# chargement de la couche
dep <- sf::st_read("departements_france_L93.gpkg")

# changement de l'ordre des colonnes de la table attributaire
dep5 <- dep %>% select('Nom_Depart', 'Code_Depar', 'code_reg', 'SUP_KM2')





Nous avons ainsi créé une couche vecteur dep5 dont les champs sont maintenant dans l’ordre tel qu’indiqué dans la fonction select().





Jointure attributaire

La jointure attributaire est une opération fondamentale en SIG et en exploration de bases de données en général. Ce type de jointure permet de relier deux tables, dans le cas des SIG nous parlerons de deux couches vecteurs, entre elles grâce à un champ commun. Par exemple, si nous possédons deux couches de communes d’une région donnée, avec des attributs différents (le Nom pour l’une et la Population pour l’autre) nous pouvons les relier si elles possèdent un champ commun. Dans l’exemple, le champ commun pourrait être le code INSEE de la commune (Fig. 214).


[image: alternate text]

Fig. 214 Exemple de jointure attributaire sur un champ commun.



Le champ commun doit être de même type, entier ou texte dans la plupart des cas. Si le champ est de type texte, les codes textuels doivent être rigoureusement identiques : même casse, même orthographe, … Il est souvent recommandé de passer par des codes officiels plutôt que par les champs textuels quand c’est possible. Par exemple, pour lier deux couches selon le Département il sera plus judicieux de passer par le code (01, 02 …,  95) que par le nom. En effet, nous sommes sûrs du numéro 95 alors que Val-d’Oise peut être orthographié val d’oise, val-d’oise, val d oise, …

Notons que si plusieurs lignes, i.e. plusieurs entités, d’une des couches possèdent le même code mais que ce code n’est représenté que par une seule entité dans la seconde table, il faudra faire attention à ne garder qu’une liaison ou bien toutes les liaisons possibles, au prix d’une multiplication des entités.


Jointure attributaire dans QGIS

Version de QGIS : 3.22.3

Les jointures attributaires sont très faciles à mettre en place dans QGIS. Dans cet exemple d’application, nous allons joindre la couche des lieux de culte en région Île-de-France avec la couche des communes d’Île-de-France. Le but sera d’associer à chaque lieu de culte le nom de la commune dans lequel il se situe. Le champ commun aux deux couches que nous utiliserons sera la code INSEE de la commune. Dans le cas de la couche des communes il est connu sous le nom de INSEE_COM et dans la couche des lieux de culte CODE_INSEE. Dans les deux cas il s’agît d’un champ de type texte (string) (Fig. 215).


[image: alternate text]

Fig. 215 Les deux couches à joindre ouvertes dans QGIS.



Une fois les deux couches ouvertes dans QGIS, nous faisons un clic droit sur la couche sur laquelle nous souhaitons rapatrier les attributs, à savoir la couche des lieux de culte dans notre cas. Une fois le clic droit effectué, nous cliquons sur Propriétés… ‣ Jointures, puis nous cliquons sur l’icône [image: icone_plus] Ajouter une nouvelle jointure en bas du panneau principal. La fenêtre suivante s’ouvre (Fig. 216).


[image: alternate text]

Fig. 216 Paramétrage de la jointure attributaire dans QGIS.



Dans le champ Joindre la couche nous sélectionnons la couche à joindre, à savoir la couche communes_IDF. Dans le champ Champ de jointure, nous indiquons le champ qui sert pour la jointure dans cette couche, ici INSEE_COM, dans le champ Champ cible nous indiquons le champ pour la jointure dans la couche initiale (celle des leiux de culte), ici CODE_INSEE. Nous pouvons cocher l’option Champs joints afin de ne joindre que le ou les champs qui nous intéressent, dans notre cas NOM_COM. Sinon par défaut, tous les champs sont joints. Enfin, en cochant l’option Personnaliser le préfixe du nom du champ, nous pouvons indiquer un préfixe pour le champ qui sera rapatrié, ici commune. Puis nous cliquons sur OK, puis encore OK.

Si nous ouvrons maintenant la table attributaire de la couche des lieux de culte, le nom de la commune a bien été rapatrié dans le champ commune_NOM_COM. Cependant, à ce stage la jointure n’est pas sauvée. Afin de vraiment la sauvegarder, il est nécessaire d’exporter notre couche dans une nouvelle couche en faisant un clic droit dessus dans le panneau des couches et en sélectionnant Exporter ‣ Sauvegarder les entités sous…


Avertissement

Pensez bien à sauvegarder le résultat de la jointure en exportant la couche résultat dans une nouvelle couche.





Jointure attributaire dans R

Version de R : 4.8.1

Il est possible de faire des jointures attributaires dans R. La méthode diffère un peu selon que nous travaillons sur un objet sf ou SpatVector. Nous verrons les deux. Dans les deux cas, nous commencerons par charger deux GeoPackage des départements de Frane métropolitaine. Le premier, dep_sup, contient un champ avec les codes des départements nommé Code_Departement et un champ contenant les superficies des départements. Le second, dep_pop, contient un champ avec les codes des départements nommé Code_Depar et un champ contenant les populations des départements. L’objectif est de joindre les deux couches selon le code du département afin d’obtenir une couche finale contenant trois champs : code, superficie et population.


Jointure attributaire dans terra

Version de R : 4.3.1

Version de terra : 1.7.29

La jointure se fait à l’aide de la fonction merge de terra.

# chargement des couches
dep_sup <- terra::vect('dep_sup.gpkg')
dep_pop <- terra::vect('dep_pop.gpkg')

# on joint les deux couches par le champ qui contient le code du département
dep_sup_pop <- terra::merge(dep_sup, dep_pop, by.x='Code_Departement', by.y='Code_Depar')






Avertissement

Nous n’avons ici conservé que les entités qui étaient présentes sur les deux couches initiales, c’est-à-dire que nous avons fait une Inner Join. D’autres types de jointure sont possibles [https://www.datasciencemadesimple.com/join-in-r-merge-in-r/], à utiliser selon les besoins.





Jointure attributaire dans sf

Version de R : 4.3.1

Version de sf : 1.0.12

Ces jointures se font à l’aide de la fonction merge(). Cette fonction merge() ne fonctionne pas sur deux objets de type sf. Il va falloir en transformer un en simple dataframe (ce qui revient à ne conserver que sa table attributaire) puis joindre ce simple dataframe à l’autre objet resté de type sf.

# chargement des couches
dep_sup <- terra::vect('dep_sup.gpkg')
dep_pop <- terra::vect('dep_pop.gpkg')

# on transforme la seconde couche en simple dataframe
dep_pop <- sf::st_drop_geometry(dep_pop)
# on joint le 'sf' avec le le simple dataframe
dep_sup_pop <- merge(x=dep_sup, y=dep_pop, by.x='Code_Departement', by.y='Code_Depar')





Nous avons ainsi créé une nouvelle couche qui contient les champs des deux couches initiales.


Avertissement

Nous n’avons ici conservé que les entités qui étaient présentes sur les deux couches initiales, c’est-à-dire que nous avons fait une Inner Join. D’autres types de jointure sont possibles [https://www.datasciencemadesimple.com/join-in-r-merge-in-r/], à utiliser selon les besoins.







Sélection attributaire

Un des points fondamentaux des SIG est de permettre des sélections attributaires, aussi appelées requêtes attributaires. La sélection d’entités basée sur des critères fondés sur les attributs d’une couche est un aspect fondamental des SIG. C’est même presque la raison d’être des SIG. Ces sélections peuvent être très simples ou très complexes. Selon les besoins et les connaissances de l’utilisateur, les sélections sont un outil puissant. L’interrogation des données attributaires se fait selon le langage SQL. Ce langage a l’avantage d’être simple pour des requêtes basiques mais peut se complexifier pour mener à bien des requêtes complexes.

Ce type de requêtes est qualifié de requêtes attributaires, à mettre en parallèle des requêtes spatiales présentées dans un autre chapitre.


Requêtes attributaires dans QGIS

Version de QGIS : 3.16.1

Dans QGIS, les requêtes attributaires se font simplement via le menu Sélection par expression. Ce menu est accessible depuis la barre d’outils de sélection (Fig. 217). Il faut au préalable avoir sélectionné la couche à interroger dans le panneau de couches. Dans cet exemple, nous travaillerons sur la couche des communes des Hauts-de-Seine (92) communes_92.gpkg.


[image: alternate text]

Fig. 217 Ouverture du menu de sélection par expression.



Plus précisément, le menu à utiliser se nomme Sélectionner des entités à l’aide d’une expression… dont l’icône ressemble à ça [image: icone-select-expr]. Une fois ce menu sélectionné, la fenêtre de Sélection par expression s’affiche (Fig. 218).


[image: alternate text]

Fig. 218 Le menu de sélection par expression.



Dans ce menu, nous retrouvons sur la gauche un panneau Expression. C’est dans ce panneau que nous entrerons notre expression en SQL nous permettant de faire notre requête. Dans le panneau central, nous trouvons des menus déroulants contenant des fonctions qui vont nous servir pour construire notre requête. Ces fonctions sont rangées par grand thème : celles qui permettent de manipuler le texte (Chaîne de caractères), celles portant sur les conversions de type (Conversions), celles permettant de requêter sur la géométrie (Géométrie), etc

Un menu déroulant que nous utiliserons tout le temps est celui permettant d’accéder aux champs de la couche Champs et valeurs (Fig. 219).


[image: alternate text]

Fig. 219 Liste des champs de la couche et de leurs valeurs.



En déroulant ce menu, nous accédons à la liste des champs présents dans cette couche. Nous pouvons ensuite cliquer sur un champ et demander à QGIS de nous lister toutes les valeurs uniques de ce champ ou un échantillon de dix valeurs via le panneau en bas à droite. Cette fonctionnalité s’avère très intéressante pour éviter de faire des fautes lorsqu’on requête sur un champ texte. Par exemple, dans notre cas, ça nous évite de chercher Boulogne-Billancourt, boulogne billancourt, boulogne-billancourt … mais d’avoir directement accès à l’orthographe tel qu’enregistré dans la couche.


Avertissement

La casse d’un mot (i.e. le fait qu’il soit écrit en majuscules ou en minuscules) est important. Ainsi Malakoff et MALAKOFF sont deux mots différents.



Il faut être prudent avec cette fonctionnalité de lister toutes les valeurs uniques. Sur un champ contenant des milliers de valeurs différentes (typiquement un champ numérique) QGIS va avoir du mal à les lister.


Requête basique

Nous allons commencer par construire une requête très basique mais fondamentale. Nous allons sélectionner les communes qui ont plus de 50 000 habitants. Nous allons donc interroger le champ Population.

Pour cela, dans le panneau central, dans le menu Champs et valeurs, nous double cliquons sur POPULATION. Le champ apparaît alors dans le panneau de gauche encadré de guillemets. Les guillemets font partie de la syntaxe SQL. Elles sont un marqueur pour bien préciser que le texte entre ces guillemets renvoie à un nom de champ.

Ensuite, de façon tout à fait naturel, nous entrons la suite de l’expression : > 50000 (Fig. 220).


[image: alternate text]

Fig. 220 Requête permettant de sélectionner les communes de plus de 50 000 habitants.



Il n’y a plus qu’à cliquer sur Sélectionner des entités. Les communes qui répondent à ce critère apparaissent en jaune (Fig. 221).


[image: alternate text]

Fig. 221 Résultat de la requête, les communes correspondant au critère apparaissent en jaune.



En ouvrant la table attributaire, les lignes correspondantes aux communes sélectionnées sont surlignées en bleu. Nous avons également le compte de communes sélectionnées en haut du cadre de la fenêtre de cette table, ici 12 (Fig. 222).


[image: alternate text]

Fig. 222 12 communes répondent au critère de sélection.




Note

Pour déselectionner les entités, le plus simple est de cliquer sur l’icône Déselectionner toutes les entités [image: icone-deselect].





Requête avec des booléens

Il est souvent nécessaire d’inclure dans notre requête des opérateurs booléens comme Et, Ou … Par exemple, nous pouvons avoir besoin de ne sélectionner que les communes dont la population est comprise entre 30000 et 50000 habitants. Dans ce cas, l’opérateur Et (And) sera nécessaire. Notre requête s’écrira alors "POPULATION" > 30000  AND  "POPULATION" < 50000 (Fig. 223).


[image: alternate text]

Fig. 223 Sélection utilisant un booléen.



Comme précédemment, les communes répondant à ce double critère apparaissent en jaune.

Une fonctionnalité intéressante de QGIS est de se servir d’une fonction booléenne un peu « cachée ». C’est une sorte de fonction booléenne par bricolage. Imaginons que nous souhaitions sélectionner les communes précédentes et aussi la commune de Vaucresson (qui n’entre pas dans le critère). La manière élégante et SQL de procéder est d’entrer la requête suivante ("POPULATION" > 30000  AND  "POPULATION" < 50000) or "NOM_COM" = 'VAUCRESSON'. Nous remarquons l’ajout de parenthèse autour de la première condition et l’apparition du booléen OR suivi de la seconde condition. L’exécution de cette requête donne bien le résultat attendu.

Une manière moins élégante mais parfois plus rapide est de se servir de la fonctionnalité Ajouter à la sélection actuelle. Concrètement, dans un premier temps, il suffit d’entrer seulement la requête principale dans le panneau Expression "POPULATION" > 30000  AND  "POPULATION" < 50000 puis de l’exécuter normalement en cliquant sur Sélectionner des entités. Une fois les entités sélectionnées, nous les gardons bien sélectionnées et nous entrons maintenant la requête secondaire "NOM_COM" = 'VAUCRESSON'. Mais au lieu de cliquer sur Sélectionner des entités, nous cliquons sur Ajouter à la sélection actuelle (Fig. 224).


[image: alternate text]

Fig. 224 Ajouter un résultat de sélection à une sélection précédente.



Une fois cette seconde requête exécutée de cette façon, la commune de Vaucresson est bien ajoutée à notre précédente sélection.

Un point encore plus intéressant est que ce principe peut être utilisé pour des sélections du type : sélectionne moi toutes ces communes sauf celle-ci. Le sauf peut être fastidieux à retranscrire en SQL. Ici, par exemple, nous allons sélectionner nos communes comprises entre 30000 et 50000 habitants sauf la commune de Puteaux qui répond pourtant au critère. La façon élégante serait d’écrire la requête suivante ("POPULATION" > 30000  AND  "POPULATION" < 50000) AND "NOM_COM" != 'PUTEAUX'. Nous retrouvons nos parenthèses autour de la requête principale et notre requête secondaire mais cette fois-ci liée par un AND et présentant l’opérateur != qui signifie différent de. Notre requête se lit donc comme suit : Sélectionne moi les communes qui ont plus de 30000 habitants et moins de 50000 habitants et dont le nom n’est pas Puteaux. Ça reste gérable mais on sent que ça peut vite se compliquer.

Dans ce cas, un moyen simple est de commencer par exécuter la requête principale seule. Une fois les communes sélectionnées, nous retournons dans le menu de sélection par expression et nous y entrons la requête simple "NOM_COM" = 'PUTEAUX'. Puis, au lieu de cliquer sur Sélectionner des entités, nous cliquons sur Supprimer de la sélection actuelle (Fig. 225).


[image: alternate text]

Fig. 225 Enlever une entité de la sélection précédente.



Ainsi, la commune qui répond au second critère est enlevée de la sélection précédente. C’est donc un moyen de faire des requêtes booléennes sans trop de gymnastique mentale.



Requête avec des opérateurs textuels

Il est possible de faire des requêtes un peu poussées sur des champs de type String (Texte). Pour cet exemple, nous allons charger la couche des communes d’Île-de-France « communes_IDF.gpkg ». Nous allons sélectionner les communes dont le code INSEE commence par 95. Nous allons donc extraire les communes du Val-d’Oise. Ce code se trouve dans le champ INSEE_COM. Nous ouvrons le menu de sélection par expression. Nous allons voir comment dire en SQL « Sélectionne moi toutes les communes dont le champ INSEE_COM commence par 95 ». La syntaxe ne se devine pas.

La requête s’écrit ainsi "INSEE_COM" like '95%'. Les deux choses importantes à saisir sont la présence de mot clef like et du symbole %. Like est utilisé dans le cas d’une comparaison pour un champ texte. Le % est un caractère joker qui signifie n’importe quel caractère. Ainsi 95% équivaut à un texte commençant par 95 suivi de n’importe quel caractère (un ou plusieurs, sans importance) (Fig. 226).
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Fig. 226 Sélectionner les communes dont le code commence par 95.



Dans la même logique, il est possible de sélectionner les communes dont le nom est composé, c’est-à-dire qui contiennent le caractère -. La requête sera alors "NOM_COM" like '%-%'. Nous sélectionnons ici les communes dont le nom commence par n’importe quel caractère suivi d’un - puis suivi de n’importe quel caractère. Nous nous apercevons que quasiment la moitié des communes d’Îlde-de-France présente un nom composé !

Il est également possible de sélectionner des entités dont un champ texte fait partie d’une liste donnée. Par exemple si nous souhaitons sélectionner les communes de Cergy, Pontoise, Malakoff et Bobigny, nous sommes, de prime abord, tentés d’écrire la requête suivante : "NOM_COM" = 'CERGY' or  "NOM_COM" = 'PONTOISE' or  "NOM_COM" = 'MALAKOFF' or  "NOM_COM" = 'BOBIGNY'. Cette requête va parfaitement fonctionner mais sa lisibilité laisse à désirer. Nos chances d’oublier une «  ou un = sont importantes.

Il existe un moyen plus simple de faire ce genre de sélection. Nous pouvons nous servir du mot clef SQL in, de la façon suivante : "NOM_COM" in ('CERGY', 'PONTOISE', 'MALAKOFF', 'BOBIGNY'). Nous avons ici quelque chose de beaucoup plus lisible et moins source d’erreur.

Mais comment dire que nous souhaiterions sélectionner toutes les communes de la région sauf ces quatre ci ? La solution SQL consiste à écrire la requête suivante : "NOM_COM" not in ('CERGY', 'PONTOISE', 'MALAKOFF', 'BOBIGNY'). Le mot clef not permet de sélectionner ce qui n’est pas dans la liste. Mais une technique de Sioux consiste à sélectionner ces quatre communes comme dans l’exemple précédent puis d”inverser la sélection grâce à la fonction Inverser la sélection [image: icone-inverser] se trouvant dans la barre d’outils de la table attributaire.



Requête basée sur la géométrie

Jusqu’ici nous avons vu des requêtes qui n’ont fait intervenir aucun concept géographique. Or l’avantage d’un SIG est justement que les entités gérées sont spatialisées et disposent donc d’attributs spatiaux. Pour une entité de type polygone nous pouvons donc avoir accès à sa superficie.

Ce fait est tout à fait intéressant lorsque nous souhaitons sélectionner des entités selon leurs tailles, même si aucun champ de superficie n’existe. Nous allons par exemple sélectionner les communes d’Île-de-France de plus de 20 km2. Nous retournons dans le menu de sélection par expression et en nous aidant du menu déroulant Géométrie qui se trouve dans le panneau central nous pouvons entrer directement la requête suivante $area > 20 * 1000000. La fonction $area retourne la superficie de chaque entité exprimée dans les unités du SCR, à savoir ici des mètres. C’est pourquoi nous multiplions par 1000000 notre critère de taille. Souvent, pour ce type de requête nous sommes tentés de d’abord créer un vrai champ Superficie puis ensuite de requêter dessus, alors que ce n’est absolument pas nécessaire (Fig. 227).


[image: alternate text]

Fig. 227 Sélectionner sur la superficie sans champ de superficie.



Cet aspect peut bien sûr être couplé aux champs présents. Par exemple, il est tout à fait possible de sélectionner les communes dont la densité d’habitants est supérieure à 50 habitants par kilomètres carrés via la requête suivante : ("POPULATION" / ( $area / 1000000)) > 50. Il faut bien faire attention aux parenthèses et à la conversion de la superficie et la requête donne le résultat escompté. Cette requête remplace le fait de créer un champ Superficie puis un champ Densité puis une requête sur ce dernier champ.




Requêtes attributaires dans R

Une fois une couche vecteur chargée dans R, il est possible d’y effectuer tout type de requêtes attributaires. Faire ce type de requêtes dans R est un moyen puissant pour chaîner les opérations en évitant d’écrire en dur sur le disque tous les fichiers intermédiaires.


Sélection attributaire avec terra

Version de R : 4.3.1

Version de terra :

Dans cet exemple, nous commençons par charger les départements de France métropolitaine dans un objet SpatVector, qui possède un attribut SUP_KM2 qui correspond à la superficie de chaque département. Puis nous allons créer un nouvel objet SpatVector dans lequel nous ne stockerons que les départements dont la superficie est supérieure à 7000 km  2. Cette sélection se fait à l’aide de la fonction subset de terra.

grands_dep <- terra::subset(dep, dep$SUP_KM2 >= 7000)







Sélection attributaire avec sf

Version de R : 4.3.1

Version de sf : 1.0.12

Dans cet exemple, nous effectuerons une requête sur une couche vecteur contenant les départements français stockée dans une variable nommée departements sous la forme d’un objet sf. Cette couche possèse un champ nommé superficie contenant les superficies de chaque département exprimé en km 2. Dans l’exemple, nous sélectionnons tous les départements dont la superficie est supérieure à 1500 km  2. Nous sauvons le résultat de cette sélection dans une variable nommée grands_dep. Cette sélection n’est finalement rien d’autre qu’un filtre au sens de R, comme il est possible de les appliquer à tout objet de type dataframe.

grands_dep <- dep[(dep$superficie > 1500),]






Note

Se référer à la documentation de base de R pour bien saisir la syntaxe employée pour les filtres [https://www.geeksforgeeks.org/how-to-filter-r-dataframe-by-values-in-a-column/].







Regrouper des entités selon un attribut

En SIG, comme en gestion de bases de données en général, il est souvent nécessaire de dériver une nouvelle table, une nouvelle couche en SIG, à partir d’une table existante, par regroupement de géométries. Ce traitement est connu sous différents noms : Regrouper / Regroupement / Agrégation ou par son nom anglais Dissolve. Concrètement, il s’agît de regrouper des géométries en se basant sur un attribut qu’elles ont en commun.

Par exemple, sur la figure suivante (Fig. 228), nous disposons d’une couche vectorielle contenant les polygones des communes pour la France. Pour chaque commune, nous disposons de différents attributs comme la population ou le département d’appartenance. Nous souhaitons en dériver une couche vectorielle de polygones, où chaque polygone sera un département. Les polygones de chaque département seront finalement les géométries regroupées des communes constitutives de chaque département. Le champ Departement sera donc utilisé comme champ de regroupement. Dans le processus, il est également possible de calculer des statistiques sur un ou plusieurs autres champs. Ici, nous choisirons de sommer les populations de chaque commune. Nous disposerons ainsi au final d’un attribut Population dans notre couche des départements qui correspondra bien à la population départementale.


[image: alternate text]

Fig. 228 Regroupement des communes par département afin d’obtenir une couche des départements.




Regrouper des entités dans QGIS

Version de QGIS : 3.22.3

Le regroupement d’entités dans QGIS se fait facilement et permet une grande souplesse. Dans cet exemple, nous allons regrouper les communes d’Île-de-France par département, en calculant en même temps les populations totales par département et les superficies totales. Une fois la couche des communes chargées dans QGIS, nous utilisons le menu Boîte à outils de traitements ‣ Géométrie vectorielle ‣ Agrégation. Le menu suivant apparaît (Fig. 229).


[image: alternate text]

Fig. 229 Regroupement d’entités dans QGIS.



Dans le champ Couche source nous définissons la couche à regrouper, ici communes_IDF.gpkg. Dans le champ Regrouper par expression, nous choisissons le champ sur lequel va s’effectuer le regoupement, ici CODE_Dept. Grâce à l’icône de sélection [image: icone-select-expr] au bout de la ligne, nous pourrions ne sélectionner que certains départements pour ce regroupement. Notons que si nous laissons cette ligne vide, toutes les entités de la couche seraient regroupées. Dans le panneau Agrégats, tous les champs de la couche sont listés. Nous commençons par enlever les champs qui ne sont pas utiles et/ou pas pertinents. Par exemple le champ contenant le nom de la commune est à enlever car ce ne sera plus une information pertinente sur une couche des départements. Pour supprimer un champ, nous cliquons dessus (il devient bleu) puis nous cliquons sur l’icône Supprimer le champ sélectionné [image: icone-supprimer-champ]. Une fois que ne restent plus que les champs d’intérêt nous effectuons différents réglages dans ce même panneau Agrégats. Le champ CODE_Dept a été conservé car le code département sera bien un attribut présent dans la table des départements. Dans la colonne Fonction d'agrégation nous sélectionnons first value. Ainsi, pour chaque département, nous retiendrons le premier code rencontré lors du regroupement. Comme toutes les communes d’un même département ont le même code de département le résultat sera bon. Ensuite, pour le champ Population nous choisissons de sommer toutes les populations communales de chaque département rencontré via la Fonction d'agrégation sum (somme). Nous procédons de même pour l’attribut area_km2. Enfin, à la ligne Agrégé nous indiquons un chemin et un nom pour la couche qui sera créée. Puis nous cliquons sur Exécuter.


Astuce

Il est possible d’organiser l’ordre que prendront les champs dans la couche résultat en jouant avec les icônes Déplacer le champ sélectionné vers le haut [image: icone-deplacer-champ-haut] et Déplacer le champ sélectionné vers le bas [image: icone-deplacer-champ-bas].



Une nouvelle couche contenant les polygones des départements apparaît bien. Cette couche possède bien des attributs relatifs au code du département, à la population départementale et à la superficie départementale.


Note

Dans QGIS, il existe un autre menu de regoupement qui se trouve dans le menu Vecteur ‣ Outils de géotraitement ‣ Regrouper… Mais cet outil est beaucoup moins pratique que l’outil Agrégation.





Regrouper des entités dans R

Une fois un vecteur chargé dans R, il est possible de regroupement des entités selon un champ tout en calculant une statistique pour un autre champ. Ici, nous allons charger un vecteur des communes d’Île-de-France, qui contient un champ avec les codes des départements CODE_DEPT et un champ de population POPULATION. Nous allons créer un nouvel objet vecteur qui contiendra les départements et leur population totale.


Regrouper des entités avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

Pour faire cette manipulation de regroupement sur un SpatVector de terra, il est nécessaire d’utiliser en plus la librairie tidyterra.

# chargement de tidyterra
library(tidyterra)

# chargement des communes d'IDF
communes_IDF <- terra::vect('communes_IDF.gpkg')
# regroupement selon le code des départements et somme des populations
group_dep <- group_by(communes_IDF, CODE_DEPT) %>% summarize(somme = sum(POPULATION))







Regrouper des entités avec sf

Version de R : 4.3.1

Version de sf : 1.O.12

Pour faire cette manipulation de regroupement sur un objet sf il est nécessaire d’utiliser en plus la librairie dplyr.

# chargement de dplyr
library(dplyr)

# chargement des communes d'Île-de-France
communes_IDF <- sf::st_read('communes_IDF.gpkg')
# regroupement selon le code des départements et somme des populations
dep_group <- communes_IDF %>% group_by(CODE_DEPT) %>% summarise(Pop_Totale = sum(POPULATION))
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Travailler sur les géométries vecteur

Dans ce chapitre vous trouverez quelques outils dédiés à la manipulation des géométries des couches vectorielles, comme les sélections spatiales, les géotraitements ou d’autres manipulations géométriques utiles.
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Erreurs de géométries

Il arrive que les fichiers de polygones vecteurs contenant beaucoup d’entités et présentant des tailles très variées contiennent des erreurs de géométries. C’est souvent le cas des couches de polygones obtenues par polygonisation, ou vectorisation, d’une couche raster (cf Raster vers vecteur). Ces erreurs sont généralement décelées lors du plantage d’un géotraitement ultérieur faisant appel à la couche en question comme une intersection ou une différence. Ces erreurs ne sont pas vraiment des erreurs dans la géométrie, il ne s’agît pas de trous ou de décalage mais plutôt des erreurs dans la définition informatique de certains nœuds des polygones. Lors d’un plantage avec le message d’erreur suivant L'entité (1) de “ma couche vecteur” a une géométrie non valide. cela signifie que la couche mentionnée dans le message a un souci de géométrie.


Vérifier la géométrie

Il est possible d’extraire les nœuds qui posent problème via le menu Vérifier la validité qui se trouve dans la Boîte à outils de traitements ‣ Géométrie vectorielle ‣ Vérifier la validité. Une fois ce menu ouvert la fenêtre suivante apparaît (Fig. 233).


[image: alternate text]

Fig. 230 Vérification de la validité des géométries dans QGIS.



Dans le champ Couche source nous indiquons la couche à vérifier. Dans le panneau Méthode nous cochons simplement la méthode GEOS. C’est en effet la méthode de vérification la plus pointilleuse et donc celle qui décèlera vraiment les erreurs. Enfin nous pouvons laisser les autres champs vides, les couches de validité et d’invalidité seront affichées en temporaire, ce qui n’est pas génant. Puis nous cliquons sur Exécuter. Les polygones contenant des erreurs ainsi que les noeuds qui posent problème apparaissent alors dans QGIS (Fig. 231).


[image: alternate text]

Fig. 231 Les polygones présentant des erreurs de géométrie (en gris foncé) et le neud problématique (en rouge).



Sur la figure Fig. 231, les polygones présentant des erreurs sont en gris foncé et le nœud problématique est en rouge. Il y a aussi un problème car les deux carrés gris foncés sont en fait un seul polygone mais avec une forme de 8 avec un nœud qui se trouve à une sorte d’intersection. C’est cette configuration précise qui pose problème. Heureusement, il est possible de réparer facilement ce type de soucis.


Astuce

Lorsqu’un traitement plante à cause d’une géométrie non valide il n’est même pas nécessaire de vérifier où se trouve le problème. Nous pouvons réparer directement la couche comme présenté dans la section suivante.





Réparer la géométrie

Lorsqu’une couche présente une géométrie non valide, qu’on l’est vérifiée ou non, il est possible de la réparer dans QGIS. Nous utilisons le menu Réparer les géométries qui se trouve dans la Boîte à outils de traitements ‣ Géométrie vectorielle ‣ Réparer la géométrie. Le menu suivant s’ouvre (Fig. 232).
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Fig. 232 Réparer les géométries dans QGIS.



Dans le champ Couche source nous indiquons la couche à réparer et dans le champ Réparer les géométries nous spécifions un chemin et un nom pour la couche vecteur après réparation. Puis nous cliquons sur Exécuter. La couche réparée apparaît alors dans QGIS. Cette couche est, visuellement, en tout point identique à la couche d’origine, c’est simplement la façon dont sont codés les nœuds qui change.




Prédicats géométriques

La particularité fondamentale des SIG est de proposer une base de données qui contient une composante spatiale. Les entités manipulées, notamment les entités de type vecteur, possèdent une implantation dans l’espace. Il est donc possible de relier différentes couches de données en fonction de leurs localisations. Une couche A peut contenir des éléments d’une couche B ou intersecter des éléments d’une couche C et ainsi de suite. Toute cette série de relations spatiales peut se formaliser sous forme de prédicats géométriques. La figure suivante résume les plus courants (Fig. 233).
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Fig. 233 Les principaux prédicats géométriques.



Ces prédicats géométriques sont à la base de deux grands types de manipulation : la Sélection spatiale et la Jointure spatiale. Notons bien que les trois implantations (surfacique, linéaire et ponctuelle) se prêtent à ce jeu de prédicats.



Extraction des sommets

Les polygones et les polylignes sont en fait constitués d’une série de points, appelés vertex, ou sommets, reliés entre eux par des morceaux de lignes. Dans le cas des polygones, ces morceaux de lignes sont fermés et une surface est comprise dans ce périmètre. Dans certains cas, il est intéressant d’extraire les vertex constitutifs des lignes ou des polygones. Cette manipulation se fait plus ou moins facilement selon les outils.

Dans les exemples suivants, nous allons voir comment extraire les vertex constitutifs du polygone présenté sur la figure suivante (Fig. 234).
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Fig. 234 Vertex constitutifs d’un polygone.




Extraction avec QGIS

Version de QGIS : 3.22.0

L’outil à utiliser se trouve dans le menu Boîte à outils de traitements ‣ Géométrie vectorielle ‣ Extraire les sommets. Le menu suivant s’ouvre.


[image: alternate text]

Fig. 235 Extraction des vertex (aussi appelés sommets) avec QGIS.



Dans le menu Couche source nous indiquons le nom de la couche de polygone dont il faut extraire les sommets. Puis à la ligne Sommets nous indiquons un chemin et un nom pour la couche qui contiendra les sommets. Notons que si nous le souhaitons nous pouvons cocher la case Entité(s) sélectionnée(s) uniquement si seuls les sommets du ou des polygones sélectionnés sont nécessaires. À la fin du traitement nous obtenons une couche vectorielle de type points dans laquelle chaque point correspond à un sommet du polygone.




Sélection spatiale

La sélection spatiale, aussi appelée requête spatiale, permet de sélectionner des entités d’une couche selon leur position géographique par rapport aux entités d’une autre couche. Ce type de sélection repose sur les Prédicats géométriques. Il est par exemple possible de sélectionner tous les éléments d’une couche A qui contiennent des éléments d’une couche B, ou tous les éléments d’une couche A qui croisent les éléments d’une couche C.


Sélection spatiale dans QGIS

Version de QGIS : 3.22.3

Dans QGIS, il est facile de faire des sélections spatiales. Il faut juste charger les couches vecteurs à croiser et s’assurer qu’elles sont bien dans le même système de coordonnées de référence pour éviter toute surprise. Pour l’exemple, nous allons sélectionner toutes les communes d’Île-de-France contenant un lieu de culte. Nous nous basons sur une couche des polygones des communes et une couche ponctuelle des lieux de culte (Fig. 236).


[image: alternate text]

Fig. 236 Les lieux de culte (sûrement non exhaustifs) en Île-de-France.



La requête que nous souhaitons faire est la suivante : Je souhaite sélectionner toutes les communes qui contiennent un lieu de culte. Pour cela nous allons dans le menu Vecteur ‣ Outils de recherche ‣ Sélection par localisation… La fenêtre suivante apparaît (Fig. 237).
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Fig. 237 Sélection par localisation dans QGIS.



Dans le menu déroulant Sélectionnez les entités depuis, nous sélectionnons la couche depuis laquelle nous souhaitons sélectionner des entités, dans notre cas la couche des communes. Dans le panneau Où les entités (prédicat géométrique), nous cochons le prédicat souhaité, ici contient. Dans le menu déroulant En comparant les entités de, nous sélectionnons la couche de comparaison, ici la couche des lieux de culte. Enfin dans le menu déroulant Modifier la sélection actuelle en, nous laissons l’option par défaut. Puis nous cliquons sur Exécuter. Les communes qui contiennent un lieu de culte sont bien sélectionnées.

Notons que si nous avions choisi de sélectionner les lieux de culte qui sont à l’intérieur d’une commune, nous aurions sélectionné tous les lieux de culte… Le sens de la requête est donc important.


Note

Il est possible de jouer sur le menu Modifier la sélection actuelle en. Par exemple, nous pouvons ajouter la sélection à une sélection précédente via Ajouter à la sélection actuelle, ce qui est pratique pour combiner des sélections. Nous pouvons également enlever la sélection à une sélection précédente via Enlever de la sélection actuelle, pratique pour une requête de type sauf.






Jointure spatiale

La jointure spatiale est une manipulation très utile en SIG. La jointure spatiale permet de joindre les attributs de deux couches selon une caractéristique géographique qu’elles partagent. Par exemple, si nous disposons d’une couche ponctuelle des plus hauts sommets d’une région montagneuse et d’une couche de polygones des communes, il est possible de rapatrier les noms des communes à celle des sommets. La manipulation sera de lier les attributs des communes qui contiennent les sommets. D’une manière générale, la jointure spatiale repose sur les Prédicats géométriques.


Jointure spatiale dans QGIS

Version de QGIS : 3.22.3

La jointure spatiale se fait facilement dans QGIS. Il est d’abord nécessaire d’ouvrir les deux couches à joindre et de s’assurer qu’elles sont dans le même système de coordonnées de référence. Dans l’exemple, nous disposons d’une couche ponctuelle des lieux de culte d’Île-de-France et d’une couche de polygones des communes de cette même région (Fig. 236). Nous souhaitons rapatrier le nom de la commune dans lequel se situe chaque lieu de culte. La jointure va donc être de la forme : Je souhaite rapatrier le nom de la commune à l’intérieur de laquelle se trouve chaque lieu de culte. Le prédicat géométrique est donc à l’intérieur (within). Le formulaire de jointure spatiale se trouve dans le menu Vecteur ‣ Outils de gestion de données ‣ Joindre les attributs par localisation… Le menu suivant apparaît (Fig. 238).
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Fig. 238 Jointure spatiale dans QGIS.



Dans le champ Couche de base nous indiquons la couche sur laquelle nous souhaitons rapatrier les informations, ici la couche ponctuelle des lieux de culte. Dans le champ Joindre la couche nous indiquons la couche que nous souhaitons joindre à savoir la couche surfacique des communes. Dans le panneau Prédicat géométrique nous cochons le prédicat à utiliser, ici within (à l’intérieur). Dans le champ Champs à ajouter nous pouvons choisir le ou les champs à joindre, par défaut tous les champs sont joints. Dans le champ Type de jointure, nous choisissons la façon dont doit se faire la jointure, ici Créer une entité distincte pour chaque entité correspondante (un à plusieurs). Ça signifie qu’à chaque lieu de culte, les attributs de la commune d’appartenance seront joints. Dans le champ Préfixe de champ joint nous pouvons indiquer un préfixe qui sera au début des noms des champs joints. Enfin, dans le champ Couche issue de la jointure spatiale nous pouvons indiquer un chemin d’export pour la nouvelle couche qui sera créée, sinon il s’agira d’une couche temporaire. Il ne rste plus qu’à cliquer sur Exécuter. Une nouvelle couche des lieux de culte s’ouvre, géographiquement tout à fait identique à l’originale. Par contre, nous constatons bien qu’un nouveau champ nommé commune_NOM_COM est apparu, contenant le nom de la commune dans laquelle se trouve le lieu de culte.

Il est important de noter que l’ordre de jointure est important. Ainsi, si nous souhaitons joindre les attributs de la couche des lieux de culte à la couche des communes (l’inverse de l’exemple précédent), c’est possible mais le résultat sera différent. En effet, si un lieu de culte n’appartient qu’à une seule commune, une commune peut très bien avoir plusieurs lieux de cultes. Que va-t-il ainsi se passer dans notre cas ? Si nous choisissons l’option Créer une entité distincte pour chaque entité correspondante (un à plusieurs), les communes disposant de plusieurs lieux de culte seront dupliquées. Ainsi, une commune disposant de 3 lieux de culte sera copié trois fois. Cette commune aura donc trois lignes dans la table attributaire, soit une par lieu de culte, mais aura aussi 3 polygones parfaitement superposés. Deux polygones seront cachés par le troisième. Il n’est pas conseillé de manipuler des couches vecteur avec des entités superposées, même si c’est possible. Sinon, nous pouvons sélectionner l’option Prendre uniquement les entités de la première entité correspondante (un à un), auquel cas simplement le premier lieu de culte rencontré sera joint au polygone de la commune. Ainsi, à une commune donnée, il n’y aura bien qu’une ligne et un seul polygone. Par contre, nous ne contrôlons pas ce que QGIS entend par première entité correspondante…




Conversion de polygones en lignes

Il est possible de convertir un polygone, donc constitué d’une limite et d’une surface, en une simple polyligne, i.e. juste la limite sans la surface. Ce type de traitements n’est pas forcément très fréquent mais peut être utile.


Avec QGIS

QGIS propose un module pour convertir un polygone en polylignes. Dans l’exemple suivant, nous allons convertir le polygone du département de l’Essonne vers une couche de type polylignes qui ne contiendra que les limites de ce département. Le module à utiliser se trouve dans le menu Vecteur ‣ Outils de géométrie ‣ Polygones vers lignes… (Fig. 239).
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Fig. 239 Conversion de polygones vers lignes dans QGIS.



Dans le champ Couche source nous indiquons la couche de polygones à convertir, ici Essonne.gpkg. Dans le champ Lignes nous spécifions un chemin et un nom pour le fichier de lignes issu de la conversion, ici Essonne_limites.gpkg. Puis nous cliquons sur Exécuter.




Désagréger des géométries

Sur les couches vecteurs, de type points, lignes ou polygones, les entités ne correspondent pas toujours à chaque géométrie individuelle. Par exemple, une entité peut être composée de plusieurs polygones. C’est le cas, par exemple, de l’entité France, composée du polygone de la France continentale mais aussi de la Corse et des autres îles comme Oléron, Ré, Ouessant… (Fig. 240).
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Fig. 240 La France en multi-polygones. Une seule entité de la table attributaire correspond à un polygone en plusieurs parties.



Si il est intéressant de travailler avec des entités multi-polygones dans certains cas, pour certains traitements il peut être utile de désagréger ces polygones afin d’obtenir une entité par géométrie. Ce processus de désagrégation se fait simplement dans les logiciels de SIG ou les langages de programmation comme R ou Python.


Désagréger des géométries dans QGIS

Version de QGIS : 3.34.0

Pour désagréger une couche multi polygones (ou multi points ou multi lignes) chargée dans QGIS, il suffit d’aller dans le menu Vecteur ‣ Outils de géométrie ‣ De morceaux multiples à morceaux uniques… Le menu suivant apparaît (Fig. 241).
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Fig. 241 Désagréger une couche multi-polygones dans QGIS.



À la ligne Couche source nous indiquons la couche multi-polygones à désagréger et à la ligne Géométries simples, nous indiquons un nom et un chemin pour stocker la couche en géométries simples qui sera générée. Il ne reste qu’à cliquer sur Exécuter. Nous obtenons une couche comme présentée ci-dessous (frdesag).
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La France, avec chaque polygone, i.e. chaque île, individualisée. Évidemment, les champs de la table attributaire n’ont pas été mis à jour. Le champ existant a été dupliqué autant de fois qu’il y a de géométries indépendantes.



Désagréger des géométries dans R

Version de R : 4.3.2

Désagréger une couche vecteur dans R est aussi possible, aussi bien avec la librairie sf que terra.


Désagréger avec terra

Version de terra : 1.7.29

Nous verrons ici comment désagréger une couche vecteur chargée dans R avec terra sous forme d’un SpatVector. Dans l’exemple, nous allons désagréger les géométries de la France.

# import des limites de la France
 lim_fr <- terra::vect('france_adm_2154.gpkg', layer='limites')
 # désagrégation des géométries
 lim_fr_desag <- terra::disagg(lim_fr)





Si nous regardons les propriétés de la variable lim_fr, nous voyons qu’elle ne contient qu’une seule géométrie alors que la variable lim_fr_desag en contient 26.





Géotraitements

Grâce à la spatialisation des SIG, il est possible de croiser les géométries des entités de différentes couches entre elles par le jeu de ce que nous appelons communément des géotraitements. Ces géotraitements peuvent être des intersections, des unions, des différences de polygones ou de lignes parfois. Les géotraitements sont très utilisés, c’est une des fonctionnalités de base à connaître des SIG. La figure suivante récapitule les principaux géotraitements en SIG (Fig. 242).
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Fig. 242 Principes de quelques géotraitements fréquemment utilisés.



Les zones tampons sont aussi connues sous l’appellation anglaise de buffers (tampon). Les zones tampons peuvent être calculées autour d’un polygone, d’une ligne ou d’un point. La taille de la zone tampon est souvent exprimée dans les mêmes unités que le SCR employé. Il est donc plus facile de créer des zones tampons avec des SCR exprimés en mètres plutôt qu’en degrés. Certains modules permettent de calculer des tampons unilatéraux le long des lignes, soit juste un tampon à droite ou un à gauche.


Avertissement

Lors d’un géotraitement faisant intervenir deux couches, il est fortement recommandé que les deux couches soient dans le même système de coordonnées de référence.




Zones tampons

Les zones tampons permettent de créer une zone, donc une surface autour d’une ou plusieurs géométries en entrée. La dimension du tampon est la plupart des cas définie par l’utilisateur dans les paramètres du module dédié. Cependant certains modules proposent de calculer une zone tampon pour chaque entité de la couche en fonction d’une valeur définie dans un champ attributaire. Il est préférable de réaliser des zones tampons sur des couches dont le SCR est exprimé en mètres. Enfin, les zones tampons sont réalisables autour de polygones, de lignes ou de points.


Note

Les zones tampons ne sont pas des anneaux encerclant juste la géométrie de départ, mais sont les géométries de départ qui ont été élargies.




Zones tampons dans QGIS

Version de QGIS : 3.22.3

QGIS propose plusieurs modules pour calculer des zones tampons autour d’une couche vecteur préalablement chargée dans le logiciel. Dans cet exemple nous allons créer une zone tampon de 500 m de large autour du réseau hydrographique du bassin-versant de la Roya dans les Alpes-Maritimes. Un tampon de 500 m m signifie ici que nous allons défnir en fait une surface de 1000 m de large, 500 m de chaque côté, autour de chaque tronçon de cours d’eau. Le module le plus couramment utilisé se trouve dans le menu Vecteur ‣ Outils de géotraitements ‣ Tampon… La fenêtre suivante s’ouvre (Fig. 243).
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Fig. 243 Création de zones tampons dans QGIS.



Dans le champ Couche source nous indiquons la couche autour de laquelle nous souhaitons obtenir une zone tampon hydro_Roya.gpkg. Dans le champ Distance nous indiquons la largeur du tampon désiré, ici 500 et nous choisissons comme unité mètres dans le menu déroulant. Il est important de cocher ou pas sur Regrouper le résultat. Si nous ne cochons pas cette option, il y aura autant de tampons que d’entités dans la table de départ. Si nous cochons l’option, toutes les zones tampons de formeront qu’une seule entité, éventuellement multi-parties (Fig. 244). Dans le champ Mis en tampon nous spécifions un nom et un chemin pour le tampon qui sera créé. Les autres options peuvent être laissées par défaut, elles influenceront peu la forme du résultat.
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Fig. 244 Zones tampons groupées (A) et non groupées (B).



Si nous ne groupons pas le résultat des zones tampons (Fig. 244 B), les tampons se chevauchent les uns les autres.



Zones tampons dans R

Il est facile de créer des zones tampons dans R aussi bien sur des objets SpatVector que sf. Nous verrons ici la procédure pour les deux formats.


Zones tampons avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

Nous commencerons par charger le réseau hydrographique de la Roya sous forme de polylignes en un objet SpatVector. Nous ferons ensuite un tempon de 100 m autour de chaque rivière grâce à la fonction buffer de la librairie terra. Pour finir, de façon facultative, nous regrouperons le résultat afin de n’avoir qu’un seul polygone pour tout le réseau.

# import du réseau hydrographique
hydro_roya <- terra::vect('hydro_Roya_L93.gpkg')
# tampon de 100 m
hydro_roya_100 <- terra::buffer(hydro_roya, width=100)
# regroupement du résultat
hydro_roya_100 <- terra::aggregate(hydro_roya_100)







Zones tampons avec sf

Version de R : 4.3.1

Version de sf : 1.0.12

Ici nous verrons la procédure à suivre pour créer une zone tampon autour d’un segment de rivière (polylignes) dont le SCR est Lambert 93. Nous commencerons par charger cette portion de rivière en un objet sf. Puis nous calculerons une zone tampon de 100 m autour de cette rivière grâce à la fonction st_buffer() de la librairie sf.

# import de la rivière
affluent_roya <- sf::st_read('affluent_Roya_L93.gpkg')

# création de la zone tampon de 100 m
affluent_buffer <- sf::st_buffer(affluent_roya, dist=100)

# facultatif : export du résultat
sf::st_write(hydro_buffer, 'affluent_tampon_100m.gpkg')






Note

La distance du tampon, donnée grâce au paramètre dist= est exprimée dans les unités du SCR (Les Systèmes de Coordonnées de Références).







Intersection de polygones

Un traitement SIG très fréquent est l’intersection de deux couches vecteurs de polygones. C’est une manipulation courante lorsque nous souhaitons par exemple croiser un raster d’occupation du sol avec des entités administratives ou biophysiques comme des bassins-versants ou des zones géologiques. Tous les outils SIG proposent des solutions pour ce genre de traitements.


Intersection de polygones dans QGIS

Version de QGIS : 3.22.3

Il est tout d’abord nécessaire de charger dans QGIS les deux couches de polygones que nous souhaitons intersecter. Ces deux couches doivent être de préférence dans le même SCR. Dans l’exemple suivant nous allons intersecter un raster d’occupation du sol (Corine Land Cover 2018) avec les départements d’Île-de-France. Cette manipulation permet de connaître l’occupation du sol par département francilien. Nous allons dans le menu Vecteur ‣ Outils de géotraitements ‣ Intersection… Le menu suivant s’affiche (Fig. 245).
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Fig. 245 Intersection de couches de polygones dans QGIS.



Dans le champ Couche source nous indiquons la couche à intersecter, ici l’occupation du sol CLC_2018_IDF.gpkg. Dans le champ Couche de superposition nous indiquons la couche qui nous sert à intersecter, ici les départements departements_IDF.gpkg. Dans le champ Champs d'entrée à conserver nous pouvons indiquer quels champs attributaires de la première couche nous souhaitons conserver dans la couche finale, ici simplement l’identifiant CLC de l’occupation du sol. Dans le champ Champs à conserver nous pouvons indiquer quels champs attributaires de la seconde couche nous souhaitons conserver dans la couche finale, ici le code des départements, la population départementale et la superficie départementale par exemple. Puis dans le champ Intersection nous spécifions un chemin et un nom pour la couche résultat. Enfin, nous cliquons sur Exécuter. La couche des polygones d’occupation du sol intersectée par les départements apparaît bien dans QGIS.


Note

Il est fréquent que dans l’une ou l’autre (ou les deux) couches d’entrées d’une intersection il existe un attribut superficie. Dans ce cas, cet attribut superficie sera également présent dans la couche final mais ne correspondra plus à la superficie des entités, puisqu’elles auront été intersectées. Attention donc à ne pas s’embrouiller à ce niveau. Il peut être utile de renommer l’attribut en question en superficie_departement par exemple (cf Renommer un champ).





Intersection de polygones dans R

Il est possible d’intersecter deux couches vecteurs de type polygone dans R. Ici, nous allons intersecter les communes du Val-d’Oise (95) (communes_95.gpkg) avec la couche d’occupation du sol Corine Land Cover de l’Île-de-France (CLC_2018_IDF.gpkg). Nous verrons la procédure pour des objets de type sf et de type SpatVector.


Intersection de polygone avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

Nous commençons par charger les deux couches vecteur en format SpatVector, puis nous utilisons la fonction intersect de la librairie terra.

# import des communes du 95
communes_95 <- terra::vect('communes_95.gpkg')
# import du CLC d'IDF
clc_IDF <- terra::vect('CLC_2018_IDF.gpkg')
# Intersection du CLC par commune
clc_communes_95 <- terra::intersect(communes_95, clc_IDF)







Intersection de polygones avec sf

Version de R : 4.3.1

Version de sf : 1.0.12

Nous commençons par charger les deux couches vecteur en format sf, puis nous utilisons la fonction st_intersection de la librairie sf.

# import des communes du 95
communes_95 <- sf::st_read('communes_95.gpkg')
# import du CLC d'IDF
clc_IDF <- sf::st_read('CLC_2018_IDF.gpkg')

# intersection des deux couches
clc_communes_95 <- sf::st_intersection(communes_95, clc_IDF)






Note

Cette méthode fonctionne aussi pour des couches de type lignes.







Différence de polygones

Faire la différence entre deux couches de polygones est une manipulation courante en SIG. Elle s’utilise par exemple dans le cas où nous souhaitons exclure une zone d’une autre. Par exemple nous souhaitons conserver simplement le territoire d’une région donnée qui ne soit pas couvert d’une certaine occupation du sol.


Différence de polygones dans QGIS

Version de QGIS : 3.22.3

Dans l’exemple, nous souhaitons connaître la portion de territoire du département du Val-d’Oise qui n’est pas recouvert de forêt. Pour cela  nous chargeons dans QGIS le polygone du département du Val-d’Oise et le polygone des forêts d’Île-de-France. Une fois ces deux couches chargées dans QGIS, nous allons dans le menu Vecteur ‣ Outils de géotraitements ‣ Différence… Le menu suivant apparaît (Fig. 246).
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Fig. 246 Différence de couches de polygones dans QGIS.



Dans le champ Couche source nous indiquons la couche de laquelle nous souhaitons exclure des portions, ici la couche du département val-d-oise.gpkg. Dans le champ Couche de superposition nous indiquons la couche à enlever, à savoir les forêts. Puis dans le champ Différence nous spécifions un chemin et un nom pour la couche résultat. Enfin nous cliquons sur Exécuter. La couche du Val-d’Oise trouée par les forêts apparaît alors dans QGIS (Fig. 247).
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Fig. 247 Les polygones de forêts superposés au polygone du Val-d’Oise (A) et le résultat de la différence qui permet d’obtenir les portions du Val-d’Oise non recouverts de forêt (B).




Avertissement

Contrairement à l’intersection, le sens à ici un sens. Si nous avions mis la couche des forêts en premier et le département en second, nous aurions obtenu en résultat les forêts qui ne sont pas dans le Val-d’Oise.





Différence de polygones dans R

Il est possible de faire une différence entre deux couches de polygones dans R, mais la manipulation diffère selon que nous travaillons avec des objets sf ou SpatVector. Nous verrons les deux. Nous allons récupérer les portions de communes du Val d’Oise qui ne sont pas recouvertes de forêts. Les communes du Val d’Oise proviennent de la couche communes_95.gpkg et les forêts proviennent de l’occupation du sol Corine Land Cover (codes 311, 312 et 313) stockées dans la couche CLC_2018_forets_IDF.gpkg.


Différence de polygones avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

Nous commençons par charger les deux couches au format SpatVector. Nous utiliserons ensuite la fonction erase de la librairie terra. L’ordre des couches a son importance. Dans le premier cas, nous enlèverons de la couche des communes du 95 toutes les forêts, et dans le second cas nous enlèverons de la couche des forêts toutes les communes du 95.

# import des communes du 95 (Val d'Oise)
communes_95 <- terra::vect('communes_95.gpkg')
# import des forrêts CLC IDF
clc_forets_IDF <- terra::vect('CLC_2018_forets_IDF.gpkg')

# difference pour avoir les communes sans les forêts
comm_sans_forets <- terra::erase(communes_95, clc_forets_IDF)
# différence pour avoir les forêts sans les communes du 95
forets_sans_comm <- terra::erase(clc_forets_IDF, communes_95)







Différence de polygones avec sf

Version de R : 4.3.1

Version de sf : 1.0.12

Il est nécessaire de passer par une fonction personnalisée. Les deux couches sont au préalable chargées en format sf.

# import des communes du 95 (Val d'Oise)
 communes_95 <- sf::st_read('communes_95.gpkg')
 # import des forrêts CLC d'Île-de-France (IDF)
 clc_forets_IDF <- sf::st_read('CLC_2018_forets_IDF.gpkg')

 # écriture d'une fonction personnalisée st_erase
 sf::st_erase = function(x, y) st_difference(x, st_union(st_combine(y)))

 # on récupère les portions de communes non forestières grâce à la fonction st_erase
 communes_non_foret <- sf::st_erase(communes_95, clc_forets_IDF)

 # facultatif : on exporte le résultat
 sf::st_write(communes_non_foret, 'communes_non_foret.gpkg')









Fusion de polygones

Il est souvent utile de fusionner tous les polygones d’une couche vecteur afin de créer une nouvelle couche vecteur de type polygone qui correspondra en quelque sorte à l’enveloppe globale. Par exemple si nous disposons de l’ensemble des communes d’une région, il est possible de les fusionner afin de calculer les limites générales de la région. Dans les exemples suivants, nous travaillerons avec les communes d’Île-de-France (communes_IDF.gpkg) et nous les fusionnerons afin d’obtenir les limites de la région Île-de-France.


Fusion de polygones dans QGIS

Version de QGIS : 3.26.1

Au préalable, nous chargeons la couche vecteur à fusionner dans QGIS. Une fois cette couche chargée, nous allons dans le menu Vecteur ‣ Outils de géotraitement ‣ Regrouper…. La fenêtre suivante s’affiche (Fig. 248).
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Fig. 248 Fusion de polygones dans QGIS.



Dans le menu Couche source nous indiquons la couche à fusionner, à savoir communes_IDF.gpkg. Dans le menu Champ de regroupement nous n’indiquons rien. Ainsi tous les polygones de la couche seront regroupés. Dans le menu Couche regroupée nous indiquons un num et un chemin pour la couche fusionnée, limites_IDF.gpkg par exemple. Puis nous cliquons sur Exécuter.

Une nouvelle couche des limites de l’Île-de-France apparaît bien.



Fusion de polygones avec R

Il est possible de fusionner une couche de polygones avec R. La méthode diffère selon que nous travaillons sur un objet sf ou SpatVector. Nous verrons les deux cas.


Fusion de polygones avec terra

Version de R : 4.3.1

Version de terra : 1.7.29

Avec terra nous utiliserons la fonction aggregate.

# import des communes d'Île-de-France
communes_IDF <- terra::vect('communes_IDF.gpkg')

# fusion des communes
limites_IDF <- terra::aggregate(communes_IDF)







Fusion de polygones avec sf

Version de R : 4.3.1

Version de sf : 1.0.12

Dans un premier temps nous chargeons la couche à fusionner en tant qu’objet sf. Puis nous effectuons la fusion grâce à la fonction st_union() de cette librairie sf. Un exemple est donné ci-dessous.

# import des communes d'Île-de-France
communes_IDF <- sf::st_read('communes_IDF.gpkg')

# fusion des communes
limites_IDF <- sf::st_union(communes_IDF)

# facultatif : export du résultat
sf::st_write(limites_IDF, 'limites_IDF.gpkg')









Intersection de lignes

Il est possible d’intersecter des lignes entre elles. Le résultat sera une couche vecteur de type points où chaque point correspondra à une intersection.


Intersection de lignes dans QGIS

Version de QGIS : 3.22.3

Il est possible d’intersecter deux couches de type lignes dans QGIS, de préférence dans le même système de coordonnées de référence. À l’issue de ce traitement, une couche de points sera créée. À chaque point correspondra une intersection entre 2 lignes. Dans cet exemple, nous allons intersecter une couche linéaire de routes avec une couche linéaire de rivières. Les intersections correspondront ainsi finalement aux emplacements des ponts routiers (Fig. 249 A).
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Fig. 249 intersection de lignes.



Pour ouvrir le menu d’intersection de lignes, nous allons dans le menu Vecteur ‣ Outils d’analyse ‣ Intersection de lignes… Le menu suivant s’ouvre (Fig. 250).
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Fig. 250 Intersection de lignes dans QGIS.



Dans le champ Couche source nous indiquons la première couche de lignes, les voies de communication par exemple. Dans le champ Couche d'intersection nous indiquons la couche à intersecter, ici le réseau hydrographique. Aux deux lignes Champ d'entrée à conserver nous pouvons indiquer quels attributs conserver sur les deux couches. Ce sont les attributs qui seront présents sur la couche ponctuelle issue du traitement. Nous pouvons également indiquer un chemin et un nom pour la couche qui sera créée dans le champ Intersections. Nous cliquons pour finir sur Exécuter. Nous obtenons bien une nouvelle couche de points où chaque point correspond à une intersection entre 2 lignes (Fig. 249 B).



Intersection de lignes dans R

L’intersection de lignes dans R se fait exactement comme pour l’intersection de polygones. Il suffit de charger deux couches de type lignes et faire l’intersection dessus à l’aide de la fonction d’intersection selon que nous travaillons avec des objets sf ou terra. Le résultat de l’intersection est alors une couche de points. Reportez vous à la partie dédiée : Intersection de polygones dans R.





Création de grilles

De temps en temps, il peut être nécessaire de générer des grilles vecteurs régulières sur un espace géographique donné. Ces grilles peuvent être sous forme de lignes, de points ou de polygones. Et les polygones peuvent être carrés, rectangulaires, hexagonaux ou autres. Cette manipulation peut être intéressante pour créer une grille cartographique avec les latitudes et longitudes, disposer des points de façon régulière pour un échantillonnage ou bien encore pour découper un grand raster en dalles plus petites et régulières. Cette création de grilles peut se faire en utilisant différents outils.


Création de grilles dans QGIS

Version de QGIS : 3.24.3

Dans QGIS il est facile de créer une grille vecteur personnalisée sur un espace donné. Pour cet exemple, nous allons créer différentes grilles régulières sur l’emprise d’une portion de scène Landsat 8 prise au-dessus de la ville de Shanghai en Chine (Fig. 251).
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Fig. 251 Raster sur lequel créer la grille régulière et ses propriétés.



Avant de créer la grille il est important de savoir en combien de parties nous voulons découper notre espace. Dans notre exemple, nous allons créer une grille de 5 colonnes sur 5 lignes, mais nous aurions pu prendre tout autre chose, même un nombre de colonnes différents du nombre de lignes. Une fois ces nombres de lignes et colonnes choisis, il est nécessaire de relever les dimensions en X et en Y du raster qui sert de référence (Exploration des propriétés d’un raster). Ces dimensions doivent être exprimées en unités du système de coordonnées de référence et non en nombre de pixels. Ici (Fig. 251), notre raster s’étend en X de 298935 à 335235 et en Y de 3435555 à 3470715. Notre raster étant géoréférencé en UTM Zone 51N, il s’agît de coordonnées métriques. L’étendue en X de notre raster est donc de 335235 m - 298935 m soit 36300 m. De même, en Y notre raster s’étend sur 3470715 m - 3435555 m soit 35160 m. Comme nous souhaitons construire une grille de 5 colonnes sur 5 lignes, nous divisons ces deux étendues par 5. Ce qui donnera des cases de 7260 m de largeur (36300 / 5) et de 7032 m de hauteur (35160 / 5).

Une fois en tête ces éléments, nous pouvons lancer le menu de création de grilles de QGIS. Nous cliquons sur le menu Vecteur ‣ Outils de recherche ‣ Créer une grille… Le menu suivant s’ouvre (Fig. 252).
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Fig. 252 Création d’une grille vecteur dans QGIS.



Dans le menu Type de grille nous choisissons Rectangle (polygone). Dans la zone de texte Étendue de la grille, soit nous entrons une étendue à la main exprimée dans le SCR désiré et sous la forme Xmin,Xmax,Ymin,Ymax, soit (plus simple) nous sélectionnons une emprise selon la couche raster chargée. Cette étendue se trouve en cliquant sur la petite flèche dirigée vers le bas à droite de la zone de texte puis en utilisant le menu Calculer depuis la couche et en sélectionnant la couche de référence, ici notre image Landsat.
Dans le menu Espacement horizontal, nous entrons la dimension horizontale d’une case telle que calculée au préalable, à savoir 7260. De même, dans le menu Espacement vertical, nous entrons la dimension en hauteur d’une case, telle que calculée plus haut, à savoir 7032. Nous pourrions changer les unités de ces espacements si désiré. Il est possible de faire superposer les éléments de la grille les uns sur les autres grâce aux menus Superposition horizontale et Superposition verticale. Ici, nous ne voulons pas de superposition, alors nous laissons ces valeurs à 0. Il est ensuite important de choisir le SCR dans lequel sera créée la grille. Par défaut c’est celui du projet. Enfin dans le menu Grille nous indiquons un chemin et un nom pour la grille qui sera créée. Il ne reste plus qu’à cliquer sur Exécuter. Le résultat s’affiche directement dans QGIS (Fig. 253 A).
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Fig. 253 Grilles créées dans QGIS : grille en polygones (A), en lignes (B), en points (C) et en hexagones (D).



Avertissement

La grille peut être un tout petit peu plus petite que le raster initial. Pour être sûr de superposer le raster dans son entièreté il est possible d’ajouter quelques mètres (5 ou un peu plus) aux espacements horizontaux et verticaux.










Exploser des couches vecteurs

Par exploser une couche vecteur nous entendons enregistrer chaque entité d’une couche vecteur en une couche indépendante. Cette manipulation est aussi connue sous le nom de séparer une couche vecteur. Avec ce traitement, chaque enregistrement d’une table attributaire est individualisé et stocké dans une couche vecteur indépendante. Par exemple, si nous disposons d’une couche vecteur contenant les 96 départements de France métropolitaine et que nous la séparons, nous obtiendrons 96 couches indépendantes (au format shp, gpkg, ou autre), une par département. Cette manipulation n’est pas très courante mais peut s’avérer utile.


Séparer une couche vecteur dans QGIS

Version de QGIS : 3.24.3

Dans cet exemple, nous allons créer une couche vecteur par département français en partant d’une couche des départements pour toute la France (Fig. 254).
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Fig. 254 Couche vecteur des départements et sa table attributaire avec un département par ligne.



Pour exploser cette couche, nous allons dans le menu Vecteur ‣ Outils de gestion de données ‣ Séparer une couche vecteur… Le menu suivant s’ouvre (Fig. 255).
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Fig. 255 Menu QGIS pour séparer une couche vecteur.



Dans le menu Couche source nous indiquons la couche à séparer, ici departements_france_L93. Dans le menu Champ d'identifiant unique nous indiquons le champ attributaire qui servira à nommer les couches en sortie, ici le champ renfermant le code du département par exemple, Code_Depar. Dans le menu Type de fichier de sortie, nous choisissons un format pour les couches individuelles qui seront créées, par exemple gpkg. Enfin, dans le menu Répertoire de destination, nous indiquons le répertoire qui contiendra toutes les couches créées. Il ne reste plus qu’à cliquer sur Exécuter. Les départements sont maintenant explosés en une couche chacun (Fig. 256).
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Fig. 256 Les départements stockés chacun dans une couche indépendante.
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Outils raster

Il est très souvent nécessaire d’appliquer quelques traitements sur les données rasters avant de les interpréter ou pour en tirer des informations supplémentaires. Il existe de nombreux outils de géomatique dédiés à l’exploitation des données rasters. Nous verrons ici quelques outils très utiles et disponibles dans différents logiciels. Nous détaillerons par exemple comment découper ou masquer un raster ou comment appliquer des opérations algébriques sur une ou plusieurs couches rasters.
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Histogramme d’un raster

Il est souvent utile de regarder la forme de la distribution des valeurs des pixels d’un raster donné en traçant ce que nous appelons l’histogramme du raster considéré. Sur ce type d’histogramme, il est possible de connaître le nombre de pixels se trouvant dans chaque tranche de valeurs. Ces tranches de valeurs sont en général définies par l’utilisateur au moment de la construction de l’histogramme. La construction de ce genre d’histogramme est possible dans tous les logiciels de géomatique et dans les différents langages de programmation.

Dans les différents exemples ci-après, nous tracerons l’histogramme du MNT du bassin de la Roya [https://fr.wikipedia.org/wiki/Roya] (Alpes-Maritime) issu du SRTM et nommé srtm_roya_L93.tif.


Histogramme d’un raster avec QGIS

Version de QGIS : 3.26.1

Tout d’abord nous chargeons le raster à étudier dans QGIS. Il est possible d’avoir un premier aperçu de l’histogramme du raster en allant dans ses Propriétés comme présenté dans la partie dédiée à l’import de raster avec QGIS (Exploration des propriétés d’un raster). Cependant, cet histogramme est assez sommaire et il existe une autre fonctionnalité de QGIS pour tracer un histogramme plus ergonomique. Nous choisissons le menu Boîte à outils de traitements ‣ Points ‣ Histogramme d’une couche raster. La fenêtre suivante s’affiche (Fig. 257).


[image: alternate text]

Fig. 257 Menu de création d’un histogramme raster dans QGIS.



À la ligne Couche source nous indiquons le raster à analyser, ici srtm_roya_L93.tif. Dans le menu Numéro de bande nous indiquons la bande à analyser, dans le cas d’un raster multi-bandes. Pour le menu Nombre de classes, nous indiquons le nombre d’intervalles à considérer dans l’histogramme, nous pouvons mettre 100 ici. Enfin, à la ligne Histogramme nous indiquons un chemin et un nom pour l’histogramme qui sera produit. Remarquons que l’histogramme produit est au format html. En effet, l’histogramme sera tracé en utilisant la technologie Plotly [https://plotly.com/python/] qui permet de créer des graphiques dynamiques. Enfin, nous cliquons sur Exécuter.

À l’exécution rien n’apparaît mais dans l’onglet Journal de la fenêtre précédente nous trouvons le chemin du fichier html produit (Fig. 258).


[image: alternate text]

Fig. 258 Le chemin de l’histogramme html produit, à la ligne Output.



Il suffit alors de copier le chemin, d’ouvrir un navigateur web comme Firefox ou autre et de coller ce chemin dans la barre d’adresse. L’histogramme s’ouvre alors dans le navigateur. Grâce à l’utilisation de Plotly, nous pouvons survoler les différents intervalles de l’histogramme pour faire apparaître les informations quantitatives sous forme d’infobulles. Il est également possible de zoomer, de se déplacer et d’exporter le graphique en png.



Histogramme d’un raster avec R

Version de R : 4.2.1

Il est tout à fait possible de tracer l’histogramme d’un raster avec R. Ici, nous le tracerons sur un raster stocké au format SpatRaster en utilisant le package terra. Après avoir chargé le raster dans le code R, nous utilisons simplement la fonction hist du package terra. Nous pouvons y ajouter des options pour augmenter le nombre d’intervalles à prendre en compte et améliorer l’habillage. Le tout est résumé dans les lignes suivantes.

# chargement de la librairie terra
library(terra)

# chargement du raster à analyser
mnt_roya <- terra::rast("srtm_roya_L93.tif")

# construction de l'histogramme avec un habillage pertinent
hist(mnt_roya,
    breaks = 100,
    main='Histogramme du MNT de la Roya',
    col='lightblue',
    xlab='Altitudes (m)',
    ylab='Fréquence')





Ici, nous avons utilisé les options suivantes pour améliorer le rendu de l’histogramme :


	breaks : le nombre d’intervalles à prendre en compte


	main : définition du titre de la figure


	col : définition de la couleur des bâtons [https://r-charts.com/colors/]


	xlab : le titre de l’axe des abscisses


	ylab : le titre de l’axe des ordonnées




Nous obtenons au final le résultat suivant (Fig. 259).


[image: alternate text]

Fig. 259 Histogramme d’un raster calculé avec R.






Découper un raster

Il est souvent utile de découper un raster afin d’appliquer des traitements seulement sur une zone en particulier. Par découper, nous entendons extraire une sous partie (rectangulaire) d’un raster « trop grand » par rapport à notre zone d’études. Par exemple, si nous disposons d’un modèle numérique de terrain (MNT) à l’échelle de la France et que nous souhaitons simplement étudier les Alpes, il sera pertinent d’extraire simplement la région des Alpes de notre MNT général. Faire ce type d’extraction nous permet de gagner du temps de calcul, d’alléger nos données d’entrée et de cibler spécifiquement notre méthode sur notre zone d’intérêt.

Il s’agît d’une opération extrêmement courante qu’il est possible de faire avec de nombreux outils différents.

Dans les exemples suivants, nous allons extraire d’une (ou plusieurs) bande spectrale de la région parisienne, un zoom sur la ville de Paris.


Découper un raster dans QGIS

Version de QGIS : 3.18.1

Nous commençons par charger dans QGIS le raster que nous souhaitons découper et nous repérons visuellement la zone à extraire (Fig. 260).
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Fig. 260 Le raster à découper selon le carré rouge.



L’opération se fait simplement en allant dans le menu Raster ‣ Extraction ‣ Découper un raster selon une emprise… La fenêtre suivante s’affiche (Fig. 261).


[image: alternate text]

Fig. 261 Découper un raster dans QGIS.



Dans le champ Couche source, nous indiquons le raster à découper. Dans le champ Étendue de découpage, soit nous écrivons à la main les coordonnées du rectangle à découper (ce qui est plutôt rare…), soit nous récupérons ces coordonnées selon trois façons possibles en cliquant sur l’icône [image: icone_browse]. Lors du clic sur cette icône, il nous est proposé soit de calculer ces coordonnées selon l’étendue d’une autre couche (Calculer depuis la couche), soit de faire coïncider ces coordonnées avec la vue actuelle dans QGIS (Use Map Canvas Extent) soit de récupérer ces coordonnées en traçant à la main un rectangle dans la fenêtre principale de QGIS (Dessiner sur le canevas). C’est très souvent cette dernière option qu’on utilise. Lors de la sélection de cette option, la fenêtre se cache et le curseur se transforme en croix. Il suffit alors de tracer le rectangle correspondant à la zone à extraire. Une fois ce triangle tracé, les coordonnées s’affichent dans le champ correspondant.

Enfin, dans le champ Découpé, nous spécifions le chemin et le nom du raster découpé qui sera créé. Nous pouvons voir dans le panneau Console GDAL/OGR, qu’en fait ce module ne fait qu’interfacer une commande GDAL. Après avoir cliqué sur Exécuter, le raster découpé apparaît dans la fenêtre principale de QGIS.


Astuce

Il est tout à fait possible de découper de la même manière un raster multi-bandes, qu’il soit sous forme de raster virtuel (.vrt) ou de raster « en dur » (.tif). Dans ce cas, le raster découpé est également multi-bandes. Il est même possible de convertir un raster virtuel en tif multi-bandes et vice versa.





Découper des rasters par lot dans QGIS

Version de QGIS : 3.18.1

Il est tout à fait possible de découper plusieurs rasters se superposant en une seule fois dans QGIS. C’est un cas qui arrive fréquemment lorsque nous travaillons avec des images de télédétection multi-spectrales par exemple. Comme dit précédemment, si nous travaillons avec un raster virtuel ou un raster multi-bandes, le découpage par lot est implicite. Ici, nous verrons comment découper plusieurs rasters indépendants mais qui se superposent. Dans cet exemple, nous allons découper plusieurs bandes spectrales Landsat centrées sur la région parisienne afin de n’avoir que des zooms sur l’étendue de la ville de Paris.

Une fois les rasters chargés dans QGIS, comme pour découper un seul raster, nous allons dans le menu Raster ‣ Extraction ‣ Découper un raster selon une emprise… La fenêtre dédiée de paramétrage du découpage s’ouvre. À ce niveau, nous cliquons sur Exécuter comme processus de lot… dans le bas de la fenêtre. La fenêtre suivante apparaît (Fig. 262).
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Fig. 262 Découper des rasters par lot dans QGIS, initialisation.



Chaque ligne correspondra à un raster associé aux paramètres de découpage. Il faut donc ajouter autant de lignes que de rasters à découper. Soit on ajoute les lignes une par une en cliquant sur l’icône [image: icone_plus] soit on sélectionne les rasters à découper parmi ceux déjà chargés dans QGIS. Nous cliquons alors sur Auto-remplissage… dans la colonne Couche source, puis nous sélectionnons Sélectionner à partir des couches chargées. Il est également possible d’ajouter des rasters depuis un répertoire sans les avoir chargés au préalable dans QGIS. Une fois cette sélection faite, autant de lignes que de rasters sont apparues, et chaque ligne correspond à un raster d’entrée.

Ensuite il est nécessaire de définir l”Étendue de découpage. Comme dans le cas d’un seul raster, nous pouvons définir l’étendue à la main en traçant un rectangle via l’option Dessiner sur le canevas accessible via l’icône [image: icone_browse]. Afin d’avoir rigoureusement la même étendue de découpage pour chacun des rasters nous faisons un copier-coller des étendues de découpage de ligne en ligne.

Les deux champs suivants peuvent être laissées par défaut et nous renseignons finalement le chemin et le nom des rasters découpés qui seront créés dans la colonne Découpé (étendue). Il est possible de faire des copier-coller des chemins en changeant simplement le nom du raster créé (Fig. 263).
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Fig. 263 Découper des rasters par lot dans QGIS.



Si nous avons coché la case Charger les couches dans la fenêtre précédente, les rasters découpés apparaissent automatiquement, sinon il faut les charger manuellement.



Découper un raster dans R

Version de R : 3.18.1

Version de terra : 1.7.29

Il est possible de découper un raster selon une l’emprise d’une couche veceur (ou raster). Pour ce faire nous pouvons passer par la librairie terra et charger un raster au format SpatRaster et un vecteur au format SpatVector. Ici nous découperons une bande spectrale Landsat selon l’emprise du département des Bouches-du-Rhône.

# chargement du raster et du vectuer
b4 <- terra::rast('Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B4.TIF')
dep_13 <- terra::vect('dep_13_buffer_32631.gpkg')

# découpage du raster selon l'emprise du vecteur
b4_emprise_dep13 <- terra::crop(b4, dep13)





Si maintenant le but est de vraiment masquer le raster selon les limites précises du vecteur, dans ce cas là il s’agît de découper un raster selon une couche vecteur, comme plus loin (Découper un raster avec R).




Créer une mosaïque de rasters

Avant de se lancer dans des traitements sur des rasters il peut être utile de créer des mosaïques de rasters. Par exemple, si vous travaillez sur un bassin-versant qui se trouve à cheval sur deux dalles de modèles numériques de terrain, il peut être pertinent de mosaïquer les deux dalles avant d’effectuer des traitements. C’est notamment indispensable si vous souhaitez extraire un réseau hydrographique à partir de ce MNT.

Un autre cas peut être l’étude par télédétection d’une région qui se trouve à cheval sur deux images satellites. Dans ce cas une mosaïque des images peut être intéressante avant les traitements. Il faudra tout de même faire attention à ce que les images à mosaïquer soit similaires (saison, couverture nuageuse, niveau de traitement…).

Pour illustrer nous allons créer une mosaïque de deux rasters multi-bandes contenant 6 bandes Landsat 8. Ces deux images Landsat 8 recouvrent respectivement le département du Val-de-Marne et la ville de Paris.

Notons qu’il est plus prudent que les rasters à mosaïquer soient tous dans le même système de coordonnées.


Mosaïque de rasters dans QGIS

Version de QGIS : 3.18.3

Nous commençons par charger dans QGIS les deux rasters correspondant à nos deux images Landsat 8 (Fig. 264).
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Fig. 264 Les deux rasters à mosaïquer.



Nous voyons tout de suite que les cadres noirs vont gêner le processus de mosaïque. Ces cadres noirs sont bien sûr les pixels en no data. La première étape consiste à relever la valeur numérique de ces pixels. Cela nous permettra de les ignorer par la suite. Nous relevons les valeurs de ces pixels via l’outil Identifier des entités [image: icone_identifier] de la barre d’outils principale de QGIS. Dans notre cas nous constatons que ces no data ont une valeur de 0 sur toutes les bandes (ce qui n’est pas des plus judicieux mais bon…).

Pour créer la mosaïque, nous allons dans le menu Raster ‣ Divers ‣ Fusion… Le menu suivant apparaît (Fig. 265).
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Fig. 265 Paramétrage de la mosaïque.



Dans le champ Couches en entrée nous sélectionnons les rasters à mosaïquer via l’icône [image: icone_browse]. Il est possible, mais pas forcément utile, de cocher la case Placer chaque fichier en entrée dans une bande séparée. Le point intéressant ici est de spécifier la valeur de no data à utiliser. Ce réglage se fait dans le champ Valeur de pixel à considérer comme NoData dans le bloc Paramètres avancés. Ici nous la paramétrons à 0. Enfin, dans le champ Fusionné nous indiquons le chemin et le nom du raster de mosaïque qui sera créé. Nous pouvons retrouver la commande GDAL sous-jacente à cette manipulation dans le bloc Console GDAL/OGR. Nous cliquons ensuite sur Exécuter. La mosaïque apparaît automatiquement (Fig. 266).
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Fig. 266 Résultat de la mosaïque de deux images Landsat 8.




Astuce

Sur la figure Fig. 266, dans la symbologie nous avons réglé les no data à 0 qui apparaissent alors en transparent, donc en blanc.



Le point intéressant est qu’avec cet outil les rasters multi-bandes sont mosaïqués bande à bande. La mosaïque résultante est donc également multi-bande.



Mosaïque de rasters dans R

Version de R : 4.3.1

Version de terra : 1.7.9

Lorsque deux rasters adjacents ou se superposant sont chargés en tant qu’objets SpatRaster, il est possible de les mosaïquer grâce à la fonction merge de la librairie terra. Le mot clef first=TRUE signifie que là où les deux rasters se superposent, les valeurs du premier raster sont prises pour la mosaïque. Il suffit de mettre ce mot clef à False pour ce soient les valeurs du second raster.

# chargement des deux rasters
rast1 <- terra::rast('Landsat_Paris1.tif')
rast2 <- terra::rast('Landsat_Paris2.tif')
# mosaïque des deux rasters
mos <- terra::merge(rast1, rast2, first=TRUE)
# affichage de la mosaïque
terra::plot(mos)






Astuce

La mosaïque avec terra fonctionne aussi sur des rasters multi-bandes.






Raster multi-bandes

La création d’un raster multi-bandes est souvent nécessaire pour différents traitements géomatiques, notamment en télédétection. Un raster multi-bandes est un fichier raster qui contient plusieurs sous rasters superposés les uns aux autres. C’est typiquement utilisé pour la manipulation d’images de télédétection multi-spectrales comme les images Landsat ou Sentinel par exemple. Selon le logiciel utilisé, la création d’un tel raster est nommé concaténation ou fusion. En franglais il est également possible de parler de stack (pile).

Une telle concaténation est souvent nécessaire pour effectuer une classification d’image satellite, une composition colorée ou extraire des signatures spectrales. Cette manipulation est faisable avec la plupart des outils de géomatique.


Création d’un raster multi-bandes avec QGIS

Version de QGIS : 3.26.1

Dans QGIS, il existe trois possibilités de concaténation de rasters. Les deux premières consistent à créer un vrai raster multi-bandes en dur et la troisième consiste à créer un raster virtuel pointant vers les rasters initiaux. La différence entre les deux premières est que dans un cas nous laissons QGIS simplement numéroter les bandes et dans le second cas nous utilisons un module supplémentaire qui permet de nommer les bandes à l’intérieur du raster fusionner.


Raster multi-bandes en dur (natif)


Avertissement

Si vous souhaitez pouvoir nommer explicitement les bandes de votre raster fusionné, allez directement à la section Raster multi-bandes en dur (avec noms).



Dans cet exemple, nous allons concaténer six bandes spectrales Landsat en un seul raster multi-bandes. Nous commençons par charger dans QGIS nos rasters de bandes spectrales. Nous avons bien six rasters correspondant à nos six bandes spectrales. Pour concaténer ces rasters, nous allons dans le menu Raster ‣ Divers ‣ Fusionner …. Le menu de fusion s’ouvre (Fig. 267).
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Fig. 267 Concaténation de rasters dans QGIS.



Dans le champ Couches en entrée nous spécifions les rasters à concaténer. Il est possible de les sélectionner en cliquant sur l’icône [image: icone_browse] (Fig. 268).
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Fig. 268 Sélection des rasters à fusionner.



Ici, il faut bien faire attention à l’ordre des rasters car ce même ordre sera repris dans le raster concaténé. Nous sélectionnons les rasters à fusionner, ici nous pouvons cliquer sur Sélectionner tout. La fenêtre précédente se met à jour et nous voyons bien que dans le champ Couches en entrée nous avons 6 inputs selected.

Il est ensuite nécessaire de bien sélectionner Placer chaque fichier en entrée dans une bande séparée, sinon le résultat ne sera pas celui attendu.

Dans le champ Fusionné nous spécifions un chemin et un nom pour le raster concaténé résultant. Nous pouvons noter que ce menu n’est finalement qu’un interface à une commande GDAL. Nous avons accès à cette commande dans le panneau Commande GDAL/OGR. En cliquant sur Exécuter, le processus se lance et le raster concaténé apparaît automatiquement dans QGIS. Nous pouvons remarquer qu’une composition colorée par défaut est automatiquement générée.


Avertissement

Le numéro des bandes est un point important à bien saisir et qui prête à confusion. Le numéro des bandes du raster concaténé est totalement indépendant du « numéro » des bandes en entrée. Par exemple, si nous souhaitons concaténer les bandes 2 (Bleu), 3 (Vert) et 4 (Rouge) d’une image Landsat 8, nous obtiendrons un raster concaténé avec des bandes numérotées de 1 à 3. Mais il faudra bien faire attention au fait que la bande 1 du raster concaténé ne correspondra pas à la bande 1 de Landsat, mais à la bande 2 et ainsi de suite.





Raster multi-bandes en dur (avec noms)

La solution native de QGIS (Raster multi-bandes en dur (natif)) fonctionne parfaitement mais les bandes du raster fusionné ne sont pas nommées, ce qui peut s’avérer fastidueux pour, par exemple, construire des compositions colorées avec QGIS (Composition colorée avec QGIS). Il faut se souvenir à quoi correspond la bande 1, la bande 2, etc du raster multi-bandes. Ça peut être source de confusion. Pour palier cette limitation, il est possible d’utiliser le module supplémentaire nommé Rename Bands. Il s’installe comme toute extension de QGIS (Installation d’extensions dans QGIS). La seule chose est que cette extension est considérée comme étant expérimentale (malgré qu’elle fonctionne très bien). Pour y avoir accès, il est donc nécessaire d’aller dans le menu Extensions ‣ Installer/Gérer les extensions ‣ Onglet Paramètres. Dans cet onglet, il faut cocher Afficher les extensions expérimentales. Une fois cette option cochée, retourner dans Toutes et l’extension se trouve maintenant bien dans la liste.

Concrètement, ce module va créer un raster fusionné en dur classique mais il va l’accompagner d’un fichier texte au format .xml qui portera le même nom que le raster fusionné et dans lequel les bandes seront nommées. Il faudra bien faire attention à toujours conserver ces deux fichiers ensemble si nous souhaitons conserver les noms des bandes.

Une fois le module installé, nous commençons par charger les rasters à fusionner dans QGIS. Ensuite, le module est accessible dans la Boîte à outils de traitements ‣ Rename bands ‣ Merge and rename bands. Une fois le module lancé, la fenêtre suivante s’affiche (Fig. 269).
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Fig. 269 Création d’un raster virtuel dans QGIS en nommant les bandes.



Dans le panneau Raster layers la liste des rasters chargés dans QGIS s’affiche. Nous devons sélectionner les rasters à fusionner dans ce panneau. Une fois sélectionnés ils apparaissent surlignés en bleu. Les rasters sélectionnés apparaissent dans le panneau suivant, à la colonne Band name. À ce niveau il est possible de changer l’ordre des bandes à l’aide des icônes [image: icone_bas] et [image: icone_haut] et d’ajouter ou enlever un raster avec les icônes [image: icone_plus] et [image: icone_moins].

Dans ce même panneau, à la colonne Band future name nous indiquons le nom explicite à donner à chaque bande. Il suffit de cliquer sur la ligne et une fenêtre d’entrée de texte Band name surgit. Nous pouvons y inscrire ce que nous souhaitons. Ici, nous travaillons sur une image Landsat 8 (OLI/TIRS - Landsat 8 / OLI-2/TIRS-2 - Landsat 9), nous choisissons donc les noms suivants B1 côtier, B2 Bleu, B3 Vert, etc

Si nous le souhaitons, à la ligne No data value nous pouvons indiquer une valeur qui correspondra aux pixels sans données. Enfin, à la ligne Raster output, nous indiquons un chemin et le nom du raster multi-bandes qui sera créé. Nous terminons en cliquant sur Exécuter. Le raster multi-bandes apparaît dans QGIS et nous constatons que les bandes sont bien nommées comme souhaité (Fig. 270).
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Fig. 270 Raster fusionné avec noms de bandes explicites.



Notons que dans le répertoire d’export, nous trouvons bien notre raster fusionné au format .tif ainsi que le fichier texte .aux.xml qui contient le nom des bandes. Par curiosité il est possible d’ouvrir ce fichier XML avec un éditeur de texte. Nous y retrouvons bien le nom de chaque bande à chaque balise Description (Fig. 271).
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Fig. 271 Le fichier XML accompagnant le raster fusionné.





Raster virtuel

Avec QGIS il est également possible de créer un raster virtuel. Un tel raster est qualifié de virtuel car le fichier généré ne sera pas un fichier raster mais un simple fichier texte pointant vers les rasters initiaux. Il s’agît d’une sorte de raccourci. L’avantage d’un raster virtuel est de ne pas dupliquer les données comme c’est le cas avec une concaténation en dur.


Avertissement

Un raster virtuel ne sera souvent pas accepté comme format d’entrée pour une classification d’images. Il faudra alors préférer un vrai raster concaténé.



Dans cet exemple, nous allons de nouveau concaténer nos six bandes spectrales Landsat. Une fois ces bandes chargées, nous allons dans le menu Raster ‣ Divers ‣ Construire un raster virtuel. La fenêtre Construire un raster virtuel s’affiche alors (Fig. 272).
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Fig. 272 Création d’un raster virtuel dans QGIS.



La procédure est très similaire à celle de la concaténation de rasters en dur. Dans le champ Inuput layers nous spécifions les rasters à concaténer de la même manière que précédemment. L’ordre des couches en entrée est important car l’ordre sera le même dans raster virtuel final.

Le champ Resolution est important. Le raster virtuel homogénéisera obligatoirement les résolutions spatiales des différents rasters en entrée. Il est possible de prendre la résolution moyenne (Average), la plus haute (Highest) ou la plus basse (Lowest). Lorsque toutes les images ont la même résolution, comme dans cet exemple, l’option choisie n’a pas d’importance. Par contre si un des rasters a une résolution plus fine, le choix sera important. De plus, lors de l’homogénéisation des résolutions, une interpolation spatiale sera effectuée de façon implicite. Il sera possible de choisir la nature de cette interpolation dans les Paramètres avancés.

Il ne faut pas oublier de cocher la case Place each input file into a separate band. Enfin, dans le champ Virtuel nous spécifions un chemin et un nom pour le raster virtuel résultat. Il s’agît encore d’une commande GDAL interfacée, comme nous pouvons le voir dans le panneau Console GDAL/OGR. À la fin de l’exécution du menu, le raster virtuel apparaît automatiquement dans QGIS associée à une composition colorée par défaut. Comme pour le raster concaténé, il faut être prudent sur les numéros de bandes, voir l’avertissement à ce sujet dans la section précédente.

Si nous regardons dans notre explorateur de fichiers, nous constatons bien que le fichier créé est en fait un simple fichier texte avec l’extension .vrt. Il est possible de l’ouvrir dans un éditeur de texte de type bloc-note (Fig. 273).
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Fig. 273 Raster virtuel dans un éditeur de texte.



Ce fichier texte est un fichier XML. Nous y retrouvons les chemins vers les rasters initiaux. Par exemple, ici nous retrouvons le chemin du premier raster au niveau de la première balise SourceFilename. Nous retrouvons également d’autres informations relatives aux dimensions du raster, à son encodage, à la méthode de rééchantillonnage…


Avertissement

Il faut être prudent lorsque nous déplaçons ou faisons un copier-coller d’un raster virtuel via l’explorateur de fichiers. Comme nous l’avons vu, il s’agît d’un raccourci pointant vers les rasters initiaux. Lorsque nous déplaçons un fichier .vrt il faut également déplacer les rasters initiaux. Le plus simple est de créer le raster virtuel dans le même répertoire que les rasters initiaux et déplacer tous les fichiers en même temps lorsque c’est nécessaire.






Création d’un raster multi-bandes avec R

Version de R : 4.2.1

Il est très simple de créer un raster multi-bandes avec R. Ici nous présenterons le cas de la création d’un raster contenant quatre bandes spectrales Landsat avec le package terra. Après avoir chargé les rasters mono bandes, nous les combinons grâce à la fonction c() qui signifie concatenate. Le tout se fait avec les lignes suivantes.

# chargement du package terra
library(terra)

# chargement dess rasters mono-bandes à fusionner
b2 <- terra::rast("Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B2.TIF")
b3 <- terra::rast("Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B3.TIF")
b4 <- terra::rast("Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B4.TIF")
b5 <- terra::rast("Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF")

# création du raster multi-bandes
multi_bandes <- c(b2, b3, b4, b5)

# affichage du résultat
plot(multi_bandes, col=gray.colors(100, start = 0.1, end = 0.9))





Nous obtenons bien un objet SpatRaster à 4 bandes (Fig. 274).


[image: alternate text]

Fig. 274 Création d’un raster multi-bandes avec R.



Une fois ce raster multi-bandes créé, il est possible de changer le nom des bandes, grâce à la fonction names(), comme indiqué ci-après.

# renommage des bandes selon leur numéro
names(multi_bandes[[1]]) <- 'Bleu'
names(multi_bandes[[2]]) <- 'Vert'
names(multi_bandes[[3]]) <- 'Rouge'
names(multi_bandes[[4]]) <- 'Proche infrarouge'

# affichage du résultat
plot(multi_bandes, col=gray.colors(100, start = 0.1, end = 0.9))





Les bandes du raster multi-bandes ont bien été renommées comme souhaité (Fig. 275).
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Fig. 275 Renommer les bandes d’un raster multi-bandes dans R.





Défusionner un raster multi-bandes avec SCP (QGIS)

Il est tout à fait possible de « défusionner » un raster multi-bandes afin de récupérer chaque bande dans un fichier .tif indépendant. Une solution consiste à passer par le module SCP.

Une fois le raster multi-bandes au format .tif chargé dans QGIS, il suffit d’aller dans le menu SCP ‣ Pré-traitement ‣ Séparer les bandes. Le menu suivant s’affiche (Fig. 276).


[image: alternate text]

Fig. 276 Séparer un raster multi-bandes avec SCP.



Dans le champ Sélectionner un raster multibandes, nous sélectionnons le raster à séparer. Si nécessaire nous actualisons la liste des rasters en cliquant sur l’icône [image: icone_refresh]. Nous pouvons spécifier un préfixe pour les rasters indépendants qui seront créés, mais ce champ peut rester vide. Enfin nous cliquons sur Lancer. Il nous est alors demander un répertoire pour sauver les rasters séparés. Les rasters indépendants s’affichent automatiquement.




Rapport de valeurs uniques

Dans de nombreux cas il est utile de compter le nombre d’occurrences de chaque valeur de pixels sur un raster. C’est-à-dire de lister toutes les valeurs que prennent les pixels d’un raster donné et, pour chaque valeur rencontrée, compter le nombre de fois où cette valeur apparaît.

Cette manipulation est souvent appelée Rapport de valeurs uniques.

Évidemment, ce rapport de valeurs uniques se calcule sur des rasters discrets, qui ne prennent qu’une certaine gammes de valeurs. C’est typiquement employé sur les rasters d’usage du sol. Pour chaque classe d’usage du sol, nous pouvons obtenir le nombre de pixels. Et connaissant la résolution spatiale du raster (donc la superficie d’un pixel), il est possible de calculer la superficie occupée par chaque classe d’usage du sol.

Cette manipulation peut s’effectuer de différentes manières, avec différents outils. Dans les exemples présentés ci-dessous, nous calculerons le rapport de valeurs uniques sur un raster d’occupation du sol de la région du Caire. Ce raster a été obtenu par classification supervisée et présente 7 classes d’occupations du sol comme présentées dans le tableau suivant.


Tableau 17 Classification visée





	ID classe

	Label classe





	1

	Eau



	2

	Végétation inondée



	3

	Végétation dense



	4

	Sol nu sableux



	5

	Sol nu rocheux



	6

	Bâti dense



	7

	Bâti diffus







Rapport de valeurs uniques avec QGIS

Version de QGIS : 3.18.3

Nous commençons par charger dans QGIS le raster sur lequel nous souhaitons calculer le rapport de valeurs uniques. Ensuite, nous allons dans la Boîte à outils de traitements ‣ Analyse raster ‣ Rapport sur les valeurs uniques de la couche raster. Le menu suivant apparaît (Fig. 277).
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Fig. 277 Calcul du rapport de valeurs uniques dans QGIS.



Dans le champ Couche source nous indiquons le raster sur lequel nous travaillons. Dans le champ Numéro de bande nous sélectionnons la bande du raster à utiliser (seulement utile dans le cas d’un raster multi-bandes). Dans le champ Rapport de valeurs uniques nous indiquons un chemin et un nom pour le rapport qui sera créé. Ce rapport sera au format HTML et sera donc consultable avec un navigateur Web. Puis dans le champ Table de valeurs uniques nous indiquons un chemin et un nom pour la table contenant le rapport qui sera créé. Ces deux sorties sont optionnelles. Puis nous cliquons sur Exécuter.

La table de rapport créée apparaît automatiquement et est nommée par défaut report. Il s’agît d’un fichier GeoPackage sans attribut géographique. Nous pouvons ouvrir ses attributs en faisant un clic droit dessus dans le panneau des couches et en sélectionnant Ouvrir la Table d'Attributs (Fig. 278).
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Fig. 278 Table de rapport des valeurs uniques.



La première colonne fid est juste une colonne technique. La colonne value contient toutes les valeurs uniques trouvées dans le raster, soit, ici, les identifiants des 7 classes d’occupations du sol. La valeur 0 correspond aux no data. La colonne count contient le nombre de pixels trouvés pour chaque valeur. La colonne m2 est la conversion du nombre de pixels en superficie exprimée en unités du raster. Cette superficie est calculée selon la résolution spatiale du raster.

Si nous l’avons exporté, nous trouvons également un fichier HTML de rapport nommé report.html contenant ces mêmes informations plus quelques autres comme le SCR du raster, son emprise…


Note

Le fait d’exporter le rapport en une table GeoPackage peut être utile si nous souhaitons ensuite faire une jointure attributaire avec ce rapport.





Rapport de valeurs uniques avec SCP

Version de QGIS : 3.18.3

Version de SCP : 7.8.21

Le module supplémentaire SCP de QGIS offre aussi une fonction pour calculer un rapport de valeurs uniques. Nous commençons par charger le raster à analyser dans QGIS. Ensuite nous allons dans le menu SCP ‣ Post-traitement ‣ Rapport de classification. Bien que la fonction soit ici nommée « Rapport de classification », elle est applicable à tout raster discret même non issu de classification. Le menu suivant s’affiche (Fig. 279).
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Fig. 279 Rapport de valeurs uniques avec SCP.



Dans le champ Sélectionner la classification, nous sélectionnons la classification à analyser depuis la liste déroulante. Il peut être nécessaire de rafraîchir la liste en cliquant sur l’icône. Il est possible de définir une valeur de no data à ne pas compter dans le rapport. Ici ce sera la valeur 0. Il n’y a plus qu’à cliquer sur Lancer. Il est demandé un chemin et un nom pour le fichier de rapport au format csv qui sera créé. Puis le rapport apparaît sous forme de texte dans le panneau Sortie du menu précédent (Fig. 280).
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Fig. 280 Sortie du rapport de valeurs uniques avec SCP.



La colonne class répertorie toutes les valeurs de pixels identifiées sur le raster. La colonne PixelSum présente le nombre d’occurrences de chaque valeur de pixel. La colonne Percentage % indique le pourcentage que représente chaque valeur de pixel par rapport au raster total. Enfin, la colonne Area traduit le nombre de pixels en superficie en mètres carrés. Ce rapport texte se retrouve exactement dans le fichier csv exporté.


Note

Le petit plus de cette façon de procéder est de sortir un fichier csv facilement chargeable dans un tableur de type Excel ou LibreOffice Calc ou dans un script R ou Python. Le fait d’avoir directement les pourcentages est également intéressant.





Rapport de valeurs uniques avec R

Version de R : 4.8.1

Il est possible de sortir un rapport de valeurs uniques dans R à partir d’un raster. Dans cet exemple, nous allons générer un rapport de valeurs uniques pour un raster d’occupation du sol d’une région de la ville du Caire. Ce raster d’occupation du sol sera chargé sous forme d’un objet SpatRaster via terra. La fonction à utiliser pour générer ce rapport est freq(). La procédure à suivre est décrite ci-après.

# chargement de la librairie terra
library(terra)

# chargement du raster d'occupation du sol
usol <- terra::rast("xtr_usol_2011.tif")

# rapport de valeurs uniques
val_uniques <- freq(usol)

# rapport de valeurs uniques pour une valeur donnée
val_uniques <- freq(usol, value=5)





Le rapport est ici stocké sous forme d’un dataframe dans la variable val_uniques. Comme présenté dans le code ci-dessus, il est possible de ne générer ce rapport que pour une valeur donnée grâce à l’ajout de value=ma valeur.




Calcul raster mono-bande

Fréquemment il est utile d’effectuer des calculs sur une ou plusieurs couches rasters. Un tel calcul peut par exemple être utile pour isoler les altitudes supérieures à un certain seuil sur un MNT ou sur tout autre raster ou pour calculer un indice radiométrique à partir de rasters de bandes spectrales comme le NDVI.

En général, il y a trois formes de calculs rasters possibles. La première consiste à combiner un raster et un scalaire par une opération arithmétique. La deuxième consiste à appliquer un opérateur logique sur un raster afin d’identifier les pixels respectant la condition. Enfin, la troisième consiste à combiner plusieurs rasters par un ou plusieurs opérateurs arithmétiques. Dans ce dernier cas, les rasters en entrée doivent, dans la plupart des cas, présenter la même résolution spatiale, la même étendue et être géoréférencés dans le même système de coordonnées. Bien sûr, ces trois formes peuvent faire intervenir plusieurs rasters ou plusieurs scalaires en même temps, ainsi que plusieurs opérateurs arithmétiques et logiques.

Dans tous les cas, la logique est que le calcul s’effectue pixel par pixel comme schématisé sur la figure suivante (Fig. 281). Sur cette figure, nous considérons le cas d’un raster composé de 9 pixels, en 3 lignes et 3 colonnes.
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Fig. 281 Les trois principaux cas de figures du calcul raster.



Dans l’exemple précédent, pour le premier cas de figure, chaque pixel est multiplié par 10. Le raster résultat est géographiquement identique au raster d’entrée mais chaque pixel vaut maintenant 10 fois plus que le pixel d’entrée. Dans le deuxième cas, nous avons extrait les pixels dont la valeur est strictement supérieure à 3. Pour chaque pixel, nous avons comparé sa valeur au chiffre 3. Si le pixel était supérieur, alors on le recodait en 1 et dans le cas contraire en 0. En effet, en informatique il n’est pas possible de stocker directement les booléens Vrai et Faux sur les pixels. Les pixels sont obligatoirement de type numérique. Par défaut, Vrai se code en 1 et Faux en 0. Mais notons bien que ces valeurs de 1 et 0 n’ont aucune signification quantitative. Enfin, par défaut (souvent mais pas toujours) à l’affichage, les pixels à 1 apparaissent en blanc et les pixels à 0 en noir. Enfin, dans le troisième cas, nous avons additionné deux rasters géographiquement identiques. Le raster produit contient pour chaque pixel la somme des pixels des deux rasters d’entrée.


Calcul raster avec QGIS

Version de QGIS : 3.20.1

Le calcul raster peut se faire très simplement avec QGIS en utilisant la calculatrice raster intégrée. Elle permet de faire des calculs numériques et logiques.


Calcul logique

Dans cet exemple, nous allons extraire les zones du bassin de la Roya [https://fr.wikipedia.org/wiki/Roya] dont l’altitude est supérieure à 2000 m. Nous commençons par charger le MNT du bassin dans QGIS. Puis l’extraction va se faire grâce à l’opérateur logique  » > « . Pour ouvrir la calculatrice raster nous allons dans le menu Raster ‣ Calculatrice Raster. La calculatrice s’ouvre (Fig. 282).

Dans le panneau Bandes raster nous trouvons la liste des rasters chargés dans QGIS. Nous remarquons qu’après le nom du raster nous trouvons un @ suivi d’un numéro (srtm_roya@1). Le numéro correspond au numéro de bande dans le raster. Dans le cas d’un raster multi-bandes, nous aurions mon_raster@1, mon_raster@2 et ainsi de suite. Dans le panneau Opérateur nous trouvons les opérateurs disponibles dans la calculatrice et dans le panneau Couche résultat les réglages pour le raster qui sera créé.

Nous allons maintenant entrer l’expression qui va nous permettre d’extraire les altitudes supérieures à 2000 m dans le panneau Expression de la calculatrice raster. Nous commençons par sélectionner le raster qui rentre dans le calcul en double-cliquant sur son nom dans le panneau Bandes raster. Le raster apparaît alors dans le panneau d’expression. Nous entrons ensuite la suite de l’expression soit au clavier, soit en nous servant des opérateurs du panneau dédié.


« srtm_roya@1 » > 2000




À la ligne Couche en sortie, nous spécifions un chemin et un nom vers le raster qui sera créé. Nous pouvons également régler le SCR du raster résultat à la ligne SCR en sortie, généralement nous laissons le même SCR que le raster en entrée. Les réglages de l’emprise du résultat peuvent garder leurs valeurs par défaut (Fig. 282). Nous cliquons ensuite sur OK.
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Fig. 282 Extraction des altitudes supérieures à 2000 m du bassin de la Roya via la calculatrice raster de QGIS.



Avec ce type de calcul logique, pour chaque pixel du raster nous regardons si son altitude est supérieure ou non à 2000. La réponse est Oui ou Non, c’est binaire. Par convention, en logique numérique, Oui est transcrit en 1 et Non est transcrit en 0. Ainsi, sur le raster résultat, les pixels supérieurs à 2000 m seront codés en 1 et ceux inférieurs à 2000 m seront codés en 0. Par défaut, dans la plupart des logiciels, les pixels à 1 sont colorés en blanc et les pixels à 0 le sont en noir. Nous obtenons ainsi le raster binaire suivant (Fig. 283 B).
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Fig. 283 MNT initial (A), raster binaire des altitudes supérieures à 2000 m en blanc et inférieures en noir (B), altitudes supérieures à 2000 m en vert et inférieures en transparent (C).



Il est tout à fait possible de complexifier ce genre d’extraction à l’aide d’opérateurs booléens comme le ET (AND) et le OU (OR) Ainsi, si nous souhaitons extraire à la fois les altitudes comprises entre 500 m et 700 m et celles comprises entre 1000 m et 1200 m, il nous suffira d’entrer l’expression suivante dans le panneau d’expression de la calculatrice raster.


(« srtm_roya@1 » > 500 AND « srtm_roya@1 »< 700)  OR  ( « srtm_roya@1 » > 1000 AND « srtm_roya@1 » < 1200)




Les AND servent à définir les bandes d’altitude et le OR sert à sélectionner les deux bandes. Nous obtenons bien un raster binaire correspondant à ces deux gammes d’altitudes (Fig. 283 B).
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Fig. 284 Raster binaire des deux bandes d’altitudes extraites.





Calcul sur plusieurs rasters

Il est également possible d’effectuer des calculs combinant plusieurs rasters. Dans l’exemple suivant nous allons calculer un NDVI sur une image Landsat 8 prise au-dessus de Shangaï en août 2020. Après avoir chargé les deux rasters dans QGIS, nous ouvrons la calculatrice raster et nous entrons simplement la formule du NDVI avec les bonnes bandes (OLI/TIRS - Landsat 8 / OLI-2/TIRS-2 - Landsat 9) dans le panneau d’expression en faisant bien attention aux parenthèses (Fig. 285).


Avertissement

Les différents rasters qui entrent dans le calcul doivent être dans le même SCR.
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Fig. 285 Calcul de NDVI avec la calculatrice raster de QGIS.



Nous obtenons bien le raster de NDVI de la zone (Fig. 286).
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Fig. 286 NDVI calculé pour la zone via la calculatrice raster de QGIS.




Avertissement

Le numéro qui suit le @ dans le nom des rasters dans la calculatrice raster correspond à la position de la bande dans un raster multi-bandes. Il ne correspond en aucun cas au numéro de la bande spectrale d’une image satellite. Par exemple, si vous travaillez avec un raster multi-bandes contenant les bandes 4 et 5 d’une image Landsat 8, ces bandes seront connues comme étant les bandes 1 et 2 du raster multi-bandes.






Calcul raster avec SCP

Version de QGIS : 3.20.1

Version de SCP : 7.9.5

Le module SCP (Module SCP dans QGIS) possède une calculatrice raster similaire à celle de QGIS mais avec quelques fonctionnalités en plus. Il est par exemple possible d’utiliser des opérateurs statistiques et des clauses conditionnelles.


Opérateurs statistiques

Ici nous allons voir un exemple de calcul avec un opérateur statistique appliqué sur le MNT de la Roya. Pour l’exercice nous souhaitons savoir de combien de mètres s’écarte chaque pixel de l’altitude moyenne de la zone. Nous allons ainsi faire la différence entre la valeur de chaque pixel et la valeur moyenne du raster, ce qui est possible en une seule opération avec SCP. Nous allons dans le menu SCP ‣ Calcul de bande et la calculatrice de bande de SCP s’ouvre (Fig. 287). Il peut être nécessaire de rafraîchir la liste des bandes dans le panneau Liste de bandes en cliquant sur l’icône d’actualisation [image: icone_refresh]. Nous entrerons ensuite l’expression dans le panneau Expression en nous servant des fonctions proposées dans le panneau Fonctions. Pour répondre à notre question nous entrons ainsi la formule suivante.

« srtm_roya » - mean(« srtm_roya »)


Note

Nous pouvons récupérer le nom du raster sans l’entrer à la main en double-cliquant sur son nom dans le panneau Liste de bandes. De même, il suffit de double-cliquer sur la fonction mean dans le panneau Fonctions. Nous évitons ainsi des fautes de frappe.
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Fig. 287 Calcul avec opérateur statistique dans SCP.



Il suffit alors de cliquer sur Lancer. Il nous est demandé d’indiquer un chemin et un nom pour le raster résultat, puis le raster calculé apparaît (Fig. 288).
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Fig. 288 Différence d’altitude entre chaque pixel et l’altitude moyenne de la région.



Sur le raster résultat (Fig. 288), les pixels allant vers le bleu sont les pixels dont l’altitude est inférieure à l’altitude moyenne de la région, et ceux tirant vers le rouge ceux dont l’altitude est supérieure à la moyenne.



Opérateurs logiques

Dans ce module SCP, nous trouvons également des opérateurs de conditions de type Si telle condition est remplie, alors ceci, sinon cela. Cet opérateur est identifié dans SCP sous le nom de where. La syntaxe est where(condition, opération si Vrai, opération si Faux). Par exemple, si nous souhaitons recoder notre MNT en mettant à 10 les pixels dont l’altitude est supérieure à 1000 m et à 20 les pixels dont l’altitude est inférieure à 1000 m, nous entrons la formule suivante dans le panneau d’expression : where(« srtm_roya » > 1000 , 10, 20) (Fig. 289).
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Fig. 289 Calcul avec opérateur conditionnel dans SCP.



Le raster résultat est similaire à un raster binaire sauf que, grâce à cet outil de condition, nous pouvons le coder en d’autres valeurs que 0 et 1. Il est même possible d’emboîter les conditions afin d’obtenir plus de deux valeurs.




Calcul raster avec OTB

Version de OTB : 9.0.0

Le logiciel OrfeoToolbox (Orfeo ToolBox) propose également un module de calcul raster. Ce module est basé sur une librairie écrite en C++ nommée muparser [https://beltoforion.de/en/muparser/index.php] optimisée pour le calcul matriciel. Ainsi, la calculatrice raster de OTB est performante en terme de puissance. L’autre avantage de OTB est de pouvoir être utilisé via QGIS ou via la console, ce qui est intéressant dans une optique d’automatisation. Dans les exemples suivants, nous calculerons un NDVI à partir d’une image Landsat 8.


Avec OTB via QGIS

Le module permettant les calculs rasters avec OTB se nomme BandMath et se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Image Manipulation. Une description détaillée est disponible sur la documentation en ligne [https://www.orfeo-toolbox.org/CookBook/Applications/app_BandMath.html]. Nous pouvons également chercher ce module via la barre de recherche de la Boîte à outils de traitements. Une fois le module sélectionné, la fenêtre suivante s’affiche (Fig. 290).
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Fig. 290 Calcul raster avec l’application BandMath de OTB.



À la ligne Input image list nous sélectionnons les rasters à utiliser dans le calcul. Le premier raster de la liste sera reconnu sous le nom de im1, le deuxième sous le nom de im2 et ainsi de suite. Puis à la ligne Expression, nous entrons l’expression à calculer en utilisant la syntaxe adéquate. Les rasters sont numérotés selon leur ordre dans la liste du panneau Input image list. Ensuite, nous devons renseigner la bande à considérer dans chacun de ces rasters. Pour faire un calcul sur la première bande du premier raster nous indiquons im1b1 et ainsi de suite. Dans notre cas nous avons des rasters mono-bande, la formule est donc :

(im2b1 - im1b1) / (im2b1 + im1b1)

où im2b1 correspond à la première bande (b1) du deuxième raster chargé (im2), soit bien le raster de la bande du proche infrarouge L8_Shangai_B5.tif

et im1b1 correspond à la première bande (b1) du premier raster chargé (im1), soit bien le raster de la bande du rouge L8_Shangai_B4.tif

Nous renseignons ensuite le chemin et le nom du raster résultat à la ligne Ouput image. Nous cliquons enfin sur Exécuter pour lancer le calcul.



Avec la commande otbcli

En ligne de commande, l’opération est simple, il suffit de bien respecter la syntaxe et de bien se placer dans le répertoire qui contient nos rasters. Nous commençons par appeler le module BandMath, nous définissons ensuite les rasters en entrée via le paramètre -il, puis nous définissons le nom du raster résultat via le paramètre -out et enfin nous entrons la même expression que précédemment mais placée entre guillemets via le paramètre -exp. Dans notre cas, la ligne de commande est la suivante :

otbcli_BandMath -il L8_Shangai_B4.tif L8_Shangai_B5.tif -out ndvi_otbcli.tif -exp "(im2b1 - im1b1) / (im2b1 + im1b1)"





Le point important est de bien faire attention à l’ordre des rasters. Le premier raster de la commande sera le im1, le deuxième im2 et ainsi de suite. Dans tous les cas, le raster calculé est exporté en .tif et peut être ouvert dans QGIS ou tout autre logiciel de géomatique.



Avec un opérateur de condition

Ce module BandMath propose aussi un opérateur de condition, comme vu dans la partie dédiée au calcul raster avec SCP (Opérateurs logiques). La syntaxe est (condition ? valeur si Vraie : valeur si Faux). Ainsi, dans notre exemple de coder les altitudes supérieures à  1000 m en 10 et celles inférieures à 1000 m en 20 sur le MNT de la Roya, l’expression à entrer à la ligne Expression (ou après -exp) est :

(im1b1 > 1000 ? 10 : 20)

où im1b1 correspont au raster de MNT.




Calcul raster avec R

Version de R : 4.8.1

Lorsqu’un ou plusieur rasters sont chargés dans R, il est possible d’effectuer des opérations mathématiques dessus. Le calcul raster avec R est très simple et très utile. La façon de calculer est légèrement différente selon les packages utilisés. Ici, nous montrerons la marche à suivre pour un raster chargé sous forme d’un objet SpatRaster via terra. Nous travaillerons sur des bandes spectrales Landsat 8 prises au-dessus des Bouches-du-Rhône.


Raster et scalaire

Il est possible d’appliquer une opération sur un raster, i.e. sur chacun des pixels de ce raster. Dans notre exemple nous multiplierons un raster, de type SpatRaster stocké dans une variable nommé proche_infrarouge, par 1000. Concrètement, nous allons multiplier chacun des pixels constitutifs du raster proche_infrarouge par 1000. Nous obtiendrons ainsi en sortie un nouveau raster aux même propriétés géométriques que le raster initial mais avec des valeurs 1000 fois plus grandes pour chacun des pixels du raster. Ce raster sera aussi un objet SpatRaster que nous stockerons dans une variable nommée pir_1000.

# chargement de la librairie terra
library(terra)

# chargement du raster
pir <- terra::rast("Landsat_13/dep_13_L8_20190613_B5.tif")

# multiplication de ce raster par 1000
pir_1000 <- pir * 1000

# affichage du résultat
plot(pir_1000, col=gray.colors(100, start = 0.1, end = 0.9))





Nous constatons que l’opération est très simple, et nous obtenons bien notre raster initial où chacun des pixels ont été multipliés par 1000 (Fig. 291).
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Fig. 291 Résultat de la bande spectrale initiale multipliée par 1000 (remarquer le facteur 1000 dans la légende).





Entre plusieurs rasters

Il est également possible d’effectuer des opérations entre deux, ou plus de deux, rasters. Il est conseillé que les rasters en entrée aient les mêmes dimensions et soient dans les mêmes systèmes de coordonnées. Ici, nous calculerons un NDVI à partir de deux rasters de bandes spectrales du proche infrarouge (pir) et du rouge (rouge). Ces rasters sont au format SpatRaster. Nous stockerons le résultat dans une variable nommée ndvi.

# chargement de la librairie terra
library(terra)

# chargement des rasters des bandes spectrales Rouge et PIR
rouge <- terra::rast("Landsat_13/dep_13_L8_20190613_B4.tif")
pir <- terra::rast("Landsat_13/dep_13_L8_20190613_B5.tif")

# calcul du NDVI
ndvi <- (pir - rouge) / (pir + rouge)





La formulation est très simple. Le raster résultat sera également un objet SpatRaster.



Opération logique

Dans certains cas, nous sommes amenés à appliquer des opérations logiques sur des rasters. À l’issue d’une telle opération logique nous obtenons un nouveau raster dans lequel les pixels répondant Vrai à la condition sont codés en 1 et les pixels répondant Faux sont codés à 0. Le raster obtenu est dit binaire car exprimé en 0 et 1. Ce type d’opération est courante lors de l’application de seuils. Dans l’exemple ici, nous appliquerons un seuil sur le MNT du bassin de la Roya [https://fr.wikipedia.org/wiki/Roya] afin d’extraire les pixels dont l’altitude est spérieure à 1500 m.

# chargement de la librairie terra
library(terra)

# chargement du MNT
mnt_roya <- terra::rast("srtm_roya_L93.tif")

# application du seuil sur les altitudes
mnt_roya_1500 <- mnt_roya > 1500

# affichage du résultat
plot(mnt_roya_1500)





Aucune difficulté dans la formulation, et le raster correspondant est bien un raster binaire dans lequel les pixels à 1 correspondent aux pixels ayant une altitude supérieure à 1500 m (Fig. 292).


[image: alternate text]

Fig. 292 Raster binaire après un calcul raster de type seuil dans R.






Calcul raster avec GDAL

Version de GDAL : 3.0.4

GDAL a une fonctionnalité permettant de faire du calcul raster. Comme GDAL s’exécute en lignes de commandes, son usage peut être intéressant pour faire un calcul rapide ou bien un calcul raster dans un script. La commande dédiée est gdal_calc.py. C’est une extension Python de GDAl installée par défaut avec GDAL. Les détails de la commande et la liste des options possibles se trouvent sur la page du manuel dédiée [https://gdal.org/programs/gdal_calc.html]. Nous verrons ici les fonctionnalités les plus fréquentes.


Raster et scalaire

Il est très simple d’associer un raster à un scalaire par un calcul. Par exemple, si nous souhaitons multiplier les altitudes d’un MNT, nommé srtm_Roya.tif, par 10, la commande à entrer est la suivante.

gdal_calc.py -A srtm_roya.tif --outfile=mnt_10.tif --calc="A*10"





Avec :



	gdal_calc.py : appel à la commande GDAL


	-A srtm_roya.tif : le raster à prendre en entrée qu’on stocke dans la variable A


	–outfile=mnt_10.tif : le nom du raster résultat en sortie


	–calc= »A*10 » : l’expression à calculer. Bien noter que cette expression fait appel à la variable A et pas directement au raster et que cette expression est entre guillemets et sans espaces







En sortie, nous obtenons bien un raster au format GeoTiff que nous pouvons charger dans QGIS. Sur ce raster, les pixels correspondent aux pixels du MNT de départ mais multipliés par 10.



Raster et calcul logique

Sur le même principe, il est facile d’appliquer une opération logique sur un raster. Par exemple, si nous souhaitons extraire les pixels dont l’altitude est comprise entre 1000 m et 2000 m à partir d’un MNT nommé srtm_Roya.tif, la commande à entrer est la suivante.

gdal_calc.py -A srtm_roya.tif --outfile=alti_1000-2000.tif --calc="(A>1000)&(A<2000)"





Notez que l’opérateur à employer pour le ET est l’esperluette &. Le résultat est un raster binaire où les pixels à 1 correspondent aux pixels respectant la condition et les pixels à 0 correspondent à tous les autres pixels. Cette expression peut également prendre la forme suivante.

gdal_calc.py -A srtm_roya.tif --outfile=alti_1000-2000.tif --calc="logical_and(A>1000, A<2000)"





Ici nous employons le mot clef logical_and() avec la condition à l’intérieur des parenthèses.

Si le calcul fait appel à une condition OU, il faut alors employer le mot clef logical_or(). Par exemple, si nous disposons d’un raster d’occupation du sol de type Corine Land Cover et que nous souhaitons extraire les occupations du sol de classe 211 et 511, la commande GDAL sera la suivante.

gdal_calc.py -A CLC.tif --outfile=CLC_extract.tif --calc="logical_or(A==211,A==511)"





Notez l’emploi de deux signes = pour l’égalité. Nous obtenons bien un nouveau raster binaire avec les pixels à 1 qui correspondent aux pixels satisfaisant la condition.



Calcul sur plusieurs rasters

Il est également tout à fait possible de combiner plusieurs rasters lors d’un calcul. Les rasters d’entrée doivent par contre être de mêmes dimensions et dans le même système de projection. Par exemple, pour calculer un NDVI à partir d’une bande de proche infrarouge nommée L8_B5.TIF et d’une bande rouge nommée L8_B4.TIF, nous entrons la commande suivante.

gdal_calc.py -A L8_B4.TIF -B L8_B5.TIF --outfile=ndvi.tif --calc="(B-A)/(B+A)"





La différence avec précédemment est que nous spécifions deux rasters en entrée stockés respectivement dans les variables A et B. Ce sont ces deux variables qui sont utilisées dans l’expression de calcul que nous retrouvons dans –calc= »(B-A)/(B+A) ». En sortie, nous obtenons bien notre raster de NDVI.


Avertissement

Le raster de sortie d’un calcul raster avec GDAL est du même type que les rasters en entrée. Ainsi, si les rasters en entrée sont de type Integer (Entiers), le résultat sera aussi de type entier, ce qui peut amener à des surprises inattendues et non souhaitées. Il est censé être possible de forcer le type souhaité en spécifiant par exemple A.astype(numpy.float64) dans le calcul mais ça n’a pas l’air de toujours fonctionner…



Si les rasters à combiner dans le calcul ne sont pas constitués de fichiers séparés mais proviennent de bandes différentes se trouvant au sein d’un raster multi-bandes, la syntaxe doit être modifiée. Par exemple, ici nous disposons d’un raster multi-bandes contenant des bandes spectrales Landsat 8 de 1 à 7. La bande du rouge est donc la bande 4 et celle du proche infrarouge la bande 5. Pour calculer le NDVI à partir de ce raster multi-bandes, la syntaxe est la suivante.

gdal_calc.py -A L8_stack.tif --A_band=5 -B L8_stack.tif --B_band=4 --outfile=ndvi_stack.tif --calc="(A-B)/(A+B)"





Notez que nous stockons le raster multi-bandes une première fois dans la variable A et que nous spécifions que nous y prenons simplement la bande 5 via le mot clef –A_band=5. Puis nous stockons le raster multi-bandes une seconde fois dans la variable B et nous spécifions que nous y prenons cette fois-ci la bande 4 via le mot clef –B_band=4. Ainsi les A et B appelés dans l’expression du calcul correspondent bien aux bandes désirées.





Calcul raster avec statistiques

En télédétection il est fréquent de manipuler des rasters multi-bandes. Dans la plupart des cas, ces rasters multi-bandes sont des regroupements de réflectances dans différentes bandes spectrales pour une date donnée ou bien des regroupements d’une même réflectance ou d’un indice pour plusieurs dates. Dans ce second cas nous parlons de séries temporelles. Pour effectuer des calculs, ou des statistiques pixel à pixel, sur ces rasters multi-bandes, il n’est pas possible d’utiliser les outils basiques de calculs rasters. Il est nécessaire d’employer des outils dédiés. Dans tous les cas, le raster résultat sera géographiquement identique aux rasters en entrée mais les valeurs des pixels auront pris la valeur de la statistique utilisée en fonction des rasters en entrée, comme présenté sur la figure suivante (Fig. 293).
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Fig. 293 Calcul de statistiques sur un stack de rasters.



Dans cet exemple théorique nous avons en entrée 4 rasters de 9 pixels chacun. Dans un premier temps, nous calculons le raster issu de la statistique Maximum appliquée au stack de ces 4 rasters. Nous obtenons un nouveau raster dans lequel chaque pixel prend la valeur maximale rencontrée dans les 4 pixels d’entrée. Dans un second temps, nous calculons le raster issu de la statistique Moyenne appliquée au stack des 4 rasters. Nous obtenons un nouveau raster dans lequel chaque pixel prend la valeur moyenne des 4 pixels d’entrée.


Calcul raster et stats avec QGIS et SCP

Version de QGIS : 3.22.0

Version de SCP : 7.10.5

Le plugin SCP de QGIS propose une fonctionnalité intéressante pour calculer des statistiques pixel à pixel sur un raster multi-bandes. L’idée est de créer un nouveau raster sur lequel les valeurs des pixels correspondront à un résumé statistique pour chacun des pixels. Dans l’exemple ci-dessous, nous allons calculer la réflectance moyenne dans le proche-infrarouge de 4 images Sentinel-2 prises sur la même zone mais à 4 dates différentes. Nous commençons par charger dans QGIS ces 4 rasters. Puis nous allons dans le menu SCP ‣ Jeu de bandes pour créer un jeu de bandes qui contiendra nos 4 rasters de réflectance.

Une fois le jeu de bandes (Band set) défini, nous allons dans le menu SCP ‣ Calcul de bandes. Le menu suivant s’affiche (Fig. 294).


[image: alternate text]

Fig. 294 Moyenne pixel à pixel sur un raster multi-bandes avec SCP dans QGIS.



Dans le panneau Expression nous entrons l’expression suivante : mean("bandset#b*"). Par défaut, le bandset est le Jeu de bandes actif. Cette syntaxe signifie que nous travaillons sur le bandset actif et sur toutes les bandes le composant #b*. Et sur toutes ces bandes nous demandons la moyenne mean(). Nous cliquons ensuite sur Exécuter et nous spécifions un chemin et un nom pour le raster résultat. Chaque pixel de ce raster résultat correspondra à la moyenne des réflectances sur les 4 dates.



Calcul raster et stats avec OTB

Version de OTB : 9.0.0

OrfeoToolbox propose une fonctionnalité qui permet de faire du calcul multibandes combinant des statistiques. Dans l’exemple ci-après, nous allons combiner 4 rasters de NDVI calculés sur une même région mais à 4 dates différentes au sein d’une année. Nous allons construire un nouveau raster, qui sera géographiquement identique aux rasters de NDVI initiaux, mais dont les pixels correspondront au NDVI maximum des 4 dates.


Avec OTB via QGIS

Le module à utiliser se nomme BandMathX, nous le trouvons dans la Boîte à outils de traitements ‣ OTB ‣ Image Manipulation ‣ BandMathX. La fenêtre suivante s’ouvre (Fig. 295).
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Fig. 295 Calcul raster avec statistiques sur plusieurs bandes.



Dans le panneau Input image list nous renseignons les rasters sur lesquels nous souhaitons calculer des statistiques. Ces rasters doivent avoir exactement les mêmes dimensions et les mêmes systèmes de projection. Ici nous ajoutons nos 4 NDVI calculés pour nos 4 dates de l’année 2016. À la ligne Output Image, nous spécifions un chemin et un nom pour le raster de sortie. Enfin, le plus important est l’expression à entrer à la ligne Expressions. Dans le cas du calcul d’un maximum, l’expression est :

max(im1b1,im2b1,im3b1,im4b1)





où max est la statistique à calculer et im1b1 signifie que nous prenons la bande 1 (b1) de l’image 1 (im1) correspondant au raster chargé en premier, et ainsi de suite.


Note

Dans le cas où nous ne travaillons pas sur des rasters séparés mais sur des bandes au sein d’un raster multi-bandes, l’expression devient simplement : max(im1b1,im1b2,im1b3,im1b4). Nous ne travaillons qu’avec l’image 1 im1 mais nous y appelons les différentes bandes de b1 à b4.



Une fois cliqué sur Exécuter, le raster contenant la valeur maximums des NDVI est calculé. Il est possible de le charger dans QGIS.



Avec la commande otbcli

Dans une optique d’automatisation de tâches, il est possible d’appeler ce module BandMathX en ligne de commandes otbcli. Cette ligne s’écrit alors simplement comme ci-dessous.

otbcli_BandMathX -il ndvi_2016-01-25.tif ndvi_2016-03-15.tif ndvi_2016-05-04.tif ndvi_2016-08-22.tif -out max_ndvi2.tif -exp "max(im1b1,im2b1,im3b1,im4b1)"






	Où :
	
	otbcli_BandMathX est l’appel au module BandMathX


	-il est le mot clef pour spécifier les rasters en entrée


	-out est le mot clef pour spécifier le nom du raster en sortie


	-exp est le mot clef pour entrer l’expression au même format que vu dans le paragraphe précédent









Note

Il peut être laborieux d’entrer le nom à la main de tous les rasters en entrée. Le plus simple est de créer au préalable un Raster multi-bandes puis d’appeler les différentes bandes de ce raster dans l’expression du calcul.







Reclassifier un raster

Il est souvent utile de reclassifier un raster, c’est-à-dire d’assigner de nouvelles valeurs aux pixels en fonction de règles. Par exemple, il est possible de changer tous les pixels dont les valeurs sont comprises entre une valeur a et une valeur b par une valeur c. Il est également possible de changer tous les pixels qui ont exactement la valeur a par la valeur c. Dans les exemples qui suivent, nous reclassifierons un raster d’usage du sol du Caire en 7 classes, obtenu par classification supervisée, pour obtenir un nouveau raster présentant de nouveaux identifiants de classe. Les 7 classes initiales sont rappelées dans le tableau suivant.


Tableau 18 Occupation du sol initiale





	ID classe

	Label classe





	1

	Eau



	2

	Végétation inondée



	3

	Végétation dense



	4

	Sol nu sableux



	5

	Sol nu rocheux



	6

	Bâti dense



	7

	Bâti diffus






La reclassification nous permettra d’assigner de nouveaux numéros de classes aux différentes classes ou de regrouper plusieurs classes en une seule classe. Pour l’exemple, dans un premier temps nous assignerons l’identifiant 11 à la classe 1, 22 à la classe 2 et ainsi de suite jusqu’à 77 à la classe 7. Dans un second temps, nous regrouperons les classes par grandes catégories comme indiqué dans le tableau suivant.


Tableau 19 Reclassification (regroupement) de l’occupation du sol







	ID classe old

	Label old

	ID classe new

	Label new





	1

	Eau

	1

	Eau



	2

	Végétation inondée

	2

	Végétation



	3

	Végétation dense

	2

	Végétation



	4

	Sol nu sableux

	3

	Sol nu



	5

	Sol nu rocheux

	3

	Sol nu



	6

	Bâti dense

	4

	Bâti



	7

	Bâti diffus

	4

	Bâti







Reclassifier un raster avec QGIS

Version de QGIS : 3.20.3

Une fois le raster à reclassifier chargé, nous ouvrons le menu Reclassification par table dans le panneau Boîte à outils de traitements ‣ Analyse raster ‣ Reclassification par table. Le menu s’ouvre (Fig. 296).
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Fig. 296 Reclassification de raster avec QGIS.



Reclassification classe par classe

Nous commençons par reclassifier le raster classe par classe, sans regroupement. Nous changeons simplement l’identifiant de chaque classe par le nouvel identifiant (1 par 11, 2 par 22…).

À la ligne Couche raster, nous sélectionnons le raster à reclassifier, ici classif_7. Dans le cas d’un raster multi-bandes, nous précisons la bande à reclassifier à la ligne Numéro de bande. Ensuite, le travail de reclassification s’effectue via une table de reclassification à paramétrer à la ligne Table de reclassification en cliquant sur l’icône [image: icone_browse] en bout de ligne. Le menu de paramétrage de la table de reclassification s’ouvre (Fig. 297).

Nous commençons par ajouter autant de lignes que de classes à reclassifier en cliquant autant de fois que nécessaire sur Ajouter une ligne. Ensuite, nous indiquons la borne inférieure et supérieure des gammes de valeurs à changer dans les colonnes Minimum et Maximum et nous renseignons la nouvelle valeur dans la colonne Valeur. Ici, comme nous changeons les valeurs de toutes les classes, classe par classe, les bornes minimum et maximum sont les mêmes et correspondent aux classes à changer (Fig. 297).
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Fig. 297 Table de reclassification de raster classe par classe.



Une fois ce paramétrage effectué, nous cliquons sur OK pour revenir à la fenêtre principale du module. Il faut maintenant régler la règle de reclassification en dépliant le panneau Paramètres avancés. Dans ce panneau, à la ligne Limites de plages, nous spécifions la règle à suivre pour la reclassification. Ici, les valeurs maximum et minimum correspondent directement à nos classes. Nous choisissons donc la règle min <= valeur <= max. Nous renseignons ensuite le chemin d’export du raster qui sera créé à la ligne Raster reclassifié. Puis nous cliquons sur Exécuter. Le raster reclassifié apparaît automatiquement. Les classes ont bien été réattribuées.

Reclassification pour regroupement de classes

Dans ce cas de figure, la table de reclassification doit être paramétrée différemment. Les bornes minimum et maximum doivent être renseignées de telle sorte que ce soient des gammes de valeurs qui vont être réassignées. Ici, pour opérer un regroupement de classes tel que présenté dans l’introduction de cette section (Reclassifier un raster), nous paramétrons la table tel que présenté ci-dessous (Fig. 298).
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Fig. 298 Table de reclassification de raster pour regroupement de classes.



Puis nous réglons la règle de reclassification dans le panneau Paramètres avancés. Tel que nous avons paramétré nos bornes de classes, la règle appropriée est alors min < valeur <= max. Nous renseignons le chemin du raster de regroupement de classes et nous cliquons sur Exécuter. Le raster aux classes regroupées apparaît (Fig. 299).
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Fig. 299 Occupation du sol initiale en 7 classes (A) et occupation du sol après regroupement en 4 classes (B).





Reclassifier un raster avec R

Version de R : 4.3.1

Version de terra : 1.7.29

Nous allons reproduire les manipulations de reclassification présentées kdans l’introduction de cette partie (Reclassifier un raster) avec R en utilisant la librairie terra.

Reclassification classe par classe

Nous commencerons par reclassifier un raster d’occupation du sol classe par classe. À chaque classe initiale nous allons attribuer une nouveau numéro de classe. Cela se fait avec la méthode classify de terra, comme présenté ci-après.

# import de l'occupation du sol à reclasser
usol <- terra::rast('classif_C_2011.tif')

# reclass classe par classe
# on créé une matrice de reclassification
m <- c(1, 11,
       2, 22,
       3, 33,
       4, 44,
       5, 55,
       6, 66,
       7, 77)
rclmat <- matrix(m, ncol=2, byrow=TRUE)
# on applique cette matrice de reclassification
usol_reclass <- terra::classify(usol, rclmat)





Comme nous pouvons le voir, nous commençons par créer une matrice de reclassification de type ancienne valeur, nouvelle valeur puis nous appliquons cette matrice au raster à reclassifier.

Reclassification pour regroupement de classes

Il est également possible de reclassifier en regroupant des classes. Dans cet exemple, nous allons simplifier notre occupation du sol initialement en 7 classes en une occupation du sol en 4 classes (Fig. 298). Nous utilisons également la fonction classify.

# import de l'occupation du sol à reclasser
usol <- terra::rast('classif_C_2011.tif')

# reclass classe par classe
# on créé la matrice de reclassification
m <- c(1, 1, 1,
       1, 3, 2,
       3, 5, 3,
       5, 7, 4)
rclmat <- matrix(m, ncol=3, byrow=TRUE)
# on applique la matrice de reclassification
usol_reclass <- terra::classify(usol, rclmat)





Cette fois-ci la matrice s’écrit sur 3 colonnes de la façon de telle valeur, à telle valeur, nouvelle valeur. Nous pouvons toutefois noter que par défaut, la fonction classify ne prend pas la valeur minimum de chaque intervalle mais prend la valeur maximale. C’est pourquoi nous lui indiquons que les pixels allant de 1 (non inclus) à 3 (inclus) doivent prendre la nouvelle valeur de 2.

Il est également possible de reclassifier spécifiquement certaines valeurs et de mettre toutes les autres valeurs à telle autre valeur. Par exemple, si nous souhaitons reclassifier notre occupation du sol en deux classes Végéation et Pas végétation en mettant les deux classes de végétation à 1 et tout le reste à 0, nous pouvons utiliser le mot clef others, comme présenté ci-dessous.

# import de l'occupation du sol à reclasser
usol <- terra::rast('classif_C_2011.tif')

# reclass en deux classes
# on créé la matrice de reclassification simplement pour la classe d'intérêt
m <- c(1, 3, 1)
rclmat <- matrix(m, ncol=3, byrow=TRUE)
# on applique la matrice de reclassification en spécifiant "tout le reste à 0"
usol_reclass <- terra::classify(usol, rclmat, others=0)






Note

La fonction classify de terra présente d’autres options intéressantes pour des usages plus précis, à regarder de plus près [https://rdrr.io/cran/terra/man/classify.html] en cas de besoin.






Compresser un raster

Il arrive d’avoir à faire à des rasters qui deviennent trop volumineux pour un ordinateur donné ou pour un logiciel. Une façon de faire peut être de le découper en tuiles, comme expliqué dans la rubrique dédiée (Découper un raster selon une grille). Mais il est également possible de réduite le poids d’un raster en utilisant des algorithmes de compression. Une présentation détaillée de ces algorithmes peut être trouvée en ligne [https://kokoalberti.com/articles/geotiff-compression-optimization-guide/?utm_source=pocket_mylist]. Ici, nous nous contenterons d’en utiliser un  sans regarder les processus sous-jacents. Néanmoins, le point clé à bien retenir est que cette compression n’altère pas les données. Ainsi, les valeurs des pixels sont bien conservées ce qui permet de garder l’intégrité de l’information du raster.

Dans les exemples ci après nous verrons comment compresser un raster d’une bande spectrale Landsat 8.


Compresser un raster avec QGIS

Version de QGIS : 3.26.0

Tout d’abord nous chargeons le raster à compresser dans QGIS. Une fois le raster chargé, il suffit de faire un clic droit sur la couche dans le panneau des couches. Puis nous sélectionnons Exporter ‣ Enregistrer sous… Le menu suivant s’affiche (Fig. 300).
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Fig. 300 Compression d’un raster avec QGIS.



Dans le champ Format nous laissons GeoTIFF. Dans le champ Nom de fichier, nous précisons un chemin et un nom pour le raster compressé qui sera créé. Nous pouvons laisser le champ SCR à sa valeur pour conserver le même SCR. Les options de compression s’obtiennent en dépliant le menu Options de création. Nous choisissons Compression élevée dans le menu Profil et nous pouvons laisser les valeurs proposées par défaut pour les variables Compress, Predictor et Zlevel qui produisent de bons résultats. Pour plus de détails techniques et des comparaisons de différentes compressions vous pouvez vous référer à cette page [https://kokoalberti.com/articles/geotiff-compression-optimization-guide/?utm_source=pocket_mylist]. Il ne reste qu’à cliquer sur OK.

Le raster passe ainsi d’un poids de 228.6 MiO à 85.2 MiO, soit une diminution de poids de près de 60 %, ce qui n’est pas négligeable du tout. De plus, comme dit en préambule, les valeurs des pixels sont conservées à l’identique.



Compresser un raster avec GDAL

Version de GDAL : 3.0.4

Il peut être intéressant de passer par GDAL en ligne de commandes pour compresser un raster. Ce type d’usage permet d’aller vite ou de chaîner des traitements facilement. Pour cela, il suffit que GDAL soit bien renseigné dans le PATH de votre système d’exploitation. La ligne de commande à utiliser est la suivante.

gdal_translate -of GTiff -co "COMPRESS=DEFLATE" -co "PREDICTOR=2" -co "ZLEVEL=9" LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF gdal-deflate_2-9.tiff





Cette ligne de commande se comprend de la façon suivante :


	gdal_translate : la fonction GDAL dédié à la conversion de format des rasters


	-of GTiff : spécification du format de raster en sortie, ici GeoTIFF


	-co « COMPRESS=DEFLATE » : l’option qui stipule qu’on va compresser le raster avec l’option DEFLATE. D’autres options sont possibles [https://gdal.org/drivers/raster/gtiff.html#creation-options].


	-co « PREDICTOR=2 » -co « ZLEVEL=9 » : les deux options qui précisent le niveau de compression DEFLATE. Il est possible de changer ces valeurs mais celles-ci donnent de bons résultats.


	LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF : le raster à compresser


	gdal-deflate_2-9.tiff : le nom du raster compressé qui sera créé




Le raster passe ainsi d’un poids de 228.6 MiO à 85.2 MiO.




Statistiques zonales raster

Il est possible de calculer des statistiques zonales d’un raster en fonction d’un raster classifié. C’est utile lorsque nous disposons d’un raster avec des valeurs continues (des altitudes, des réflectances, des températures, …), qui peut être multi-bandes, et que nous souhaitons avoir des statistiques selon des zones définies sur un second raster en valeurs discrètes. Ces valeurs discrètes peuvent être des labels de classes, aussi appelées zones. Sauf cas contraire, lans les exemples ci-après nous montrerons comment calculer des signatures spectrales moyennes d’une image Landsat TM en six bandes prise au-dessus du Caire le 13 juillet 2011 pour 10 classes définies par classification non supervisée (Classification non supervisée d’images satellites). Le raster multi-bandes contient ainsi les réflectances de la scènes dans six bandes spectrales et le raster labellisé contient 10 valeurs différentes, correspondant à 10 classes.


Avertissement

Pour la plupart des outils permettant ce calcul de statistiques zonales, il est nécessaire d’avoir les deux rasters dans le même système de coordonnées de référence. Si nécessaire, penser à reprojeter l’un des deux rasters (Reprojection d’un raster).




Statistiques zonales raster avec QGIS

Version de QGIS : 3.38.1

Pour cet exemple, nous calculerons l’altitude moyenne sous différentes occupations du sol sur le bassin-versant de la Roya (Alpes-Maritimes). Le MNT utilisé est le SRTM et l’occupation du sol est le raster Corine Land Cover de 2018.


Astuce

QGIS permet de prendre en entrée deux rasters dans des systèmes de coordonnées différents et/ou de résolutions différentes.



Le calcul de statistiques zonales entre deux rasters se fait facilement dans QGIS. Une fois le raster continu et le raster labellisé chargés, il suffit d’aller dans Boîte à outils de traitements ‣ Analyse raster ‣ Statistiques zonales de la couche raster. Le menu suivant s’affiche (Fig. 301).
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Fig. 301 Statistiques zonales entre deux rasters avec QGIS.



Dans le champ Couche source nous renseignons le raster sur lequel calculer les statistiques zonales, ici le modèle numérique de terrain srtm_roya_L93. À la ligne, Couche zonale nous spécifions le raster contenant les labels, ici l’occupation du sol CLC_2018_Roya. Enfin, à la ligne Statistiques nous renseignons un chemin et un nom pour le fichier qui contiendra les statistiques. Il s’agira d’un GeoPackage sans géométrie.


Avertissement

Comme il est possible de le constater dans le menu précédent, QGIS ne propose pas de calculer des statistiques zonales sur un raster multi-bandes. Si besoin, privilégier un des outils présentés plus lion dans cette rubrique.



Le résultat apparaît dans le panneau des couches de QGIS et peut s’ouvrir comme une table attributaire (Fig. 302).
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Fig. 302 Table des statistiques zonales entre deux rasters.



Dans le champ Zone nous retrouvons les numéros des zones, qui correspondent ici aux classes d’occupation du sol Corine Land Cover, puis les différentes statistiques d’altitudes dans les colonnes suivantes. Ici, seule la colonne mean (moyenne) a du sens. Par exemple, l’occupation du sol numéro 23 a une altitude moyenne de 903.4 m.



Statistiques zonales raster avec OTB

Version de OTB : 9.0.0

OTB propose un outil pour calculer des statistiques zonales entre deux rasters, en permettant d’utiliser un raster multi-bandes. Par contre, les deux rasters doivent être dans le même système de coordonnées de référence et de la même résolution spatiale.


Avec OTB via QGIS

Dans cet exemple, nous allons calculer les signatures spectrales moyennes d’un raster multi-bandes suite à une classification non supervisée. Une fois les deux rasters chargés dans QGIS, le menu OTB dédié se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Image manipulation ‣  ZonalStatistics. Le menu suivant s’affiche (Fig. 303).
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Fig. 303 Statistiques zonales entre deux rasters avec OTB.



À la ligne Input image nous sélectionnons le raster sur lequel calculer les statistiques. Ce raster peut être multi-bandes. Ici, nous choisissons le stack multi-bandes de l’image Landsat du Caire. À la ligne Type of input for the zone definitions nous choisissons labelimage et nous choisissons le raster contenant les zones (i.e. les classes) à la ligne Input label image. Dans le champ Format of the output stats nous pouvons prendre vector et nous stipulons où sauvegarder le fichier vecteur qui sera produit à la ligne Filename for the output vector data. Le fichier produit sera une vectorisation du raster de classes avec une table attributaire associée qui contiendra les statistiques zonales pour chaque bande spectrale du raster initial. Il est également possible de sélectionner xml à la ligne Format of the output stats. Auquel cas il faut écrire un chemin où stocker le fichier xml produit à la ligne Filename for the output xml data. Un fichier XML contenant les statistiques zonales pour chaque classe et chaque bande du raster initial sera produit et lisible avec un éditeur de texte.


Note

L’ergonomie des sorties fournies par OTB n’est pas très pratique…







Aligner deux rasters

Pour certains traitements, comme le calcul entre plusieurs rasters, il est nécessaire d’aligner des rasters lorsque ceux-ci ne sont pas de la même résolution et donc pas alignés sur une même grille. C’est par exemple le cas lorsque nous calculons certains indices radiométriques faisant appel à des bandes spectrales de différentes résolutions spatiales. Il faudra alors choisir un raster qui servira de référence et aligner le, ou les autres rasters, sur ce raster de référence. Il existe différents outils pour aligner un raster selon un autre raster.


Avertissement

Certains logiciels, comme QGIS, permettent d’emblée de faire des calculs rasters entre rasters de différentes résolutions. Dans ce cas, le logiciel réalise par lui même, de façon cachée, un alignement entre les différents rasters. L’avantage est que l’utilisateur n’a pas à se soucier de cette étape, mais le désavantage est que l’utilisateur n’a pas la main sur l’alignement. Quel raster utilisé comme référence ? Quelle méthode de rééchantillonnage pour l’alignement ? Le logiciel décide sans rien dire…




Avertissement

Un alignement entre deux rasters entraîne obligatoirement un ré-échantillonnage de l’un des rasters. Or la méthode de ré-échantillonnage a son importance. Si nous souhaitons aligner un raster discret (une occupation du sol par exemple) il faut choisir le plus proche voisin, sinon une interpolation linéaire entre les valeurs de classes sera faite, ce qui n’a pas de sens. Par contre, sur un raster continu (comme un MNT ou une bande spectrale) il est possible de choisir une méthode qui interpole.




Aligner deux rasters avec QGIS

Version de QGIS : 3.22.1

Même si QGIS permet de faire des calculs entre rasters de différentes résolutions, il est possible d’aligner des rasters manuellement en choisissant le raster de référence et la méthode de ré-échantillonnage. Pour l’exemple nous allons aligner un raster correspondant à la bande 3 à 10 m d’une image Sentinel-2 sur un raster correspondant à la bande 11 à 20 m.

Une fois les deux rasters chargés dans QGIS, nous allons dans le menu Raster ‣ Aligner les rasters…. Dans le menu qui s’ouvre, nous commençons par choisir les rasters à aligner entre eux en cliquant sur le [image: icone_plus]. La fenêtre suivante s’affiche (Fig. 304).
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Fig. 304 Sélection du premier raster à aligner dans QGIS.



À Couche d'entrée nous choisissons au moins les deux rasters à aligner. Nous pouvons commencer par le raster à aligner, à savoir celui à 10 m nommé S2_B03_10m. À la ligne Nom de du fichier de raster de sortie nous indiquons un chemin et un nom pour le raster qui sera aligné, par exemple S2_B03_10m_resample.tif. Puis nous devons choisir une Méthode de ré-échantillonnage parmi celles proposées dans le menu déroulant. Nous pouvons choisir Bilinéaire dans notre cas. Enfin nous cliquons sur OK. Nous recliquons sur le [image: icone_plus] pour ajouter le second raster, ici S2_B11_20m. Nous indiquons ce raster à la ligne Nom de du fichier de raster de sortie et nous choisissons aussi un nom de sortie et une méthode de ré-échantillonnage pour ce raster. La fenêtre précédente s’est mise à jour comme suit (Fig. 305).
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Fig. 305 Paramétrage de l’alignement des rasters.



Nos deux rasters apparaissent dans le cadre Couches rasters à aligner. Il faut ensuite choisir une Couche de référence, ici S2_B11_20m. Nous pouvons laisser les autres options vides. Si nos deux rasters ne se superposaient pas totalement, nous pourrions régler l’emprise du résultat dans le cadre Découper selon l'emprise actuelle. Enfin nous cliquons sur OK. Bien que deux fichiers rasters ont été générés, celui qui a servi de référence n’est en fait pas modifié.



Aligner deux rasters avec OTB

Version de OTB : 9.0.0

Le logiciel OrfeoToolbox (Orfeo ToolBox) propose un module pour aligner un raster sur un autre. Ce module se nomme Superimpose. Comme tout module de OTB, il est possible de l’utiliser via l’interface graphique QGIS ou via la ligne de commande.


Avec OTB via QGIS

Nous trouvons l’application Superimpose dans la Boîte à outils de traitements ‣ OTB ‣ Geometry ‣ Superimpose. Une fois l’application lancée, la fenêtre suivante apparaît (Fig. 306). Dans l’exemple, nous alignons une bande spectrale Sentinel-2 à 10 m (B3) sur une bande spectrale à 20 m (B11).
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Fig. 306 Aligner deux rasters dans OTB.



À la ligne Reference input nous pointons vers le raster à utiliser comme référence, à savoir ici S2_B11_20m.tiff. À la ligne, The image to reproject nous pointons vers le raster à aligner, ici S2_B03_10m.tiff. Dans le menu déroulant Interpolation, nous choisissons une méthode de rééchantillonnage. Comme nous modifions un raster à valeurs continues, nous pouvons choisir linear ou bco. Si nous avions travaillé avec un raster à valeurs discrètes, comme une occupation du sol, nous aurions choisi nn (Nearest Neighboor). Puis, nous renseignons le chemin et le nom du raster résultat à la ligne Output image. Les autres paramètres peuvent conserver leurs valeurs par défaut. Une fois tout paramétré, il ne reste plus qu’à cliquer sur Exécuter.



Avec la commande otbcli

Il est possible d’exécuter l’application Superimpose via la ligne de commande otbcli. La synataxe est la suivante :

otbcli_Superimpose -inr S2_B11_20m.tiff -inm S2_B03_10m.tiff -interpolator bco -out S2_B03_resample_otbcli.tiff






	Où :
	
	otbcli_Superimpose est l’appel au module Superimpose


	-inr est le mot clef pour spécifier le raster à utiliser comme référence


	-inm est le mot clef pour spécifier le raster à aligner


	-interpolator est le mot clef pour choisir la méthode d’interpolation (bco pour Bicubic interpolation et nn pour Nearest neighbor interpolation)


	-out est le mot clef pour le raster de sortie aligné











Aligner deux rasters avec R

Version de R : 4.2.2

Version de Terra : 1.5.34

À l’aide du package terra de R, il est facile d’aligner un raster sur un autre. Il suffit d’utiliser la fonction resample, comme présenté ci-après, où la bande 3 à 10 m d’une image Sentinel-2 est alignée sur la bande 11 à 20 m.

# chargement de la librairie terra
library(terra)

# chargement du raster qui devra être aligné sur un autre
s2_b3_10m <- terra::rast('S2_B03_10m.tiff')
# chargement du raster sur lequel le premier sera aligné
s2_b11_20m <- terra::rast('S2_B11_20m.tiff')

# alignement de la bande à 10m sur la bande à 20m
b3_20m <- terra::resample(s2_b3_10m, s2_b11_20m)





À la fin de ce code, un nouveau raster de type SpatRaster est créé dans la variable b3_20m. Et ce nouveau raster est identique au premier mais qui a été aligné sur le second.
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Combinaison de rasters et vecteurs

Il est possible de croiser des couches rasters et vecteurs afin d’en tirer une nouvelle information. Les deux formats dialoguent très bien et de nombreux outils permettent de croiser ces deux types de données. Nous en verrons ici quelques un comme les statistiques zonales ou la conversion d’un raster vers un vecteur et vice versa.


Avertissement

Pour tous les outils qui font intervenir une superposition de rasters et de vecteurs, il est vivement conseillé de travailler avec des couches partageant le même système de coordonnées de référence.
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Découper un raster selon une couche vecteur

En plus de découper un raster selon une emprise, il est parfois utile de découper un raster selon un polygone issu d’une couche vecteur. Cette opération de découpe est aussi connu sous le nom de clip. Par exemple si vous travaillez sur un département précis, il peut être intéressant de découper vos rasters (de bandes spectrales, de MNT et autres) selon les contours du département étudié. Cette manipulation permet d’alléger le poids des données et de ne travailler que sur les données précisément contenues dans la zone d’étude.

Cette manipulation est très courante et peut être effectuée avec la plupart des logiciels de géomatique et des langages comme R ou Python.

Dans cet exemple nous allons découper une (puis plusieurs) bande spectrale Landsat 8 selon les contours du département du Val-de-Marne dans l’agglomération parisienne.


Découper un raster avec un vecteur dans QGIS

Version de QGIS : 3.18.3

Nous commençons par charger dans QGIS le raster que nous souhaitons découper ainsi que la couche vecteur du polygone qui nous servira pour découper (Fig. 307). Notons que les deux couches doivent être dans le même SCR.
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Fig. 307 Le raster à découper selon les contours du Val-de-Marne.



Une fois ces couches chargées, nous allons dans le menu Raster ‣ Extraction ‣ Découper un raster selon une couche de masque… Le menu suivant apparaît (Fig. 308).
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Fig. 308 Paramétrage du découpage du raster.



Dans le champ Couche source nous sélectionnons le raster à découper. Dans le champ Couche de masquage, nous indiquons la couche vecteur de type polygone qui doit servir de masque. Les champs SCR peuvent normalement rester vides. Si la couche de découpage est plus petite que le raster à masquer nous laissons cocher le champ Faire coïncider l'emprise du raster découpé avec l'emprise du calque de masque. Grâce à cette option le raster sera redimensionné aux dimensions du masque. Par contre, si la couche de découpage est plus grande que le raster à découper nous décochons cette case sinon le raster sera « agrandi » par l’ajout de pixels en « no data » aux dimensions de la couche de masque. Il peut être judicieux de définir la valeur que prendront les pixels en « no data » c’est-à-dire ceux qui seront en dehors du masque. En effet, par défaut ils seront mis à 0 ce qui n’est pas toujours pertinent. Cette valeur peut, par exemple, être mise à -99 pour vraiment différencier les « no data » du reste. Enfin dans le champ Découpé nous indiquons un chemin pour sauver le raster masqué qui sera créé. Il n’y plus qu’à cliquer sur Exécuter. Le nouveau raster apparaît automatiquement.


Astuce

Si nous découpons un raster multi-bandes, toutes les bandes sont découpées et nous obtenons bien un raster multi-bandes masqué.



Nous pouvons noter que ce processus de découpage dans QGIS n’est en fait (comme souvent dans les prétraitements de rasters) qu’un interfaçage d’une commande GDAL. La commande sous-jacente s’affiche dans le bloc Console GDAL/OGR en bas de la fenêtre précédente (Fig. 308).


Note

Comme pour la fonction Découper, il est possible de découper plusieurs rasters en lot via la fonction Exécuter comme processus de lot se trouvant en bas de la fenêtre du menu.





Découper un raster avec un vecteur dans SCP

Version de QGIS : 3.18.3

Version de SCP : 7.8.21

Le module SCP de QGIS permet également de découper des rasters. Comme à chaque fois que nous travaillons avec ce module, il est nécessaire de commencer par définir un Jeu de bandes de travail. Cela se fait via le menu SCP ‣ Jeu de bandes. Une fois le jeu de bandes défini, le découpage s’effectue en allant dans le menu SCP ‣ Pré-traitement ‣ Découper plusieurs rasters. Le menu suivant s’affiche (Fig. 309).
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Fig. 309 Découper un raster avec SCP.



Dans le champ Sélectionner un jeu de bandes nous sélectionnons le jeu de bandes à découper. Dans le champ Préfixe de sortie nous indiquons un préfixe qui sera donné aux rasters découpées qui seront créés. Nous cochons ensuite la case Utiliser un vecteur de découpe et nous sélectionnons le vecteur à utiliser. Si celui-ci n’apparaît pas dans la liste déroulante il peut être nécessaire de la rafraîchir avec l’icône [image: icone_refresh]. Nous cliquons ensuite sur Lancer. Il nous est demandé de sélectionner un répertoire de sortie et les rasters découpés apparaissent automatiquement.


Avertissement

Les rasters découpés seront créés sous forme de rasters individuels. Même si notre jeu de bandes a été créé avec un raster multi-bandes, les rasters découpés seront tout de même indépendants.



Nous pouvons noter que nous pourrions simplement découper nos rasters selon une emprise sans utiliser de couche de masque. Pour cela nous ne sélectionnons pas l’option Utiliser un vecteur de découpe (Fig. 309) mais nous utilisons l’icône [image: icone_trace] pour tracer une emprise sur la fenêtre principale de QGIS.



Découper un raster avec R

Version de R : 4.8.1

Il est possible de découper un raster chargé dans R selon une couche vecteur. Ici, nous prendrons l’exemple d’une bande spectrale Landsat (LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF) chargé sous forme d’un objet SpatRaster issu du package terra. Cette bande correspond à une scène Landsat prise au-dessus du sud de la France. Nous allons la déocuper selon les limites du département des Bouches-du-Rhône (dep_13_buffer_32631.gpkg). Ces limites sont un polygone que nous chargerons sous forme d’un objet SpatVector. La manipulation s’effectue en deux temps. D’abord nous découpons le raster selon l’emprise de la couche vecteur et ensuite nous masquons ce sous raster selon les limites du polygone présent sur la couche vecteur. Notons que le raster et le vecteur de découpage doivent être dans le même système de coordonnées de référence. La mnipulation est présentée dans les lignes qui suivent.


Avertissement

La fonction mask() de terra prend en entrée un objet SpatRaster et un objet SpatVector. Si le vecteur de découpage est chargé au format sf, il sera nécessaire de le transformer en un objet SpatVector à l’aide de la fonction vect() de terra.



# chargement du raster à découper
b5 <- terra::rast('Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF')

# chargement du polygone vecteur à utiliser pour le découpage
dep13 <- terra::vect('dep_13_buffer_32631.gpkg')

# découpage du raster selon l'emprise du vecteur
b5_emprise_dep13 <- terra::crop(b5, dep13)

# masque de ce sous raster selon le polygone du département 13
b5_dep13 <- terra::mask(b5_emprise_dep13, dep13)

# affichage du résultat
plot(b5_dep13, col=gray.colors(100, start = 0.1, end = 0.9))





Nous obtenons bien la bande spectrale initiale mais masquée selon les contours du département des Bouches-du-Rhône (Fig. 310).
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Fig. 310 Raster masqué selon un polygone avec R.




Note

Dans le cas d’un raster multi-bandes, la procédure est exactement la même.






Statistiques zonales

Cette partie présente la manière de procéder pour calculer des statistiques zonales. Par statistiques zonales nous entendons le fait de calculer des statistiques comme une moyenne, une médiane, un écart-type … à partir d’une couche raster et pour chaque entité d’une couche vecteur de type polygones. Le principe est de récupérer les valeurs de tous les pixels se trouvant sous un polygone et d’en calculer une statistique descriptive comme la moyenne ou autre (Fig. 311).
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Fig. 311 Principe du calcul de statistiques zonales par recouvrement d’une couche raster (en gris) par une couche vecteur de type polygone en vert et de type ligne en rouge.



Sur la figure précédente (Fig. 311), nous pouvons par exemple calculer une statistique zonale pour le polygone vert. Le principe est dans un premier temps de repérer tous les pixels recouverts par le polygone vert lorsque la couche vecteur de polygones est superposée à la couche raster. Puis dans un second temps de calculer la statistique souhaitée sur ces pixels. Cette statistique peut être le maximum, le minimum, la moyenne, la variance, un percentile… Il est également possible, en théorie, de calculer des statistiques zonales selon le même principe mais pour une couche vecteur de type lignes. Dans ce cas aussi, les pixels recouverts par la ligne seront repérés puis une statistique sera calculée sur ces pixels. Notons que les statistiques zonales sous des lignes ne sont pas calculables avec tous les outils.


Note

Les vecteurs de type polygones, et à fortiori de type lignes, ne recouvrent pas tous les pixels à 100 %. En bordure, des pixels se retrouvent recouverts par le polygone en partie seulement. Faut-il alors les compter dans les statistiques zonales ? La question reste entière et il n’est pas toujours simple de savoir ce que fait chaque algorithme selon les outils. Dans la plupart des cas, nous fermons les yeux sur cette question…



Cette manipulation est assez fréquente en SIG. Par exemple, si vous disposez d’un raster de modèle numérique de terrain (MNT) et d’une couche vectorielle présentant des polygones de bassins-versants, grâce à cette manipulation vous pourrez calculer l” altitude moyenne / médiane / maximum … pour chacun de vos bassins.
Dans cet exemple, nous allons calculer l’altitude moyenne pour chaque bassin-versant unitaire du bassin de la Roya [https://fr.wikipedia.org/wiki/Roya] dans les Alpes-Maritimes. Pour effectuer ce calcul, nous disposons du MNT de la Roya (srtm_roya.tif) et d’une couche vecteur de polygones (hydro_bv_roya.gpkg).

Cette manipulation peut s’effectuer avec tous les logiciels de SIG ainsi qu’avec R ou Python.


Statistiques zonales avec QGIS

Version de QGIS : 3.16.1


Avec des polygones

Il faut tout d’abord charger dans QGIS votre MNT et votre couche des bassins-versants. La manipulation s’effectue alors simplement en cherchant le module nommé Statistiques de zone dans la Boîte à outils de traitements de QGIS. À l’ouverture de ce module, la fenêtre de configuration suivante apparaît (Fig. 312).
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Fig. 312 Paramétrage des statistiques zonales dans QGIS.



Dans le champ Couche source, il faut définir la couche vecteur sur laquelle nous voulons calculer les statistiques, à savoir hydro_bv_roya. Dans le champ Couche raster, nous spécifions le raster depuis lequel nous calculons les statistiques, ici srtm_roya. Notons que dans le cas d’un raster multi-bandes, comme une image satellite multispectrale par exemple, nous pouvons choisir la bande à étudier dans le champ Bande raster. Dans le champ Préfixe de la colonne en sortie, nous pouvons mettre alti pour altitude. Le underscore va permettre de nommer le champ résultant alti_moyenne.

Dans le champ Statistiques à calculer, nous cliquons sur l’icône [image: icone_browse] et nous sélectionnons la statistique que nous désirons parmi toutes celles proposées, moyenne dans notre cas. Enfin, dans le champ Statistiques de zone, nous spécifions le chemin d’export de la couche vecteur qui contiendra les statistiques. En effet, une nouvelle couche sera créée, il n’est pas possible de mettre directement à jour la couche. La nouvelle couche apparaît automatiquement et elle contient un nouveau champ nommé alti_mean qui contient l’altitude moyenne de chaque bassin-versant.



Avec des polylignes

Il est possible de calculer des statistiques zonales le long de polylignes dans QGIS en utilisant un outil issu de GRASS GIS. Comme les outils GRASS sont interfacés nativement par QGIS, il n’y a aucune difficulté. Dans l’exemple, nous allons calculer quelques statistiques zonales d’altitude le long du réseau hydrographique du bassin de la Roya (Roya_hydro.gpkg). Nous commençons par charger la couche du réseau hydrographique sous forme de polylignes. Dans le fichier employé, chaque tronçon de rivière compris entre une source et la première confluence ou entre deux confluences est considéré comme une entité. Une fois les couches chargées, nous ouvrons le menu v.rast.stats qui se trouve dans la Boîte à outils de traitements ‣ GRASS ‣ Vector (v.*). La fenêtre suivante s’ouvre (Fig. 313).
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Fig. 313 Statistiques zonales le long de lignes dans QGIS.



À la ligne Name of vector polygon map nous indiquons le nom de la couche de points pour laquelle nous souhaitons les statistiques, à savoir Roya_hydro. Bien qu’il soit mentionné Polygon, il est possible de mettre des lignes en entrée. À la ligne Name of raster map to calculate statistics from, nous indiquons le raster à utiliser pour le calcul des statistiques, à savoir srtm_roya. La ligne Column prefix for new attribute columns est pratique. Il s’agît de définir le préfixe que prendront les colonnes de statistiques, ici hydro. Dans le panneau The methods to use, nous précisons les statistiques à calculer en cliquant sur l’icône [image: icone_browse]. Pour l’exemple nous choisissons la moyenne (average) et l’écart-type (stdev). Enfin, à la ligne Rast stats nous indiquons un chemin et un nom pour la nouvelle couche de type lignes qui contiendra deux nouvelles colonnes dans la table attributaire, une pour les altitudes moyennes et une autre pour l’écart-type des altitudes de chaque tronçon de rivière. Nous pouvons la nommer Roya_hydro_stats_alti.gpkg. Puis nous cliquons sur Exécuter. La nouvelle couche, en tout point identique à la couche de lignes initiale, apparaît. Mais nous y retrouvons bien deux nouvelles colonnes dans la table attributaire.




Statistiques zonales sur raster multi-bandes avec QGIS

Version de QGIS : 3.34.0

Il est possible de calculer des statistiques zonales sur plusieurs rasters à la fois en calculant ces statistiques sur un raster multi-bandes. Ce raster multi-bandes peut être un « vrai » multi-bandes au format .tif ou un bien un raster virtuel au format .vrt.


Note

Ce module ne prend en entrée que des couches vecteurs de type polygones.



Dans cet exemple, nous allons calculer les réflectances moyennes sur 7 bandes spectrales Landsat 8 pour quelques communes du Val-d’Oise.

Cette fonctionnalité nécessite d’installer au préalable une extension supplémentaire nommée Zonal Statistics for Multiband Rasters. Cette extension n’est pas disponible dans les dépôts officiels de QGIS, mais dans un dépôt maintenu par la société Dymaxion labs [https://dymaxionlabs.com/]. Comme indiqué sur la page de documentation du plugin [https://github.com/dymaxionlabs/qgis-zonal-statistics-multiband], il suffit d’aller dans le menu Extensions ‣ Installer/Gérer les extensions ‣ Paramètres. La fenêtre des paramètres des extensions apparaît (Fig. 314).


[image: alternate text]

Fig. 314 Ajout d’un dépôt tierce dans le gestionnaire d’extensions.



Dans ce menu, nous commençons par cocher la case Afficher les extensions expérimentales puis nous cliquons sur Ajouter…. Dans la fenêtre qui apparaît, dans le champ Nom, nous mettons un nom libre, par exemple Dymaxion. Dans le champ URL, nous renseignons l’URL du dépôt https://dymaxionlabs.github.io/qgis-repository/plugins.xml puis nous cliquons sur OK. Sur la fenêtre précédente, il n’y a plus qu’à cliquer sur Recharger tous les dépôts, à retourner dans l’onglet Toutes et à rechercher l’extension Zonal Statistics for Multiband Rasters.


[image: alternate text]

Fig. 315 Installation de l’extension de calcul de statistiques zonales multi-bandes.



Une fois l’extension installée, elle apparaît comme un module dans la Boîte à outils de traitements` sous l’entrée Dymaxion Labs. Nous chargeons ensuite le raster multi-bandes à analyser. Il peut être en .tif ou bien sous la forme d’un raster virtuel. Nous chargeons également la couche des entités polygonales sur lesquelles nous souhaitons calculer les statistiques.

Nous ouvrons cette extension en allant dans la Boîte à outils de traitements ‣ Dymaxion Labs ‣ Raster Analysis ‣ Zonal statistics (multiband). Le menu suivant apparaît (Fig. 316).


[image: alternate text]

Fig. 316 Calcul de statistiques zonales multi-bandes.



Dans le champ Raster layer nous indiquons le raster multi-bandes à analyser, ici L8_stack. Dans le champ Vector layer containing zones, nous sélectionnons la couche vecteur de polygones, ici communes_95_str. Dans le champ Output column prefix nous pouvons spécifier un préfixe pour le nouveau champ qui sera calculé. Comme nous allons calculer la moyenne des réflectances, nous le nommons moy_ . Enfin, dans le champ Statistics to calculate nous sélectionnons une ou plusieurs statistiques à calculer. Ici, nous ne calculons que la moyenne. Nous cliquons ensuite sur Exécuter.

Contrairement à l’outil interne à QGIS, les statistiques sont directement ajoutées à la couche vecteur d’entrée. Si nous ouvrons sa table attributaire, nous remarquons les nouveaux champs calculés à la fin. Ils se nomment moy_b1_mean, moy_b2_mean, etc


Astuce

Ce module peut s’avérer très pratique. Il peut même être pertinent de créer un raster multi-bandes spécialement pour utiliser cette extension. Par exemple, lorsque nous souhaitons calculer des primitives pour classifier des segments suite à une segmentation d’images, cette extension peut nous faire gagner du temps. Nous pouvons également l’utiliser sur un raster mono-bande si nous souhaitons « mettre à jour » une couche vecteur avec les statistiques zonales sans devoir en créer une nouvelle.





Statistiques zonales avec OTB

Version de OTB : 9.0.0

Orfeo ToolBox propose un module de calcul de statistiques zonales. Comme tous les modules OTB, il est utilisable via QGIS ou via la ligne de commende otbcli. Dans l’exemple nous allons calculer l’altitude moyenne de quelques communes localisées dans le bassin-versant de la Roya.


Avertissement

OTB ne permet pas de calculer des statistiques zonales sur autre chose que des polygones.




Avec OTB via QGIS

Le module dédié se nomme ZonalStatistics et se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Image Manipulation ‣ ZonalStatistics. Une fois sélectionné, le menu suivant s’ouvre (Fig. 317).


[image: alternate text]

Fig. 317 Calcul de statistiques zonales avec OTB via Monteverdi.



À la ligne Input Image, nous sélectionnons le raster sur lequel calculer les statistiques, à savoir srtm_roya.tif. Dans le panneau Type of input for the zone definitions, nous spécifions si nos zones sont sous forme de fichier vecteur ou raster. Ici, nous travaillons avec une couche vecteur de type polygones représentant les communes, nous sélectionnons donc vector ; et à la ligne Input vector data nous indiquons où se trouve le fichier vecteur à utiliser. Si jamais le fichier vecteur n’est pas dans le même système de coordonnées de référence que la couche raster d’entrée, nous pouvons la reprojeter à la volée en cochant la case Reproject the input vector. Nous devons ensuite choisir un type de sortie dans le panneau Format of the output stats. Si nous choisissons une sortie en vecteur, nous sélectionnons vector et nous le nommons à la ligne Filename for the output vector data. La sortie peut être en geopackage. Puis nous cliquons sur Execute. Un fichier vecteur en tout point identique au fichier d’entrée est créé. Mais il y a maintenant cinq nouvelles colonnes dans la table attributaire :



	count : le nombre de pixels sous chaque polygone


	mean_0 : la moyenne des pixels sous chaque polygone et dans la première bande du raster d’entrée (qu’une bande ici)


	stdev_0 : l’écart-type des pixels


	min_0 : le minimum des pixels


	max_0 : le maximum des pixels







Il n’y a pas le choix des statistiques calculées avec OTB.


Astuce

Si le raster en entrée est un Raster multi-bandes, les statistiques zonales sont calculées sur toutes les bandes dans le même ordre que dans le raster. Les colonnes de statistiques ont alors un suffixe _0, _1, …



Ce module propose également de sortir le résultat sous forme d’un raster plutôt que d’un vecteur. Le résultat est alors un raster multi-bandes où chaque bande est une statistique et dans le même ordre que présenté dans le cas d’une sortie vecteur. Cette sortie sous forme de raster peut être utile dans le cas où cette sortie sert d’entrée à une classification.



Via la ligne de commande

Le calcul des statistiques zonales est également possible via la ligne de commande otbcli. Pour une documentation détaillée, voire la référence sur le site de OTB [https://www.orfeo-toolbox.org/CookBook/Applications/app_ZonalStatistics.html]. La ligne de commande idoine prend la forme suivante.

otbcli_ZonalStatistics -in srtm_roya.tif -inzone.vector.in roya_communes.gpkg -out.vector.filename roya_communes_alti.gpkg






	Avec :
	
	otbcli_ZonalStatistics : l’appel à la fonction dédiée


	-in srtm_roya.tif : le raster duquel calculer les statistiques à utiliser en entrée


	-inzone.vector.in roya_communes.gpkg : les zones à utiliser, ici sous forme de vecteur


	-out.vector.filename roya_communes_alti.gpkg : le fichier de sortie, ici sous forme de vecteur











Statistiques zonales avec R

Il est possible de calculer des statistiques zonales avec R. Il est nécessaire d’avoir au préalable chargé une couche raster et une couche vecteur avec des librairies dédiées. Dans les exemples ci-dessous, nous allons calculer l’altitude médiane pour quelques communes du bassin-versant de la Roya [https://fr.wikipedia.org/wiki/Roya]. Nous utiliserons le MNT fourni par le SRTM (srtm_roya_L93.tif) et une couche des communes au format geopackage sous forme de polygones (Roya_communes.gpkg).


Avec Terra

Version de R : 4.3.1

Version de terra : 1.7.29

Nous commençons par charger le raster dans un objet SpatRaster et le vecteur dans un objet SpatVector. Si jamais le vecteur est chargé en sf, il suffit de transformer cet objet sf en SpatVector (Format SpatVector de terra). Le calcul proprement dit se fait à l’aide de la fonction extract de terra.

# chargement du raster et du vecteur
mnt_roya <- terra::rast('srtm_roya_L93.tif')
communes_roya <- terra::vect('communes_bv_Roya.gpkg')

# calcul de l'altitude médiane par commune
communes_alti <- terra::extract(mnt_roya, communes_roya, fun=median, bind=TRUE)

# on renomme le champ créé avec un nom explicite
names(communes_alti)[names(communes_alti) == names(mnt_roya)] <- 'Alti_mediane'





Il faut faire attention à deux choses. Tout d’abord, il ne faut pas oublier le mot clef bind=TRUE de la fonction extract, il permet de récupérer le résultat dans un objet SpatVector avec tous les champs initiaux. Sans ça, nous récupérons un simple dataframe duquel les champs initiaux ont disparu. Ensuite, le champ de statistique créé porte par défaut le nom du raster, ici srtm_roya_L93, ce qui n’est pas explicite. C’est pour cette raison, qu’il est bien de le renommer avec la fonction names.





Histogramme zonal

Cette partie présente comment calculer ce que nous appelons un histogramme zonal. Contrairement aux statistiques zonales, il ne s’agira pas de calculer une moyenne ou un maximum d’une couche raster sous un polygone mais de compter le nombre d’occurrences de chaque valeur différente d’une couche raster sous un polygone. Par exemple, sur la figure suivante, nous avons superposé une couche vecteur de polygones de départements à une couche d’occupation du sol de l’Île-de-France (Corine Land Cover). Le calcul d’un histogramme zonal va nous permettre de compter le nombre de pixels de chaque valeur d’occupation du sol sous chaque département. Nous connaîtrons ainsi, par exemple, le nombre de pixels ayant le code 313 (forêt mixte) sous chaque département francilien. Nous pourrons ensuite, si nous le souhaitons, connaître la superficie de chaque occupation du sol en multipliant le nombre de pixels trouvé par la taille du pixel.


[image: alternate text]

Fig. 318 Exemple d’application d’histogramme zonal.



Cette manipulation est très utile, notamment lorsque nous souhaitons rester en mode raster et éviter de convertir des données en vecteur pour calculer des superficies.


Avertissement

Le calcul d’un histogramme zonal doit se faire sur un raster discret, i.e. qui ne contient qu’un nombre limité de valeurs possibles (comme un raster d’occupation du sol par exemple). Si un histogramme zonal est calculé depuis un raster continu comme une bande spectrale, le calcul plantera certainement du fait du trop grand nombre de valeurs différentes rencontrées.




Histogramme zonal avec QGIS

Version de R : 3.24.3

Le calcul d’un histogramme zonal dans QGIS est très simple. Il se fait à l’aide du menu Histogramme zonal qui se trouve dans la Boîte à outils de traitements ‣ Analyse raster ‣ Histogramme zonal. Le menu suivant s’ouvre (Fig. 319).


[image: alternate text]

Fig. 319 Calcul d’un histogramme zonal dans QGIS.



Dans le menu Couche raster, nous spécifions la couche raster à partir de laquelle nous souhaitons calculer l’histogramme, à savoir CLC_2018_IDF.gpkg. Si nous avions affaire à un raster multi-bandes, nous pourrions choisir la bande à traiter via le menu Numéro de bande. Puis, dans le menu Couche vecteur contenant les zones, nous indiquons la couche de polygones à utiliser, ici departements_IDF. Nous pouvons changer le Préfixe de la colonne en sortie par un préfixe explicite, comme CLC_ (pour Corine Land Cover) dans notre cas. Enfin, à la ligne Zones de sortie, nous indiquons un chemin et un nom pour la couche vecteur de polygones qui sera créée.

À la fin de ce calcul, la nouvelle couche s’affiche. Elle est géographiquement identique à la couche de polygones de départ, mais sa table attributaire a été amendée avec le compte de chaque occurrence de pixel (Fig. 320). Dans cette table, nous retrouvons les champs attributaires de la couche initiale plus les nouveaux champs, ici commençant par CLC_, le préfixe que nous avions choisi précédemment. Ainsi, par exemple, pour le département 78, il y a 205 pixels classés en 205.


[image: alternate text]

Fig. 320 Résultat d’un calcul d’histogramme zonal.






Échantillonnage de raster selon des points

Il est possible de superposer une couche vecteur ponctuelle sur une couche raster et de relever les valeurs des pixels recouverts par les points. Ainsi, nous ajoutons dans la table attributaire de la couche de points les valeurs des pixels du raster sous-jacents à chacun des points. Cette manipulation peut se faire selon différents outils. Cette manipulation est aussi connue sous son appellation en anglais Point sampling tool.

Dans les exemples suivants, nous releverons l’altitude à partir d’un MNT pour quelques points superposés à ce MNT (Fig. 321).


[image: alternate text]

Fig. 321 Points d’échantillonnage.




Échantillonnage avec QGIS

Version de QGIS : 3.22.0

Nous commençons par charger dans QGIS le raster à échantillonner et la couche de points pour lesquels nous souhaitons relever les échantillons. Le menu à utiliser se trouve dans la Boîte à outils de traitements ‣ Analyse raster ‣ Prélever des valeurs rasters. Le menu suivant s’ouvre (Fig. 322).


[image: alternate text]

Fig. 322 Échantillonnage d’un raster selon une couche de points dans QGIS.



Dans le menu Couche source nous spécifions la couche de points à utiliser. Nous pouvons, si nous le souhaitons, cocher la case Entité(s) séléectionnée(s) uniquement si nous souhaitons simplement échantillonner certains points précédemment sélectionnés. Dans le menu Couche raster nous indiquons le raster à échantillonner. Nous pouvons personnaliser le Préfixe de la colonne en sortie, ici alti_ par exemple. Enfin, dans le champ Échantillonné nous indiquons un chemin et un nom pour la couche de points qui contiendra les valeurs du raster échantillonné.

Nous obtenons une couche de points identiques à la couche de points initial mais avec un nouveau champ intitulé alti_1 où nous trouvons la valeur du pixel du MNT sous-jacent à chaque point.


Note

Si notre MNT avait été multi-couches, nous aurions obtenu autant de nouveaux champs que de couches dans le raster, nommés alti_1, alti_2, …





Échantillonnage avec R

Version de R : 4.3.1

Version de terra : 1.7.29

Il est possible d’échantillonner un raster selon une couche de points dans R en utilisant la librairie terra et sa fonction extract. Cela se fait simplement comme présenté ci-dessous.

# chargement du raster et du vecteur de points
mnt_roya <- terra::rast('srtm_roya_L93.tif')
points_bv <- terra::vect('points_bv_Roya.gpkg')
# extraction des valeurs
mnt_points <- terra::extract(mnt_roya, points_bv, bind=TRUE)





Nous ajoutons le paramètre bind=TRUE afin de récupérer le résultat sous forme d’un objet SpatVector. Si nous mettons ce paramètre à False, nous obtenons le résultat sous forme d’un simple tableau.




Raster vers vecteur

Il est possible de convertir un raster en un vecteur. C’est une manipulation notamment utilisé pour transformer un raster d’occupation du sol en une couche vecteur sur laquelle il sera possible de calculer des superficies ou de faire des croisements avec d’autres couches géospatiales. C’est également utilisé à la suite de la construction d’un raster binaire mettant en avant un aspect particulier du terrain. La manipulation peut se faire selon différents outils qui peuvent proposer plus ou moins d’options. Dans les exemples suivants nous convertirons un (petit) raster d’occupation du sol.

Seuls certains outils proposent de convertir autre chose que des surfaces, comme des lignes par exemple. C’est le cas de l’outil proposé par GRASS GIS (Cas pour des lignes).


Avertissement

Après une conversion de couche raster en couche vecteur, même si le résultat est visuellement propre, il peut y avoir des erreurs de topologie dans le vecteur résultat. Ces erreurs empêcheront d’effectuer des géotraitements à partir de ce vecteur. Il sera nécessaire de corriger les erreurs générées en port-traitement. Ces corrections peuvent se faire dans QGIS avec l’outil Réparer les géométries.




Raster vers vecteur dans QGIS

Version de QGIS : 3.20.1

Une fois le raster chargé dans QGIS, il est possible de le transformer une couche vecteur. Pour ce faire, nous allons dans le menu Raster ‣ Conversion ‣ Polygoniser (raster vers vecteur)… Le menu dédié s’ouvre (Fig. 323).
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Fig. 323 Conversion d’un raster en vecteur dans QGIS.



Dans la ligne Couche source, nous indiquons le raster à convertir, ici xtr_usol_2011. Nous pouvons choisir la bande à convertir dans le menu déroulant Numéro de bande, mais ici nous n’avons qu’une bande dans notre raster. Nous indiquons le nom du champ qui sera créé et qui contiendra les valeurs des pixels à la ligne Nom du champ à créer, nous pouvons indiquer usol. La case Use 8-connectedness permet de regrouper dans un même polygone deux entités qui ne se toucheraient que par un coin. Si cette case est décochée, deux entités se touchant par un coin seront considérées comme distinctes. Enfin, dans la ligne Vectorisé nous indiquons un chemin et un nom pour le fichier vecteur qui sera créé. Notons que ce menu est en fait un simple interface d’une commande GDAL comme nous pouvons le voir dans le panneau Console GDAL/OGR. Nous cliquons sur Exécuter pour lancer la conversion. Nous obtenons bien un fichier vecteur de type polygones (Fig. 324 B) possédant une table attributaire associée.


[image: alternate text]

Fig. 324 Le raster initial (A) et le résultat de la conversion en vecteur (B).




Note

Nous constatons qu’avec ce menu il n’est possible d’obtenir que des vecteurs de type polygones (i.e. surfacique), il n’est pas possible de vectoriser des lignes comme un réseau hydrographique par exemple.





Raster vers vecteur avec SCP

Version de QGIS : 3.20.1

Version de SCP : 7.9.5

Le module SCP de QGIS (Module SCP dans QGIS) propose lui aussi un menu de conversion de raster vers vecteur. Une fois le raster chargé dans QGIS, nous allons dans le menu SCP ‣ Post-traitement ‣ Classification vers vecteur. Le menu s’ouvre (Fig. 325). Dans le panneau Clasification vers vecteur, nous sélectionnons le raster à convertir. Si besoin nous rafraîchissons la liste à l’aide de l’icône dédiée [image: icone_actualiser]. Si le raster à convertir est issu d’une classification réalisé avec SCP nous pouvons récupérer directement son style en cochant la case Utiliser les codes de la liste des signatures. Nous cliquons ensuite sur Lancer.


[image: alternate text]

Fig. 325 Conversion d’un raster en vecteur avec SCP.



Nous constatons que le fichier vecteur créé est découpé en bandes horizontales. C’est un artefact utilisé par ce module pour accélérer le traitement. Il suffit de regrouper les polygones par classe d’occupation du sol pour s’affranchir à postériori de cet artefact.



Raster vers vecteur avec GRASS GIS dans QGIS

Version de QGIS : 3.20.1

Le logiciel GRASS GIS (GRASS GIS) propose un module de transformation de raster vers vecteur. Comme GRASS GIS est interfacé en natif par QGIS, ce module est utilisable directement depuis QGIS. Une fois le raster chargé, nous sélectionnons le menu r.to.vect dans la Boîte à outils de traitements ‣ GRASS ‣ Raster ‣ r.to.vect. Le menu GRASS apparaît (Fig. 326).


Cas pour des polygones


[image: alternate text]

Fig. 326 Conversion d’un raster en vecteur avec GRASS GIS dans QGIS.



À la ligne Couche raster en entrée nous indiquons le raster à convertir, ici xtr_usol_2011. Dans le menu Type d'entités nous spécifions que nous allons convertir des surfaces (i.e. des polygones) en sélectionnant area. Dans le champ Nom de la colonne d'attribut nous pouvons indiquer le nom que prendra le champ qui contiendra les valeurs prises du raster, usol par exemple. Nous pouvons laisser les cases suivantes décochées. Enfin, dans Vectorisé, nous indiquons un chemin et un nom pour le raster qui sera créé. Puis nous cliquons sur Exécuter. Le fichier converti apparaît automatiquement. Plusieurs champs sont créés, mais seul le champ que nous avons baptisé usol nous importe. Les autres champs peuvent être supprimés.



Cas pour des lignes

Un aspect intéressant de cet outil de GRASS GIS est qu’il permet de vectoriser des lignes. C’est tout à fait intéressant dans le cas où nous avons un raster présentant un réseau hydrographique, par exemple issu d’une extraction automatique de réseau hydrographique à partir d’un modèle numérique de terrain. Le point délicat d’une telle conversion de lignes est que le raster de départ doit rigoureusement représenter des lignes. C’est-à-dire que chaque pixel doit toucher au plus deux pixels (et pas un de plus). Heureusement, GRASS propose également un outil qui permet d’amincir un raster de lignes nommé r.thin. Ainsi, la conversion d’un raster de lignes va se faire en deux temps. D’abord, l’amincissement avec r.thin puis la conversions proprement dite avec r.to.vect. Dans l’exemple, nous allons convertir en vecteur le réseau hydrographique de la région de la Roya [https://fr.wikipedia.org/wiki/Roya] que nous avons en raster. Nous commençons par charger ce raster dans QGIS puis nous ouvrons le menu r.thin via la Boîte à outils de traitements ‣ GRASS ‣ Raster ‣ r.to.thin. Le menu suivant apparaît (Fig. 327).


[image: alternate text]

Fig. 327 Amincissement d’un raster de lignes avec GRASS GIS dans QGIS.



Dans le menu Input raster layer to thin nous sélectionnons le raster à amincir hydro_Roya. Le Nombre maximum d'itérations doit être d’autant plus élevé que le raster a besoin d’être aminci, la valeur de 200 peut être laissée par défaut. Enfin, à la ligne Aminci, nous indiquons le chemin et le nom du raster aminci qui sera créé. Il ne reste plus qu’à cliquer sur Exécuter. Le raster résultat est très similaire au raster initial, seuls quelques pixels ont été enlevés (Fig. 328).


[image: alternate text]

Fig. 328 Raster initial (A) et raster après amincissement (B).



Nous constatons sur la figure précédente (Fig. 328) que le pixel en rouge du raster initial touchait 3 autres pixels. Il a donc été enlevé par la procédure d’amincissement, ainsi chaque pixel ne touche au plus que 2 pixels. Nous pouvons maintenant lancer la procédure de conversion en vecteur en lançant le menu r.to.vect (Fig. 329).
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Fig. 329 Conversion d’un raster de lignes en vecteur avec GRASS GIS dans QGIS.



Dans le menu Couche raster en entrée nous indiquons le raster aminci, ici hydro_thin. Dans Type d'entités nous précisons qu’il s’agît de lignes (line). Nous donnons éventuellement un nom pour le champ qui contiendra les valeurs du raster dans le menu Nom de la colonne d'attribut et enfin dans Vectorisé, nous précisons un chemin et un nom pour le fichier vecteur de type lignes qui sera créé. Pour finir nous cliquons sur Exécuter. Nous avons bien un vecteur de type lignes qui apparaît.




Raster vers vecteur avec GDAL

Il est possible de faire une conversion de raster en vecteur avec GDAL en ligne de commande. Cette procédure est rapide et peut être intéressante dans une optique d’automatisation. Il est juste nécessaire de faire attention à la syntaxe qui est somme toute assez simple. Il faut, dans une console, se placer dans le répertoire qui contient le raster à convertir et entrer la commande suivante :

gdal_polygonize.py xtr_usol_2011.tif -f "GPKG"  xtr_usol_2011_gdal.gpkg usol_2011 classe





avec les éléments suivants :


	gdal_polygonize.py : le nom de la commande GDAL à utiliser


	xtr_usol_2011.tif : le nom du raster à convertir


	-f « GPKG » : le format de la couche vecteur à créer. Mettre « SHP » pour créer un shapefile.


	xtr_usol_2011_gdal.gpkg : le nom du fichier vecteur qui sera créé


	usol_2011 : le nom de la couche qui sera créé dans le geopackage. Cette option n’est possible que pour les formats vecteur proposant de stocker plusieurs couches (comme le geopackage).


	classe : le nom du champ qui contiendra les valeurs du raster





Note

Si nous ne nous plaçons pas dans le répertoire qui contient le raster à convertir, nous devons pointer explicitement sur ce raster en inscrivant son chemin dans la ligne de commande, par exemple C:\Test\Truc\mon_raster.tif sous Windows ou /home/SIG/truc/mon_raster.tif sous Linux. Faire de même pour l’export du vecteur si désiré.





Raster vers vecteur avec OTB

Version de OTB : 9.0.0

Orfeo ToolBox propose un module permettant de transformer un raster vers un vecteur, accessible via QGIS ou en ligne de commandes otbcli. Nous allons vectoriser un extrait d’un raster d’occupation du sol sur la ville du Caire.


Note

OTB ne vectorise que vers un vecteur de type polygones.




Avec OTB via QGIS

Le module dédié se nomme LSMSVectorization et se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Segmentation ‣ Vectorization. Une fois le module lancé, la fenêtre suivante s’affiche (Fig. 330).
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Fig. 330 Vectorisation d’un raster en vecteur avec OTB.



À la ligne Input Image, nous renseignons le raster à vectoriser, ici xtr_usol_2011. La ligne Segmented image reprend le raster initial. À la ligne Output GIS vector file nous renseignons le chemin et le nom du fichier vecteur résultat en .shp.


Avertissement

L’export ne peut se faire qu’en shapefile, en précisant .shp après le nom du fichier vecteur à exporter.



Nous cliquons enfin sur Exécuter.




Raster vers vecteur avec R

Version de R : 4.8.1

Il est possible de convertir un raster vers un vecteur en utilisant R. La méthode à employer sera différente selon le package raster employé. Dans cet exemple, nous travaillerons sur un objet SpatRaster chargé via terra. Le raster chargé est un MNT du bassin de la Roya issu de la mission SRTM. À partir de ce MNT, nous allons extraire les pixels dont l’altitude est supérieure à 1500 m en appliquant un seuil, puis nous transformerons le résultat de ce raster binaire en une couche vecteur. Cette transformation d’un raster en un vecteur se fait via la fonction terra nommée as.polygons(). Il suffit de changer le mot clé polygons par lines ou points si il s’agît de vectoriser des lignes ou des points respectivement. Le code suivant présente la marche à suivre.

# chargement du raster de MNT
mnt_roya <- terra::rast("srtm_roya_L93.tif")

# application du seuil pour extraire les pixels d'altitude supérieures à 1500 m
mnt_roya_1500 <- mnt_roya > 1500

# vectorisation du raster binaire obtenu
seuil_1500_vect <- as.polygons(mnt_roya_1500, extent=FALSE)





Nous obtenons un vecteur de type polygone stocké en format SpatVector.




Découper un raster selon une grille

Lorsque nous disposons d’un raster assez lourd à manipuler il peut être intéressant de le découper en dalles plus petites qui seront plus faciles à manipuler par la suite. Dans les exemples ci-après, nous allons découper une scène Landsat 8 prise au dessus de Shangai selon une grille composée de 25 carreaux (Fig. 331). À l’issue du traitement, nous disposerons ainsi de 25 dalles rasters correspondant exactement à notre image Landsat initiale par assemblage.
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Fig. 331 Image Landsat 8 à découper selon la grille rouge.




Découper un raster selon une grille dans QGIS

Version de QGIS : 3.24.3

Dans QGIS il n’existe pas (à ma connaissance) d’outils permettant de faire cette manipulation en une seule fois de façon directe. L’astuce est de procéder en trois étapes :


	création d’une grille de polygones


	séparation de chacun des carreaux de la grille dans une couche indépendante


	découpage du raster initial par chacun des carreaux




La première étape se fait en suivant les explications fournies dans la partie dédiée à la construction de grilles (Création de grilles dans QGIS). La deuxième étape se fait également en suivant les explications fournies dans la partie qui traite de la séparation d’une couche vecteur (Séparer une couche vecteur dans QGIS). La troisième partie est expliquée dans les lignes qui suivent.

L’idée est maintenant de découper notre raster selon les différents carreaux constitutifs de notre grille qui sont maintenant individualisés (Fig. 332).
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Fig. 332 Grille de découpage individualisée carreau par carreau.



Il serait fastidieux de répéter manuellement la manipulation de découpage du raster carreau par carreau. Nous utiliserons donc la possibilité de lancer des processus par lot offerte par QGIS. Pour cela nous ouvrons le menu de découpage d’un raster par un vecteur en allant dans le menu Raster ‣ Extraction ‣ Découper un raster selon une couche de masque… Et au lieu de directement paramétrer la fenêtre qui s’ouvre, nous cliquons sur Exécuter comme processus de lot… en bas de la fenêtre. Une grande fenêtre s’ouvre alors. Dans cet interface, chaque ligne correspondra à un processus à traiter ligne par ligne.

Seulement trois colonnes devront être renseignées : la première nommée Couche source, la deuxième nommée Couche de masque et la dernière nommée Découpé (masque). Nous allons commencer par renseigner la deuxième colonne qui renseignera tous nos carreaux à utiliser. Pour tout renseigner en une seule fois, dans cette colonne Couche de masque, nous cliquons sur Auto-remplissage... et dans le menu qui apparaît nous choisissons l’entrée Sélectionner à partir des couches chargées.... Dans le menu qui apparaît nous sélectionnons les couches correspondant à tous les carreaux (Fig. 333).
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Fig. 333 Sélection des carreaux de découpage.



Astuce

Il peut être plus rapide de choisir Sélectionner tout et d’enlever les couches à ne pas utiliser plutôt que de cliquer sur chacune des couches à utiliser.







Une fois les couches choisies il suffit de cliquer sur OK. Autant de lignes que de couches sélectionnées sont créées dans le menu du processus de lot. Nous pouvons maintenant spécifier quel raster nous souhaitons découper, dans la colonne Couche source. Le même raster apparaîtra à chaque ligne puisque c’est bien un seul raster que nous souhaitons découper selon plusieurs carreaux. Dans le menu déroulant de la première ligne, dans la colonne Couche source nous choisissons le raster à découper, à savoir ici L8_Shangai_B5. Afin de le répéter sur toutes les lignes, il suffit de cliquer sur la zone Auto-remplissage... de cette colonne et de choisir l’entrée Remplir. Le même raster d’entrée est alors spécifié pour toutes les lignes (Fig. 334).
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Fig. 334 Remplissage des colonnes Couche source et couche de masque.



Maintenant nous devons régler la dernière colonne Découpé (masque) qui spécifiera le nom et le chemin des dalles créées. Dans cette colonne, à la première ligne, nous cliquons sur l’icône [image: icone_browse] et nous indiquons un répertoire dans lequel nous sauverons les dalles ainsi que le nom générique de chaque dalle, par exemple dalle_ (avec un tiret bas à la fin). Lorsque nous cliquons sur Enregistrer, une fenêtre nous demande si nous souhaitons compléter le nom générique de chaque dalle avec un paramètre permettant son identification individuelle (Fig. 335).
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Fig. 335 Remplissage d’un paramètre automatique pour nommer les dalles produites.



Dans le menu Mode de remplissage automatique nous pouvons sélectionner Remplir avec les valeurs du paramètre et dans le menu Paramètre à utiliser nous pouvons choisir Couche de masque. Ainsi, le morceau de raster découpé avec le carreau nommé id_01 sera nommée dalle_id_01 et ainsi de suite. En cliquant sur OK, chaque ligne de cette colonne est maintenant renseignée comme il faut (Fig. 336).
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Fig. 336 Remplissage de la colonne d’export.



Il n’y a plus qu’à cliquer sur Exécuter pour lancer le processus. Si nous avons coché la case Charger les couches dans le menu de processus de lot, toutes les dalles sont chargées. Sinon il suffit de les charger depuis le répertoire où elles ont été créées. Nous avons bien maintenant autant de dalles rasters que de carreaux dans la grille initiale (Fig. 337).
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Fig. 337 Dalles rasters correspondant aux carreaux de la grille de découpage.
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Outils de télédétection

Dans cette partie, nous verrons quelques outils utiles à appliquer (si besoin) avant une étude de télédétection. Nous détaillerons par exemple la construction de compositions colorées ou le principe du pansharpening.
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Astuce

Concernant les corrections radiométriques et atmosphériques, il est possible de télécharger facilement les images déjà fournies en réflectance de surface (niveau L2) sur les différents poratils de téléchargement (Télécharger des images satellites). Il ne faut pas hésiter à récupérer ces données pour nous éviter ces corrections.




Les compositions colorées en télédétection

Dans cette section nous allons découvrir les principes théoriques de ce que nous appelons compositions colorées en télédétection. Le principe peut être appliquée à des images optiques ou radars. Les compositions colorées sont une manipulation basiques dans un projet faisant intervenir un traitement d’images satellites. Cette manipulation permet d’avoir un premier aperçu de sa zone d’étude et de ses caractéristiques.

La plupart des logiciels de géomatique permettent de construire concrètement ce genre de compositions. Pour des exemples pratiques, reportez vous à la section dédiée.


Les fondements : la synthèse additive des couleurs

En ce qui concerne la synthèse des couleurs, il faut différencier la synthèse additive de la synthèse soustractive. La seconde est celle que nous découvrons en premier dans les petites classes. Elle repose sur trois couleurs primaires à base de pigments que nous mélangeons afin d’obtenir toutes les couleurs possibles. Ce n’est pas celle-ci que nous utilisons en télédétection. Nous utilisons la synthèse additive, basée sur les propriétés électromagnétiques (lumineuses) des couleurs. Cette synthèse repose également sur trois couleurs primaires, aussi appelées couleurs fondamentales.

Ces trois couleurs sont le rouge, le vert et le bleu. C’est pourquoi le terme de RVB ou RGB (pour Red, Green, Blue) est couramment utilisé. À partir du mélange des ces trois couleurs, en jouant sur les proportions, il est possible de retrouver toutes les couleurs existantes. Le mélange du bleu et du rouge donne du magenta, celui du bleu et du vert donne du cyan et celui du vert et du rouge donne du jaune. Enfin le mélange du bleu, du rouge et du vert en même temps donne du blanc. Alors qu’une absence totale de ces trois couleurs donne du noir (Fig. 338). Au final, en jouant sur les proportions des mélanges, il est possible d’obtenir toute la gamme de couleurs. Cette synthèse additive est également employée par tous les écrans.
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Fig. 338 Le principe de la synthèse additive des couleurs.




Note

Vous avez sûrement déjà entendu un ami parfois agaçant vous dire « le blanc et le noir ce ne sont pas des couleurs car c’est un mélange de tout (dans le premier cas) et une absence de tout (dans le second cas) ! » Certes, mais à ce compte, le jaune n’est pas non plus une couleur puisqu’il résulte lui aussi d’un mélange. Au final, seul le bleu, le vert et le rouge seraient des couleurs ? La définition d’une couleur est finalement plus compliquée qu’attendue et nous ne nous y attarderons pas.





Application à la télédétection optique

En télédétection optique, ce principe est appliqué à la combinaison de bandes spectrales. Chaque bande spectrale est codée sous forme d’une image raster composée de pixels. À chaque pixel est associée une mesure de luminance qui équivaut à l’intensité de l’énergie réfléchie par le pixel sous-jacent dans la bande spectrale donnée. Plus cette intensité est faible, plus la valeur du pixel tend vers 0. Plus l’intensité est élevée, plus la valeur du pixel est élevée. La borne supérieure dépend de l’encodage de l’image. Une fois les luminances converties en réflectance, ces valeurs s’échelonnent entre 0 et 1. Un pixel qui ne réfléchit rien aura une valeur de 0 et un pixel qui réfléchit tout aura une valeur de 1.

D’un point de vue visuel, ces valeurs sont traduites par des teintes de gris. Un pixel qui ne réfléchit rien, donc qui tend vers 0, apparaîtra noir. À l’autre extrémité, un pixel qui réfléchit tout, donc qui tend vers 1, apparaîtra blanc. Pour les valeurs intermédiaires, nous retrouverons toutes les gammes de gris imaginables. C’est pourquoi, lorsque nous chargeons une bande spectrale isolée dans un logiciel SIG, le raster apparaît en teintes de gris (Fig. 339).
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Fig. 339 Bande 5 d’une scène OLI (Landsat 8) au dessus de Paris en teintes de gris.



Sur la figure (Fig. 339), nous constatons que les pixels correspondant aux bois de Vincennes et de Boulogne apparaissent très clairs. Nous en déduisons que ces pixels réfléchissent beaucoup dans la bande 5 de OLI qui correspond au proche infrarouge. Au contraire, les surfaces bâties du centre de l’agglomération apparaissent très sombres. Les pixels de ces zones réfléchissent donc peu dans ce domaine du proche infrarouge.

L’idée est de combiner trois bandes spectrales en les transformant chacune dans une teinte de rouge, de vert et de bleu. Par exemple, la figure (Fig. 340) présente la même bande spectrale que sur la figure (Fig. 339) mais codée en teintes de rouge plutôt qu’en teintes de gris. Le point délicat est de bien comprendre que les zones qui apparaissent très claires sur la figure (Fig. 339) correspondent à celles qui apparaissent très rouges sur la figure (Fig. 340). Au contraire, les zones très sombres de la figure (Fig. 339) apparaissent très claires sur la figure (Fig. 340). L’explication est simple et logique. Un pixel avec une forte réflectance a une valeur élevée, il va donc être codé avec beaucoup de blanc dans le cas de la figure (Fig. 339) mais avec beaucoup de rouge dans le cas de la figure (Fig. 340). Au contraire, un pixel qui réfléchit peu va être codé avec peu de blanc, donc presque noir, dans le cas de la figure (Fig. 339) et peu de rouge, donc presque blanc, dans le cas de la figure (Fig. 340).
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Fig. 340 Bande 5 d’une scène OLI (Landsat 8) au dessus de Paris en teintes de rouge.



Les trois bandes spectrales choisies pour la composition colorée doivent être « colorées » de la même manière, la première en bleu, la deuxième en vert et la troisième en rouge. Par convention, l’ordre des couleurs et des bandes doit être respectée. La plus « petite » bande sera codée en bleu et la plus « grande » en rouge. Une fois ces colorations effectuées, les trois bandes « colorées » sont « mélangées » afin d’obtenir une vue de la même scène mais en couleurs (figure Fig. 341). Notez bien que la « coloration » en bleu, vert et rouge des bandes ainsi que le « mélange » se fait de façon automatique par le logiciel.
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Fig. 341 Composition colorée assemblant les bandes OLI 5, 3 et 2.





Interprétation d’une composition colorée

L’interprétation des compositions colorées n’est pas compliquée mais demande d’acquérir une certaine gymnastique. Nous allons nous entraîner en interprétant la composition résultante de la figure Fig. 341, présentée en plus grand format sur la figure Fig. 342.


[image: alternate text]

Fig. 342 Composition colorée issue du traitement effectuée sur la figure Fig. 341.



Sur cette composition colorée, nous voyons tout d’abord des zones qui apparaissent en rouge plus ou moins foncé. Ces zones correspondent donc à des pixels avec beaucoup de rouge et très peu de vert et de bleu. Comme nous avons codé la bande 5 en rouge, la bande 3 en vert et la bande 2 en bleu, ça signifie que ces zones réfléchissent beaucoup dans la bande 5 et très peu dans les autres. Or la bande 5 correspond au proche infrarouge du capteur OLI, la bande trois au vert et la bande 2 au bleu. Ainsi, les zones rouges réfléchissent préférentiellement dans le proche infrarouge et peu dans le vert et le bleu. En s’appuyant sur les signatures spectrales connues, nous pouvons constater que ce comportement est typique des zones en végétation. En effet, nous reconnaissons bien en rouge les bois de Vincennes, de Boulogne ainsi que les forêts de grande couronne francilienne.

En suivant la même logique, la Seine et ses affluents, ainsi que les lacs apparaissent en bleu sombre. Ces zones réfléchissent en effet peu dans les trois bandes spectrales choisies mais tout de même un peu plus dans la bande 2 qui correspond au domaine du bleu. Ce comportement est également en cohérence avec la signature spectrale de l’eau.

Les zones bâties apparaissent plus ou moins cyan. Elles correspondent à un mélange de bleu et de vert mais pas de rouge. Ce sont donc des zones qui réfléchissent préférentiellement dans les domaines du bleu et du vert par rapport à celui du proche infrarouge. Nous retrouvons bien la signature spectrale des surfaces bâties.

Enfin, en zoomant, nous constatons qu’une portion du jardin des Tuileries apparaît très claire, presque blanche. Cette clarté signifie que cette zone réfléchit intensément dans les trois bandes choisies, à savoir le proche infrarouge, le bleu et le vert. Selon les signatures spectrales, ce comportement est typique soit de la neige, ce qui n’est bien sûr pas le cas ici, soit d’un sol nu très clair. Le revêtement des allées de ce jardin est en effet de couleur très clair.


Astuce

Il est tout à fait possible, et parfois très intéressant, de faire des compositions colorées multi-dates. Par exemple, imaginons qu’avec une série d’images Landsat 8 nous calculions un NDVI pour un mois hivernal, un mois printanier et un mois estival. Il est ensuite possible de colorer le NDVI hivernal en rouge, le NDVI printanier en vert et le NDVI estival en bleu. Les zones bleu de la composition résultante correspondra alors aux zones végétalisées en été mais non végétalisées en hiver et au printemps.





Composition colorée avec QGIS

Version de QGIS : 3.26.1

Nous allons voir dans cette partie comment réaliser une composition colorée avec QGIS. Cela se fait très simplement à partir d’un raster multi-bandes. La construction d’un raster multi-bandes est décrite dans la partie dédiée : Raster multi-bandes. La plupart du temps nous réalisons une composition colorée selon différentes bandes spectrales d’une même image satellite. Mais rien n’empêche de réaliser une composition colorée à partir d’autres rasters comme des NDVI calculés sur une même zone mais à des dates différentes.


Astuce

Il sera plus facile de créer des compositions colorées si le raster multi-bandes a été construit en nommant explicitement les différentes bandes comme décrit ici : Raster multi-bandes en dur (avec noms).



Ici nous nous contenterons de réaliser une composition colorée en vraies couleurs et une en fausses couleurs mettant en avant la végétation à partir d’une image Sentinel-2 de la région parisienne prise le 24 juin 2020. Une fois le raster multi-bandes (qui peut être un raster virtuel) chargé dans QGIS, nous faisons un clic droit sur cette couche dans le panneau des couches puis nous sélectionnons Propriétés ‣ Symbologie. La fenêtre de réglage de la symbologie apparaît (Fig. 343).
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Fig. 343 Création d’une composition colorée avec QGIS.



Nous commençons par construire une composition colorée en vraies couleurs. Nous colorons donc la bande du domaine du Bleu (bande 2) en bleu, celle du domaine du Vert (bande 3) en vert et celle du domaine du Rouge (bande 4) en rouge. Si besoin, reportez vous à la section présentant les bandes de Sentinel-2 pour revoir les équivalences (Les images Sentinel-2). Ainsi, pour la Bande rouge nous choisissons la Bande 04, pour la Bande verte la Bande 03 et pour la Bande bleue la Bande 02. Il n’y a plus qu’à cliquer sur OK et la composition colorée apparaît (Fig. 344 A).


Avertissement

Il faut être très prudent lorsque nous choisissons nos bandes si les bandes n’ont pas été nommées. Le numéro des bandes qui apparaît dans ce menu n’est que le numéro d’ordre de la bande dans le raster multi-bande, en aucun cas le numéro de bande de l’image de base. Si votre raster multi-bandes contient les bandes 2, 3 et 4 de votre image Sentinel-2, alors la bande 2 de Sentinel sera vue comme étant la bande 1 du raster multi-bandes et ainsi de suite.



Pour réaliser une composition colorée en fausses couleurs mettant en avant la végétation nous procédons de même mais mettons cette fois-ci pour la Bande rouge la bande du proche infrarouge soit la bande 08. Les autres bandes restent inchangées : Bande bleue avec la bande 02 et Bande verte avec la bande 03 (Fig. 344 B).
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Fig. 344 Composition colorée vraies couleurs 4-3-2 (A) et fausses couleurs 8-3-2 (B) d’une image Sentinel-2.




Astuce

Les réglages des contrastes peuvent se faire au niveau du menu de symbologie de la couche mais le plus simple est d’utiliser à posteriori l’outil d’amélioration des contrastes disponible dans la barre d’outils raster sous l’icône Histogramme cumulatif de l'emprise locale [image: icone-raster-contraste].





Composition colorée avec R

Version de R : 4.2.1

Il est possible de créer des compositions colorées dans R. Il est nécessaire de charger au préalable un raster multi-bandes ou bien d’en créer un (Création d’un raster multi-bandes avec R). Dans l’exemple suivant nous travaillons sur des objets SpatRaster chargés via le package terra. Nous commençons par charger un raster geoTIFF qui est déjà multi-bandes, composé des quatre premières bandes spectrales d’une image Landsat 8 OLI prise au-dessus des Bouches-du-Rhône. La composition colorée se fait alors via la fonction plotRGB. Le tout est résumé dans les lignes suivantes.

# chargement de la librairie terra
library(terra)

# chargement du raster multi-bandes
stack_Landsat <- terra::rast("stack.tif")

# création de la compostion colorée fausses couleurs
plotRGB(stack_Landsat, r=4, g=2, b=1, stretch='hist')





Dans la fonction plotRGB, nous indiquons les bandes à colorer en Rouge, Vert et Bleu via les clés r=, g= et b= suivies des numéros de bandes à colorer. Ces numéros de bandes correspondent simplement à l’ordre d’empilement dans le raster multi-bandes. Nous indiquons également stretch='hist' afin d’améliorer les contrastes. Plus d’options sont possibles comme indiqué sur la page terra dédiée [https://rspatial.github.io/terra/reference/plotRGB.html]. Au final, nous obtenons la figure suivante (Fig. 345).


[image: alternate text]

Fig. 345 Composition colorée avec R.






Correction radiométrique

Lorsque nous récupérons une image satellite dont les pixels représentent des niveaux d’énergie, souvent des images en niveau L1, il est nécessaire d’y appliquer au moins une correction radiométrique afin d’obtenir une image en Réflectance en haut de l’atmosphère (Reflectance Top Of Atmosphere (TOA)). Cette correction est nécessaire pour toutes les images Landsat en niveau L1, se reporter à la section consacrée aux niveaux de traitements pour les détails : Niveaux de traitements. Cette correction peut se faire avec différents outils dont certains sont présentés ici.

Nous appliquerons cette correction sur une image Landsat OLI du 2 avril 2021 prise au-dessus de la commune de Mbandjock [https://www.openstreetmap.org/?mlat=4.4463888888889&mlon=11.905277777778&zoom=10#map=10/4.4464/11.9053], située dans la Haute-Sanaga au centre du Cameroun.


Correction radiométrique dans QGIS avec SCP

Version de QGIS : 3.20.1

Version de SCP : 7.9.5

Le module SCP de QGIS permet d’appliquer cette correction facilement. Le plus sûr est d’appliquer cette correction sur toutes les bandes et l’intégralité de la scène, puis de supprimer à posteriori les bandes corrigées qui ne nous intéressent pas et de découper ou masquer celles que nous garderons.

Une fois QGIS lancé, nous allons dans le menu SCP ‣ Pré-traitement ‣ Landsat. La fenêtre suivante apparaît (Fig. 346).
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Fig. 346 Correction radiométrique d’une image Landsat avec SCP.



Sur la ligne Dossier contenant les bandes Landsat nous pointons vers le répertoire qui contient les bandes Landsat. Ce répertoire doit être exactement celui qui a été téléchargé avec les mêmes fichiers et la même structure. Sur la ligne Sélectionner le fichier MTL nous pointons vers le fichier texte de métadonnées qui se trouve dans le répertoire des images. Ce fichier texte se termine par _MTL.txt. C’est dans ce fichier que se trouve les paramètres nécessaires à la correction radiométrique comme la distance entre la Terre et le Soleil, l’élévation du Soleil par rapport à l’horizon ou l’angle de vue du satellite.

Comme la structure du fichier est normalisée, SCP comprend de lui même quel raster correspond à quelle bande et quelles corrections administrées. Ces informations sont récapitulées dans le tableau sous la ligne Métadonnée. Il suffit ensuite de lancer le processus en cliquant sur Lancer. Il nous est alors demandé de sélectionner un répertoire dans lequel les bandes spectrales corrigées apparaîtront, les rasters résultants s’affichent automatiquement dans QGIS. Les rasters corrigés portent le même nom que les rasters initiaux mais sont précédés du préfixe RT_.


Note

La bande panchromatique (Bande 8 de Landsat 8) ainsi que la bande 9 correspondant aux cirrus ne sont pas corrigées.



Après correction, nous constatons que les pixels ont bien des valeurs comprises entre 0 et 1. Cette valeur est maintenant une réflectance en haut de l’atmosphère (TOA).


Note

Il est rare de travailler sur une scène Landsat entière et sur toutes les bandes spectrales. L’utilisateur doit maintenant supprimer manuellement les bandes qui ne serviront pas et découper, masquer ou mosaïquer celles d’intérêt, voir la section dédiée aux outils rasters : Outils raster.






Correction atmosphérique

Lorsque nous disposons d’une image en réflectance en haut de l’atmosphère (TOA), il peut être utile de la convertir en réflectance de surface. Cette étape est notamment indispensable dans le cas d’un suivi dans le temps d’une même région. En effet, grâce à cette correction nous serons sûrs que les changements observés dans le temps représentent des changements de surface et non pas de conditions atmosphériques. Cette correction atmosphérique peut se faire via différents outils.

La correction atmosphérique peut être réalisée selon un modèle physique ou empirique. Seule l’utilisation du modèle empirique sera présentée ici. Ce modèle est nommé DOS pour Dark Object Subtraction. Il peut être décliné en plusieurs versions notées DOS1 à DOS6.


Correction atmosphérique dans QGIS avec SCP

Version de QGIS : 3.20.1

Version de SCP : 7.9.5


Image Landsat

Nous présenterons ici le cas d’une correction atmosphérique appliquée à une image Landsat. Nous appliquerons plus précisément cette correction atmosphérique à une image Landsat OLI du 2 avril 2021 prise au-dessus de la commune de Mbandjock [https://www.openstreetmap.org/?mlat=4.4463888888889&mlon=11.905277777778&zoom=10#map=10/4.4464/11.9053], située dans la Haute-Sanaga au centre du Cameroun.

Le menu employé est le même que celui dédié à la correction radiométrique, ce qui permet d’enchaîner les deux corrections en une seule manipulation. Une fois QGIS lancé, nous allons dans le menu SCP ‣ Pré-traitement ‣ Landsat. La fenêtre suivante apparaît Fig. 347.


[image: alternate text]

Fig. 347 Correction atmosphérique d’une image Landsat avec SCP.




Avertissement

Il semble qu’avec le module SCP, il ne soit pas possible d’effectuer une correction atmosphérique seule. Elle doit obligatoirement se faire dans la foulée d’une correction radiométrique (Correction radiométrique). Ainsi, si par hasard vous récupérez une image Landsat en réflectance TOA, il ne sera pas possible d’y appliquer seulement une correction atmosphérique en utilisant SCP.



Sur la ligne Dossier contenant les bandes Landsat nous pointons vers le répertoire qui contient les bandes Landsat. Ce répertoire doit être exactement celui qui a été téléchargé avec les mêmes fichiers et la même structure. Sur la ligne Sélectionner le fichier MTL nous pointons vers le fichier texte de métadonnées qui se trouve dans le répertoire des images. Ce fichier texte se termine par _MTL.txt. Ce fichier de métadonnées n’est pas utile à la correction atmospéhrique, mais SCP est obligé de partir d’une image en niveau d’énergie pour obtenir une image en réflectance de surface en passant implicitement par une correction radiométrique. Pour indiquer à SCP que nous souhaitons une correction atmosphérique, il ne faut pas oublier de cocher la case Appliquer correction atmosphérique DOS1. Nous cliquons ensuite sur Lancer. Il nous est demandé de renseigner le répertoire qui contiendra les images corrigées.

Les bandes spectrales corrigées portent le même nom que les bandes initiales mais précédées du préfixe RT_. Nous constatons que les pixels ont bien maintenant des valeurs comprises entre 0 et 1 qui correspondent à des réflectances de surface. La bande panchromatique et celle correspondant au cirrus ne sont pas corrigées.


Note

En comparant, pour une bande donnée, les valeurs des pixels en réflectance en haut de l’atmosphère (TOA) et en réflectance de surface, nous constatons logiquement que les réflectances de surface sont moins fortes. En effet, la réflectance atmosphérique a été enlevée.





Image Sentinel-2

Pour transformer une image Sentinel-2 de niveau L1C (Niveaux de traitements Sentinel-2) en réflectance de surface depuis une image en réflectance au sommet de l’atmosphère avec SCP, la procédure est très semblable. Nous allons dans le menu SCP ‣ Pré-traitement ‣ Sentinel-2. La fenêtre suivante apparaît Fig. 348.


[image: alternate text]

Fig. 348 Correction atmosphérique d’une image Sentinel-2 avec SCP.



À la ligne Dossier contenant les bandes Sentinel-2, nous pointons vers le répertoire qui contient les rasters des bandes spectrales. Généralement ces rasters se trouvent dans le sous répertoire GRANULE du répertoire se terminant par .SAFE. Dans la ligne Sélectionner un fichier de métadonnées, nous pointons vers le fichier texte de métadonnées au format .XML du répertoire parent. Mais nous pouvons également laisser cette ligne vide, SCP trouvera le fichier par lui-même. Il ne faut bien sûr pas oublier de cocher la case Appliquer correction atmosphérique DOS1. Nous cliquons ensuite sur Lancer. Il nous est demandé de renseigner le répertoire qui contiendra les images corrigées.

Les bandes spectrales corrigées portent le même nom que les bandes initiales mais précédées du préfixe RT_. Nous constatons que les pixels ont bien maintenant des valeurs comprises entre 0 et 1 qui correspondent à des réflectances de surface. Par défaut, les bandes 1, 9 et 10 à 60 m de résolution spatiale ne sont pas corrigées (Les images Sentinel-2). Il est possible de les ajouter en cochant la case Preprocess bands 1, 9, 10 du menu précédent (Fig. 348).





Masquer les nuages

Il est rare d’avoir une image sans aucun nuage pour une date donnée. Il est fréquent de devoir tolérer un certain pourcentage de nuages sur une scène que nous souhaitons traiter. Par contre, ces nuages ne doivent pas rentrer dans l’analyse de l’image que nous ferons par la suite. En effet, calculer un NDVI sur un nuage n’aura, par exemple, aucun sens. De même, un nuage ne peut pas être une classe d’occupation du sol. Il est donc nécessaire de créer un raster sur lequel ne figureront que les nuages (et éventuellement d’autres objets indésirables comme leurs ombres, les cirrus ou les aérosols). Ce raster nous servira à masquer les images que nous traiterons par la suite.

Il existe diférentes techniques pour extraire les nuages d’une image satellite. Selon les niveaux de traitements, certaines images sont fournies avec un raster représentant une bande de qualité (Qulity band). Sur ce raster, les valeurs des pixels renseignent sur la présence (ou l’absence) de nuages, d’ombres, de cirrus… C’est notamment le cas pour les images Landsat de niveau L2 (et même L1).

Nous verrons ici de façon pratique comment extraire les nuages d’une image selon différentes techniques et pour différentes images.


Nuages et Landsat dans QGIS

Ici, nous allons extraire les nuages de notre image Landsat OLI du 2 avril 2021 prise au-dessus de la commune de Mbandjock [https://www.openstreetmap.org/?mlat=4.4463888888889&mlon=11.905277777778&zoom=10#map=10/4.4464/11.9053], située dans la Haute-Sanaga au centre du Cameroun. Cette image présente de nombreux nuages comme nous pouvons le voir sur la composition colorée en fausses couleurs présentée ci-dessous (Fig. 349). Le but va être de repérer les nuages de cette image.
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Fig. 349 Présence de nuages sur une image Landsat .



Il est tout d’abord nécessaire d’installer l’extension Cloud Masking. Pour des détails sur l’installation d’une extension QGIS, voire la section dédiée : Installation d’extensions dans QGIS. Une fois l’extension installée, il suffit de l’ouvrir via le menu Extensions ‣ Cloud masking for Landsat products ‣ Cloud Masking. Le module s’ouvre en bas à droite de l’interface de QGIS (Fig. 350).


[image: alternate text]

Fig. 350 Paramétrage de l’extension Cloud Masking.



Nous commençons par pointer le fichier texte des métadonnées de l’image à la ligne Landsat Metadata File (MTL) dans l’onglet Open and Load. Ces métadonnées permettent au module de savoir de quel Landsat il s’agît (TM, ETM+ ou OLI) et d’appliquer l’algorithme de masque de nuages correspondant. Une fois ces métadonnées renseignées nous cliquons sur load. Nous allons ensuite dans l’onglet Filters and Mask. Ici, nous pouvons choisir quelle technique appliquer. Trois techniques sont proposées : une basée sur la bande qualité fournie avec l’image (QA Band (C2)), une basée sur la bande bleue (Blue Band) et une basée sur un algorithme plus poussé nommé FMask. La technique basée sur la bande bleue ne donnant pas des résultats très bons, nous ne la présenterons pas ici.


Avec la bande de qualité

La technique la plus simple est d’utiliser la bande de qualité fournie avec l’image. En fait, le module ne va finalement que recoder la bande de qualité avec des valeurs plus simples à manipuler et lui associer une symbologie. Nous cochons la case QA Band (C2) puis nous spécifions ce que nous souhaitons inclure dans notre masque. Ici nous allons y inclure les pixels correspondant aux Dilated Cloud, Cirrus, Cloud (nuage) et Cloud Shadow (ombre de nuage) (Fig. 351). La bande de qualité contient également un code pour les pixels en neige et en eau dans le cas où nous voudrions aussi exclure ces surfaces ci.
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Fig. 351 Masque de nuages selon la bande de qualité.



Nous cliquons ensuite sur Generate mask tout en bas de la fenêtre. Le raster des nuages (et des autres éléments sélectionnés précédemment) apparaît. Les nuages sont bien repérés mais les ombres ne sont pas toutes bien identifiées.


Astuce

Nous pouvons restreindre le masque à une zone d’intérêt soit à partir d’une couche de polygone de notre zone d’étude avec l’option In only polygon layer ou en dessinant à la volée une zone d’intérêt avec l’option In only areas of interest.





Avec l’algorithme FMask

L’algorithme FMask [https://www.sciencedirect.com/science/article/abs/pii/S0034425711003853?via%3Dihub] est une méthode de détection des nuages et de leurs ombres parmi les plus robustes. FMask n’est pas basé sur la bande de qualité mais reconnait directement les nuages et leurs ombres à partir de l’analyse de l’image par des calculs relaitvement complexes. Pour utiliser cet algorithme, il suffit de cocher la case FMask de l’onglet Filters to apply. Dans cet algorithme, il est possible de régler 3 paramètres, mais les valeurs par défaut donnent généralement de bons résultats. Nous constatons que cet algorithme est également capable de détecter la neige et l’eau, mais nous n’utiliserons pas cette fonctionnalité ici (Fig. 352).
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Fig. 352 Masque de nuages en utilisant l’algorithme FMask.



Nous cliquons ensuite sur Generate mask tout en bas de la fenêtre. Le raster des nuages (et des autres éléments sélectionnés précédemment apparaît). Les nuages sont bien repérés et leurs ombres aussi, ce qui est la vraie plus-value de cette méthode (Fig. 353).


Avertissement

L’algorithme étant assez complexe, il peut prendre un peu de temps à s’exécuter, surtout si nous l’exécutons sur une scène Landsat entière.
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Fig. 353 Comparaison de l’extraction des nuages : selon la bande de qualité (QA) et selon la méthode FMask (FMask). Pour FMask, les ombres des nuages sont en jaune.



Nous constatons que FMask est plus généreux sur l’extension des nuages et qu’il repère bien mieux les ombres qu’en utilisant la bande de qualité seule. Par contre, dans les deux cas les cirrus sont difficilement identifiés.


Astuce

Si nous désirons être sûrs de n’avoir aucun nuage et aucune ombre de nuages, quitte à perdre des portions de l’image qui seraient nettes, nous pouvons augmenter le buffer des nuages et de leurs ombres dans les paramètres de FMask (Fig. 352).







Les indices radiométriques

Grâce aux images satellites multi-spectrales il est possible de calculer des indices radiométriques en combinant plusieurs bandes spectrales. Un indice radiométrique est une combinaison de bandes spectrales via un calcul raster qui permet de mettre en exergue un état de la surface. Concrètement, à partir de deux, ou plus, bandes spectrales nous construisons un nouveau raster qui sera plus facile à interpréter en fonction de notre objet d’étude. Il existe des indices radiométriques dédiés à l’étude de la végétation, des surfaces en eau, du couvert neigeux, des zones incendiées, du sol nu, de la qualité des eaux … Il en existe énormément, mais seuls les plus fréquemment utilisés seront détaillés ici.

Certains logiciels ou certaines extensions proposent des modules tout prêts pour les calculer, mais la plupart du temps il est tout aussi simple, voire même plus sûr, de les calculer simplement à l’aide de la calculatrice raster de son logiciel de géomatique préféré (Calcul raster mono-bande).


Avertissement

L’ensemble de ces indices doivent se calculer à partir des bandes spectrales exprimées en réflectance de surface. Si les réflectances de surface ne sont vraiment pas disponibles, les réflectances au sommet de l’atmosphère (TOA) peuvent à la rigueur faire l’affaire. Mais il est déconseillé de calculer ces indices sur des bandes spectrales en niveau L1 qui ne seraient pas des réflectances. Voir la fiche Niveaux de traitements.




Indices dédiés à la végétation

La végétation est sans doute l’état de surface le plus étudié via les images de télédétection.  Le but de la plupart de ces indices est de construire un raster sur lequel les pixels aux plus fortes valeurs correspondront aux pixels couverts de végétation luxuriante. Il existe différents indices, mais l’indice roi est le NDVI.


NDVI

NDVI est l’acronyme anglais de Normalized Difference vegetation Index. La traduction en français n’a pas trop de sens… C’est un indice mis au point dès les années 1970 et qui renseigne sur l’état de la végétation. C’est de loin l’indice le plus utilisé en télédétection de par sa simplicité de calcul, d’interprétation et sa robustesse. Il se calcule simplement comme suit :


\[NDVI = \frac{(PIR - R)}{(PIR + R)}\]

où PIR correspond à la bande spectrale du Proche infrarouge et R correspond à la bande spectrale du Rouge.

Cette formulation est basée sur la signature spectrale typique de la végétation. Pour bien comprendre le principe, nous nous appuierons sur la figure Fig. 354. Nous nous focaliserons sur les signatures spectrales de la végétation (Surface herbacée) et celle de la neige. Sur cette figure, nous avons également ajouté les domaines du Rouge et du Proche infrarouge.
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Fig. 354 Principes du NDVI.



Sur cette figure, nous relevons une réflectance de 0.02 et de 0.5 pour la surface herbacée dans le Rouge et le Proche infrarouge respectivement. Pour la neige nous relevons respectivement 0.98 et 0.92 pour le Rouge et le  Proche infrarouge. Connaissant ces valeurs, il est possible de calculer le NDVI pour ces deux états de surface :


\[NDVI végétation = \frac{(0.5 - 0.02)}{(0.5 + 0.02)} = 0.92\]


\[NDVI neige = \frac{(0.92 - 0.98)}{(0.92 + 0.98)} = -0.03\]

Nous constatons que les surfaces en végétation présentent un NDVI élevé et que les surfaces enneigées un NDVI négatif. Sur le même principe, les surfaces en eau libre présentent également un NDVI négatif généralement. D’une manière générale, le raster résultat est borné entre -1 et 1. L’interprétation d’un raster de NDVI est la suivante : plus un pixel tend vers 1, plus ce pixel est couvert de végétation bien développée et en bonne santé. Un pixel qui tend vers 0 est un pixel de sol nu. Enfin, un pixel négatif est généralement un pixel en eau. Mais attention, dans certains cas, si des algues ou une forte turbidité sont présents dans les zones en eau, alors cette eau pourra avoir un NDVI légèrement positif du fait de l’activité chlorophyllienne des algues et du phytoplancton. La figure Fig. 355 présente le NDVI calculé sur les Bouches-du-Rhône le 13 juin 2019 à partir d’une image Landsat 8.
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Fig. 355 NDVI des Bouches-du-Rhône pour le 13 juin 2019. Remarquez que quelques portions du littoral apparaissent légèrement positives du fait de la turbidité et/ou de la faible profondeur.





SAVI

SAVI est l’acronyme anglais de Soil Adjusted Vegetation Index. Tout comme le NDVI, le SAVI donne une indication sur la présence ou l’absence de végétation pour tout pixel. Une forte valeur de SAVI traduit un pixel couvert de végétation en bonne santé et une faible valeur traduit plutôt un sol sans végétation. Le SAVI introduit un facteur correctif qui prend en compte la présence de sol nu au sein de la végétation. Par exemple, dans le cas d’une forêt éparse ou d’une savane sèche, où les arbres se trouvent séparés les uns des autres par du sol nu, le SAVI peut produire des résultats rendant mieux compte du couvert végétal que le NDVI. Le SAVI se calcule comme suit :


\[SAVI = \frac{(1 + L)(PIR - R)}{(PIR + R + L)}\]

où PIR correspond à la bande spectrale du Proche infrarouge, R correspond à la bande spectrale du Rouge et L correspond au facteur correctif de sol nu.

Le facteur L peut varier entre 0 et 1 selon les configurations mais il est admis qu’une valeur de 0.5 donne de bons résultats en règle général. La figure Fig. 356 présente le SAVI calculé sur les Bouches-du-Rhône le 13 juin 2019 à partir d’une image Landsat 8.
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Fig. 356 SAVI des Bouches-du-Rhône pour le 13 juin 2019.






Indices dédiés aux sols nus

Les sols nus sont une occupation du sol qui peut être intéressante à suivre à plusieurs égards. Un sol nu peut être naturel, dans le cas d’une région aride par exemple, mais peut également renseigner sur des dynamiques environnementales. Après un incendie ou une inondation ayant décapé la végétation, un sol nu peut être une trace de l’événement. Dans un contexte agricole, un sol nu peut faire partie d’une rotation culturale en étant le stade post récolte et pré germination. Il existe différents indices pour mettre en avant un sol nu. Quelques exemples sont donnés ici.


BSI

BSI est l’acronyme anglais de Bare Soil Index (Indice de sol nu). Il se calcule par combinaison des bandes des domaines du bleu, du rouge, du proche infrarouge et du moyen infrarouge. Sa formulation mathématique est présentée ci-dessous.


\[BSI = \frac{(MIR + R)-(PIR + B)}{(MIR + R)+(PIR + B)}\]

où MIR est la bande du Moyen infrarouge (B6, B5 ou B11 pour respectivement les capteurs OLI/OLI2, TM et MSI de Sentinel-2), R la bande du domaine du Rouge, PIR la bande du domaine du Proche infrarouge et B la bande du domaine du Bleu.

Sur le raster résultat, les pixels ayant une valeur positive peuvent être considérés comme étant des pixels de sol nu. Un exemple est montré sur une scène Landsat 8 prise au-dessus des Bouches-du-Rhône le 13 juin 2019 (Fig. 356). Les pixels en rouge ont un BSI positif et sont donc des pixels de sol nu.
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Fig. 357 BSI des Bouches-du-Rhône pour le 13 juin 2019.



En comparant le résultat de cet indice à un indice de végétation comme le NDVI (Fig. 355), il s’agit presque d’une image symétrique, ce qui est tout à fait cohérent.




Indices dédiés aux zones incendiées

Il existe des indices dédiés au repérage des des zones incendiées et dédiées à l’analyse de la sévérité des incendies.


NBR

NBR est l’acronyme anglais de Normalized Burn Ratio et est un indice utilisé pour cartographier les zones touchées par un incendie. L’indice repose sur la signature spectrale de la végétation et la signature spectrale des zones incendiées. La végétation en bonne santé présente un pic dans le domaine du proche infrarouge (à peu près 0.75 µm) et un creux dans celui de l’infrarouge moyen (à peu près 2.30 µm). Au contraire, les surfaces récemment incendiées présentent un creux dans le domaine du proche infrarouge et un pic dans celui de l’infrarouge moyen (Fig. 358).
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Fig. 358 Principes de caldul du Nomalized Burn Ratio.



En se basant sur ces signatures spectrales, le NBR se calcule comme suit :


\[NBR = \frac{(PIR - MIR)}{(PIR + MIR)}\]

Avec PIR la bande spectrale du domaine du Proche InfraRouge et MIR celle du domaine du Moyen InfraRouge. Dans le cas de Landsat 8 ou Sentinel-2, la seconde bande du moyen infrarouge, à savoir la MIR2 sera privilégiée.

À la suite de ce calcul, le raster obtenu varie entre -1 et +1. Les pixels négatifs correspondent à des zones récemment incendiées tandis que les pixels positifs correspondent à une végétation en bonne santé.



difference NBR

L’indice dNBR - diffference NBR - aussi noté ΔNBR, est un indice utilisé pour quantifier la sévérité des incendies. Il se calcule simplement par différence des indices NBR calculés pour une date avant incendie et pour une date après incendie. Concrètement, il s’agît de la soustraction des deux rasters de NBR calculés pour les deux dates.


\[ΔNBR = NBR avant Incendie - NBR après Incendie\]

Le raster résultat varie autour de 0. Les valeurs négatives reflètent généralement une repousse de la végétation et les valeurs positives reflètent la sévérité de l’incendie. Les valeurs sont normalement à interpréter au cas par cas avec une étude de terrain, mais l’USGS propose une échelle de sévérité des incendies qui fonctionne dans la plupart des cas [https://un-spider.org/advisory-support/recommended-practices/recommended-practice-burn-severity/in-detail/normalized-burn-ratio].


Tableau 20 dNBR et sévérité des incendies





	Niveau de sévérité

	gammes de ΔNBR





	Repousse de la végétation (élevée)

	-2.000 à -0.250



	Repousse de la végétation (modérée)

	-0.250 à -0.100



	Pas incendié

	-0.100 à +0.100



	Incendié à faible sévérité

	+0.100 à +0.270



	Incendié à sévérité modérée

	+0.270 à +0.440



	Incendié à sévérité élevée

	+0.440 à +0.660



	Incendié à sévérité très élevée

	+0.660 à +2.000









Indices dédiés à l’eau

Les surfaces en eau sont également un important sujet d’étude de la télédétection. C’est pourquoi il existe plusieurs indices de détection des surfaces en eau, plus ou moins élaborés.


MNDWI

MNDWI est l’acronyme anglais de Modified Normalized Water Index. C’est un indice largement utilisé pour détecter les surfaces en eau depuis une image satellite multispectrale. Il se calcule comme suit :


\[MNDWI = \frac{(V - MIR)}{(V + MIR)}\]

où V correspond à la bande du domaine du Vert et MIR correspond à la bande du domaine du Moyen Infrarouge. Dans le cas de Landsat 8, il est conseillé de prendre la bande 6 correspondant au MIR 1 pour calculer cet indice.


Avertissement

La formule du MNDWI peut varier quelque peu selon les auteurs.



Au final, le raster obtenu varie entre -1 et 1. Sur un raster de MNDWI, les pixels positifs correspondent aux pixels en eau et les pixels négatifs aux pixels de terre. Il est donc facile de faire la différence entre les zones en eau et les zones en terre. La figure Fig. 359 présente le MNDWI calculé sur les Bouches-du-Rhône le 13 juin 2019 à partir d’une image Landsat 8.
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Fig. 359 MNDWI des Bouches-du-Rhône pour le 13 juin 2019. Certaines portions du littoral apparaissent négatives du fait de la turbidité et/ou de la faible profondeur.





AWEI

AWEI est l’acronyme anglais de Automated Water Extraction Index. Il a notamment été développé pour être appliqué sur les images Landsat disposant de deux bandes spectrales dans le moyen infrarouge. Cet indice a la particularité d’avoir deux versions. Une version AWEIsh est dédiée à l’extraction des zones en eau dans les régions présentant beaucoup d’ombres sur les images, comme les régions de montagnes. Une seconde version AWEIns est dédiée à l’extraction des zones dans les régions présentant peu d’ombres, comme les régions de plaines et de plateaux.


Avertissement

De par sa formulation, le AWEI ne peut être calculé que sur des bandes spectrales en réflectance exprimées entre 0 et 1.



Cet indice se calcule comme suit pour sa version appliquée aux images présentant des ombres (shadow) :


\[AWEIsh = B + 2.5 × V − 1.5 × (P IR + MIR1) − 0.25 × MIR2\]

Cet indice se calcule comme suit pour sa version appliquée aux images sans ombres (non shadow) :


\[AWEIns =  4 × (V − MIR1) − (0.25 × P IR + 2.75 × MIR2)\]


	où :
	
	B correspond à la bande spectrale du domaine du Bleu


	V correspond à la bande spectrale du domaine du Vert


	PIR correspond à la bande spectrale du domaine du Proche Infrarouge


	MIR1 correspond à la bande spectrale du domaine du Moyen Infrarouge 1


	MIR2 correspond à la bande spectrale du domaine du Moyen Infrarouge 2









Astuce

La version sans ombres est plus couramment employée que celle avec ombres.



Sur le raster de AWEI résultat, un pixel en eau aura une valeur positive et un pixel de terre aura une valeur négative. Ce seuil est pratique pour la détection automatisée des surfaces en eau. Il présente généralement des résultats un peu plus précis que les autres indices d’extraction des surfaces en eau. La figure Fig. 360 présente le AWEI (sans ombres) calculé sur les Bouches-du-Rhône le 13 juin 2019 à partir d’une image Landsat 8.
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Fig. 360 AWEI des Bouches-du-Rhône pour le 13 juin 2019. Certaines portions du littoral apparaissent négatives du fait de la turbidité et/ou de la faible profondeur.






Indices dédiés à la neige

Des indices dédiés à l’extraction des zones enneigées depuis les images de télédétection ont été développées depuis longtemps. Nous présenterons ici l’indice le plus utilisé.


NDSI

NDSI est l’acronyme anglais de Normalized Difference Snow Index. Il s’agît d’un indice simple à calculer en utilisant l’équation suivante.


\[NDSI = \frac{(V - MIR)}{(V + MIR)}\]

où V correspond à la bande du domaine du Vert et MIR correspond à la bande du domaine du Moyen Infrarouge. Dans le cas de Landsat 8, il est conseillé de prendre la bande 6 correspondant au MIR 1 pour calculer cet indice.


Note

Nous pouvons noter que le NDSI se formule de la même manière que le MNDWI dédié à l’eau. La distinction de la neige de l’eau libre se fera en trouvant un seuil de NDSI au-dessus duquel nous serons quasiment certains de n’extraire que les surfaces en eau.
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Fig. 361 Composition colorée 6-3-2 Landsat 8 du 28 octobre 2021 au-dessus du Tibet (A) sur laquelle la neige apparaît en turquoise, et NDSI sur cette même scène avec les valeurs négatives en gris et les positives en ocre (B).



Sur la figure précédente nous constatons que les surfaces de terre ont des valeurs de NDSI négatives et que les surfaces en eau libre ou en neige présentent des valeurs de NDSI positives. Cependant nous constatons que les surfaces en neige présentent un NDSI bien plus élevé (au-dessus de 0.5 généralement) que l’eau (qui reste au-dessous de 0.1 dans la plupart des cas).




Outils dédiés

Même si il est très simple d’utiliser le calcul raster (Calcul raster mono-bande), via par exemple la calculatrice raster de QGIS (Calcul raster avec QGIS) ou de R (Calcul raster avec R), pour calculer ces différents indices, il existe des outils dédiés. Ces outils peuvent être contenus dans des logiciels ou peuvent faire partie de librairies de langages de programmation comme R ou Python.


Indices avec OTB

Version de Orfeo ToolBox : 7.2.0

OTB (Orfeo ToolBox) propose un menu dédié au calcul de différents indices. Ce menu se nomme RadiometricIndices et s’utilise soit via l’interface Monteverdi soit via la ligne de commande otbcli.

Via Monteverdi

Le menu se trouve dans le panneau Navigateur d’OTB-Applications ‣ Feature extraction ‣ RadiometricIndices. Le menu suivant apparaît (Fig. 362).
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Fig. 362 Calcul d’indices radiométriques avec OTB Monteverdi.



Dabs le champ Input image nous indiquons le raster à utiliser pour le calcul. Il doit nécessairement s’agir d’un raster multi-bandes (Raster multi-bandes) (en dur car les rasters virtuels ne sont pas acceptés) contenant au moins les bandes spectrales nécessaires au calcul de l’indice en question. Ici, nous travaillons avec une scène Landsat 8 constituée d’un raster multi-bandes contenant les bandes 2 à 6 sur les Bouches-du-Rhône. Dans le champ Output image, nous spécifions un chemin et un nom pour le raster qui sera créé, ici nous allons calculer un NDVI. Dans le panneau Channels selection, nous indiquons quelles sont les bandes qui correspondent aux différents domaines radiométriques.


Note

Il n’est pas indispensable de renseigner les 5 canaux. Si le raster multi-bandes ne dispose que d’une bande rouge (1ère bande) et proche-infrarouge (2nde bande), nous indiquons pour le Red Channel 1 et pour le NIR Channel 2, puis des valeurs fictives, 3 par exemple, pour les autres canaux.



Enfin, dans le panneau Available Radiometric Indices, nous sélectionnons le ou les indices à calculer. Puis nous cliquons sur Execute pour lancer le calcul. Si nous avons sélectionné plusieurs indices, le raster résultat sera un raster multi-bandes dans lequel la première bande correspondra au premier indice et ainsi de suite.

Via otbcli

Le menu RadiometricIndices est également utilisable via la ligne de commande otbcli, ce qui peut s’avérer pratique dans une optique d’automatisation de tâches. Pour l’exemple, nous allons calculer un NDVI et un (MNDWI) à partir d’un raster multi-bandes Landsat 8 contenant les bandes 2 à 6. La commande à employer est la suivante :

otbcli_RadiometricIndices -in stack_LC08_L2SP_196030_20190613.TIF -channels.blue 1 -channels.green 2 -channels.red 3 -channels.nir 4 -channels.mir 5 -list Vegetation:NDVI Water:MNDWI -out RadiometricIndicesImage.tif






	Où :
	
	otbcli_RadiometricIndices : la commande à utiliser


	-in : le mot clé pour spécifier le raster multi-bandes à utiliser


	-channels.blue 1 : la précision du numéro de bande à utiliser pour le canal du Bleu, et ainsi de suite pour tous les canaux


	-list Vegetation:NDVI Water:MNDWI : la liste des indices à calculer, se reporter à la documentation pour la liste complète [https://www.orfeo-toolbox.org/CookBook/Applications/app_RadiometricIndices.html]


	-out : le mot clé pour spécifier le chemin et le nom du raster qui sera créé
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Classification non supervisée d’images satellites

Avant de se lancer dans une classification supervisée de sa zone d’études, il est souvent utile de commencer par une classification non supervisée. Cette approche un peu en aveugle permet de se faire une idée sur la façon dont nous pourrons différencier les différents usages du sol. Concrètement, l’utilisateur stipule simplement un nombre de classes désirées et laisse la main à l’algorithme pour « faire au mieux », le but étant de minimiser la variance intra-classe et de maximiser la variance inter-classes.

Par exemple, si nous visons une classification en 6 classes, nous pourrons tenter une classification non supervisée en 10 classes et faire par la suite un regroupement de classes. Si nous constatons que le résultat est intéressant nous pourrons alors nous lancer dans une classification supervisée avec des réglages plus fins. Par contre, si nous constatons que nous ne parvenons pas à individualiser une classe désirée, peut-être que même avec une approche supervisée nous aurons du mal à la faire ressortir.

L’interprétation des classes sorties automatiquement peut se faire de façon empirique en comparant la classification avec une composition colorée ou une image à plus haute résolution spatiale. Mais l’interprétation peut également se faire à l’aide des signatures spectrales moyennes calculées pour chaque classe.

Une classification non supervisée peut être suivie d’un regroupement de classes. Ce regroupement peut se faire avec différents outils.

Ce processus de classification non supervisée peut se reposer sur différents algorithmes mais le plus fréquemment utilisée est celui des K-means (K-moyennes). Cet algorithme peut se mettre en œuvre avec différents logiciels et outils. Certains seront détaillés ci-après.

Pour chacun des exemples, nous ferons une classification non supervisée de l’occupation du sol de la région du Caire [https://www.openstreetmap.org/search?query=caire#map=8/30.045/31.805] en Égypte à partir d’une image Landsat 5 TM du 13 juillet 2011.
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Classification non supervisée avec OTB

Version de OTB : 9.0.0

Dans cette partie nous allons voir comment réaliser une classification non supervisée en kmeans en utilisant le logiciel Orfeo ToolBox (OTB). Nous utiliserons en premier OTB au travers de son interface via QGIS. Nous ferons cette démonstration sur la base d’une image Landsat TM prise au dessus du Caire le 13 juillet 2011. Pour rappel, des informations supplémentaires sur les images Landsat TM sont disponibles ici : TM - Landsat 4-5.


Préparation des données

Cette classification se fait sur au moins deux bandes spectrales. Nous construisons donc au préalable un raster multibandes (Raster multi-bandes) contenant seulement les bandes sur lesquelles nous souhaitons baser notre classification. Ici nous la baserons sur les bandes 1 à 6.


Avertissement

Le raster multibandes doit être au format .tif, un raster virtuel ne sera pas géré par OTB comme donnée d’entrée.



Avant de procéder à tout traitement, il est bon de réaliser une composition colorée de notre zone d’étude afin de se rendre compte de sa physionomie (Composition colorée avec QGIS). La figure suivante présente une composition colorée en fausses couleurs de notre image avec le proche infrarouge colorée en rouge (Fig. 363).
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Fig. 363 Composition colorée fausses couleurs du Caire avec la bande du proche infrarouge colorée en rouge.



Sur cette composition colorée (Fig. 363), nous retrouvons les surfaces en eau représentées par le Nil et quelques canaux, du bâti dense au cœur du Caire, du bâti moins dense sur la périphérie de la ville, différents types de végétation notamment à l’entrée du delta et différents types de sols nus aux alentours de la ville.

Maintenant que nous avons un raster multibandes et que nous avons une idée de notre zone d’étude nous pouvons passer à la classification en kmeans dans OTB.



Kmeans dans OTB - QGIS

Dans QGIS, nous retrouvons la fonction dédiée de OTB dans la Boîte à outils de traitements ‣ OTB ‣ Learning ‣ KMeansClassification. Lorsque nous ouvrons cette fonctionnalité, le menu suivant apparaît (Fig. 364).
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Fig. 364 Paramétrage d’une classification en kmeans avec OTB.



Dans le champ Input Image nous sélectionnons le raster multibandes à classifier, ici stack_caire_20110713.tif. Dans le champ Output Image nous spécifions le répertoire dans lequel nous allons sauver la classification et nous nommons le raster résultant. Dans le champ Number of classes nous spécifions le nombre de classes souhaité, par exemple 10. Plusieurs autres paramètres sont ajustables, mais ces trois points là sont les points essentiels. Nous cliquons ensuite sur Exécuter.

Le résultat apparaît alors directement dans le panneau des couches de QGIS (Fig. 365).
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Fig. 365 Classification en 10 classes de l’image Landsat TM de juillet 2011.



Comme pour toutes les classifications non supervisées, le travail suivant consiste à interpréter chaque classe selon sa signature spectrale et à faire des regroupements de classes afin d’obtenir un résultat pertinent. Pour cela, il suffit de calculer les statistiques zonales du raster multi-bandes initial selon les classes du raster résultat de la classification non supervisée.



Kmeans dans OTB - OTBcli

Il est également possible de procéder à cette même classification mais en passant par la ligne de commande OTB dédiée, comme présentée ci-dessous :

otbcli_KMeansClassification -in stack_caire_20110713.tif -nc 10 -out classif_10.tif





où :


	otbcli_KMeansClassification  = l’appel de l’application de classification en kmeans


	-in stack_caire_20110713.tif = paramétrage du raster multibandes à prendre en entrée


	-nc 10 = définition du nombre de classes, ici 10


	-out classif_10.tif = le nom de la classification en sortie







Classification non supervisée dans R

Version de R : 4.3.1

Version de terra : 1.7.29

Il est possible de réaliser une classification non supervisée par la méthode des k moyennes (kmeans) dans R en utilisant en partie la librairie terra. Nous commençons par définir un corpus de bandes sur lequel se fera la classification. Il peut s’agir d’une seule bande ou d’un nombre illimité de bandes. Il est également nécessaire de définir un nombre de classes souhaitées, aussi appelé nombre de clusters.

Dans l’exemple ci-dessous, nous réaliserons une classification non supervisée par la méthode des k-moyennes sur une image Landsat 5 (TM - Landsat 4-5) prise au-dessus de la ville du Caire le 13 juillet 2011. Nous nous contenterons des bandes TM suivantes : Bleu, Vert, Rouge, PIR, MIR1 et MIR2. Nous choisirons de créer une classification en 10 classes. Les traitements rasters se feront via la librairie terra mais la classification non supervisée proprement dite sera faite en utilisant la fonction kmeans de r-base.

Nous procéderons en quatre étapes :


	Préparation du jeu de rasters à classifier


	Classification non supervisée du jeu de rasters


	Récupération des signatures spectrales moyennes des classes


	Affichage des signatures spectrales moyennes des classes




Préparation du jeu de raster

Nous commençons par importer dans R sous forme de SpatRasters les bandes à classifier puis nous en faisons un stack.

# import des bandes spectrales
b1 <- terra::rast('LT05_L2_176039_20110713_20180312_01_T1_B1.tif')
b2 <- terra::rast('LT05_L2_176039_20110713_20180312_01_T1_B2.tif')
b3 <- terra::rast('LT05_L2_176039_20110713_20180312_01_T1_B3.tif')
b4 <- terra::rast('LT05_L2_176039_20110713_20180312_01_T1_B4.tif')
b5 <- terra::rast('LT05_L2_176039_20110713_20180312_01_T1_B5.tif')
b7 <- terra::rast('LT05_L2_176039_20110713_20180312_01_T1_B7.tif')
# on créé un stack avec ces bandes
stack_Landsat <- c(b1, b2, b3, b4, b5, b7)
# on renomme les bandes de ce stack
names(stack_Landsat) <- c('Bleu', 'Vert', 'Rouge', 'PIR', 'MIR1', 'MIR2')





À cette étape, nous avons un stack de rasters composé de 5 bandes spectrales nommé stack_Landsat. Nous allons pouvoir maintenant lancer la classification non supervisée sur ce stack.

Classification non supervisée

La classification proprement dite se fait à l’aide de la fonction kmeans de r-base. Il faut donc transformer notre stack SpatRaster en une matrice R classique. Nous pourrons ensuite appeler la fonction kmeans sur cette matrice. De façon symétrique, il faudra rappatrier le résultat de la classification généré en matrice dans un objet SpatRaster.

# on transforme ce stack en matrice
stack_mtrx <- as.matrix(stack_Landsat)
# on définit des seeds
set.seed(99)
# on créé les clusters par la méthode des kmeans, en 10 classes et jusqu'à 500 itérations
kmncluster <- kmeans(stack_mtrx, centers=10, iter.max = 500)
# on récupère le résultat de la classification sous forme de matrice
val_cluster <- as.matrix(kmncluster$cluster)

# on créé un raster à 0 à partir d'une des bandes initiales
rast0 <- b1 - b1
# on intègre dans ce raster les résultats de la classification
rast_cluster <- rast0 + val_cluster
# (facultatif) on créé une palette de 10 couleurs
mycolor <- c("#fef65b","#ff0000","#daa520","#0000ff","#0000ff","#00ff00","#cbbeb5","#c3ff5b","#ff7373","#00ff00","#808080")
# on affiche le raster résultat avec la palette
terra::plot(rast_cluster, main = 'Classification non supervisée', col = mycolor, type="classes")





À la fin de cette étape, nous avons un raster avec les 10 classes issues du partitionnement en k-moyennes nommé rast_cluster. Nous y avons associé une palette de couleurs nommée mycolor (Fig. 366). Il est possible d’exporter ce raster si nous le souhaitons (Exporter un raster depuis R).
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Fig. 366 Classification non supervisée en 10 classes via R.



Récupération des signatures spectrales moyennes des classes

À l’issue d’une classification non supervisée, il est nécessaire d’analyser les signatures radiométriques de chaque classe afin de les interpréter et éventuellement fusionner certaines classes. Nous pouvons facilement récupérer les valeurs moyennes des classes à l’aide de la fonction centers appelée sur un résultat de classification non supervisée générée par la fonction kmeans.

# on créé un vecteur avec les identifiants des classes
id_classes <- c('cl_01', 'cl_02', 'cl_03', 'cl_04', 'cl_05', 'cl_06', 'cl_07', 'cl_08', 'cl_09', 'cl_10')
# on récupère les valeurs moyennes des classes dans un dataframe
sign_classes <- as.data.frame(kmncluster$centers, row.names=id_classes)





Nous obtenons ici un dataframe avec les signatures radiométriques moyennes de chaque classe dans un objet nommé sign_classes. Si nous le souhaitons nous pouvons l’exporter en csv pour l’analyser par ailleurs.

Affichage des signatures spectrales moyennes des classes

Si nous souhaitons rester dans l’environnement R, nous pouvons créer un graphique présentant les signatures spectrales des différentes classes. Nous pouvons utiliser la librairie ggplot2 pour ce faire. Un exemple est donné ci-après. Le but n’étant pas d’apprendre à tracer des graphiques avec R, nous ne nous attarderons pas sur l’explication des différentes options.

# on transforme ce dataframe en format 'long'
sign_classes_long <- tidyr::pivot_longer(sign_classes, cols = c('Bleu', 'Vert', 'Rouge', 'PIR', 'MIR1', 'MIR2'), names_to = "Bande", values_to = "Réflectance")
# on trace le graphique des signatures spectrales moyennes par classe
ggplot(sign_classes_long, aes(x=factor(Bande, level=c('Bleu', 'Vert', 'Rouge', 'PIR', 'MIR1', 'MIR2')),
                              y = Réflectance,
                              group = id_cl,
                              color = id_cl)) +
       # Ajout des lignes pour chaque classe
       geom_line() +
       # Ajout des points pour chaque valeur
       geom_point() +
       # on associe les mêmes couleurs que pour le raster
       scale_color_manual(values = mycolor) +
       # Ajout d'un titre général
       ggtitle("Signatures spectrales moyennes par classe") +
       # on centre le titre et on le met en gras
       theme(plot.title = element_text(hjust = 0.5, face = "bold")) +
       # on définit un titre pour l'axe des abscisses
       xlab("Bande spectrale") +
       # on définit un titre pour la légende
       labs(color = "Classe")





Il ne reste plus qu’à analyser ce graphique de signatures pour interpréter les différentes classes (Fig. 367).
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Fig. 367 Signature spectrale moyenne de chaque classe.



Ces signatures sont à mettre en regard du raster produit. Ainsi, la classe 9 présente une signature spectrale très faible dans toutes les gammes de longueurs d’ondes et semble spatialement correspondre au Nil. Nous en déduisons que la classe 9 correspond à de l’eau. Et ainsi de suite pour les différentes classes. Ici, il faudrait certainement fusionner plusieurs classes correspondant à des états de surfaces très proches. Ce type de fusion de classes peut se faire par une reclassification du raster rast_cluster en suivant la méthode présentée dans la partie dédiée (Reclassifier un raster avec R).


Note

Le script complet en un seul tenant est disponible ici : script R kmeans



Cette méthode utilisant R est complète et permet d’automatiser le processus et d’explorer facilement différentes combinaisons de bandes.
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Classification supervisée d’images satellites

En géographie, un des buts fréquents de la télédétection est de produire une classification de l’usage du sol d’une région à partir d’images satellites. Dans la plupart des cas, nous utilisons une procédure de classification supervisée afin de maîtriser le nombre et la nature des classes qui seront produites. Il existe de nombreuses solutions pour effectuer ce genre de classifications. Nous en détaillerons quelques unes dans cette partie.
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Quelques algorithmes

Il existe de très nombreux algorithmes de classification d’images. Ces algorithmes sont plus ou moins complexes et peuvent être mis en pratique par différents outils. Ici, nous présenterons un peu de théorie vulgarisée sur quelques algorithmes couramment rencontrés en classification d’images. Notons que ces techniques de classification ne sont pas propres au monde de l’imagerie mais sont largement utilisés dans le monde de la statistique en général.


Classification par distance minimale

Cet algorithme est aussi connu sous le nom de classification au plus proche voisin. C’est l’algorithme le plus facile à appréhender et à mettre en place. Il est largement répandu dans le monde de la télédétection, bien que maintenant des techniques plus poussées soient plus communément employées.

Comme pour tout processus de classification supervisée, cette technique repose sur une digitalisation manuelle de régions d’entraînement. Chaque région d’entraînement est une région homogène de l’image que l’utilisateur a défini comme étant représentative d’une classe donnée. Ces régions d’entraînement sont aussi connues sous leur appellation en anglais de Region Of Interest (ROI). Pour chaque zone d’entraînement, les valeurs des pixels sous-jacents sont relevées, les moyennes sont calculées, et chaque classe est ainsi caractérisée par une signature radiométrique. L’idée est ensuite d’associer à chaque pixel de l’image qui n’a pas servi comme zone d’entraînement la classe qui lui est le plus proche d’un point de vue radiométrique.

Nous allons illustrer le fonctionnement de cet algorithme sur un cas simplifié. Dans l’exemple, nous souhaitons classifier une image Landsat 8 prise sur le littoral des Bouches-du-Rhône. Cette image se compose de 4 bandes spectrales : Bleu, Vert, Rouge et Proche Infrarouge (PIR). Nous visons une classification en 3 classes : eau, végétation et bâti, respectivement classe 1, 2 et 3. Nous commençons par créer une composition colorée en fausses couleurs (Les compositions colorées en télédétection) qui va nous aider à digitaliser une zone d’entraînement, i.e. un polygone, représentative de chaque classe (Fig. 368).
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Fig. 368 Zones d’entraînement des 3 classes. À gauche la composition colorée qui nous sert d’aide d’identification visuelle. À droite, les polygones d’entraînement superposées à chaque bande individuellement.



Une fois les polygones d’entraînement créés, l’algorithme calcule les valeurs de réflectances moyennes dans chaque bande spectrale. Un barycentre est ainsi calculé pour chaque classe. Nous détaillons sur la figure suivante le principe de construction de ce barycentre en prenant en compte seulement la bande du Bleu et du PIR pour des raisons de représentation (Fig. 369).
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Fig. 369 Placement des pixels de chaque classe (Classe 1 : Eau, Classe 2 : Végétation, Classe 3 : Bâti.) dans l’espace représenté par les bandes Bleu et PIR (A). Calcul des barycentres de chaque classe (B).



Sur la figure précédente (Fig. 369), chaque pixel de chaque classe a été replacé dans le repère cartésien formé des axes de la bande Bleu, en ordonnée, et de la bande du PIR, en abscisse. La figure est bien sûr simplifiée et les caractéristiques radiométriques de chaque classe sont exacerbées. En bleu, nous retrouvons les pixels de la classe 1. Il y a 9 pixels, ce qui signifie que dans notre exemple, la zone d’entraînement de l’eau recouvre 9 pixels de l’image. Pour chacun de ces 9 pixels, leurs valeurs dans les bandes du Bleu et du PIR sont relevées ce qui permet de replacer ces pixels dans le repère Bleu - PIR (Fig. 369 A). Par exemple, le pixel noté p1 a une valeur de réflectance dans le PIR de 0.02 et dans le Bleu de 0.1. Une fois tous les pixels placés, les barycentres de chaque classe sont calculés (Fig. 369 B). Ce sont maintenant ces barycentres qui vont résumer les classes.

Ces barycentres sont caractérisés par des coordonnées sur les deux axes radiométriques (Fig. 370 A). Pour classifier un pixel quelconque P, l’algorithme va commencer par relever les valeurs de réflectance de ce pixel et le replacer dans le repère contenant les barycentres (Fig. 370 A). Ce pixel va également être caractérisé par deux coordonnées (Xp, Yp).
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Fig. 370 Les coordonnées de chaque barycentre et du pixel à classifier dans le repère Bleu - PIR (A) et calcul de chaque distance euclidienne (B).



Le but est maintenant de calculer les distances séparant ce pixel à chacun des barycentres. Attention, il ne s’agît pas de distances métriques mais de distances radiométriques, calculées dans notre repère formé des bandes Bleu et PIR (Fig. 370 B). Ces distances sont des distances euclidiennes et se calculent donc facilement selon la formule dédiée. Par exemple pour calculer la distance d1 séparant notre pixel P à classifier du barycentre de la classe 1, l’algorithme utilise la formule suivante.


\[d1 = \sqrt{(Xp-X_1)^2+(Yp-Y_1)^2}\]

Une fois toutes les distances calculées, le pixel P est attribué à la classe dont le barycentre est le plus proche. C’est-à-dire à la classe pour laquelle la distance est minimale. Dans notre exemple, P sera attribué à la classe 3, à savoir le bâti.

Pour faciliter l’explication, nous avons considéré un espace à 2 dimensions formées par les bandes du Bleu et du PIR, mais le principe est généralisable à un espace à n dimensions formées de n bandes. Il ne sera juste plus possible de le représenter graphiquement. Ainsi, dans notre cas initial où nous faisons une classification en se basant sur 4 bandes spectrales, chaque barycentre de classe sera repéré selon 4 coordonnées. Le barycentre de la classe 1 aura les coordonnées suivantes (X1, Y1, Z1, T1), où X sera la réflectance de ce barycentre dans la bande du Bleu, Y, dans la bande du Vert, Z dans la bande du Rouge et T dans la bande du PIR. De même un pixel à classifier P sera repéré par (Xp, Yp, Zp, Tp). La distance radiométrique de P au barycentre de la classe 1 sera donc la suivante.


\[d1 = \sqrt{(Xp-X_1)^2+(Yp-Y_1)^2+(Zp-Z_1)^2+(Tp-T_1)^2}\]

Chaque distance sera calculée de cette façon, et le pixel sera attribué à la classe du barycentre le plus proche.

La classification par distance minimale peut se faire à l’aide du module SCP de QGIS. Elle y est connue sous le nom de Plus proche voisin. Le processus est décrit dans la partie dédiée (Classification supervisée d’images satellites dans QGIS avec SCP).




Création des couches d’entraînement et de validation

Version de QGIS : 3.18.1

Toute classification supervisée d’images satellites nécessite une couche d’entraînement. Cette couche d’entraînement est une couche vecteur de type polygones où chaque polygone est représentatif d’une classe. Les polygones doivent être suffisamment grands pour prendre en compte l’hétérogénéité de chaque classe mais suffisamment homogènes pour ne représenter qu’une classe.


Avertissement

Le module SCP a une procédure de digitalisation de couche d’entraînement propre. Si vous utilisez ce module, cette section n’est pas utile, rendez-vous directement ici : Classification supervisée d’images satellites dans QGIS avec SCP.




Définition des classes

Le principe général est de commencer par définir les classes souhaitées au final, par exemple zone arborée, eau, sol nu, bâti… Une fois ces classes définies, nous repérons visuellement sur l’image satellite des ensembles de pixels représentatifs de ces classes. Nous pouvons nous servir des compositions colorées pour mieux identifier ces groupes de pixels. Ensuite, nous créons une couche vecteur de type polygones et nous digitalisons manuellement des polygones représentatifs de ces classes. Ces polygones sont parfois connues sous le nom de ROI pour Region Of Interest. Pour chaque classe, nous devons associer plusieurs polygones afin de nous assurer de la représentativité des polygones. Au final, c’est cette couche vecteur qui servira d’entraînement à la classification supervisée.

Dans l’exemple présenté ici, nous allons digitaliser une couche d’entraînement en 7 classes pour classifier une image Landsat TM du Caire prise le 13 juillet 2011. Les 7 classes sont présentées dans le tableau suivant.


Tableau 21 Classification visée





	ID classe

	Label classe





	1

	Eau



	2

	Végétation inondée



	3

	Végétation dense



	4

	Sol nu sableux



	5

	Sol nu rocheux



	6

	Bâti dense



	7

	Bâti diffus






Chaque classe doit être identifiée par un identifiant au format Entier (Integer). En effet, les algorithmes de classification ne travaillent que sur des données numériques. Le label textuel est simplement là pour rendre les classes plus facilement identifiables par l’utilisateur.

La première chose à faire est de repérer sur l’images des zones représentatives de ces classes (Fig. 371). Une composition colorée peut nous aider (Composition colorée avec QGIS).


[image: alternate text]

Fig. 371 Repérage de zones représentatives de chaque classe.





Couche d’entraînement


Création de la couche

La digitalisation peut se faire avec QGIS (Digitalisation), ce que nous ferons ici. Nous commençons par créer et paramétrer la couche vecteur. Nous allons dans le menu Couche ‣ Créer une couche ‣ Nouvelle couche GeoPackage… Le menu de création de couche apparaît (Fig. 372).


[image: alternate text]

Fig. 372 Initialisation de la couche d’entraînement.



À la ligne Base de données, nous indiquons le chemin et le nom de la couche que nous allons créer, ici train_7.gpkg. Le Nom de la table se remplit automatiquement mais nous pouvons le changer si nous le souhaitons. Pour le Type de géométrie nous spécifions Polygone. Ensuite il faut bien faire attention de définir le SCR de cette couche d’entraînement correctement. Le SCR doit être le même que celui de l’image satellite à classifier. Ici, notre image est en WGS84 / UTM Zone 36 N (EPSG 32636). Le SCR est modifiable en cliquant sur l’icône adjacente [image: icone_SCR]. Dans le panneau Nouveau champ, nous ajoutons deux champs. Nous nommons le premier id_classe de type Nombre entier et le second label_classe de type Donnée texte. Puis nous cliquons sur OK. Notre nouvelle couche, vide pour le moment, apparaît bien dans le panneau des couches.



Définition d’un formulaire

Avant de créer nos polygones d’entraînement nous allons définir un formulaire qui va nous faciliter la création de nos polygones. Cette étape n’est pas indispensable, vous pouvez la passer et vous rendre ici Digitalisation des polygones si vous le désirez. Dans le panneau des couches, nous faisons un clic droit sur notre couche d’entraînement et allons dans Propriétés ‣ Formulaire d’attributs. Le menu du formulaire s’ouvre (Fig. 373).


[image: alternate text]

Fig. 373 Définition d’un formulaire de saisie.



Dans le panneau Contrôles disponibles, nous sélectionnons le champ id_classe pour lui adjoindre un formulaire. Une fois ce champ sélectionné, il est alors surligné en bleu, dans le panneau Général, nous cochons la case Éditable et Réutiliser la dernière valeur saisie. Dans le panneau Type d'outils, dans le menu déroulant nous choisissons Liste de valeurs. Ainsi, nous n’aurons pas à entrer à la main les identifiants des classes mais nous les choisirons parmi une liste de valeurs. Cela nous évitera les fautes de frappe. Dans la zone d’édition qui suit nous ajoutons à la colonne Valeur 7 lignes avec des valeurs de 1 à 7. Enfin, dans le panneau Contraintes nous cochons la case Non nul pour préciser que cette colonne d’identifiant doit obligatoirement être renseignée.

Nous procédons ensuite de même pour le champ label_classe en le sélectionnant dans le panneau Contrôles disponibles. Nous cochons la case Éditable et Réutiliser la dernière valeur saisie. Nous sélectionnons encore Liste de valeurs et nous remplissons les valeurs que peuvent prendre ce champ. Ici ce ne sont plus des identifiants de 1 à 7 mais les labels textuels des classes (Fig. 374). Puis nous cochons aussi la case Non nul. Nous pouvons maintenant passer à la digitalisation proprement dite.


[image: alternate text]

Fig. 374 Définition d’un formulaire de saisie pour les labels de classes.





Digitalisation des polygones

Nous allons commencer par digitaliser un premier polygone représentatif de la classe Eau. Nous zoomons quelque part sur le Nil, nous sélectionnons notre couche d’entraînement dans le panneau des couches et nous la rendons éditable en cliquant sur l’icône Basculer en mode édition [image: icone_edition] dans la barre d’outils de digitalisation. Nous sélectionnons ensuite l’outil de création d’entités en cliquant sur l’icône Ajouter une entité polygonale [image: icone_entite]. Le curseur devient alors une sorte de cible. Il suffit alors de digitaliser notre polygone d’entraînement par une série de clics gauches terminés par un clic droit pour fermer le polygone. Une fenêtre s’ouvre pour remplir les champs associés à cette entité. Comme nous avons défini un formulaire, il nous propose les premières valeurs des listes définies, à savoir 1 pour le champ id_classe et Eau pour le champ label_classe (Fig. 375). Comme nous venons de digitaliser un polygone d’eau nous laissons ces valeurs.


[image: alternate text]

Fig. 375 Digitalisation d’un polygone d”Eau et formulaire de remplissage des champs associés.



Nous recommençons la manipulation pour avoir 4 autres polygones représentatifs de cette classe Eau. Comme le formulaire a été réglé à Réutiliser les dernières valeurs saisies, les identifiant et label de la classe Eau sont automatiquement proposés.


Note

Pensez à régulièrement enregistrer votre couche en cliquant sur l’icône Enregistrer les modifications de la couche [image: icone_enregistrer].



Nous procédons ensuite de même pour les 6 autres classes : végétation inondée, végétation dense, sol nu sableux, sol nu rocheux, bâti dense et bâti diffus. Nous pouvons digitaliser 5 polygones par classe (Fig. 376). Notez que l’intérêt du formulaire qui nous facilite la tâche de remplissage de la table attributaire. Il faut simplement avoir bien en tête les identifiants numériques de chaque classe. Lorsque tous les polygones sont digitalisés, nous quittons le mode édition de la couche en recliquant sur l’icône d’édition [image: icone_edition].
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Fig. 376 Polygones d’entraînement des différentes classes.






Couche de validation

Les classifications supervisées doivent toujours être accompagnées d’une validation, autrement dit d’un ensemble d’indicateurs numériques renseignant sur la qualité de la classification. Ce calcul de qualité fait intervenir une couche dite de validation. Finalement cette couche est en tous points semblable à la couche d’entraînement avec des polygones représentatifs de chaque classe. La seule différence est que les polygones ne sont pas digitalisés aux mêmes endroits. Dans notre cas nous pouvons nommer cette couche valid_7.gpkg. Nous ne sommes pas obligés de digitaliser autant de polygones, nous pouvons nous contenter de 3 polygones par classe. Pour les aspects pratiques liés à la digitalisation, se référer à la section dédiée : Digitalisation des polygones.


Note

Combien de polygones de contrôle soit-on digitaliser pour chaque classe ? Il n’y a pas vraiment de réponse absolue. Il en faut plusieurs… Trois, cinq, plus, selon l’utilisateur. Ici, nous en prendrons trois par classe. Certains auteurs proposent des méthodes rigoureuses pour choisir ce nombre (Olofsson et al., 2014 [https://www.sciencedirect.com/science/article/pii/S0034425714000704?casa_token=mL5aoRrPE2wAAAAA:kzgBOAnITLvBYpQf71_cLdBn2RFO8JbPRQuOThzFa0Tbdsas-Of1ZHtPu_iKCxoZ7gC3S00wij4] par exemple).



Il est important de digitaliser les polygones de contrôle non pas en se basant sur le raster de classification, ce qui serait un non sens méthodologique mais en se basant sur une interprétation visuelle d’une composition colorée (Fig. 377) ou sur l’interprétation d’une image à plus haute définition.
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Fig. 377 Un polygone de validation de Bâti diffus et la table attributaire associée.






Classification supervisée d’images satellites dans QGIS avec SCP

Version de QGIS : 3.24.1

Version de SCP : 7.10.6

Dans cette partie nous allons voir comment effecteur une classification supervisée d’images satellites en utilisant le module SCP (Semi-Automatic Classification Plugin) de QGIS. Comme dit dans la partie de présentation des outils, ce module propose de très riches fonctionnalités de classification et de traitements liés à ces classifications.

Ici, nous allons prendre l’exemple d’une classification de l’occupation du sol de la région du Caire [https://www.openstreetmap.org/search?query=caire#map=8/30.045/31.805] en Égypte à partir d’une image Landsat 5 TM du 13 juillet 2011.


Avertissement

Le module SCP évolue très vite, de nouvelles mises à jour sont distribuées régulièrement. Lors de ces mises à jour, les fonctionnalités évoluent et l’interface également. La trame général de ce qui est présenté ici ne devrait pas changer mais les détails, notamment les endroits où cliquer et le nom des menus peut évoluer.




Définition du jeu de bandes à classifier

Toute classification s’appuie sur un, ou plus souvent plusieurs rasters à classifier. Ces rasters sont souvent des bandes spectrales mais peuvent également être des indices radiométriques comme des NDVI ou autres. Ici, nous souhaitons classifier les bandes 1, 2, 3, 4, 5 et 7 d’une image Landsat TM afin d’en dériver une occupation du sol. La première chose à faire est de charger ces bandes dans QGIS.

Une fois ces bandes chargées, nous spécifions à SCP que ce sont ces bandes que nous souhaitons classifier. En terminologie SCP, nous allons définir ces bandes comme étant le Jeu de bandes (Band set) à classifier. Pour cela, nous allons dans le menu SCP ‣ Jeu de bandes. La fenêtre suivante apparaît (Fig. 378).


[image: alternate text]

Fig. 378 Définition du jeu de bandes dans SCP.



En premier lieu, nous listons la liste des bandes chargées dans QGIS dans le panneau Liste des bandes en cliquant sur l’icône [image: icone_refresh]. Une fois les bandes listées, nous sélectionnons celles à ajouter à notre jeu de bandes. Ici nous sélectionnons donc toutes nos bandes. Nous les ajoutons à notre jeu de bandes en cliquant sur l’icône [image: icone_add] Les bandes apparaissent maintenant dans le panneau Détail du jeu de bande comme étant le Band set 1. Il est possible de spécifier à SCP que nous travaillons sur des images Landsat 5 TM, en choisissant ce capteur dans le menu déroulant Paramétrage rapide des longueurs d'onde. Grâce à ça, une longueur d’onde centrale est définie pour chaque bande. Il est ensuite possible de créer un raster virtuel à partir ce jeu de bandes en cochant la case Créer un raster virtuel à partir du jeu de bandes dans le bas de la fenêtre. Ensuite, nous cliquons sur Lancer. Nous spécifions un chemin pour la création du raster virtuel et même si nous avons l’impression que rien ne se passe, notre jeu de bandes est créé.


Note

L’interface de SCP étant touffue, il se peut que le nom des menus n’apparaisse pas en entier, notamment sur un petit écran.



Nous avons maintenant notre jeu de bandes bien défini et un raster virtuel ouvert dans QGIS. À partir de ce raster virtuel, nous pouvons faire une composition colorée en fausses couleurs (PIR, Vert, Bleu) qui va nous permettre de bien identifier visuellement l’occupation du sol.



Définition des classes d’occupation du sol

Comme il s’agît d’une classification supervisée, nous devons au préalable définir quelles occupations du sol nous souhaitons obtenir à partir de cette image. Cette étape se fait en fonction de notre problématique, de notre connaissance du terrain et de l’observation de l’image.

Il est à noter que SCP oblige l’utilisateur à définir deux niveaux de classification. Un niveau méta-classe et un niveau classe. Une méta-classe est par exemple Végétation qui regrouperait des classes comme Forêt de feuillus, Forêts de conifères, Prairies … Ou une méta-classe Bâti subdivisée en classes Bâti dense, Bâti diffus, Routes … Si nous ne souhaitons pas de hiérarchie il suffit de ne mettre qu’une seule classe par méta-classe.

Chaque méta-classe et chaque classe posséderont un label ainsi qu’un identifiant numérique entier. L’identifiant de type entier est obligatoire car c’est sur celui-ci que l’algorithme de classification va travailler. Dans notre exemple, nous allons classifier notre image comme présenté dans le tableau suivant.


Tableau 22 Classification visée







	ID méta-classe

	Label méta-classe

	ID classe

	Label classe





	1

	Eau

	1

	Eau



	2

	Végétation

	2

	Végétation inondée



	2

	Végétation

	3

	Végétation dense



	3

	Sol nu

	4

	Sol nu sableux



	3

	Sol nu

	5

	Sol nu rocheux



	4

	Bâti

	6

	Bâti dense



	4

	Bâti

	7

	Bâti diffus






Nous aurons ainsi 4 méta-classes subdivisées en 7 classes. Seule la méta-classe Eau ne sera pas subdivisée. Une fois cette liste effectuée, il faut repérer visuellement sur l’image des zones représentatives de chacune de ces classes (Fig. 379).
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Fig. 379 Repérage de zones représentatives de chaque classe.





Digitalisation des polygones d’apprentissage

Comme toute classification supervisée, il nous faut délimiter des polygones d’apprentissage correspondant aux classes souhaitées. Pour chaque classe nous allons digitaliser trois polygones représentatifs. Dans un processus de classification supervisée, ces polygones sont souvent connus sous l’acronyme anglais de ROI pour Region Of Interest (Région d’Intérêt).


Note

Combien de polygones d’apprentissage faut-il digitaliser pour chaque classe ? Il n’y a pas de réponse absolue, entre 3 et plus selon votre zone d’étude.



Avant de digitaliser notre premier ROI (nous commençons par la classe Eau par exemple), nous indiquons à SCP un chemin et un nom sous lequel nous allons sauver notre couches de polygones d’apprentissage. Pour cela, nous nous plaçons dans le panneau SCP situé en bas à gauche de l’écran de QGIS et nous cliquons sur Créer une nouvelle donnée d'entraînement [image: icone_new_data] dans l’onglet Entrée données d’entraînement. Nous pouvons nommer ce fichier train_2011. Ce fichier sera sauvé au format .scp, propre à ce module. Le chemin se met à jour dans le champ correspondant (Fig. 380).


Avertissement

Dans SCP la création des polygones d’apprentissage est extrêmement procédurière. Il faut bien s’imprégner des étapes.



Nous devons ensuite indiquer à SCP que nous allons digitaliser la classe Eau qui se trouve dans la méta-classe Eau. Pour cela, toujours dans le panneau SCP, nous allons dans l’onglet Entrée données d’entraînement. Nous spécifions, dans le bas du panneau, que nous allons digitaliser un ROI appartenant à la méta-classe 1 (MC ID 1) dont le label est Eau (Nom de MC Eau) et qui sera plus précisément représentatif de la classe 1 (C ID 1) dont le label est Eau (Nom de C Eau) (Fig. 380).


[image: alternate text]

Fig. 380 Définition de la méta-classe et de la classe à digitaliser.



Dans SCP, il existe deux façons de digitaliser des ROI. La première est classique et se fait manuellement. Nous zoomons fortement sur une zone en eau et nous sélectionnons l’outil Create a ROI polygon [image: icone_ROI] qui se trouve dans la SCP Working Toolbar. Une fois cet outil sélectionné, le curseur se change en croix. Au-dessus du curseur, la valeur de NDVI du pixel sous-jacent s’affiche. Nous allons digitaliser un polygone représentatif de l’eau. Ce polygone doit être suffisamment petit pour être homogène mais suffisamment grand pour rassembler une certaine quantité de pixels (quelques dizaines). La digitalisation se fait classiquement par une série de clics gauches suivie d’un clic droit pour fermer le polygone (Fig. 381).
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Fig. 381 ROI manuel pour la classe Eau.




Astuce

Si le polygone n’est pas satisfaisant, il est possible de l’annuler complètement en faisant Ctrl + z.



Une fois ce polygone digitalisé, il est nécessaire de l’enregistrer en cliquant sur l’icône [image: icone_save_ROI] qui se trouve en bas à droite du panneau SCP. Deux nouvelles lignes apparaissent dans le panneau. Une pour la méta-classe, en gras, et une pour la classe (Fig. 382). Nous pouvons changer la couleur de la méta-classe et de la classe en double cliquant sur l’applat coloré.
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Fig. 382 Mise à jour des classes dans le panneau SCP.



Nous allons maintenant digitaliser un deuxième polygone pour la classe Eau, mais de façon automatique. Nous zoomons sur une autre zone en eau. Avant la digitalisation, il faut s’assurer que nous sommes toujours dans la méta-classe Eau et que l’identifiant de classe a été incrémenté (Fig. 383).


Avertissement

À ce niveau, même si nous digitalisons un polygone appartenant à la même classe, il faut lui mettre un identifiant différent. Nous ferons une fusion des polygones plus tard.
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Fig. 383 Classe incrémentée.



Pour capturer un ROI automatique nous nous servons de l’outil Activate ROI pointer [image: icone_ROI_auto] de la SCP Working Toolbar. Le curseur se remet en croix et il suffit de cliquer sur un pixel représentatif de notre zone. Les pixels similaires les plus proches seront automatiquement capturés (Fig. 384). Il est possible de régler la distance minimale et maximale de ce ROI automatique ainsi que du niveau d’hétérogénéité autorisée au sein du ROI. Ce réglage se fait avec les champs numériques Dist, Min et Max de la même barre d’outils.
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Fig. 384 Création automatique de ROI pour la classe Eau.



Une fois ce ROI automatique créé, nous l’enregistrons comme précédemment. Une troisième ligne apparaît dans le panneau SCP. Nous recommençons la manipulation pour un troisième polygone d’eau pris ailleurs sur l’image.

À ce stade, nous disposons de 4 lignes dans le panneau SCP, une pour la méta-classe et 3 pour les 3 polygones d’eau. La prochaine étape va être de fusionner les signatures spectrales de nos 3 polygones d’eau afin d’obtenir une signature spectrale moyenne de la classe Eau. Avant cette fusion, nous pouvons vérifier que nos trois polygones sont bien similaires d’un point de vue radiométrique. SCP propose un outil simple pour tracer les signatures spectrales de ces polygones. Nous sélectionnons les 3 lignes correspondantes à nos 3 polygones dans le panneau SCP et nous cliquons sur l’icône [image: icone_ajout_signatures] Ajouter les signatures spectrales surlignées au graphique (Fig. 385).
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Fig. 385 Calcul des signatures spectrales des polygones sélectionnés.



Les signatures spectrales apparaissent dans une nouvelle fenêtre (Fig. 386). Sur ce graphique, nous retrouvons autant de lignes que de polygones sélectionnés. En abscisse nous avons les longueurs d’ondes et en ordonnées les niveaux d’énergies réfléchies. Les lignes verticales pointillées correspondent aux bandes spectrales du jeu de bandes, ici ce sont donc les bandes Landsat TM. Pour chaque signature est indiquée son enveloppe min - max. Ici, nous souhaitons avoir des polygones représentatifs d’une seule classe ; nous souhaitons donc que nos signatures soient le plus proches possibles (ce qui est bien le cas).
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Fig. 386 Signatures spectrales des polygones sélectionnés.




Note

Les signatures spectrales sont calculées sur les bandes spectrales définies dans le Jeu de bandes.



Si nous sommes satisfaits de nos signatures nous pouvons maintenant les fusionner afin d’obtenir une signature moyenne (représentative) de notre classe Eau. Pour cela nous sélectionnons nos 3 lignes à fusionner (dans le Menu SCP dans la fenêtre principal de QGIS) et nous sélectionnons l’outil Fusionner les signatures spectrales surlignées [image: icone_fusion]. Une quatrième ligne intitulée merged_eau est apparue. Nous pouvons maintenant supprimer les 3 lignes initiales et ne considérer que la signature issue de la fusion. Pour effectuer cette suppression, nous sélectionnons les 3 lignes à supprimer et nous cliquons sur Supprimer les éléments surlignés [image: icone_suppr]. Nous pouvons changer la couleur de cette classe fusionnée (Fig. 387).
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Fig. 387 La seconde ligne correspond à la signature fusionnée. Remarquez bien son identifiant à 1 et son label Eau.



Nous pouvons maintenant passer à la digitalisation des ROI de la deuxième méta-classe Végétation, en commençant par la classe Végétation inondée. Nous commençons par définir dans le panneau SCP une méta-classe 2 ayant pour label Végétation et une classe 2 avec pour label Végétation inondée (Fig. 388).
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Fig. 388 Définition de la deuxième méta-classe et de sa première classe.



Nous digitalisons ensuite manuellement ou automatiquement les 3 polygones d’apprentissage de la classe Végétation inondée de la même manière qu’effectuée pour la classe Eau. Puis nous répétons l’opération pour la seconde classe de végétation (Végétation dense) puis pour toutes les autres méta-classes et classes (Fig. 389).


Avertissement

Pensez bien à enregistrer le polygone après chaque digitalisation de polygone en cliquant sur l’icône [image: icone_save_ROI].
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Fig. 389 Exemple de ROI pour les autres classes.




Avertissement

Attention de bien définir chaque nouvelle méta-classe à chaque fois qu’on s’attaque à une nouvelle méta-classe et à bien régler à postériori les identifiants et labels de classes issues des fusions de signatures.



À ce stade nous disposons de polygones d’apprentissage pour chacune de nos classes (Fig. 390).
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Fig. 390 ROI finaux.





Contrôle des polygones d’apprentissage

Avec SCP il est possible tracer les signatures spectrales de toutes ces classes afin de vérifier qu’elles s’individualisent bien les unes des autres. Nous sélectionnons les classes à tracer dans le panneau SCP et nous cliquons sur l’icône Ajouter les signatures spectrales au graphique [image: icone_graph] (Fig. 391).


[image: alternate text]

Fig. 391 Signatures spectrales des ROI.



Nous retrouvons les signatures spectrales de nos 7 classes, les couleurs sont les mêmes que celles définies dans le panneau SCP. Les lignes pointillées correspondent aux bandes Landsat TM. Par exemple, pour la classe Eau, nous retrouvons bien la signature typique de l’eau avec un léger pic dans le domaine du Bleu et une forte décroissance jusqu’à des valeurs quasi nulles dans l’infrarouge. De même, la végétation présente bien le pic caractéristique dans le proche infrarouge. Nous pouvons constater que les signatures spectrales des deux classes de sol nu sont très proches, il y a donc un fort risque de confusion entre ces deux classes dans la classification finale.

Il est possible de quantifier la séparabilité des classes via l’outil Calculer les distances spectrales [image: icone_spec_dist] qui se trouve sur la partie droite de la fenêtre des graphiques. Les similarités entre classes sont calculées selon quatre critères différents. Pour des détails sur ces critères, se référer à la documentation du module SCP [https://semiautomaticclassificationmanual-v4.readthedocs.io/en/latest/remote_sensing.html#spectral-distance-definition]. Les distances spectrales sont calculées pour tous les couples de classes possibles. Lorsqu’une métrique indique une similarité entre deux classes, cette métrique est affichée en rouge (Fig. 392).


[image: alternate text]

Fig. 392 Distances spectrales entre la classe Eau et Végétation dense (en haut) ; entre la classe Sol nu sableux et Sol nu rocheux (en bas).



Par exemple, les classes Eau et Végétation dense sont bien séparées. Par contre, les deux classes de sol nu sont très semblables. Elles seront donc probablement confondues lors du processus de classification.



Classification standard

Une fois satisfaits de nos polygones d’apprentissage, nous pouvons lancer le processus de classification proprement dit. Pour cela nous allons dans le menu SCP ‣ Traitement de bandes ‣ Classification. Le menu suivant apparaît (Fig. 393).
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Fig. 393 Paramétrage de la classification.



Dans le panneau Classification nous spécifions le jeu de bandes à classifier, ici le 1. Nous indiquons si nous souhaitons effectuer la classification sur les méta-classes seulement ou sur les classes. Nous testerons les deux. Dans le panneau Algorithme nous choisissons un algorithme de classification. Le Plus proche voisin est couramment employé. Les autres paramètres peuvent conserver leurs valeurs par défaut. Le processus se lance en cliquant sur Lancer. Il faut spécifier un chemin et un nom pour le raster de classification qui sera créé. Nous pouvons noter que le raster produit respecte la symbologie définie par l’utilisateur au moment de la création des ROI (Fig. 394). Un fichier de style .qml accompagne le raster créé.


Astuce

Avant de lancer la classification sur toute l’image, il est possible de créer des aperçus sur différentes sous parties de l’image. Il suffit d’utiliser l’outil Activate classification preview pointer [image: icone_preview] de la SCP Working Toolbar. Une fois l’outil sélectionné, le curseur se change en croix et un aperçu de classification se fait au moment du clic sur un carré de 200 pixels de côté. Le réglage de cette valeur est possible sur cette même barre d’outils. Il est possible d’enchaîner les aperçus, ce qui est pratique pour vérifier à priori le comportement de la classification sur les zones qui nous paraissent « compliquées ».
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Fig. 394 Classification en méta-classe (gauche) et en classes (droite).



Comme vu au moment du calcul des distances spectrales, les classes de sol nu sont probablement en partie confondues et la classe d’urbain diffus est plus importante qu’en réalité. Elle déborde sur le Sol nu sableux. La figure suivante compare la même classification mais effectuée selon les trois algorithmes proposés. Celui utilisant le Spectral Angle Mapping semble moins faire déborder l’urbain diffus sur le sol nu sableux, alors que le Maximum de Vraisemblance, au contraire, le fait déborder encore plus (Fig. 395).
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Fig. 395 Paramétrage de la classification.



C’est ensuite à l’utilisateur de tenter d’améliorer la classification en incluant plus de polygones d’apprentissage, notamment dans les zones qui semblent conflictuelles. Ou au contraire, en dégradant la classification en supprimant certaines classes qui seraient trop compliquées à individualiser.




Classification supervisée d’images satellites avec OTB

Version de OTB : 9.0.0

Orfeo ToolBox (OTB Orfeo ToolBox) propose des outils pour effectuer des classifications supervisées d’images satellites. La procédure avec OTB se passe en deux temps, d’abord une phase d’apprentissage basée sur des régions d’intérêts puis une phase d’application du modèle. Ces deux temps s’effectuent avec deux modules différents : trainImagesClassifier et ImageClassifier.

Dans cette section, nous prendrons le même exemple que pour la classification supervisée avec SCP, à savoir classifier une image Landsat TM du Caire prise le 13 juillet 2011. Seules les bandes 1 à 5 seront employées. Concrètement nous travaillerons sur un raster multi-bandes (Raster multi-bandes en dur (natif)) contenant les bandes 1 à 5. Nous ferons une classification en 7 classes comme expliqué précédemment : Définition des classes.


Couches d’apprentissage et de validation

Le première étape est de digitaliser une couche d’apprentissage de type polygones ainsi qu’une couche de validation de type polygones également. Les procédures de création de ces deux couches sont décrites dans les sections consacrées : Création des couches d’entraînement et de validation et Couche de validation.



Échantillonnage de la couche d’apprentissage

Orfeo ToolBox propose un ensemble de prétraitements qui permettent de définir finement la stratégie d’échantillonnage pour l’apprentissage. Concrètement, pour certaines classes les polygones d’apprentissage sont grands et contiennent donc beaucoup de pixels et d’autres classes sont représentées par de petits polygones contenant peu de pixels. Le déséquilibre des pixels d’apprentissage selon les classes peut avoir des répercussions sur le résultat final de la classification. OTB propose donc différentes techniques pour prendre en compte ce phénomène : prendre tous les pixels possibles, prendre le même nombre de pixels pour chaque classe, prendre une certaine proportion de pixels … Ces prétraitements ont également l’avantage d’extraire dans une table les signatures radiométriques de chaque échantillon d’apprentissage.


Avertissement

Cette phase de prétraitements n’est pas obligatoire, si vous êtes pressés, allez directement à la partie consacrée à l’apprentissage du modèle de classification : Apprentissage du modèle.




Statistiques par polygone

La première étape est de compter le nombre de pixels que représentent l’ensemble des polygones d’apprentissage pour chaque classe. Le module dédié se nomme PolygonClassStatistics (Boîte à outils de traitements ‣ OTB ‣ Learning ‣ PolygonClassStatistics (Fig. 396).
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Fig. 396 Calcul des statistiques des polygones d’apprentissage.




Note

La couche d’apprentissage ne doit pas forcément être de type polygones, elle peut être de type points ou lignes.



À la ligne Input image nous sélectionnons le raster à classifier, ici le raster multi-bandes contenant les 5 bandes spectrales Landsat à utiliser pour la classification stack_Le_Caire_20110713.tif. À la ligne Input vectors nous renseignons la couche vecteur d’apprentissage train_7.gpkg. Dans le panneau Field Name, nous sélectionnons le nom du champ qui contient les identifiants numériques des classes id_classe. À la ligne Output XML statistics file nous indiquons un chemin et un nom pour le fichier XML qui contiendra les statistiques, nous pouvons le nommer train_7_stats.xml, puis nous cliquons sur Exécuter.


Avertissement

Il est nécessaire de préciser l’extension .xml dans le nom du fichier XML qui sera produit.




Astuce

Il est possible d’indiquer un masque pour cacher les portions du raster à ne pas prendre en compte, à la ligne Input validity mask.



Nous disposons maintenant d’un fichier XML contenant les statistiques du nombre de pixels disponibles pour l’apprentissage et pour chaque classe. Nous pouvons l’ouvrir avec un éditeur de texte (Fig. 397).
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Fig. 397 Statistiques des polygones d’apprentissage.



Ce fichier renseigne sur le nombre de pixels que représentent chaque polygone d’apprentissage. Par exemple, pour la classe 1 (Eau) l’ensemble des polygones d’apprentissage représentent 2625 pixels. Cela signifie que l’apprentissage de l’eau peut se faire sur 2625 pixels au maximum. Par contre, les polygones d’apprentissage de la classe 2 (Végétation inondée) représentent 11489 pixels, ce qui est beaucoup plus. C’est ce déséquilibre que se propose de traiter l’ensemble de ces prétraitements.

La seconde partie du fichier XML renseigne sur le nombre de pixels de chaque polygone individuellement. Nous retrouvons bien 35 lignes, une par polygone d’apprentissage. Par exemple le polygone key= »10 » est constitué de 2418 pixels alors que celui key= »14 » n’est constitué que de 43 pixels.



Sélection des échantillons d’apprentissage

Maintenant que nous connaissons le nombre de pixels d’apprentissage disponibles pour chaque classe, nous pouvons adopter une stratégie de sélection de ces échantillons afin de rétablir (ou non) l’équilibre entre les classes. Le module dédié se nomme sampleSelection (Fig. 398). Six différentes stratégies d’échantillonnage sont proposées :


	Constant strategy : toutes les classes seront échantillonnées avec le même nombre d’échantillons (i.e. de pixels), défini par l’utilisateur.


	Smallest class strategy : la classe avec le moins de pixels disponibles sera totalement échantillonnée (tous ces pixels seront pris en compte) et ce même nombre de pixels sera adopté pour échantillonner toutes les autres classes.


	Percent strategy : toutes les classes seront échantillonnées selon un même pourcentage de pixels défini par l’utilisateur.


	Total strategy : un nombre total de pixels sera défini par l’utilisateur puis distribué proportionnellement entre toutes les classes.


	Take all strategy : tous les pixels sont sélectionnés pour toutes les classes.


	By class strategy : chaque classe est échantillonnée selon un nombre fixé par l’utilisateur (défini dans un fichier csv annexe).




De plus, dans chacun des polygones, il est possible de régler la stratégie d’échantillonnage spatial. Si seulement 10 % des pixels sont échantillonnés pour un polygone, il est possible de spécifier comment choisir ces 10 %. Les deux stratégies d’échantillonnage spatial sont :


	Random : les pixels sont sélectionnés aléatoirement au sein des polygones.


	Periodic : les pixels sont sélectionnés de façon régulière.




La stratégie d’échantillonnage se règle via le module sampleSelection qui se trouve dans la (Boîte à outils de traitements ‣ OTB ‣ Learning ‣ sampleSelection (Fig. 398).
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Fig. 398 Stratégie d’échantillonnage des pixels d’apprentissage.



À la ligne InputImage, nous indiquons le raster multi-bandes qui servira à la classification. Il s’agît du raster à classifier stack_Le_Caire_20110713.tif. À la ligne Input vectors, nous indiquons le fichier vecteur de polygones d’apprentissage train_7.gpkg. À la ligne Input Statistics nous renseignons le fichier de statistiques que nous avons dérivé à l’étape précédente (Statistiques par polygone). Dans le panneau Sampler type nous choisissons une stratégie d’échantillonnage spatial parmi les deux proposées (periodic ou random), pour l’exemple nous prenons le periodic. Dans le panneau Sampling strategy nous choisissons une stratégie d’échantillonnage parmi les six décrites précédemment. Ici, pour l’exemple nous choisissons la Take all strategy (all). Enfin, dans le panneau Field name, nous indiquons le nom du champ qui contient l’identifiant numérique des classes id_classe. À la ligne Output vectors nous indiquons un chemin et un nom pour le fichier vecteur qui contiendra le résultat de l’échantillonnage, nous pouvons le nommer train_7_samples.gpkg. Nous pouvons sortir un fichier csv à la ligne suivante de façon facultative si nous souhaitons regarder en détails la stratégie d’échantillonnage employée. Puis nous cliquons sur Exécuter.


Avertissement

Il est nécessaire de préciser l’extension .gpkg (ou .shp) dans le nom du fichier vecteur qui sera produit à la ligne Output vectors.



Nous disposons maintenant d’une nouvelle couche vecteur de type Points nommée train_7_samples.gpkg. Nous pouvons ouvrir cette couche dans QGIS afin de voir à quoi elle correspond concrètement. Si nous zoomons sur un groupe de points nous constatons bien que ce groupe de points correspond à un polygone d’apprentissage (Fig. 399).
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Fig. 399 Comparaison de deux stratégies d’échantillonnage : Take all strategy (A) et Percent strategy avec pourcentage fixé à 50 % et un échantillonnage spatial réglé à Periodic (B).



Sur la figure précédente (Fig. 399), la figure A présente le résultat de la stratégie que nous avons détaillée plus haut. Nous pouvons la comparer à la figure B qui correspond à une stratégie où nous aurions choisi de ne prendre que 50 % des pixels de chaque polygone et de les sélectionner de façon à n’en prendre qu’un sur deux.



Récupération des valeurs associées aux échantillons

L’ultime étape de ce prétraitement est d’associer pour les pixels d’échantillons sélectionnés les valeurs sous-jacentes du raster à classifier. Cela se fait à l’aide du module sampleExtraction (Fig. 400). Ce menu se trouve dans la (Boîte à outils de traitements ‣ OTB ‣ Learning ‣ sampleExtraction. Cette étape est intéressante car elle va nous permettre de tracer les signatures radiométriques de chaque polygone d’apprentissage et les signatures radiométriques moyennes de chaque classe. Nous pourrons ainsi déjà nous rendre compte des classes susceptibles d’être confondues.
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Fig. 400 Extraction des valeurs du raster à classifier au niveau des pixels échantillonnés.



À la ligne InputImage, nous indiquons le raster duquel nous souhaitons relever les valeurs, il s’agît du raster à classifier stack_Le_Caire_20110713.tif. À la ligne Input sampling positions nous pointons vers la couche vecteur de type points contenant les pixels à échantillonner telle que nous l’avons construite à l’étape précédente (Sélection des échantillons d’apprentissage). Dans le menu déroulant Output field names nous choisissons prefix, et à la ligne Output field prefix nous mettons b. Ainsi, les champs dans lesquels nous allons récupérer les valeurs de réflectances seront nommés b0, b1, jusqu’à la dernière bande du raster à classifier. À la ligne Field name nous indiquons le nom du champ qui contient l’identifiant numérique des classes dans la couche d’apprentissage id_classe. Enfin, à la ligne Output samples nous indiquons un chemin et un nom pour la couche vecteur de type points qui correspondra aux pixels échantillonnés auxquels les valeurs du raster sous-jacent auront été associées. Puis nous cliquons sur Exécuter.

Nous disposons maintenant d’une nouvelle couche de points qui est spatialement la même que celle définie à l’étape précédente (Sélection des échantillons d’apprentissage) mais qui contient dans sa table attributaire les valeurs du raster sous-jacent à classifier (Fig. 401).
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Fig. 401 Valeurs des bandes spectrales du raster à classifier sous-jacent aux pixels d’échantillons.



À chaque pixel est associé d’une part son identifiant de classe et son label de classe, et d’autre part les valeurs des bandes spectrales sous-jacentes. Par exemple, le pixel 15609 est labellisé comme étant de la végétation dense et présente des valeurs radiométriques de 0.097, 0.179, 0.375, 0.044, 0.045 et 0.028  respectivement dans les bandes 1 à 6, soient les bandes Bleu à Moyen infrarouge 2, codées ici de b0 à b5.


Note

Le nom des champs reprend l’ordre des couches du raster à classifier. L’utilisateur doit donc bien avoir en tête les correspondances de bandes.



À partir de cette couche il est possible de tracer les signatures radiométriques de chaque polygone ou de chaque classe en exportant la table dans un tableur ou via l’extension Data Plotly de QGIS (Fig. 402).


Note

La couche finale des points correspondant aux pixels des échantillons associées aux valeurs du raster à classifier sera la couche à employer dans la phase d’apprentissage qui vient juste après.
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Fig. 402 Boîtes à moustaches des signatures dans la bande proche infrarouge des échantillons des 7 classes.






Apprentissage du modèle

L’étape suivante est de « faire apprendre » à un modèle à reconnaître les classes identifiées à partir des bandes spectrales, i.e. du raster multi-bandes, à classifier. Pour chaque classe, l’algorithme va extraire une sorte de signature radiométrique moyenne et va apprendre à la reconnaître. Cet apprentissage pourra reposer sur des algorithmes différents comme le Random Forest, le Support Vector Machine, le Boost Classifier … Les fondements théoriques de ces techniques ne seront pas discutés ici.

Pour cet apprentissage nous utilisons le module TrainImagesClassifier de OTB. Ce module se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Learning ‣ TrainImagesClassifier. La fenêtre suivante apparaît (Fig. 403).
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Fig. 403 Paramétrage de la phase d’apprentissage dans OTB.



Dans le panneau Input Image List nous renseignons le raster multi-bandes sur lequel l’algorithme devra apprendre. Ici, il s’agît de notre raster multi-bandes du Caire stack_Le_Caire_20110713.tif contenant les bandes TM 1 à 6. Dans le panneau Input Vector Data List, nous sélectionnons soit directement la couche vecteur qui contient les polygones d’apprentissage à savoir train_7.gpkg ou (encore mieux) la couche des points échantillonnés dans l’étape d’échantillonnage (Échantillonnage de la couche d’apprentissage). Nous pourrions cocher la case Validation Vector Data List et nous y pointer la couche vecteur de validation valid_7.gpkg. L’activation de cette option nous permettrait de « valider » notre classification c’est-à-dire calculer une matrice de confusion qui nous renseignerait sur la qualité de la classification. Mais un autre module de OTB dédié au calcul d’une matrice de confusion sera plus appropriée. À la ligne Output Model, nous indiquons un chemin vers lequel le fichier de modèle sera stocké. Ce fichier sera un simple fichier texte intelligible par OTB. Nous pouvons le nommer model_7_RF.txt. À la ligne Field containing the class integer label for supervision nous renseignons le champ de la couche vecteur d’apprentissage qui contient les identifiants numériques des classes, ici id_classe.


Avertissement

OTB ne travaille qu’avec des rasters multi-bandes en « dur » au format .tif. OTB ne prend pas en entrée les rasters virtuels .vrt.



Enfin, dans le panneau Classifier to use for the training, nous devons choisir un algorithme de classification. Plusieurs choix sont possibles, ici nous pouvons prendre par exemple le Random forests classifier (rf). Les autres paramètres peuvent conserver leurs valeurs par défaut. Nous cliquons pour finir sur Execute.

À l’issue de cette étape, la classification n’est pas encore effectuée, mais un fichier texte a été créé : un modèle, que nous avons nommé model_7_RF.txt. Le fichier de modèle est éditable avec un éditeur texte mais il ne sera pas intelligible pour nous. C’est ce fichier texte de modèle que nous utiliserons dans la seconde étape pour classifier notre image.



Application du modèle

La phase d’application se fait à l’aide du module ImageClassifier disponible dans la Boîte à outils de traitements ‣ OTB ‣ Learning ‣ ImageClassifier. La fenêtre suivante apparaît (Fig. 404).
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Fig. 404 Paramétrage de classification dans OTB.



À la ligne Input image list nous indiquons le raster multi-bandes à classifier, ici stack_Le_Caire_20110713.tif. À la ligne Model file, nous indiquons le fichier texte de modèle à utiliser pour la classification. Il s’agît du fichier de modèle créé à l’étape précédente d’apprentissage, ici model_7_RF.txt. Nous renseignons le chemin et le nom que prendra la classification à la ligne Output Image, nous pouvons la nommer classif_7.tif. Les autres options peuvent conserver leurs valeurs par défaut. Nous cliquons finalement sur Execute.


Astuce

Nous pouvons appliquer la classification seulement sur une portion de l’image si nous disposons d’un raster de masque. Un tel raster de masque doit avoir des valeurs positives sur les régions à classifier et négatives sur les régions à ignorer. Si nous disposons d’un tel masque nous le renseignons à la ligne Input Mask.



Nous obtenons un raster au format .tif présentant notre classification en 7 classes (Fig. 405).
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Fig. 405 Classification de l’image du Caire en 7 classes par Random Forest.
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Post-traitement d’une classification

Une fois qu’une classification supervisée ou non a été faite, il est souvent nécessaire d’y appliquer un ou plusieurs post-traitements. Dans le cas d’une classification supervisée, il est notamment nécessaire d’en faire une évaluation, appelée validation.
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Validation d’une classification supervisée

Après avoir effectué une classification supervisée d’images satellites, il est nécessaire de la valider. Une validation est en fait le calcul d’un ensemble d’indicateurs qui nous permettent d’apprécier quantitativement la justesse de notre classification. Un processus de validation fournit en premier lieu une matrice de confusion qui nous indique la qualité de la classification classe par classe. En second lieu, nous pouvons tirer de cette matrice de confusion des indicateurs globaux renseignant sur la qualité de la classification dans son ensemble.

Concrètement, une validation de classification résulte de la comparaison entre le raster de classification et des polygones de contrôle digitalisés manuellement par l’utilisateur (Couche de validation). Cette comparaison peut se faire à l’aide de différents outils dont certains sont présentés ici.

Dans ces exemples d’application, nous allons valider une classification de l’occupation du sol de la région du Caire [https://www.openstreetmap.org/search?query=caire#map=8/30.045/31.805] en Égypte à partir d’une image Landsat 5 TM du 13 juillet 2011. Cette classification a été mise en œuvre dans la partie dédiée aux classifications.


Note

Avec certains outils il est possible de faire la validation directement au moment de la classification. Ici, nous verrons seulement les outils qui proposent de faire la validation à postériori.



Pour rappel, la classification du Caire que nous souhaitons valider dans cet exemple est un usage du sol en sept classes comme présentées dans le tableau suivant.







	ID classe

	Label classe





	1

	Eau



	2

	Végétation inondée



	3

	Végétation dense



	4

	Sol nu sableux



	5

	Sol nu rocheux



	6

	Bâti dense



	7

	Bâti diffus







Validation avec le plugin SCP de QGIS

Version de QGIS : 3.18.1

Version de SCP : 7.8.7


Lancement

Le plugin SCP de QGIS permet de faire des classifications supervisées ou non supervisées et propose également un grand panel d’outils tournant autour de ces questions de classifications. L’un de ces outils est justement un outil de post-traitement permettant de calculer une matrice de confusion et des indicateurs quantitatifs relatifs à la qualité d’une classification supervisée. Pour utiliser cet outil, il est nécessaire de disposer d’un raster de classification et de polygones de contrôle, c’est-à-dire d’une couche de validation. Cette couche de validation s’obtient par digitalisation manuelle de polygones de contrôle (Couche de validation).


Astuce

Le raster de classification peut bien sûr être issu d’une classification effectuée à l’aide du plugin SCP, mais peut également avoir été produit avec tout autre outil.



L’outil de validation se trouve dans le menu SCP ‣ Post-traitement ‣ Précision. Le menu suivant s’affiche (Fig. 406).
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Fig. 406 Paramètres de la validation.



Dans le champ Sélectionner la classification à évaluer, nous sélectionnons le raster à évaluer. Si il n’apparaît pas dans le menu déroulant, il peut être nécessaire de rafraîchir cette liste en cliquant sur l’icône Actualiser la liste [image: icone_refresh]. Ensuite, dans le champ Sélectionner le vecteur ou raster de référence, nous choisissons le fichier de polygones de contrôle. Enfin, dans le champ Champ vec, nous indiquons le champ de la couche vecteur qui contient les identifiants numériques de classe. Bien sûr ces identifiants doivent être identiques à ceux du raster de classification. Ensuite, nous lançons la validation en cliquant sur Lancer.

Les polygones de contrôle vont être rasterisés afin d’être comparés à la classification. Le module nous demande de sauver cette rasterisation à un endroit de notre choix. Nous pouvons la nommer valid_2011.tif.



Lecture

Deux sorties ont été produites : un raster et un fichier texte au format .csv. C’est le fichier texte qui va nous intéresser. Ce texte est également reproduit dans le panneau Sortie de la fenêtre de validation de SCP (Fig. 407).


[image: alternate text]

Fig. 407 Sortie texte de la validation par SCP.



Le raster est à mettre en parallèle du premier bloc du fichier texte selon la figure suivante (Fig. 408). Sur cette figure, nous prenons d’abord l’exemple de pixels du raster de validation présentant la valeur 2 (en bleu). La signification de cette valeur se trouve dans le premier bloc de texte du fichier csv. La valeur 2 correspond ainsi aux pixels étant identifiés en référence comme appartenant à la classe 1 (eau). C’est-à-dire que ces pixels appartiennent à des polygones de contrôle identifiés comme étant de la classe 1. Mais ces pixels correspondent également à des pixels classifiés en classe 1. C’est-à-dire que ces pixels sont en 1 sur le raster de classification. Au final, ce sont donc des pixels classifiés en 1 et identifiés en contrôle en 1 également. Il s’agît donc de pixels d’eau bien classés. Nous pouvons en plus lire sur le fichier texte qu’en tout, 2308 pixels appartiennent à cette catégorie. Il y 2308 pixels classifiés en eau et dont le contrôle nous dit bien qu’il s’agît d’eau.

Par contre, les pixels en vert sont des pixels labellisés 37. Cette valeur de 37 correspond aux pixels qui appartiennent à des polygones de contrôle de Sol nu rocheux (classe 5) mais qui ont été classifiés en Sol nu sableux (classe 4). Il s’agît donc des pixels confondus entre les deux classes de sol nu. En tout, 680 pixels, parmi les pixels de contrôle, présentent cette confusion.
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Fig. 408 Raster de validation produit par SCP.



Ce raster de validation est un sous produit intéressant pour visualiser finement dans l’espace les zones qui posent problème. Ce raster peut aider l’utilisateur à revoir ces zones d’entraînement en y incluant éventuellement des polygones représentatifs des problèmes.

Le deuxième bloc du fichier texte correspond à la matrice de confusion, appelée ici matrice d’erreur (Fig. 409).
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Fig. 409 Matrice d’erreur en compte de pixels.



Dans cette matrice, en ligne nous retrouvons les 7 classes d’occupation du sol de nos polygones de validation, i.e. la vérité terrain (> Référence). En colonne, nous retrouvons ces 7 mêmes classes d’occupation du sol mais telles que classifiées (V_Classified). La classe 0 correspond aux pixels non classifiés, ici les bords de l’image, nous pouvons en faire abstraction.

À chaque intersection de lignes et de colonnes, nous retrouvons un nombre (un compte) de pixels. Par exemple, parmi nos polygones de contrôle, 2308 pixels ont été identifiés comme de la classe 1 (eau) et en même temps classifiés comme étant de la classe 1. La diagonale correspond ainsi au nombre de pixels correctement classés pour chaque classe.

La colonne Total correspond au nombre total de pixels de chaque classe recouverts par nos polygones de validation. Ainsi, nos polygones de validation recouvrent 2518 pixels de notre raster de classification classés en eau (classe 1). De même, nos polygones de validation recouvrent 5055 pixels de bâti diffus (classe 7) sur notre raster de classification.

La ligne Total correspond au nombre total de pixels recouverts pour chaque classe de polygone de validation. Par exemple, les polygones de validation identifiés comme étant de l’eau (classe 1) recouvrent 2308 pixels du raster de classification. Dans la même idée, les polygones de validation identifiés comme étant du bâti diffus (classe 7) recouvrent 6546 pixels du raster de classification.

Grâce à ces éléments, nous pouvons calculer les deux indicateurs suivants : la qualité producteur (Qualité producteur et erreur par omission) et la qualité utilisateur (Qualité utilisateur et Erreur par commission).

Le bloc suivant du fichier texte intitulé Area Based Error Matrix reprend cette matrice de confusion mais exprimée en aires non biaisées. Nous ne la détaillerons pas ici.

Enfin, les lignes Précision globale et Kappa hat classification présentent des statistiques de qualité globale. La précision globale doit tendre vers 100 % et le Kappa hat classification doit tendre vers 1.


Note

Au final, SCP propose un outil plutôt puissant pour évaluer la qualité d’une classification supervisée. Le raster de validation est particulièrement intéressant pour visualiser les pixels non correctement classés. Les matrices de confusion calculées présentent tous les éléments nécessaires à l’évaluation de la classification. Cependant, une documentation pour bien comprendre toutes les sorties serait la bienvenue.






Validation avec Orfeo ToolBox

Version de OTB : 9.0.0

OTB propose un module dédié au calcul d’une matrice de confusion suite à une classification supervisée. En entrée, il est logiquement nécessaire de disposer d’un raster de classification d’occupation du sol (construit avec OTB ou un autre outil) et de polygones de validation. OTB va confronter ces deux données pour calculer une matrice de confusion qui renseignera sur la qualité de la classification. Comme tout module OTB, il est utilisable via QGIS ou via la ligne de commande otbcli dédiée.


Avec OTB via QGIS

Le module dédié se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Learning ‣ ComputeConfusionMatrix. Le menu suivant s’ouvre (Fig. 410).
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Fig. 410 Module de calcul de matrice de confusion dans OTB.



À la ligne Input image nous pointons vers le raster de classification à évaluer, ici classif_7.tif. Nous indiquons ensuite dans le menu déroulant que nous souhaitons sortir une matrice de confusion (confusionmatrix) et non pas une table de contingence. Puis, dans le panneau Ground truth nous allons renseigner la vérité terrain sous forme d’un fichier vecteur ou raster. Ici nous disposons de polygones de validation, donc d’un fichier vecteur. Nous sélectionnons donc vector dans le menu déroulant Ground truth. Ensuite nous pointons vers le fichier vecteur contenant les polygones de validation à la ligne Input reference vector data, ici valid_7.gpkg. Puis nous spécifions le Field name contenant l’identifiant des classes, id_classe. À la ligne Matrix output nous indiquons un chemin et un nom pour la matrice de confusion qui sera produite. Cette matrice sera sous forme d’un fichier texte. Nous pouvons la nommer confusion.csv. Il ne reste plus qu’à cliquer sur Exécuter.



Création via la ligne de commande

Cette manipulation peut se faire en utilisant la ligne de commande otbcli dédiée. Cette manipulation peut être pratique dans le cas d’une automatisation de processus. La ligne de commande à utiliser est la suivante :

otbcli_ComputeConfusionMatrix -in classif_7.tif -ref vector -ref.vector.in valid_7.gpkg -ref.vector.field id_classe -out confusion_matrix.csv





où :


	otbcli_ComputeConfusionMatrix : l’appel au module


	-in classif_7.tif : le raster de classification à évaluer


	-ref vector : l’indication si la couche de validation est sous forme de raster ou de vecteur


	-ref.vector.in valid_7.gpkg : le fichier de polygones vecteur à utiliser pour la validation (utiliser -ref.raster.in si la couche de validation est au format raster)


	-ref.vector.field id_classe : l’indication du nom du champ qui contient les identifiants numériques des classes


	-out confusion_matrix.csv : le nom de la matrice de confusion à produire




Après l’exécution de cette commande nous retrouvons bien notre matrice de confusion au format .csv.


Astuce

En utilisant ce module via la ligne de commande nous obtenons les indicateurs de qualité calculés en sortie sur la console.





Lecture

La matrice est créée sous forme de fichier texte. Le format n’est pas des plus commodes, il est nécessaire de le changer un peu avant d’interpréter la matrice. Nous pouvons commencer par ouvrir de fichier texte avec un éditeur de texte, mais la lisibilité est compliquée. Il est plus simple de l’ouvrir avec un tableur comme Excel ou LibreOffice Calc. Nous pouvons régler les séparateurs comme étant la « virgule » (,) et les deux points (:). Malgré ça, une fois le fichier ouvert, il faut encore décaler les colonnes de chiffres de une colonne vers la droite et copier - coller en transposé les chiffres de la première ligne d’en-tête, afin d’obtenir une matrice comme présentée ci-dessous (Fig. 411).
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Fig. 411 Ouverture et réglage de la matrice de confusion OTB dans un tableur.



Comme souvent pour les matrices de confusion, les lignes correspondent aux classes de référence, c’est-à-dire aux classes de vérité terrain soit les classes de validation. Les colonnes, quant à elles, correspondent aux classes prédites i.e. les classes simulées ou classifiées. La grille de lecture est la même que pour une matrice de confusion créée avec le plugin SCP. Sur cet exemple, la valeur 1547 à l’intersection de la colonne 1 et de la ligne 1 signifie que 1547 pixels identifiés comme appartenant à la classe 1 en validation ont en effet été classifiés en classe 1 par notre classification. La classe 1 correspond ici à l’eau, donc 1547 pixels identifiés comme étant de l’eau en validation ont bien été classifiés en eau. Par contre, 20 pixels identifiés comme étant de la classe 1 (eau) en validation ont été classifiés comme appartenant à la classe 2 (végétation inondée). L’eau a donc tendance a être (légèrement) sous évaluée par rapport à la végétation inondée. Mais la confusion entre les deux classes n’est pas forcément surprenante, la végétation inondée contient par définition de l”eau.

Au contraire, la classe 4 - sol nu sableux - est largement confondu avec la classe 7 bâti diffus. En effet, 10317 pixels identifiés comme étant du sol nu sableux en validation sont bien classifiés en sol nu sableux mais 1388 de sol nu sableux ont été classifiés en bâti diffus . Là encore ce résultat était attendu, vu la difficulté de bien distinguer ces deux occupations du sol même visuellement sur l’image de départ.

Il est possible d’aller plus loin dans l’analyse de cette matrice en calculant les indicateurs quantitatifs renseignant sur la qualité globale de la classification ou sur la qualité classe par classe (Indicateurs de qualité). Pour cela, il est nécessaire d’ajouter une colonne de somme tout à droite et une ligne de somme tout en bas (somme en ligne et somme en colonne (Fig. 412).
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Fig. 412 Somme en ligne et en colonne d’une matrice de confusion calculée avec OTB.



Ces sommes se lisent comme suit. Par exemple, ici sur la ligne des sommes, 3665 pixels ont été classifiés en classe 2. Tandis que sur la colonne des sommes nous constatons que 3844 pixels ont été identifiés en validation comme appartenant à la classe 2.


Note

Au final, OTB propose un module basique de calcul de matrice de confusion. Il serait pratique que cette matrice soit exportée dans un format mieux structuré et que certains indicateurs globaux soient déjà calculés.






Indicateurs de qualité

À partir d’une matrice de confusion il est possible de calculer une batterie d’indicateurs quantitatifs renseignant sur la qualité d’une classification. Certains indicateurs renseignent sur la qualité de classification classe par classe et d’autres renseignent sur la qualité globale de la classification. Pour les exemples suivants, nous nous baserons sur la matrice de confusion suivante (Fig. 413).
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Fig. 413 Matrice d’erreur en compte de pixels avec les sommes en lignes et colonnes.




Qualité utilisateur et Erreur par commission

La qualité utilisateur (user’s accuracy en anglais), aussi appelée précision utilisateur,  s’obtient, pour chaque classe, en divisant le nombre de pixels correctement classés par le nombre total de pixels prédits dans cette classe. Cela revient à diviser le nombre de pixels bien classés (sur la diagonale) par le total en colonnes. Par exemple, ici, la qualité utilisateur de la classe Végétation inondée (classe 2) est de :


\[\frac{3642}{3665} = 99.37 \%\]

Cette qualité utilisateur revient à répondre à cette question : « Si je vais sur un endroit de ta carte qui a été classifié en 2, quelle est la probabilité que cet endroit soit réellement du 2 sur le terrain ? ».

À partir de qualité utilisateur il est possible de calculer une erreur par commission. Cette erreur par commission correspond à la proportion des pixels qui ont été incorrectement attribués à une classe particulière. Elle se calcule en retranchant la qualité utilisateur à 1.


\[ErreurParCommission = 1 - QualitéUtilisateur\]

Dans notre cas, pour la classe 2 :


\[1 - 0.9937 = 0.0063\]

Nous pouvons donc dire que notre classe 2 est surestimée de 0.63 %.



Qualité producteur et erreur par omission

La qualité producteur (producer’s accuracy en anglais), aussi appelé rappel produecteur, s’obtient, pour chaque classe, en divisant le nombre de pixels correctement classés par le nombre total de pixels utilisés en validation pour cette classe. Cela revient à diviser le nombre de pixels bien classés (sur la diagonale) par le total en lignes. Par exemple, ici, la qualité producteur de la classe Végétation inondée (classe 2) est de :


\[\frac{3642}{3844} = 94.75 \%\]

Cette qualité producteur revient à répondre à cette question : « Quelle est la probabilité qu’une zone réellement en 2 sur le terrain soit classifiée en 2 sur ta carte ? ».

À partir de qualité producteur il est possible de calculer une erreur par omission. Cette erreur par omission correspond à la proportion de pixels qui appartiennent réellement à une classe sur le terrain qui n’ont pas été classifiés dans cette classe. Elle se calcule en retranchant la qualité producteur à 1.


\[ErreurParOmission = 1 - QualitéProducteur\]

Dans notre cas, pour la classe 2 :


\[1 - 0.9475 = 0.0525\]

Nous pouvons donc dire que 5.25 % de nos pixels de classe 2 n’ont pas été détectés.



Précision globale

La précision globale (Overall accuracy en anglais) s’exprime en pourcentage et renseigne sur la qualité globale de la classification. Elle se calcule en divisant la somme des pixels bien classés par la somme totale des pixels. Par exemple, ici :


\[\frac{1547 + 3642 + 75 + 10317 + 4545 + 1646 + 2412}{27378} = 88.33 \%\]



Indice Kappa

L’indice kappa (ϰ), calculé sur l’ensemble des classes, renseigne également sur la qualité globale de la classification. Son calcul prend en compte le fait que certains pixels peuvent être bien classés au hasard. Cet indice varie entre -∞ et 1. Plus le kappa se rapproche de 1 meilleure est la classification. Il est possible d’interpréter les valeurs de l’indice ϰ en suivant ce tableau.







	Indice ϰ

	Interprétation





	< 0

	Désaccord



	0 - 0.2

	Accord très faible



	0.21 - 0.40

	Accord faible



	0.41 - 0.60

	Accord modéré



	0.61 - 0.80

	Accord fort



	0.81 - 1.00

	Accord presque parfait







Avertissement

Les matrices de confusion et les indicateurs associés sont des outils indispensables à tout processus de classification. Toute classification doit être accompagnée d’une matrice de confusion commentée. Par contre, il faut garder en tête que la matrice de confusion est extrêmement dépendante des échantillons de classes digitalisés par l’utilisateur.







Fusion de classifications

Il existe de nombreuses méthodes de classifications supervisées d’images satellites, basées sur différents algorithmes comme le Random Forest, le Support Vector Machine, Normal Bayes Classifier, … De plus, chacune peut prendre en entrée des valeurs de paramètres définis par l’utilisateur. Par exemple, une classification en Random Forest prend en entrée un nombre d’arbres, une profondeur d’arbre maximale, … Au final, il n’est pas toujours facile de choisir un résultat de classification parmi d’autres. Une stratégie consiste à effectuer plusieurs classifications, soit en utilisant des algorithmes différents, soit en utilisant des paramètres d’entrée différents, puis de fusionner ces différents résultats de classification. L’idée est d’obtenir la classification qui résume le mieux les différents résultats. Il existe différentes façon d’effectuer ces fusions, selon les outils utilisés.


Fusion de classifications avec OTB

Version de OTB : 9.0.0

Le logiciel Orfeo ToolBox propose un outil pour fusionner plusieurs classifications, nommé FusionOfClassifications. Cet outil propose deux méthodes de fusion : Majority Voting et Dempster Shafer combination. Nous détaillerons ici la première méthode. Pour l’exemple, nous avons effectué 5 classifications supervisées d’une scène Landsat au-dessus de la ville du Caire, en Égypte. Ces classifications ont été faites avec 4  algorithmes différents et 2 configurations différentes pour la classification utilisant le Random Forest (Fig. 414).
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Fig. 414 Cinq classifications différentes et résultat de leur fusion (entourée en bleu).




Avec OTB via QGIS

Dans OTB avec QGIS, pour lancer le module de fusion, il suffit d’aller dans le menu Boîte à outils de traitements ‣ OTB ‣ Learning ‣ FusionOfClassifications. Le menu suivant s’ouvre (Fig. 415).
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Fig. 415 Fusion de cinq classifications dans OTB.



Dans le panneau Input Classifications, nous indiquons les classifications à fusionner, à savoir nos cinq classifications. À la ligne The output classification image, nous indiquons le chemin et le nom du raster résultant à la fusion. Dans le menu déroulant Fusion method, nous choisissons la méthode de fusion à utiliser, ici Majority voting. Via cette méthode, dans le raster de fusion, à chaque pixel nous allons associer la valeur qui revient le plus souvent dans les classifications. Par exemple, dans la zone Zoom de la figure (Fig. 414), les pixels sont classés en Bâti diffus (en rouge clair) dans deux classifications et en Sol nu sableux (en jaune) dans trois classifications. Par conséquent, dans la fusion, cette zone sera classée en Sol nu sableux (3 occurrences VS 2 occurrences).

Cette méthode a une limite lorsque le choix ne peut pas être fait, c’est-à-dire quand il n’y a pas de classes majoritaires. Par exemple, sur un zoom de la fusion précédente, un tel problème apparaît (Fig. 416). Par défaut, une valeur sera attribuée à ces pixels sans décisions. Cette valeur est à O par défaut mais peut être changée à la ligne Label for the Undecided class.
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Fig. 416 Choix majoritaire impossible pour les pixels 1 et 2.



Sur la figure (Fig. 416), le pixel 1 apparaît une fois classifié en Bâti diffus (en rouge clair), deux fois en Sol nu rocheux (en orange) et deux fois en Sol nu sableux (en jaune). La fusion par Vote majoritaire ne peut donc pas faire de choix. Le pixel apparaît donc en 0 sur le raster de fusion final. Le même cas de figure existe pour le pixel 2. Le choix est impossible entre Bâti diffus (en rouge clair) et Sol nu sableux (en jaune). Si l’utilisateur le souhaite, il est possible de changer à posteriori ces valeurs en no data puis de les combler d’une façon ou d’une autre avec la classe majoritaire la plus proche par exemple.

La seconde méthode de fusion proposée Dempster Shafer combination est plus complexe et repose sur l’analyse des matrices de confusion de chacune des classifications à fusionner. Pour les détails de cette méthode, reportez vous à la page dédiée de la documentation du module FusionOfClassifications de OTB [https://www.orfeo-toolbox.org/CookBook/Applications/app_FusionOfClassifications.html?highlight=fusion#].



Avec la commande otbcli

En ligne de commande, l’opération est simple, il suffit de bien respecter la syntaxe et de bien se placer dans le répertoire qui contient nos classifications à fusionner. Nous commençons par appeler le module otbcli_FusionOfClassifications, nous définissons ensuite les classifications en entrée via le paramètre -il, puis nous définissons le nom du raster de fusion résultat via le paramètre -out. Enfin, nous choisissons la méthode de fusion via le paramètre -method. Dans notre cas, la ligne de commande est la suivante :

otbcli_FusionOfClassifications -il classif_7_RF.tif classif_7_RF-2.tif classif_7_Shark_RF.tif classif_7_SVM.tif classif_7_KNN.tif -method majorityvoting -out classification_fused.tif





L’avantage est qu’en ligne de commande, le processus tourne très vite.
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Segmentation d’images

La segmentation d’images est une technique de traitement d’images qui permet d’individualiser des zones homogènes sur une image. Ces zones homogènes sont appelées segments. Cette technique permet par exemple de classifier une image non pas en individualisant les pixels un par un mais en replaçant chaque pixel dans son contexte immédiat. L’avantage de cette technique est de fournir des segments d’images, i.e. des zones homogènes d’images, qu’il est possible de transformer en polygones vecteurs. Cette transformation en polygones permet de calculer de nouveaux attributs pour chaque segment comme une superficie, un périmètre, un indice de forme, un indice de voisinage… Cette technique de segmentation est également connue sous l’acronyme anglais OBIA pour Object-Based Image Analysis.

Cette technique de segmentation est plus particulièrement utilisée sur des images en très haute résolution spatiale (THRS), comme les images issues du capteur Pléiades (ou tout autre capteur satellite de THRS) ou les orthophotographies. Cependant rien n’empêche d’appliquer cette technique à tout type d’images quelle que soit sa résolution spatiale.

Le but d’une segmentation est la plupart du temps le calcul d’une occupation du sol ou l’identification de certaines classes ou certains objets. C’est une technique qu’il est, par exemple, possible d’employer pour détecter les espaces verts urbains à partir d’othophotographies de milieux urbains ou bien pour détecter des voitures sur des parkings ou des bateaux dans un port.

Le terme de Segmentation recouvre souvent quatre étapes qui s’enchaînent :


	la segmentation proprement dite pour détecter les segments homogènes de l’image


	la vectorisation des segments obtenus en transformant les segments en polygones vecteurs


	le calcul de primitives pour caractériser ces segments, comme des valeurs de réflectances moyennes, des surfaces, des indices de formes, des moyennes de NDVI, MNDWI,..


	la classification supervisée de ces segments polygonisés pour détecter les objets d’intérêt




Différents logiciels de géomatique proposent des fonctionnalités plus ou moins complètes de segmentations d’images. Néanmoins, Orfeo ToolBox (OTB) est un de ceux proposant la solution la plus complète.

Dans la suite de cette section, nous prendrons l’exemple de l’extraction des espaces verts des alentours de la Place d’Italie [https://www.openstreetmap.org/search?query=place%20d%27italie#map=16/48.8309/2.3559] dans le 13ème arrondissement de Paris, à partir d’une orthophotographie infrarouge centrée sur cette place. L’orthophotographie est issue de la BD Ortho [https://geoservices.ign.fr/documentation/donnees/ortho/bdortho] fournie par l’IGN via son portail Géoservices [https://geoservices.ign.fr/bdortho]. Sa résolution spatiale est de 20 cm, elle se compose de trois canaux : proche-infrarouge (bande 1), rouge (bande 2) et vert (bande 3) et est référencée en Lambert 93. Une vue en fausses couleurs de la zone prise en exemple est montrée sur la figure suivante (Fig. 417).
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Fig. 417 Orthophotograhie centrée sur la Place d’Italie (Paris 13ème), en rouge le canal du proche-infrarouge, en vert le canal du rouge et en bleu le canal du vert.




Note

La segmentation d’images est une technique puissante mais qui s’avère être très procédurière. Il faut bien être attentif aux différentes étapes. Le géomaticien distrait a vite fait de se perdre dans les méandres de cette technique. Mais une fois la logique acquise, le processus coule de source.
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Segmentation d’images avec Orfeo ToolBox

Dans OTB il existe plusieurs façons de procéder pour segmenter une image, nous verrons ici une des plus utilisées. Nous commencerons par détailler l’étape de Segmentation proprement dite. Cette étape se subdivise elle-même en trois sous étapes. Dans un premier temps nous verrons comment réaliser ces trois sous étapes une par une puis nous verrons une solution qui permet de les chaîner en une seule sous étape.


Segmentation de l’image en trois sous-étapes

Nous commencerons par voir le processus de segmentation de façon détaillée en passant par les trois (ou quatre) sous-étapes qui sont :


	le lissage de l’image initiale (facultatif)


	la segmentation de cette image lissée


	la fusion des plus petits segments avec les grands segments voisins les plus similaires (facultatif)


	la vectorisation de la segmentation





Lissage de l’image initiale

Cette étape de lissage n’est pas indispensable mais elle permet d’accélérer les traitements. Le but est de simplifier l’image initiale en homogénéisant les zones similaires d’un point de vue radiométrique. Le module permettant ce lissage se nomme MeanShiftSmoothing et se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Image Filtering ‣ MeanShiftSmoothing. Le menu suivant s’affiche (Fig. 418).
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Fig. 418 Lissage de l’image initiale avec le module MeanShiftSmoothing de OTB.



Dans le menu de ce module, à la ligne Input Image nous pointons vers l’image à lisser, ici Place_Italie_ortho_IRC_0m20_2018-01-01.jp2. À la ligne Spectral filtered output, nous indiquons un chemin et un nom pour le raster lissé qui sera créé, nous pouvons le nommer place_italie_smooth.tif. Les paramètres suivants peuvent être modifiés ou laissés à leurs valeurs par défaut :


	Spatial radius : le rayon maximal (en pixels) sur lequel les zones seront lissées


	Range radius : l’écart de radiométrie maximal pour que deux pixels soient lissés




Autrement dit, deux pixels qui seront distants de moins d’un spatial radius et qui auront une différence de radiométrie inférieure à un range radius seront lissés. C’est-à-dire une même valeur moyenne dans chaque bande leur sera attribuée. Par contre, deux pixels éloignés de plus d’un spatial radius ne seront pas lissés. De même que deux pixels dont les radiométries diffèrent de plus d’un range radius ne seront pas lissés, même si ils sont spatialement voisins.

Les autres paramètres peuvent être laissés à leurs valeurs par défaut.


Avertissement

OTB lit sans problème les images au format .jp2 mais peut rencontrer des problèmes pour écrire des images dans ce format. Il est conseillé d’exporter les résultats OTB en .tif.



Le résultat est un raster au format .tif de même résolution et de même emprise que le raster initial mais dont les valeurs ont été localement lissées (Fig. 419). Nous constatons que ce lissage permet de réduire ce qui pourrait s’apparenter à du bruit. Les zones similaires voisines ont été comme aplanies.
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Fig. 419 Zoom sur l’orthophotographie initiale (A) et sur la même portion mais sur le raster lissé (B).





Segmentation de l’image (lissée)

Une fois l’image lissée (Lissage de l’image initiale) il est maintenant possible de la segmenter. Le module conseillé se nomme LSMSSegmentation et se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Segmentation ‣ LSMSSegmentation. LSMS signifie Large Scale Meanshift Segmenation. C’est-à-dire que cette segmentation emploie la méthode dite Meanshift (une méthode de segmentation couramment employée) codée pour s’appliquer aux objets à large échelle (aux images lourdes). Le module se paramètre comme présenté sur la figure suivante (Fig. 420).
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Fig. 420 Segmentation de l’image précédemment lissée dans OTB.



À la ligne Filtered image nous indiquons l’image à segmenter c’est-à-dire l’image lissée que nous avons précédemment calculée place_italie_smooth.tif. Nous pouvons laisser le menu Filtered position image vide. Concernant le Spatial radius et le Range radius, nous pouvons laisser les valeurs par défaut ou bien les changer. Dans notre cas, nous mettons le Range radius à 5. Les autres champs peuvent conserver leurs valeurs par défaut. Les deux champs Size of tiles in pixel (X-axis) et (Y-axis) correspondent à la taille de la fenêtre qui sera utilisée pour accélérer le traitement de l’algorithme. En effet, ce module, pour accélérer les calculs, découpe l’image en sous images, dont la taille est définie par ces deux champs, et segmente ces sous images une par une. Les différentes sous segmentations sont ensuite fusionnées en une seule. À la ligne Output labeled image nous indiquons un chemin et un nom pour l’image segmentée qui sera produite place_italie_segments.tif.

Le résultat est un raster découpé en segments, où chaque segment correspond à une région homogène de l’orthophotographie initiale (Fig. 421). Chaque segment possède un identifiant unique.
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Fig. 421 Résultat de la segmentation au format raster.




Note

Ne trouvez-vous pas qu’il y a un petit côté artistique de type tableau fauviste de Derrain [https://duckduckgo.com/?q=fauvisme+derain&t=ffab&iar=images&iax=images&ia=images] ?





Fusion des petits segments

Cette étape est tout à fait facultative mais peut s’avérer très intéressante. Il est possible que lors du processus de segmentation des très petites zones aient été individualisées. Ces petites zones peuvent être constituées d’un seul pixel ou d’une poignée de pixels. Même si ces zones respectent les critères de segmentation définis précédemment, elles ne sont pas forcément pertinentes et vont alourdir fortement le poids du fichier vecteur qui sera créé par la suite.

Il est donc possible de simplifier notre raster de segmentation en fusionnant les zones plus petites qu’un certain seuil avec la zone voisine la plus similaire et de taille supérieure au seuil fixé. Cette opération se fait en utilisant le module LSMSmallRegionsMerging se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Segmentation ‣ LSMSmallRegionsMerging. Le menu suivant s’affiche (Fig. 422).
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Fig. 422 Fusion des petits segments issus de la segmentation.



À la ligne Input image nous renseignons l’image lissée place_italie_smooth.tif. À la ligne Segmented image, nous vers le raster des segments place_italie_segments.tif. À la ligne Output image, nous indiquons un chemin et un nom vers la couche raster qui contiendra les segments fusionnés, par exemple place_italie_segments_merged.tif. Enfin, à la ligne Minimum Segment Size, nous définissons la taille minimale des segments en pixels, ici nous pouvons laisser 50. Concrètement, tous les segments de moins de 50 pixels seront fusionnés au segment de plus de 50 pixels adjacent et le plus similaire. Nous pouvons laisser les menus Size of tiles à leurs valeurs par défaut.



Vectorisation de la segmentation

L’étape suivante consiste à vectoriser ce raster de segmentation, éventuellement fusionné. Chaque segment sera ainsi transformé en un vecteur de type polygone. Cette transformation permettra par la suite de calculer des primitives (i.e. des caractéristiques) de chaque segment. Ce processus de vectorisation peut se faire en utilisant un module dédié de OTB LSMSVectorization qui se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Segmentation ‣ LSMSVectorization (Fig. 423). De plus l’intérêt de ce module est qu’il calcule par défaut pour chaque segment les valeurs moyennes des différentes bandes spectrales initiales, ainsi que les variances de ces bandes spectrales pour chaque segment.
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Fig. 423 Vectorisation d’un raster de segmenation avec OTB.



À la ligne Input image, nous indiquons l’image initiale à savoir l’orthophotographie non lissée Place_Italie_ortho_IRC_0m20_2018-01-01.jp2. Cette indication permettra au module de calculer les moyennes et les variances de chaque bande spectrale pour chaque segment. À la ligne Segmented image nous indiquons le raster résultat de la segmentation (avec les petits segments fusionnés de préférence) tel que calculé à l’étape précédente (Segmentation de l’image (lissée)) place_italie_segments_merged.tif comme expliqué ici : Fusion des petits segments. À la ligne Output GIS vector file, nous indiquons un chemin et un nom pour le fichier vecteur de type polygones qui sera créé place_italie_segments.shp. Les autres paramètres peuvent conserver leurs valeurs par défaut.


Avertissement

OTB ne gère pas encore le format Geopackage dans ce module. Il est donc nécessaire de travailler au format shapefile. Notez également qu’il est nécessaire d’écrire à la main l’extension .shp dans le nom du fichier exporté pour que le module fonctionne.



Le résultat est un fichier vecteur contenant autant de polygones que de segments issus de la segmentation, ce qui représente souvent un très grand nombre (Fig. 424). Il est possible de superposer ces polygones à l’orthophotographie initiale pour apprécier visuellement le résultat (Fig. 424).
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Fig. 424 Polygones des différents segments superposés à l’orthophotographie initiale.



Même si tous les segments identifiés n’apparaissent pas comme étant pertinents nous constatons tout de même que les différents objets de l’image semblent avoir été individualisés. Nous pouvons tout de suite voir que les ombres constituent un problème majeur dans ce type d’approche.

Cette couche de polygones possède une table attributaire dans laquelle chaque ligne correspond à un polygone, i.e. un segment. À chaque segment sont associées différents attributs :


	label : un label unique pour chacun des segments.


	nbPixels : le nombre de pixels contenus dans le segment.


	mean : les colonnes commençant par mean contiennent les valeurs moyennes de chaque bande du raster initial sous chaque segment.


	var : les colonnes commençant par var contiennent les variances de chaque bande du raster initial sous chaque segment. De façon logique, les segments ne comportant qu’un seul pixel ont une variance de 0.





Avertissement

Il se peut que la couche vecteur générée présente des erreurs de géométrie (des points redondants, des lignes qui se recoupent …). Si tel est le cas, il est nécessaire de réparer la couche, par exemple en utilisant le module réparer les géométries (Réparer la géométrie) de QGIS.




Note

L’étape de fusion des petits segments (Fusion des petits segments) permet d’obtenir une couche vecteurs contenant 103400 polygones contre 3523543 pour la version sans fusion. Hormis le fait que la couche générée avec l’option de fusion sera beaucoup plus facile et rapide à manipuler, les segments extraits ne perdent pas forcément en pertinence (Fig. 425).
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Fig. 425 Segmentation avec l’option de fusion (A) et sans l’option de fusion (B).






Segmentation de l’image en une seule étape

Comme dit en introduction, si les trois étapes discutées précédemment permettent de bien visualiser chaque sous-étape, OTB propose également un module permettant de chaîner ces trois sous-étapes en un seul traitement. C’est le module LargeScaleMeanShift qui fera ce chaînage (Fig. 426).`Nous le retrouvons dans la Boîte à outils de traitements ‣ OTB ‣ Segmentation ‣ LargeScaleMeanShift.


Astuce

Dans la phase exploratoire de la méthodologie il est bon de faire les sous-étapes une par une pour visualiser les résultats intermédiaires. Et une fois la méthodologie mise au point, il est possible de l’appliquer de façon plus automatique avec le module permettant de tout chaîner d’un coup.
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Fig. 426 Segmentation en une seule étape dans OTB.



À la ligne Input image nous indiquons l’orthophotographie initiale Place_Italie_ortho_IRC_0m20_2018-01-01.jp2. Nous pouvons régler ou laisser par défaut les valeurs du Spatial radius, Range radius ou Minimum Segment Size. Reportez vous à la partie précédente pour avoir des détails sur ces paramètres. Dans le panneau Output mode, nous spécifions si nous souhaitons le résultat sous forme de raster ou de vecteurs de types polygones. Ici, nous choisissons une sortie sous forme de vecteurs en sélectionnant vector, puis à la ligne Output GIS vector file nous indiquons le chemin et le nom du fichier vecteur qui sera créé, par exemple place_italie_segments_all_in_one.shp. Nous pouvons laisser les paramètres Size of tiles à leurs valeurs par défaut.


Avertissement

Cette méthode All in One produit des résultats quelque peu différents. Les segments sont un peu plus détaillés que ceux obtenus avec les trois sous-étapes effectuées une par une.





Calcul de primitives

Un résultat de segmentation n’est intéressant que pour l’exploitation qui s’ensuit. Une fois une couche de polygones de segments dérivée d’une image initiale, la plupart du temps nous devons classifier les segments de cette couche afin d’en dériver une occupation du sol ou bien d’extraire un type d’objets bien précis. Cette analyse se fait, la plupart du temps, par un processus de classification supervisée. Un tel processus suppose de décrire les polygones de segments en fonction de caractéristiques, autrement dit de primitives, pertinentes. C’est à partir ce ces primitives que le modèle que nous construirons un modèle qui apprendra à reconnaître les différents segments. Par défaut, OTB nous calcule déjà les valeurs moyennes pour chaque bande ainsi que les variances pour chaque bande et chaque segment (Vectorisation de la segmentation). Ainsi, pour chaque segment nous disposons déjà des moyennes et des variances des bandes sous-jacentes du raster initial.

Si ces primitives de base ne suffisent pas, c’est à l’utilisateur d’en ajouter de nouvelles. Ces primitives peuvent être des caractéristiques associées directement aux polygones comme la superficie, le périmètre ou un indice de forme comme le rapport entre superficie et périmètre. Ce type de primitives s’ajoutent très facilement en calculant ces nouveaux champs pour chaque polygone. Pour plus de détails sur ces manipulations, vous pouvez vous référer au chapitre consacré (Calcul de champs).

Pour les primitives portant sur des valeurs de bandes ou d’indices sous-jacents aux polygones, nous utiliserons le concept de Statistiques zonales pour associer des valeurs moyennes ou de variances (ou tout autre statistique) à chacun des polygones. Ici, par exemple, nous souhaitons extraire la végétation de notre orthophotographie, il est donc pertinent d’associer un NDVI moyen pour chaque polygone. Nous pouvons penser que les segments de végétation auront en effet un NDVI plus élevé que les autres. La première étape consiste donc à calculer le raster de NDVI à partir de notre orthophotographie (Fig. 427). Ce calcul peut se faire via la calculatrice raster de QGIS par exemple (Calcul sur plusieurs rasters) ou via celle de OTB (Calcul raster avec OTB).
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Fig. 427 NDVI calculé à partir de l’orthophotographie initiale. Les pixels en vert foncé sont ceux à fort NDVI.




Avertissement

Les valeurs radiométriques des pixels d’une orthophotographie ne sont pas exactement comme des réflectances issues d’images satellites, le NDVI est donc légèrement différent, un peu décalé vers les valeurs basses.



Nous pouvons également noter que OTB propose un module pour calculer le NDVI, et d’autres indices, à partir d’un raster multi-bandes, nommé RadiometricIndices*.

Hormis les valeurs de bandes et les indices, il peut également être intéressant de calculer des rasters d’indices de texture. Ces indices de texture renseignent sur l’homogénéité, l’hétérogénéité ou la granularité sur une ou plusieurs bandes. Par exemple, sur une orthophotographie les routes ou les toits apparaissent comme étant lisses alors que les espaces arborés apparaissent granuleux (Fig. 419 A). Les indices de texture renseignent de façon quantitative sur ces aspects.

Une fois ces indices radiométriques ou de textures calculés, nous devons les associer aux polygones de segments par statistiques zonales. Pour rappel, il est possible de combiner plusieurs rasters de primitives sous forme d’un Raster virtuel puis de calculer des statistiques zonales sur ce raster multi-bandes pour chaque polygone (Statistiques zonales sur raster multi-bandes avec QGIS). OTB propose également un module de calcul de statistiques zonales nommé ZonalStatistics (Statistiques zonales raster avec OTB).


Avertissement

Si la géométrie de la couche présente des erreurs, réparez la à l’aide du module de QGIS Réparer les géométries (Réparer la géométrie).



Quelque soit les outils employés, à la fin de cette séquence, nous devons avoir un fichier vecteur de type polygones, où à chaque polygone sont associées différentes valeurs qui peuvent être des statistiques zonales de différents indices radiométriques ou texturaux, des statistiques zonales de bandes ou des caractéristiques relatifs à leurs formes. C’est sur ce fichier vecteur que se fera l’étape suivante à savoir la classification. Dans notre exemple, nous avons ajouté le NDVI moyen et la variance du NDVI pour chaque polygone issu de notre segmentation. Le tout est sauvé dans une couche que nous nommons par exemple segments_primitives.gpkg.



Classification des segments

Une fois les segments caractérisés par l’ajout de primitives, nous pouvons passer à la phase de classification de ces segments. La plupart du temps nous procédons par classification supervisée. Orfeo ToolBox propose un module pour classifier des segments selon plusieurs algorithmes standards comme le Random Forest, le Support Vector Machine, le KNN classifier, …

Comme tout processus de classification supervisée, la première chose à faire est de définir les classes que nous souhaitons obtenir, et de leur associer un identifiant unique. Dans notre exemple, nous souhaitons nous focaliser sur la végétation, nous viserons donc la classification décrite dans le tableau suivant.


Tableau 23 Classification visée





	ID classe

	Label classe





	1

	Végétation



	2

	Bâti



	3

	Ombres






Par Bâti nous comprenons tout ce qui n’est pas de la végétation à savoir les routes, les toits, les façades, … La classe Ombres n’est pas une vraie classe d’occupation du sol bien sûr, mais nous sommes souvent obligés d’individualiser les ombres lorsque nous travaillons avec ce type d’images.


Segments d’apprentissage

Ce module nécessite en premier lieu la construction d’une nouvelle couche de polygones qui servira de couche d’apprentissage. Pour créer cette couche, nous commençons par dupliquer la couche de polygones de segments qui contient les primitives segments_primitives.gpkg. Nous pouvons nommer cette couche dupliquée qui nous servira à l’apprentissage segments_train.gpkg. Une fois cette couche dupliquée, nous l’ouvrons dans QGIS par exemple et nous la superposons à l’orthophotographie initiale. Le but est d’identifier visuellement un certain nombre (trois ou plus) de segments représentatifs de nos 3 classes. Pour cela, nous créons deux nouveaux champs dans la table attributaire (Calcul de champs). Nous nommons le premier id_classe et nous le définissons comme étant de type Entier. Ce champ stockera l’identifiant de la classe d’appartenance du segment. Nous créons un second champ nommé label_classe de type Texte qui nous servira simplement à plus facilement identifier les classes par leur vrai nom.

Une fois ces deux champs créés, nous sélectionnons quelques polygones que nous identifions comme étant de la Végétation arborée (classe 1) et nous mettons à jour les champs id_classe et label_classe de ces polygones. Nous procédons de même pour les deux autres classes.


Avertissement

À chaque mise à jour de la table, vérifiez bien que vous ne mettez à jour que les champs des entités sélectionnées !



Une fois ces polygones d’apprentissage renseignés, nous sélectionnons tous les polygones dont les champs id_classes et label_classe ne sont pas renseignés (Requêtes attributaires dans QGIS) et nous les supprimons. Nous disposons ainsi d’une couche ne présentant que des polygones clairement identifiés. Ce sont sur ces polygones que nous allons faire apprendre le modèle de classification.



Segments de validation

Comme pour tout processus de classification supervisé, nous devons associer une phase de validation à notre étude. La validation consistera à comparer les segments classifiés suite à l’apprentissage à certains segments que nous aurons au préalable identifiés pour la validation. Nous devons donc créer une couche de segments de validation en tout points identiques à celle que nous avons créée pour les segments d’apprentissage (Segments d’apprentissage). Cette couche ne doit contenir que les polygones renseignés pour la validation. La seule chose à faire attention est de ne pas sélectionner de polygones qui ont déjà servi à l’apprentissage. Les polygones des deux couches d’apprentissage et de validation ne doivent donc pas se superposer du tout. Nous pouvons nommer cette couche de validation segments_valid.gpkg.

À la fin de cette étape nous disposons d’une couche de polygones (de segments) d’apprentissage et d’une couche de polygones (de segments) de validation (Fig. 428).
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Fig. 428 Segments d’apprentissage en orange et segments de validation en vert.




Avertissement

Les champs contenant les identifiants numériques des classes doivent être nommés de la même manière dans les couches d’apprentissage et de validation.





Processus de classification

Une fois ces deux couches créées et renseignées, il est temps de passer à l’étape de classification proprement dite. Cette étape peut se faire directement dans Orfeo ToolBox en deux phases :


	phase d’apprentissage : nous faisons apprendre à un modèle à reconnaître l’occupation du sol des différents polygones grâce à la couche d’apprentissage (Segments d’apprentissage)


	phase d’application du modèle : nous appliquons le modèle construit à tous les polygones non renseignés afin de déterminer à quelle occupation du sol ils appartiennent.




Phase d’apprentissage

Cette phase d’apprentissage se fait à l’aide du module TrainVectorClassifier, qui se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Learning ‣ TrainVectorClassifier, le menu suivant s’affiche (Fig. 429).
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Fig. 429 Entraînement du modèle sur les polygones d’apprentissage.



À la ligne Input Vector Data, nous indiquons la couche d’apprentissage à utiliser, à savoir segments_train.gpkg. Dans le panneau Field names for training features nous indiquons le nom des champs contenant les primitives sur lesquelles le modèle doit apprendre, ici ce sont les deux champs de NDVI ndvi_mean et ndvi_variance. À la ligne Validation Vector Data, nous spécifions quelle couche de validation nous devons utiliser, ici segments_train.gpkg. À la ligne Field containing the class integer label for supervision, nous indiquons quel champ contient les identifiants numériques des classes, à savoir id_classe. Dans le panneau Classifier to use for the training, nous choisissons un algorithme de classification, le Random forests classifier (rf) par exemple. À la ligne Output model, nous indiquons un chemin et un nom pour le fichier de modèle qui sera créé. Nous pouvons le nommer model_classif.txt. Ce fichier de modèle sera un fichier texte difficilement compréhensible par nous mais néanmoins lisible avec un éditeur de texte. À la ligne Output confusion matrix nous indiquons un nom et un chemin vers la matrice de confusion qui sera créée, par exemple confusion_matrice.csv. Nous pouvons laisser les paramètres de l’algorithme de classification par défaut. Puis nous n’avons plus qu’à cliquer sur Exécuter.

À ce stade, un simple fichier texte de modèle a été créé.

Application du modèle

Une fois le modèle construit, nous l’appliquons aux segments à classifier à l’aide du module VectorClassifier qui se trouve dans la Boîte à outils de traitements ‣ OTB ‣ Learning ‣ VectorClassifier. Le menu suivant s’affiche (Fig. 430).
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Fig. 430 Application du modèle aux polygones non renseignés.



À la ligne Name of the input vector data, nous sélectionnons la couche des segments à classifier. À savoir la couche vecteur issue de la segmentation qui contient les primitives, segments_primitives.gpkg. Il s’agît de la couche produite à la fin l’étape de calcul des primitives (Calcul de primitives). À la ligne Model file, nous pointons vers le fichier texte de modèle généré à l’étape précédente. À la ligne Output field, nous spécifions le nom que prendra le champ qui contiendra les valeurs de classes prédites. Nous pouvons lui laisser sa valeur par défaut.

Dans le panneau Field names to be calculated, nous indiquons les champs qui doivent être calculés lors du processus de classification, à savoir les deux champs de NDVI ndvi_mean et ndvi_variance. Enfin, à la ligne Output vector data file, nous indiquons un chemin et un nom pour le fichier vecteur qui sera créé, par exemple segments_classif.shp. Nous cliquons sur Exécuter pour lancer le processus.


Avertissement

À ce stade, un bug empêche OTB d’exporter la couche des segments classifiés au format Geopackage, il faut donc l’exporter au format shapefile en spécifiant bien l’extension .shp.



Nous disposons maintenant d’une couche de polygones classifiée selon nos trois classes. Nous pouvons charger cette couche dans QGIS et changer sa symbologie pour apprécier le résultat (Fig. 431).
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Fig. 431 Résultat de la classification des segments en vue générale (A) avec la végétation en vert et en vue zoomée (B) avec le détour des polygones de végétation.



Nous constatons que le résultat n’est pas parfait, notamment les arbres qui semblent être les moins en forme ne sont pas repérés, mais dans l’ensemble, le résultat semble satisfaisant.




Validation de la classification

La validation de la classification se fait de façon classique via la matrice de confusion qui a été générée lors de la Phase d’apprentissage. Cette matrice se nomme ici confusion_matrice.csv. Se reporter au chapitre dédié à la lecture des matrices de confusion pour l’interprétation.


Avertissement

Lorsque peu de polygones ont été sélectionnés pour l’apprentissage et la validation, la matrice peut être artificiellement excellente. Dans l’idéal il faudrait sélectionner un grand nombre de polygones surtout pour la validation, et ne pas hésiter à sélectionner des polygones difficiles.
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Calculs géomorphologiques

Il est souvent utile en géographie de dériver des données d’intérêt géomorphologique à partir de modèles numériques de terrain (MNT). À partir d’un MNT, il est notamment possible de calculer un raster de pentes.
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Calcul de pentes

Calculer des pentes à partir d’un modèle numérique de terrain (MNT) est une manipulation très courante. La plupart des outils de SIG intègrent une fonction permettant de faire ce calcul. À la fin de ce calcul, nous obtenons un raster, de même dimension que le MNT initial, mais dans lequel les pixels ne représentent plus une valeur d’élévation mais une valeur de pente locale. Cette pente peut être exprimée en degrés ou en pourcentage. Le choix de l’unité est en général laissé à la discrétion de l’utilisateur.

Dans les exemples suivants, nous allons calculer les pentes du bassin-versant de la Vésubie [https://fr.wikipedia.org/wiki/V%C3%A9subie] (Alpes-Maritimes) à partir du MNT local issu du SRTM ( »srtm_vesubie.tif »).


Calcul de pentes avec QGIS

Version de QGIS : 3.16.1

Dans un premier il est nécessaire de charger ce MNT dans QGIS. Une fois ce raster chargé, nous allons dans le menu Raster ‣ Analyse ‣ Pente… La fenêtre suivante s’affiche (Fig. 432).
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Fig. 432 Paramétrage du calcul de pentes dans QGIS.



Dans le champ Couche source, nous spécifions le MNT à utiliser, ici srtm_vesubie. Dans le champ Pente, nous spécifions un chemin d’export de notre raster de pentes. Les autres options peuvent être laissées telles quelles. En cochant la case Pente exprimée en pourcentage plutôt qu'en degrés permet d’obtenir un raster de pentes exprimés en pourcentage. Nous pouvons également constater que cet outil est en fait un simple interface à une fonction GDAL, comme nous pouvons le voir dans le panneau Console GDAL/OGR. Le raster de pentes apparaît ensuite automatiquement dans QGIS.
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Capture de données sur le terrain

Nous allons voir dans cette partie comment capturer des données sur le terrain, comme des traces GPS ou des photos localisées dans l’espace.
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Capture d’une trace GPS

Capturer une trace GPS peut être utile lorsque nous sommes amenés à faire du terrain. Nous allons voir ici comme capturer facilement une telle trace avec un smartphone.

Concrètement, nous allons régler notre smartphone de telle sorte qu’il enregistre notre localisation GPS à des intervalles de temps réguliers pendant une durée définie par l’utilisateur. Des arcs relieront automatiquement ces points individuels afin de les assembler en trace. Cette trace sera sauvegardée en format .gpx, format standard pour ce type de fichier. Ce fichier gpx pourra ensuite être importé dans un logiciel SIG comme QGIS pour l’intégrer à un projet géomatique.


Trace GPS avec l’application OsmAnd

L’application OsmAnd [http://osmand.net/] est basée sur le projet de carte collaborative ̀ OpenStreetMap`_. OpenStreetMap est à la cartographie ce que Wikipedia est à l’encyclopédie. C’est une carte globale construite par une communauté de contributeurs. C’est une donnée reconnue pour sa qualité même si cette dernière est forcément inégale d’un endroit du monde à un autre. Cependant, d’une manière générale, nous pouvons totalement nous y fier.

OsmAnd est l’application pour smartphone qui permet d’utiliser ces cartes de façon mobile. OsmAnd est disponible pour Android et IOS gratuitement. Il existe une version payante qui offre des possibilités supplémentaires, mais la version gratuite est largement suffisante pour ce que nous souhaitons faire.


Astuce

En passant par le dépôt F-Droid [https://f-droid.org/], il est possible de télécharger gratuitement la version intégrale de OsmAnd.




Installation et configuration

Une fois l’application installée, au premier lancement il est proposé de télécharger la carte de la région dans laquelle nous nous trouvons. Ce téléchargement du fond de carte nous permettra d’utiliser cette application en mode hors-ligne. L’écran principal affiche notre localisation et la direction dans laquelle nous pointons notre appareil sur le fond de carte OSM. En bas à gauche de l’écran nous pouvons accéder au menu général (Fig. 433).
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Fig. 433 Vue générale (à gauche) et accès au menu de OsmAnd (à droite).



Nous allons maintenant charger le plugin (aussi appelé greffon) qui permet d’enregistrer une trace GPS. Pour cela nous allons dans le menu et nous sélectionnons l’entrée Greffons supplémentaires (ou Plugins selon la langue d’installation). Nous allons activer le deux greffon permettant d’enregistrer une trace Trip recording et celui permettant de prendre une note (audio, vidéo ou photo) géoréférencée Audio/video notes (Fig. 434).
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Fig. 434 Activation de greffons supplémentaires.



Pour activer ces greffons, il suffit de cliquer sur l’icône [image: icone_osmand_explore] et de sélectionner Activer. Une fois cette activation effectuée, si ces greffons n’apparaissent pas automatiquement sur la vue générale, nous pouvons activer leur affichage. Cela se fait via le menu général en choisissant l’entrée Configure screen. Le menu de configuration de l’écran s’affiche et nous pouvons alors choisir les greffons à afficher sur la vue générale. Nous sélectionnons Trip recording et Audio/video notes. Il est également intéressant d’afficher l’altitude et les informations relatives au signal GPS (Fig. 435).
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Fig. 435 Configuration de l’écran (à gauche) et affichage des greffons (à droite).





Capturer et sauvegarder une trace

L’option d’enregistrement de trace et les autres greffons apparaissent en haut à droite de l’écran. Pour lancer un enregistrement, nous cliquons sur REC. Un menu nous demandant l’intervalle de temps entre deux enregistrements de points s’ouvre. Nous pouvons laisser la valeur par défaut (Fig. 436).


Avertissement

À priori plus cet intervalle de temps sera court, plus la trace sera précise. Néanmoins, la position enregistrée n’est pas parfaite, surtout avec un smartphone. Ainsi, dans un déplacement de position enregistrée il y a une part de « vrai » déplacement mais également une part de bruit.




[image: alternate text]

Fig. 436 Mise en route de l’enregistrement (à gauche) et configuration du pas de temps de l’enregistrement.



Lorsque l’enregistrement est en cours, un point rouge apparaît au niveau du menu d’enregistrement. Pour mettre fin à l’enregistrement, il suffit de recliquer sur le menu REC (Fig. 437).
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Fig. 437 Sauvegarder la trace GPS (à gauche) et la nommer (à droite).



Pour sauvegarder la trace, nous sélectionnons Save current track. D’autres choix sont possibles comme la mise en pause de la capture, ce qui peut être intéressant lorsqu’on s’arrête à une étape. Il faut ensuite nommer sa trace.



Visualiser et exporter une trace

Une fois la trace capturée, elle s’affiche automatiquement sur la vue générale de l’application. Si ce n’est pas le cas, il suffit de se rendre dans le menu principal et de sélectionner Configure map (Fig. 438).
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Fig. 438 Affichage de la trace GPS (à gauche) et choix de l’affichage (à droite).



Via le menu de configuration de la carte, il est possible d’afficher et de désafficher la trace enregistrée. En cliquant sur l’icône [image: icone_osmand_choix], il est possible de faire de même avec d’autres traces qui auraient été capturées précédemment.

Il est possible d’accéder à plus de détails concernant notre trace en se rendant dans le menu principal et en sélectionnant le Dashboard (Fig. 439).
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Fig. 439 Sélection de la trace GPS (à gauche) et affichage des détails (à droite).



Dans le Dashboard, nous trouvons un panneau contenant les traces. Lorsque nous cliquons sur une trace, ses détails s’affichent. Nous retrouvons la trace sur la carte mais également d’autres éléments. Sur le graphique central, nous trouvons le linéaire de la trace assorti de l’évolution de l’altitude le long de ce linéaire (en bleu) et de l’évolution de la vitesse lors du capture de la trace (en orange). Si nous sélectionnons l’option Show on map, nous synchronisons la position sur le graphique et sur la carte. Au dessous, nous retrouvons d’autres informations comme la distance totale, la durée de l’enregistrement, et les dates de début et de fin.

Nous pouvons également exporter notre trace à partir de ce menu. En cliquant sur l’icône de partage [image: icone_osmand_partage], nous pouvons par exemple nous l’envoyer par mail.


Note

Au final, nous disposons là d’un outil très intéressant et plutôt complet lorsque nous souhaitons capturer une trace GPS sans autre matériel que son smartphone.



Une fois la trace GPS exportée, il est possible de l’importer dans un logiciel SIG (Importer des points GPS).





Prendre une photo géoréférencée

Lorsque nous arpentons notre terrain d’études ou lors d’une simple randonnée il peut être intéressant de prendre une photo avec sa localisation GPS. Cette localisation nous permettra ensuite d’inclure cette photo dans un projet de géomatique.

Cette manipulation peut, par exemple, être utile lorsque nous souhaitons confronter une image satellite à la réalité terrain. Les photos peuvent alors servir de validation à une classification d’image satellite.


Prendre une photo géolocalisée en « natif » avec son smartphone

Il est possible d’associer automatiquement la géolocalisation aux photos prises avec son smartphone. Ainsi, dès qu’une photo est prise, ses métadonnées incluront les coordonnées géographiques de la prise de vue et même parfois la direction visée.

Pour activer cette fonctionnalité, il suffit d’aller dans les réglages de la caméra au moment de prise de la photo. Dans les réglages, il y a une ligne qui permet d’activer ou non la localisation des photos. Cette méthode a l’avantage d’éviter de passer par une application tierce pour prendre des photos géolocalisées.


Avertissement

Avec cette méthode, toutes vos photos seront géolocalisées. Attention, si vous partagez vos photos sur les réseaux sociaux, tout le monde sera capable de vous tracer.





Prendre une photo géolocalisée avec l’application OsmAnd

Nous montrerons ici la procédure à suivre pour prendre ce genre de photos avec l’application OsmAnd. Pour des détails sur cette application, référez vous à la section consacrée à la capture de traces GPS. Il est tout d’abord nécessaire d’activer le module Audio/video notes dans le gestionnaire de greffons accessible via le menu général (Fig. 440).
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Fig. 440 Activation du greffon de prises de notes audios et vidéos (à gauche) et ouverture du menu de prises de photos (à droite).



Une fois ce greffon installé, une icône Start apparaît en haut à droite de la vue générale. Pour prendre une photo, il suffit de cliquer dessus (Fig. 441).


[image: alternate text]

Fig. 441 Prise de photo (à gauche) et localisation de la photo (à droite).



Une fenêtre s’ouvre nous demandant si nous souhaitons prendre une note audio (i.e. un enregistrement audio), une vidéo ou une photo. Nous sélectionnons le dernier choix. La fonction d’appareil photo classique du smartphone s’ouvre alors. Une fois la photo prise, une icône de photo apparaît à l’emplacement précis de la prise de vue sur la vue générale de OsmAnd.


Note

Si nous choisissons de prendre un enregistrement audio ou vidéo et que nous nous déplaçons pendant la prise de son ou de vue, la localisation restera celle du déclenchement de l’enregistrement.



Il est ensuite possible de voir les détails de la photo prise. Pour cela, nous retournons dans le menu principal et nous ouvrons le Dashboard (Fig. 442).
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Fig. 442 Liste des photos (à gauche) et détails de la photo sélectionnée (à droite).



Dans ce Dashboard, nous trouvons un panneau Audio/video notes dans lequel sont listées toutes nos photos et autres notes. Si nous cliquons sur notre photo, sa position sur la carte apparaît. Nous pouvons également voir la photo sur cette même vue en tirant la fenêtre vers le haut.

Notons qu’il est tout à fait possible de renommer une photo si le nom par défaut ne nous convient pas. Il suffit d’aller dans le menu général et dans le menu My Places et dans l’onglet A/V Notes (Fig. 443).
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Fig. 443 Renommer, effacer ou exporter une photo.



En cliquant sur l’icône [image: icone_osmand_explore], nous trouvons les outils de manipulation de l’image, notamment celui pour la renommer. Nous pouvons également exporter notre photo à partir de ce menu en cliquant sur l’icône de partage [image: icone_osmand_partage2].


Note

Il aurait été pratique de pouvoir associer une petite note écrite à une photo afin de donner quelques éléments de contexte.



Une fois des photos localisées dans l’espace capturées, il est possible de les importer dans un logiciel SIG comme QGIS (Importer des photos localisées).
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Rendu cartographique et visualisation

Le rendu cartographique est souvent un des produits finaux d’un projet géomatique faisant intervenir des SIG ou de la télédétection. Nous allons voir ici la façon de procéder pour réaliser quelques rendus cartographiques (et autres). Il ne s’agît pas de faire un cours de cartographie, nous verrons des rendus relativement simples. Reportez vous à des manuels de cartographie pure pour de plus amples détails et à des documentations spécialisées pour les traitements avancés.
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Visualisation 3D

Lorsque nous disposons d’une couche géographique possédant une valeur en z comme une valeur d’altitude, il est possible de créer une visualisation en 3D de nos données. C’est notamment le cas lorsque nous disposons d’un modèle numérique de terrain (MNT). Il est possible de visualiser le terrain comme si nous le survolions. Nous pouvons même y superposer des couches vecteurs ou des couches rasters pour mieux appréhender notre zone d’études.


Note

Il est abusif de parler de 3D dans la plupart des cas. En toute rigueur, nous devrions parler de visualisation en 2.5D. En effet, un MNT reste un simple plan. Les pixels le constituant ne sont pas en trois dimensions. Nous parlons alors de 2.5D car la vue que nous créons s’apparente plus à une feuille de papier froissé qu’à un vrai pavé en trois dimensions.



Dans les exemples suivants, nous allons visualiser en 3D le Mont Elbrouz [https://fr.wikipedia.org/wiki/Elbrouz], le plus haut sommet d’Europe, situé dans la chaîne du Causase en Russie. Le MNT utilisé sera le SRTM. Par dessus, nous y calquerons une composition colorée en vraies couleurs Landsat 8 de septembre 2020.


Note

La visualisation 3D aide à mieux appréhender son terrain d’études et présente une sortie sexy. Mais d’un point de vue strictement scientifique, elle n’apporte pas grand chose.
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Visualisation 3D dans QGIS avec l’extension QGIS2threejs

Version de QGIS : 3.18.0

Il existe deux façons de créer des vues 3D dans QGIS. La plus aboutie est celle utilisant l’extension nommée QGIS2threejs. Cette extension est basée sur la technologie ̀ threejs`_. Il s’agît d’une extension Javascript permettant d’afficher et de manipuler des objets en 3D dans une page web. Ainsi, grâce à cette extension il sera possible de créer une vue 3D au sein de QGIS mais également d’exporter cette vue dans un fichier HTML. Ce type d’export nous permettra d’explorer et de partager notre vue avec un simple navigateur web sans avoir besoin de QGIS.

Pour commencer, il est nécessaire d’installer l’extension en allant dans le menu Extensions et en cherchant l’extension par son nom QGIS2threejs. Une fois installée, elle est accessible via le menu Internet > QGIS2threejs.

Nous chargeons maintenant notre MNT de la zone SRTM_Elbrouz.tif. Une fois ce raster chargé, nous ouvrons le menu principal de QGIS2threejs. La fenêtre principale de l’extension apparaît (Fig. 444). Dans le panneau Layers, dans le menu DEM, nous cochons notre MNT, à savoir SRTM_Elbrouz. Nous spécifions ainsi que le MNT qui sert de support à la 3d est ce raster ci.
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Fig. 444 Initialisation de la vue 3D.



Le MNT apparaît avec la même symbologie que celle utilisée dans QGIS. Par défaut il s’agît d’un dégradé de gris, avec les altitudes les plus hautes qui tendent vers le blanc et les plus basses vers le noir. En allant dans le menu Widget, il est possible d’afficher le repère x, y, et z (Navigation Widget) en bas à droite et la flèche du nord (North Arrow).

Il est possible de régler l’exagération verticale, i.e. de l’altitude. Par défaut, il n’y en a pas, elle est à 1. Sur l’exemple précédent, elle est réglée à 2, ce qui permet d’accentuer le relief. Pour cela, nous allons dans le menu Scene > Scene Settings… et dans le menu qui s’ouvre nous pouvons mettre la Vertical exaggeration à 2.

Superposer un raster par dessus est très simple. Il suffit de charger le raster d’intérêt, ici LC08_20200927_Elbrouz.tif, dans QGIS et de le mettre au-dessus du raster dans le panneau de couches. La vue 3D se met à jour automatiquement. Notons, que si nous disposions de fichiers vecteurs, il serait possible de les ajouter de la même manière. Nous pourrions également gérer leur affichage via les menus Line, Polygon et Point Cloud du panneau Layers (Fig. 445).
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Fig. 445 Vue 3D avec une composition colorée Landsat superposée.



Il est possible de zoomer et de dézoomer dans cette vue 3D à l’aide de la molette de la souris. Le changement d’inclinaison et d’orientation de la vue se fait à l’aide du curseur de la souris. Pour changer le centre de la vue, cela se fait également via le curseur de la souris mais en maintenant enfoncée la touche Control. Lors des mouvements, la flèche du Nord pointe toujours vers le nord et le repère de navigation suit le mouvement général (Fig. 446).
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Fig. 446 Changement de position de la vue 3D.



Il est possible d’exporter votre vue 3D en image PNG via le menu File > Save scene as… > Image (.png). Il est également possible d’exporter votre vue 3D en un vrai fichier 3D en choisissant le format glTF (.gltf, .glb). Ce format est à la 3D ce que le Jpeg est à la 2D. Vous pourrez par exemple importer votre vue dans un logiciel de 3D comme Blender.

Une force de cette extension est de pouvoir exporter les vues 3D dans un fichier HTML manipulable facilement avec n’importe quel navigateur web. Pour cela, il suffit d’aller dans File > Export to Web… La fenêtre d’export s’ouvre alors (Fig. 447).
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Fig. 447 Export de la vue 3D pour le Web.



Dans le champ Output Directory nous spécifions un répertoire d’export. Dans le champ HTML filename, nous indiquons un nom pour le fichier HTML principal, ici Elbrouz.html. Nous pouvons indiquer un titre pour la page Web dans le champ Page Title. Il est conseillé de cocher la case Enable the Viewer to Run Locally pour éviter certains bugs d’affichage. Puis nous cliquons sur Export.

Dans notre explorateur de fichier, nous n’avons plus qu’à ouvrir le fichier Elbrouz.html avec un navigateur pour explorer notre vue 3D indépendamment de QGIS.


Note

Au final, cette solution est vraiment très paratique. Le rendu est bon, fluide et rapide. L’intégration dans QGIS est très bonne et la navigation dans la vue 3D facile. La possibilité d’exporter en HTML est également très appréciable, je pense que c’est la meilleure solution pour de la visualisation 3D dans QGIS.





Visualisation avec la Vue Cartographique 3D de QGIS

Version de QGIS : 3.18.0

Il existe dans QGIS, une façon native de visualiser les données en 3D sans passer par des extensions tierces. Cette visualisation se fait à l’aide de la Vue Cartographique 3D.

Une fois notre MNT chargé, nous pouvons ouvrir cette vue 3D via le menu Vue > Nouvelle Vue Cartographique 3D. La vue fenêtre de la vue 3D s’affiche alors. C’est une fenêtre flottante qu’il est possible « d’accrocher » à un des bords de la fenêtre principale de QGIS (Fig. 448).
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Fig. 448 Vue Cartographique 3D de QGIS.



La première chose à faire est de définir le MNT qui va servir de support à la 3D. Pour cela, nous allons dans le menu Options sous l’icône [image: icone_options] et nous sélectionnons Configurer (Fig. 449).
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Fig. 449 Réglage des options de la vue 3D dans QGIS.



Dans le champ Type nous spécifions que nous souhaitons représenter un MNT (couche Raster). Dans le champ Élévation, nous indiquons le MNT à représenter, à savoir SRTM_Elbrouz. Nous pouvons régler l’échelle verticale, qui est en fait l’exagération verticale. Nous pouvons la mettre à 2. Puis nous cliquons sur OK.

Le MNT est vu d’en haut, il faut maintenant régler l’angle de vue pour profiter de la 3D. Pour cela, nous cliquons n’importe où sur la vue 3D et nous bougeons le curseur de la souris en maintenant la touche Majuscule enfoncée. Il est aussi possible de zoomer et dézoomer via la molette de la souris. Nous pouvons également déplacer la vue avec la souris comme nous le ferions du raster dans la fenêtre principale de QGIS (Fig. 450).
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Fig. 450 Réglage de l’angle de vue.



La superposition d’une autre couche se fait simplement en mettant une autre couche par dessus le MNT dans le panneau des couches dans QGIS. En ce qui concerne l’affichage des couches, la vue 3D se comporte comme la vue normale de QGIS. Ici, nous superposons la composition colorée Landsat 8 de septembre 2020 LC08_20200927_Elbrouz.tif (Fig. 451).
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Fig. 451 Superposition d’une composition colorée vraies couleurs Landsat 8.



Il est possible d’exporter une image de sa vue 3D via l’icône [image: icone_export_image] Enregistrer comme image…. Nous pouvons également exporter notre vue en objet 3D .obj manipulable par d’autres logiciels en cliquant sur l’icône [image: icone_export_objet] Export 3D Scene.



Créer une animation ou une vidéo

Il est possible d’exporter une série de vues au format Jpeg afin de les assembler dans un GIF animé ou dans une vidéo. Au final nous obtenons une vidéo d’un survol de notre vue 3D. Pour cela nous ouvrons le panneau d’animation en cliquant sur l’icône Animations [image: icone_export_animation]. Le panneau d’animation s’ouvre en bas de la fenêtre. Par défaut, la vidéo débutera avec la vue qui apparaît au moment de l’ouverture du menu d’animations.

Nous changeons maintenant d’angle de vue, à l’aide du curseur de la souris, pour avoir notre deuxième vue de la vidéo. Lorsque nous somme satisfaits de notre deuxième vue, nous cliquons sur Ajouter une image clé [image: icone_export_add]. Une fenêtre nous demande la position temporelle de cette vue dans l’animation, ici nous indiquons que cette vue doit apparaître après 1 seconde de vidéo (Fig. 452).
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Fig. 452 Position temporelle de la vue.



Nous répétons ensuite cette opération avec autant d’étapes que désirées. Par défaut, la vidéo dure 5 secondes, il est possible de faire une vue toutes les secondes. Ainsi, nous répétons cette étape avec des vues différentes aux positions 2, 3 et 4 secondes. La position de la seconde 5 est déjà fixée par défaut. Mais à l’aide de l’édition des images clés, il est possible de la modifier.

Il faut bien noter, que ce menu d’animations fera des interpolations d’images entre nos différentes vue afin d’obtenir une vidéo fluide. Il est possible de régler la nature de l’interpolation dans le menu Interpolation. Avant d’exporter notre vidéo, nous pouvons la jouer pour en juger la qualité. Il suffit de cliquer sur l’icône [image: icone_export_animation] en bas. Si nous sommes satisfaits, nous exportons les images de l’animation en cliquant sur Exporter les images de l’animation [image: icone_enregistrer]. Il faut bien noter, que nous n’exportons pas la vidéo directement mais seulement les images la constituant. C’est pourquoi la fenêtre d’export des images s’affiche (Fig. 453).
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Fig. 453 Paramètres d’export des images de l’animation.



Nous ne touchons pas au champ Modèle. Nous sélectionnons juste un Répertoire de destination. Les autres réglages peuvent être laissés à leurs valeurs par défaut. Puis nous cliquons sur OK.


Note

Changer la nature de l’interpolation des images ne semble pas changer drastiquement le rendu.



Si nous regardons dans notre explorateur de fichiers le répertoire créé, nous constatons que plusieurs dizaines d’images .jpg ont été exportées. Seules 5 de ces images correspondent aux vues que nous avons définies, les autres résultent de l’interpolation. C’est maintenant à l’utilisateur de créer son animation à partir de ces images. Il est possible de créer un GIF animé, pour les nostalgiques des années 90, ou un fichier vidéo en format .avi, .mp4 ou autre.

Pour un GIF animé, il est possible d’utiliser une solution en ligne ou le logiciel  ̀ImageMagick`_ (disponible sous Linux et Windows) qui s’utilise en lignes de commandes. Une fois ce logiciel installé, nous nous positionnons dans le répertoire contenant les images et nous y ouvrons une invite de commandes. Nous pouvons entrer la commande suivante.

convert *.jpg anim.gif





convert est le mot clé de ImageMagick pour convertir le format des images, ici de .jpg à .gif. *.jpg signifie que nous prenons toutes les images du Jpeg du répertoire. Et anim.gif signifie que nous les assemblons dans un fichier GIF que nous nommons anim. Au bout de quelques secondes, nous obtenons notre GIF animé.

Pour créer une vidéo, nous pouvons utiliser l’utilitaire ffmpeg [https://ffmpeg.org/] qui s’utilise également en ligne de commandes. Comme précédemment, nous nous positionnons dans le répertoire contenant les images, nous ouvrons une invite de commandes et nous pouvons y entrer la commande suivante.

ffmpeg -framerate 25 -pattern_type glob -i '*.jpg' -c:v libx264 Elbrouz.mp4





Pour les intéressés par les options de ffmpeg regardez la documentation sinon acceptons la commande telle quelle. Nous obtenons ici une vidéo .mp4 nommée Elbrouz.mp4. Notons qu’elle pèse bien moins lourd que le GIF animé.
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Divers

Dans ce chapitre vous trouverez quelques outils qui ne sont pas à proprement parler dédiés à la géomatique mais qui peuvent s’avérer utile dans un contexte d’analyse de données géospatiales.
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Fouiller un fichier texte

Dans certains traitements il peut être utile d’aller récupérer une valeur qui se trouve dans un fichier texte, comme un fichier de paramètres ou un fichier de métadonnées. C’est notamment le cas lorsque nous développons un script avec R ou Python et que nous avons besoin de récupérer une valeur stockée dans un fichier texte annexe.


Fouille avec R

Version de R : 4.8.1

Dans cet exemple, nous allons voir comment récupérer le niveau de produit d’une image Landsat stocké dans un fichier de métadonnées associé à l’image traitée. Dans ce fichier au format texte (MTL.txt), l’information recherchée se trouve à la ligne nommée PROCESSING_LEVEL. Dans un premier temps, nous allons donc récupérer les caractères de cette ligne et les stocker dans une variable que nous nommons niveau. Cette récupération se fait à l’aide de la méthode grep qui se trouve de base dans R. Cette méthode prend en entrée la chaîne de caractères recherchée et le fichier dans lequel chercher cette chaîne.

niveau <- grep("PROCESSING_LEVEL", readLines('LC08_L2SP_037034_20201027_20201106_02_T1_MTL.txt'), value = TRUE)





Cette variable niveau contient l’intégralité de la ligne contenant la chaîne de caractères PROCESSING_LEVEL, à savoir PROCESSING_LEVEL = « L2SP » avec les espaces et la tabulation du début de ligne. Il convient donc de nettoyer cette chaîne afin de ne conserver que le niveau L2SP (sans guillemets ni espaces). Pour cela nous utilisons la méthode str_replace() qui se trouve dans la librairie stringr. Cette méthode prend en entrée la chaîne de caractères à modifier, les caractères à remplacer et les caractères de remplacement. Ici, nous commencerons par enlever les caractères « PROCESSING_LEVEL = « , c’est-à-dire remplacer cette chaîne par rien.

library(stringr)
niveau <- str_replace(niveau, 'PROCESSING_LEVEL = ', '')





Nous mettons en fait à jour notre variable niveau en remplaçant la chaîne PROCESSING_LEVEL = (avec un espace après le égal) par aucun caractère comme indiqué par les guillemets vide “”. Notre variable niveau contient maintenant le texte « L2SP » avec encore les guillemets et la tabulation. Il ne reste plus qu’à procéder de même pour enlever ces deux ensembles de caractères.

niveau <- str_replace(niveau, '"', '')
niveau <- str_replace(niveau, '    ', '')





Notre variable niveau ne contient maintenant plus que le niveau L2SP.



Extraire du texte avec R

Version de R : 4.3.2

Version de terra : 1.7.29

Dans certaines chaînes de traitements, il peut être utile de récupérer des caractères inclus dans une chaîne de caractères plus grande. Par exemple, le nom des images satellites, comme Landsat ou Sentinel, sont normalisés et contiennent des informations utiles comme la date d’acquisition, le path and row, le niveau de traitement… L’extraction de caractères peut se faire avec la fonction substring de R. Dans l’exemple ci-dessous, nous chargeons une bande spectrale Landsat, dont le nom est normalisé (nom_landsat) et nous en extrayons les caractères correspondants à la date d’acquisition.

# import d'une bande spectrale Landsat
b_landsat <- terra::rast('./Landsat_13/LC08_L2SP_196030_20190613_20200828_02_T1_SR_B5.TIF')
# on récupère le nom du raster
name_landsat <- names(b_landsat)
# on récupère la date entre les caractères 18 et 25
date_landsat <- substring(name_landsat, 18, 25)





Nous récupérons ainsi la chaîne de caractères 20190613 qui correspond au 13 juin 2019.



Trier avec R

Version de R : 4.3.2

Version de terra : 1.7.29

Il est possible de trier des données quantitatives avec R avec la fonction sort. Le tri se fait par défaut dans l’ordre croissant, mais il est facile de le faire dans l’ordre décroissant en ajoutant le paramètre decreasing = TRUE. Dans l’exemple ci-dessous, nous chargeons une couche vecteur des communes d’Île-de-France qui contient un champ Population renseignant sur le nombre d’habitants de chaque commune. Nous trions ensuite les communes par population décroissante.

# import des communes d'Île-de-France
comm_idf <- terra::vect('communes_IDF.gpkg')
# trier les communes par population décroissante
sort(comm_idf$POPULATION, decreasing = TRUE)
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